Questo manuale dlistruzione & fornito da trovaprezzi.it. Scopri tutte le offerte per LG K51S o cerca il tuo
@ trovaprezzi.it prodotto tra le migliori offerte di Cellulari e Smartphone

@ LG

Life's Good

HSITON3 | YIINHVVI | ONVITVLI

USER GUIDE

LM-K510EMW

Copyright ©2020 LG ElectronicsInc. All rights reserved.

MFL71704203(1.0) www.lg.com


https://www.trovaprezzi.it/Fprezzo_cellulari_lg_k51s.aspx?utm_source=pdf&utm_medium=referral&utm_campaign=pdf_7
https://www.trovaprezzi.it/prezzi_cellulari.aspx?utm_source=pdf&utm_medium=referral&utm_campaign=pdf_7

[TALIANO

Info sulla guida per l'utente

Grazie per aver scelto questo prodotto LG. Per garantire un uso sicuro e corretto
del dispositivo, si prega di leggere con attenzione la guida per l'utente prima di
utilizzarlo per la prima volta.

Utilizzare sempre accessori LG originali. Gli elementi forniti in dotazione sono
progettati esclusivamente per questo dispositivo e potrebbero non essere
compatibili con altri dispositivi.

Le descrizioni si basano sulle impostazioni predefinite del dispositivo.

Le app predefinite presenti sul dispositivo sono soggette ad aggiornamenti e il
supporto per tali applicazioni puo essere sospeso senza preawiso. Per eventuali
domande relative alle app preinstallate sul dispositivo, contattare un Centro di
assistenza LG. Per le app installate dall'utente, contattare il provider del servizio
di riferimento.

La modifica del sistema operativo del dispositivo o linstallazione di software
provenienti da fonti non ufficiali potrebbe danneggiare il dispositivo e causare
il danneggiamento o la perdita di dati. Tali azioni costituiscono una violazione
dellaccordo di licenza LG e annullano la garanzia.

Alcuni contenuti e illustrazioni potrebbero differire dal dispositivo acquistato
a seconda dellarea, del provider del servizio, della versione del software o del
sistema operativo e sono soggetti a modifiche senza preawiso.

| software, laudio, gli sfondi, le immagini e gli altri elementi multimediali forniti
con questo dispositivo sono concessi in licenza per uso limitato. Lestrazione e
[utilizzo di questi materiali per scopi commerciali o altri scopi potrebbe costituire
una violazione delle leggi sul copyright. La piena responsabilita per ['utilizzo
illegale degli elementi multimediali spetta agli utenti.

| servizi relativi ai dati, come ad esempio messaggistica, caricamento e
download, sincronizzazione automatica o servizi di posizionamento, potrebbero
comportare costi aggiuntivi. Per evitare costi aggiuntivi, selezionare un piano
dati adeguato alle proprie esigenze. Per ulteriori informazioni, rivolgersi al
proprio gestore di telefonia mobile.

La presente guida per l'utente e redatta nelle principali lingue per ogni paese. A
seconda della lingua di redazione, i contenuti potrebbero in parte variare.



Notifiche informative

& ATTENZIONE: situazioni che potrebbero provocare lesioni all'utente e a terze parti.

ATTENZIONE: situazioni che potrebbero provocare lesioni lievi o danni al
dispositivo.

E NOTA: awisi o informazioni aggiuntive.

Info sulla guida per lutente
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Indicazioni per un uso sicuro ed
efficiente

Leggere le semplici indicazioni riportate di sequito. Il mancato rispetto di tali indicazioni pud
rivelarsi pericoloso o illegale.

Nel caso si verifichino errori, il software integrato nel dispositivo crea un registro degli errori.
Questo strumento raccoglie solo i dati specifici dellerrore come l'intensita del segnale, la “cell ID
position” quando la chiamata viene interrotta e le applicazioni caricate. Il registro viene utilizzato
solo per determinare la causa dellerrore. Questi registri sono crittografati e possono essere
aperti solo nei centri di riparazione LG autorizzati, nel caso sia necessario restituire il dispositivo
per la riparazione.

Esposizione all'energia elettromagnetica a
radiofrequenze (RF)

Informazioni sullesposizione alle onde radio e sulla SAR (Specific Absorption Rate)
Questo dispositivo e stato progettato in conformita ai requisiti di sicurezza vigenti per
lesposizione alle onde radio. Tali requisiti si basano su precise indicazioni scientifiche che
definiscono, tra laltro, i margini di sicurezza necessari per salvaguardare tutte le persone,
indipendentemente dalleta e dalle condizioni di salute.

+ Le indicazioni sullesposizione alle onde radio fanno riferimento a un'unita di misura detta
SAR, acronimo per Specific Absorption Rate. Le prove relative ai valori SAR sono state
condotte mediante metodi standardizzati con il dispositivo in stato di trasmissione al
massimo livello di alimentazione certificato, con qualsiasi banda di frequenza.

Anche se si possono riscontrare differenze trai livelli SAR nei vari modelli di dispositivi
portatili LG, questi sono comunque stati progettati con unattenzione particolare alle
normative vigenti sullesposizione alle onde radio.

La commissione internazionale ICNIRP (International Commission on Non-lonizing
Radiation Protection) raccomanda un limite SAR pari a 2 \W/kg in media per dieci grammi
di tessuto.

Il valore SAR pili elevato registrato per questo modello per ['uso vicino allorecchio & pari a
0,501 W/kg (10 g) e paria 1,335 W/kg (10 g) a contatto con il corpo.



+ Questo dispositivo e conforme alle direttive sullesposizione alle radiofrequenze quando
utilizzato nella normale posizione d'uso vicino allorecchio o posizionato a una distanza di
almeno 5 mm dal corpo. Se una custodia, una clip per cintura o un altro sostegno vengono
posizionati a stretto contatto con il corpo, tali accessori non devono contenere metallo ed &
importante mantenere il dispositivo a una distanza di almeno 5 mm dal corpo. Il dispositivo
richiede una connessione ottimale alla rete per poter trasmettere file di dati o messaggi.

In alcuni casi, la trasmissione di file di dati o messaggi potrebbe essere ritardata fino a che
tale connessione diventi disponibile. Le istruzioni relative alla separazione del dispositivo dal
corpo devono essere rispettate fino alla fine della trasmissione.

Informazioni fornite dalla FCC in merito
all'esposizione alle frequenze radio

Nellagosto del 1996, la Federal Communications Commission (Commissione federale per

le comunicazioni, FCC) degli Stati Uniti, attraverso azione in Report and Order FCC 96-326,
ha adottato uno standard di sicurezza aggiornato relativo allesposizione umana allenergia
elettromagnetica delle frequenze radio emessa dai trasmettitori con normativa FCC. Tali linee
guida sono coerenti con gli standard di sicurezza in precedenza determinati da standard sia
internazionali sia statunitensi. La progettazione del presente dispositivo & conforme alle linee
guida FCC e a tali standard internazionali.

Parte 15.19

Questo apparecchio e conforme alla parte 15 delle norme FCC. Il funzionamento e soggetto
alle due condizioni riportate di seguito:

(1) Il dispositivo non deve generare interferenze dannose.

(2) Il dispositivo deve accettare eventuali interferenze ricevute, incluse quelle che potrebbero
comportare errori di funzionamento.

Parte 15.21

Modifiche non espressamente approvate dal produttore potrebbero annullare lautorita
dellutente all'utilizzo dellattrezzatura.

Indicazioni per un uso sicuro ed efficiente 6



Funzionamento del dispositivo indosso all'utente

Il presente dispositivo ¢ stato testato per le tipiche funzioni in cui lo siindossa, mantenendo

la parte posteriore del dispositivo a 1 cm (0,39 pollici) di distanza da corpo dell'utente. Per
rispettare i requisiti FCC relativi allesposizione alle frequenze radio, & necessario mantenere
una distanza di separazione minima tra il corpo dell'utente e la parte posteriore del dispositivo
di 1 cm (0,39 pollici). Potrebbe non essere possibile utilizzare fermagli da cintura, custodie

e accessori simili contenenti componenti in metallo. Gli accessori da indossare che non
mantengono una distanza di separazione di 1 cm (0,39 pollici) tra il corpo dellutente e la parte
posteriore del dispositivo e che non sono stati testati per le tipiche funzioni in cui si indossa il
dispositivo potrebbero non rispettare i limiti FCC relativi allesposizione alle frequenze radio e
devono dunque essere evitati.

Parte 15.105

Questa apparecchiatura é stata testata e rispetta i limiti di un dispositivo digitale di Classe B,

ai sensi della parte 15 delle norme FCC. Questi limiti sono stabiliti per fornire una protezione
adatta dalle interferenze dannose in un'installazione residenziale. Questo apparecchio genera,
utilizza e puo irradiare energia in radiofrequenza; inoltre, se non viene installato e utilizzato
secondo le istruzioni, pud causare interferenze dannose alle comunicazioni radio. Tuttavia, non
esiste alcuna garanzia che queste interferenze non si verifichino in una particolare installazione.
Se la presente apparecchiatura causa interferenze dannose o ricezione di canali televisivi,
determinabili accendendo e spegnendo il dispositivo, si consiglia vivamente di tentare di
correggere linterferenza attuando una o piti delle sequenti misure:

Orientare o posizionare di nuovo lantenna di ricezione.
+ Aumentare lo spazio che intercorre tra lapparecchio e il ricevitore.

+ Collegare lapparecchio a una presa su un circuito differente rispetto a quello a cui &
collegato il ricevitore.

Per assistenza, consultare il rivenditore o un tecnico radio/TV esperto.

Indicazioni per un uso sicuro ed efficiente 7



Manutenzione e cura del prodotto

Utilizzare solo gli accessori forniti autorizzati da LG. Qualsiasi danno o guasto causato da
accessori di terze parti non é coperto dalla garanzia LG.

Alcuni contenuti e illustrazioni possono differire dal dispositivo senza preawviso.

Non smontare [apparecchio. Se & necessaria una riparazione, rivolgersi presso un centro
assistenza autorizzato LG.

La garanzia copre, a discrezione di LG, la sostituzione di parti o schede nuove o riconvertite,
funzionalmente equivalenti.

Tenere lontano da apparecchiature elettriche quali TV, radio e PC.

Tenere lontano da fonti di calore quali termosifoni o fornelli.

Non far cadere apparecchio.

Non sottoporre [apparecchio a scosse, urti o vibrazioni.

Spegnere il dispositivo nelle aree in cui e specificamente richiesto. Ad esempio, non
utilizzarlo all'interno di ospedali, in quanto potrebbe interferire con il funzionamento di
apparecchiature mediche sensibili.

Non afferrare il dispositivo con le mani bagnate mentre € in carica. Cio potrebbe provocare
scosse elettriche o danneggiare seriamente il prodotto.

Non ricaricare il telefono vicino a materiali infiammabili che potrebbero provocare incendi a
causa del calore sviluppato dal dispositivo.

Usare un panno asciutto per la pulizia esterna del cellulare (non usare solventi come
benzene, acquaragia o alcol).

Non caricare il dispositivo quando si trova su superfici morbide.

Il dispositivo dovrebbe essere caricato in unarea ben ventilata.

Non esporre [apparecchio a fumo o polvere.

Tenere lontano il dispositivo da carte di credito o supporti magnetici per evitarne la
smagnetizzazione.

Non toccare lo schermo con oggetti appuntiti per evitare di danneggiare il dispositivo.

Non esporre il dispositivo a umidita o a contatto con liquidi.

Usare gli accessori con attenzione e delicatezza. Non toccare [antenna se non strettamente
necessario.

In caso di vetro rotto o scheggiato, non utilizzare il dispositivo, non toccare il vetro, né
tentare di rimuoverlo o ripararlo. I danni al display in vetro dovuti ad abuso o utilizzo non
corretto non sono coperti dalla garanzia.
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Il dispositivo e un dispositivo elettronico che genera calore durante il normale
funzionamento. Il contatto diretto e prolungato con la pelle e lassenza di unadeguata
ventilazione possono provocare disagi e piccole bruciature. Pertanto, € necessario
maneggiare con cura il dispositivo durante o subito dopo ['utilizzo.

Se il dispositivo si bagna, scollegarlo immediatamente e farlo asciugare completamente.
Non tentare di accelerare il processo di asciugatura con una fonte di calore esterna, ad
esempio un forno, un forno a microonde o un asciugacapelli.

Il liquido presente nel dispositivo bagnato potrebbe modificare il colore delletichetta del
prodotto presente allinterno. | danni al dispositivo derivanti dallesposizione ai liquidi non
sono coperti da garanzia.

Un dispositivo mobile ha bisogno di una corretta circolazione dellaria per disperdere il
calore. Il contatto diretto con la pelle ed uninsufficiente circolazione daria sul dispositivo
potrebbe causare un surriscaldamento. Il dispositivo deve trovarsi ad almeno 1,0 cm dal
corpo dellutente.

Evitare che la polvere di sostanze estranee entri nel caricatore / porta del cavo USB. Pud
generare calore o fuoco.

Evitare di esporre il dispositivo a basse pressioni dellaria ad alta quota.

Non esporre il dispositivo a pressioni dellaria estremamente basse. Altrimenti cio pud
causare lesplosione della batteria o perdite di liquido o gas infiammabile.

Evitare che il prodotto venga a contatto con liquidi. Non utilizzare o caricare il prodotto se
& bagnato. Se il prodotto si bagna, indicatore dei danni causati dai liquidi cambia colore.
Tenere presente che cio limitera la possibilita di ricevere eventuali servizi di riparazione
gratuiti previsti dalla garanzia.

Funzionamento efficiente del dispositivo

Dispositivi elettronici

Tutti i dispositivi possono subire interferenze che influiscono sulle prestazioni.

Indicazioni per un uso sicuro ed efficiente

Non utilizzare il dispositivo in prossimita di apparecchiature mediche senza autorizzazione.
Consultare un medico per determinare se ['uso del dispositivo possa interferire con il
funzionamento dell'apparecchio medico.

| produttori di pacemaker raccomandano una distanza minima di 15 cm da altri dispositivi e
pacemaker per evitare possibili interferenze con quest'ultimo.

Il dispositivo potrebbe produrre una luce forte o lampeggiante.
Il dispositivo potrebbe interferire con alcuni tipi di apparecchi acustici.
Il telefono potrebbe interferire con apparecchi televisivi, radio, computer, ecc.

Utilizzare il dispositivo a una temperatura compresa tra 0 °C e 40 °C, se possibile.
Lesposizione del dispositivo a temperature estremamente alte o basse pud causare danni,
malfunzionamenti o perfino esplosioni.



Sicurezza in automobile
Verificare le leggi e le normative che riguardano ['utilizzo dei dispositivi quando si guida.

Non utilizzare il dispositivo in modalita manuale durante la quida.

Prestare la massima attenzione alla guida.

Se le condizioni di guida lo richiedono, accostare e parcheggiare prima di telefonare o
rispondere a una chiamata.

L'energia RF puo influire sul sistema elettronico del veicolo, ad esempio sullo stereo o sulle
apparecchiature di sicurezza.

Se il veicolo  dotato di airbag, non collocarvi accanto oggetti come apparecchi wireless
portatili o installati per evitare lesioni gravi causate dallerrato funzionamento dellair bag.

Durante lascolto della musica tramite il cellulare, assicurarsi che il volume sia
ragionevolmente basso da consentire il rilevamento dei rumori circostanti. Cio &
particolarmente importante in prossimita di strade.

Come evitare danni all'udito

Per evitare eventuali danni all'udito, non ascoltare audio ad alto volume per
lunghi periodi.

L'udito potrebbe danneggiarsi se viene esposto a volumi eccessivi e prolungati nel tempo. Si
consiglia pertanto di non accendere o spegnere il telefono indossando gli auricolari e di tenere il
volume di ascolto delle conversazioni e della musica a un livello ragionevole.
Quando si utilizzano gli auricolari, abbassare il volume se non si riesce a sentire le persone
nelle vicinanze o se il volume & tale da essere udito dalla persona accanto.

E « Lutilizzo di auricolari e cuffie a volume troppo elevato pud causare |a perdita
delludito.

Indicazioni per un uso sicuro ed efficiente 10



Parti in vetro

Alcune parti del dispositivo sono in vetro. Se il dispositivo cade su una superficie rigida o subisce
un forte impatto, il vetro pud rompersi. Se cio accade, non toccare o tentare di rimuovere il
vetro. Non utilizzare il dispositivo finché il vetro non viene sostituito da un centro di assistenza
autorizzato.

Aree a rischio di esplosione

Non utilizzare il dispositivo in aree dove sono in atto operazioni di detonazione. Rispettare le
restrizioni e osservare tutte le norme o i regolamenti al riguardo.

Atmosfere potenzialmente esplosive
+ Non utilizzare il dispositivo in prossimita di stazioni di servizio.
+ Non utilizzare [apparecchio in prossimita di combustibili o prodotti chimici.

+ Non trasportare né conservare sostanze esplosive, liquidi o gas infiammabili allinterno
dellautovettura in cuisi trovano il dispositivo o i relativi accessori.

A bordo di aeromobili
L'uso di dispositivi portatili pud causare delle interferenze al velivolo.
+ Spegnere il dispositivo prima di imbarcarsi su qualsiasi aeromobile.

+ Utilizzarlo a terra (prima o dopo il decollo) solo con il permesso dellequipaggio.

Bambini

Conservare il dispositivo in un posto sicuro, lontano dalla portata dei bambini. Lapparecchio
& composto da parti smontabili di piccole dimensioni che, se ingerite, possono provocare
soffocamento.

Chiamate di emergenza

Le chiamate di emergenza potrebbero non essere disponibili su tutte le reti cellulari. Pertanto,
si consiglia di non affidarsi solo al dispositivo per eventuali chiamate di emergenza. Contattare
il fornitore di servizi locale per conoscere la disponibilita dei servizi di emergenza nel proprio
paese.

Indicazioni per un uso sicuro ed efficiente 1



Manutenzione e informazioni sulle batterie

Non & necessario scaricare completamente la batteria prima di ricaricarla. A differenza
dialtri sistemi a batteria, questo cellulare non presenta un effetto memoria in grado di
compromettere le prestazioni della batteria.

Utilizzare solo batterie e caricabatterie LG, in quanto sono progettati per consentire una
maggiore durata della batteria.

Non smontare né cortocircuitare la batteria.
Tenere puliti i contatti metallici della batteria.

Sostituire la batteria quando le prestazioni non sono pit accettabili. La batteria puo essere
ricaricata centinaia di volte prima che sia necessario sostituirla.

Se la batteria e rimasta inutilizzata per un lungo periodo, ricaricarla per ottimizzarne le
prestazioni.

Non esporre il caricabatterie alla luce solare diretta e non utilizzarlo in ambienti
particolarmente umidi, ad esempio nel bagno.

Evitare di lasciare il dispositivo in luoghi con temperature eccessivamente basse o elevate
per non comprometterne le prestazioni.

L'uso di un tipo di batteria errato pud comportare il rischio di esplosioni. Attenersi alle
istruzioni per lo smaltimento delle batterie usate.

Quando il dispositivo e completamente carico, scollegare sempre il caricabatterie dalla presa
di corrente per evitare consumi energetici non necessari.

La durata della batteria effettiva varia a seconda di configurazione di rete, impostazioni del
prodotto, uso, batteria e condizioni ambientali.

Assicurarsi che la batteria non venga a contatto con oggetti affilati come ad esempio,
forbici, denti o unghie di animali. Cio potrebbe causare incendi.

Indicazioni per un uso sicuro ed efficiente 12



Protezione delle informazioni personali

+ Assicurarsi di proteggere le informazioni personali per evitare la perdita e [uso improprio
delle informazioni sensibili.

+ Esequire sempre il backup dei dati importanti durante ['utilizzo del dispositivo. LG non &
responsabile di eventuali perdite di dati.

Assicurarsi di esequire il backup di tutti i dati e di ripristinare il dispositivo durante lo
smaltimento del dispositivo per impedire 'uso improprio delle informazioni sensibili.

+ Leggere attentamente la schermata delle autorizzazioni durante il download delle
applicazioni.

+ Utilizzare con cautela le applicazioni che hanno accesso a piti funzioni o a informazioni
personali.

Controllare regolarmente gli account personali. In caso di uso improprio, chiedere al provider
del servizio di eliminare o modificare le informazioni del proprio account.

+ In caso di perdita o furto del dispositivo, modificare la password dellaccount per proteggere
le informazioni personali.

+ Non utilizzare applicazioni provenienti da fonti sconosciute.

Indicazioni per un uso sicuro ed efficiente 13



Indicazioni per un uso sicuro ed efficiente

Awviso sulla sostituzione della batteria

+ Una batteria agli ioni di litio & un componente pericoloso che puo causare lesioni
gravi.

« Lasostituzione della batteria da parte di personale non qualificato puo causare
danni al dispositivo.

+ Non sostituire la batteria autonomamente. La batteria potrebbe essere
danneggiata, surriscaldarsi e provocare lesioni. La batteria deve essere sostituita
da personale qualificato. La batteria deve essere riciclata o smaltita separatamente
rispetto ai rifiuti domestici.

Nel caso in cui il prodotto contenga una batteria incorporata nel prodotto che
non puo essere facilmente rimossa dall'utente finale, LG raccomanda che la
batteria venga rimossa solo da professionisti qualificat, sia per la sostituzione sia
per il riciclaggio al termine della vita del prodotto. Per evitare danni al prodotto,

e per la propria sicurezza, gli utenti non devono tentare di rimuovere la batteria,
ma contattare il Servizio clienti di LG o altri fornitori di servizi indipendenti per
ottenere consiglio.

La rimozione della batteria comporta lo smantellamento della custodia del
prodotto, la disconnessione di cavi/contatti elettrici, e [attenta estrazione della
cella batteria utilizzando strumenti specifici. In caso di bisogno di istruzioni per
professionisti qualificati su come rimuovere la batteria in modo sicuro, si prega di
visitare http//www.lge.com/global/sustainability/environment/take-back-recycling.
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Funzioni
personalizzate



Funzionalita fotocamera

Fotocamera grandangolare

E possibile scattare foto o registrare video con un angolo di campo piti ampio
del campo visivo effettivo utilizzando lobiettivo grandangolare della fotocamera
posteriore e di quella anteriore.

Toccare Q> (&), quindi (2) /(@) oppure / per passare dall'obiettivo standard al
grandangolo.

langolo della
fotocamera

Fotocamera posteriore

E « Per ulteriori dettagli, consultare la sezione Awio della fotocamera.

« Puoi passare dalle lenti standard a quelle a campo ampio solo sulla fotocamera
posteriore.

Funzioni personalizzate

Consente di cambiare

16



Ritratto

Puoi scattare un ritratto applicando un effetto di sfocatura delle lenti per la
fotocamera.

1 Tocca (D> (&) quindi tocca Ritratto.

2 Sfiorare () per scattare una foto.

« Perregolare il livello dello sfocaturg, trascina la barra di scorrimento a sinistra

0adestra.

E + Mantieni la distanza dal tuo soggetto entro 1,3 - 5,0 piedi quando usi la
fotocamera posteriore.
Questa funzionalita non e disponibile se 'ambiente ¢ buio.
Dopo avere applicato questa funzionalita, tocca la posizione desiderata sulla
schermata di anteprima per applicare automaticamente il valore di esposizione e
messa a fuoco quando usi la fotocamera posteriore, oppure soltanto un valore di
esposizione quando usi la fotocamera anteriore.

Funzioni personalizzate
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Al CAM

E possibile scattare foto o registrare video in modo efficace in quanto la fotocamera
riconosce ['oggetto quando si scatta una foto o si registra un video.

1 Toccare O > (&) quindi toccare Al CAM.

7 Quando l'oggetto viene riconosciuto, viene applicato il miglior effetto per la
scena.

+ Per applicare altri effetti, toccare licona della scena.

- E possibile riconoscere automaticamente un totale di 8 categorie: animali
domestici, cittg, fiori, cibo, paesaggi, persone, tramonti, auto.

Tramonto Fiore

E « llrisultato del riconoscimento della scena potrebbe essere differente a seconda
dell'illuminazione o della posizione del soggetto quando si scatta |a foto. Le parole
chiave non appaiono sulle foto o i video.

« Questa funzionalita & disponibile solo quando le telecamere posteriore e anteriore
sono in modalita automatica.
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Funzioni della Galleria

Creazione di un filmato
E possibile creare un nuovo filmato, mettendo insieme immagini e video.
T Tocca la scheda O > [¥> Foto, quindi tocca + > Crea filmato.

Puoi anche toccare la scheda O > 3> Play, quindi tocca : > Crea filmato.

7 Selezionare immagini e video per il tuo filmato e toccare Avanti.

3 Modificare le immagini e i video selezionati, quindi toccare Salva.

Funzioni personalizzate
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Eliminazione di file

E possibile selezionare le immagini e i video che vuoi rimuovere dal filmato,
toccando € nelle relative miniature.

Aggiunta di file

E possibile selezionare le immagini e i video che vuoi aggiungere al filmato, toccando
- sul fondo dello schermo. E anche possibile selezionare le immagini e i video che
sono stati aggiunti in precedenza.

E + Toccare e tenere premuto un file, quindi toccare un altro file per una selezione
multipla.

Riorganizzazione dei file

Per riorganizzare le immagini e i video, toccare e tenere premuto il file che si vuole
spostare, quindi trascinarlo nella posizione desiderata.

Reset delle modifiche del filmato

E possibile resettare le modifiche applicate al filmato (ad es. tempo di riproduzione),
toccando &)

Anteprima di un file

Controllare il nuovo video prima del salvataggio, toccando (»). Al termine dalla
riproduzione, il file seguente viene riprodotto in automatico.

E « Per creare un video possono essere utilizzate un massimo di 50 immagini e video.

« lltempo di riproduzione di un'immagine per impostazione predefinita e di 3
secondi, e non pud essere modificato. | video possono essere tagliati fino a un
minimo di 1 secondo.

+ Questa funzione potrebbe non supportare alcuni formati di immagini o video.
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Realizzazione di una GIF
E possibile realizzare una GIF con facilita utilizzando un video o foto registrati.

Crea una GIF utilizzando video registrati.

1 Durante la visualizzazione del video, in corrispondenza del punto di partenza
desiderato, toccare @),

7 Selezionare la durata della GIF che si desidera creare.
+ Viene generata una GIF della durata desiderata a partire dal punto indicato.

+ In caso divideo con durata inferiore ai 5 secondi, le immagini GIF vengono
generate automaticamente per il tempo restante.

Crea una GIF utilizzando foto
T Mentre si sta visualizzando un album, toccare ¢ > Crea GIF.

2 Seleziona le foto desiderati per creare un file GIF, quindi tocca Avanti.
- E possibile aggiungere piti immagini e regolare la velocitd, le proporzioni
schermo e l'ordine dei file della GIF

A - E possibile utilizzare questa funzione solo per finalita creative. L'utilizzo di questa
funzione per finalita che comportino una violazione dei diritti di un altro individuo,
come la violazione del copyright, la diffamazione o dichiarazioni offensive, sara
soggetto a responsabilita civili, penali o amministrative e/o a sanzioni, in base a
quanto stabilito dalla legge applicabile. Non & consentita la copig, a riproduzione,
la distribuzione o qualsiasi altro uso illegale dei materiali protetti da copyright,
senza previo consenso del proprietario di diritto o del titolare del copyright. LG
Electronics non riconosce alcuna garanzia, espressa o implicita, né responsabilita a
essa collegata, nella massima misura consentita dalla legge applicabile.

+ Per creare un file GIF possono essere utilizzate un massimo di 100 immagini.
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Qualita audio e funzionalita effetti

DTS:X 3D Surround

Puoi riprodurre una canzone o un video con un suono vivido, immersivo e
tridimensionale. Per usare questa funzionalita, connetti auricolari, altoparlante, o
altrei dispositivi audio esterni al tuo dispositivo.

Tocca O > Impostazioni > Suono > Qualita del suono ed effetti> DTS:X 3D
Surround, quindi tocca QD) per attivare questa funzionalita.

Consente di regolare la direzione dell'audio

Puoi regolare la direzione dell'audio come la desideri.

1 Tocca O > Impostazioni > Suono > Qualita del suono ed effetti> DTS:X 3D
Surround.

7 Seleziona la direzione dell'audio.

Assistente Google

Panoramica Assistente Google
Puoi awviare o usare app con la tua voce.

E - Per usare questa funzionalita, per prima cosa connettiti alla rete e accedi al tuo
account Google.

+ Questa funzionalita potrebbe non funzionare correttamente oppure l'accuratezza
del riconoscimento vocale potrebbe ridursi in aree dove la potenza del segnale
della rete mobile o Wi-Fi e debole.

« Questa funzione potrebbe non essere supportata o le lingue supportate
potrebbero variare a seconda della zona di copertura del servizio.
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Avwvio di Assistente Google

T Tieni premuto Q) dalla schermata iniziale per lanciare Assistente Google.

7 Tocca INIZIA.

3 Seguile istruzioni su schermo e pronuncia "Ok Google".
+ Il dispositivo salva i dati della tua voce per il riconoscimento.

/A Tocca Salva.

Awvio di Assistente Google usando la tua voce
1 Pronuncia "Ok Google" quando lo schermo & acceso.

7 Pronunciare un comando o una domanda quando il pop-up di Assistente
Google appare sullo schermo.

Awvio di Assistente Google dalla schermata iniziale

1 Tieni premuto O dalla schermata iniziale.

7 Pronunciare un comando o una domanda quando il pop-up di Assistente
Google appare sullo schermo.

E + Laccuratezza del riconoscimento vocale potrebbe ridursi se parliin modo poco

chiaro o in un luogo rumoroso. Quando usi la funzionalita di riconoscimento vocale,

aumenta |'accuratezza parlando in modo chiaro e in un luogo silenzioso.

Funzioni personalizzate
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Riconoscimento delle impronte
digitali

Informazioni generali sul riconoscimento delle

impronte digitali
Prima di utilizzare la funzione di riconoscimento delle impronte digitali, € necessario
registrare la propria impronta sul dispositivo.
La funzione di riconoscimento delle impronte digitali puo essere impiegata nei casi
seguenti:

+ Per sbloccare lo schermo.

« Per visualizzare i contenuti bloccati in QuickMemo+.

+ Per confermare un acquisto effettuando laccesso a un'app o identificandosi

tramite limpronta digitale.

E « Limpronta puo essere utilizzata dal dispositivo per il riconoscimento dellutente.
Impronte digitali molto simili appartenenti a utenti diversi potrebbero essere
riconosciute dal sensore di impronte come la stessa impronta.

Se il dispositivo non riesce a individuare le impronte digitali o se si dimentica il
valore specificato per la registrazione, recarsi presso il pit vicino Centro di servizio
clienti LG con il dispositivo e la scheda di identificazione.

Precauzioni per il riconoscimento delle impronte digitali
L'accuratezza del riconoscimento delle impronte digitali potrebbe diminuire a causa
di diverse regioni. Per massimizzarla, esequire le sequenti verifiche prima dell'utilizzo
del dispositivo.
- Il dispositivo dispone di un sensore per impronte digitali. Assicurati che il sensore
per impronte digitali non venga danneggiato da un oggetto metallico, come ad
esempio una moneta o una chiave.

Nel caso in cui sul sensore per impronte digitali o sul dito siano presenti acqua,
polvere o altre sostanze estranee, la registrazione o il riconoscimento delle
impronte digitali potrebbero non avere esito positivo. Pulire e asciugare il dito
prima di procedere al riconoscimento dell'impronta.

Il riconoscimento dell'impronta potrebbe non andare a buon fine se la superficie
del dito ha una cicatrice oppure non e liscia a causa dellimmersione in acqua.
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Se si piega il dito o si usa solamente la punta del dito, il riconoscimento
dellimpronta potrebbe non avere esito positivo. Assicurati che il tuo dito copra
lintera superficie del sensore per impronte digitali.

Eseguire la scansione di un solo dito per ciascuna registrazione. La scansione
di piti di un dito potrebbe compromettere la registrazione e il riconoscimento
dellimpronta.

Il dispositivo potrebbe generare elettricita statica se laria circostante e secca. Se
laria circostante e secca, evitare la scansione delle impronte digitali o toccare un
oggetto metallico, quale ad esempio una moneta o una chiave, prima di eseguire
la scansione delle impronte al fine di eliminare lelettricita statica.

Registrazione delle impronte digitali
E possibile registrare e salvare la propria impronta digitale sul dispositivo per
utilizzare l'identificazione tramite impronta digitale.

T Toccare Q> Impostazioni > Blocco schermo & sicurezza > Impronte digitali.

E + Per poter utilizzare questa funzione, e necessario impostare un blocco schermo.

« Seil blocco schermo non é attivo, configurare la schermata di blocco seguendo le
istruzioni visualizzate sullo schermo. Per ulteriori dettagli, consultare la sezione
Impostazione di un blocco schermo.

7 Individua la posizione del sensore per impronte digitali sul retro del dispositivo e
appoggia il dito con delicatezza per registrare limpronta digitale.

E « Premere delicatamente il sensore per impronte digitali in modo che il sensore
possa riconoscere ['impronta digitale dell utente.
« Assicurarsi che la punta del dito copra l'intera superficie del sensore delle impronte
digitali.
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3 Seguire le istruzioni visualizzate sullo schermo.
« Ripetere la scansione dellimpronta digitale muovendo leggermente il dito
fino alla registrazione dellimpronta digitale.
/. Una volta completata la registrazione dell'impronta, toccare OK.

+ Toccare Aggiungi altro per registrare unaltra impronta digitale. Se si registra
solo un'impronta digitale e il dito corrispondente non € in condizioni ottimali,
il riconoscimento dellimpronta potrebbe non funzionare correttamente. Per
prevenire linsorgere di questo tipo di situazione, & consigliabile registrare pit
impronte digitali.

Gestione delle impronte digitali

E possibile modificare o eliminare le impronte digitali registrate.

T Toccare Q> Impostazioni > Blocco schermo & sicurezza > Impronte digitali.
2 Sbloccare in base al metodo di blocco specificato.

3 Dallelenco delle impronte digitali, toccare un‘impronta digitale per rinominarla.
Per eliminarla, toccare _||j

Sblocco dello schermo con un'impronta digitale

E possibile sbloccare lo schermo e visualizzare i contenuti bloccati utilizzando la
propria impronta digitale. Attivare la funzione desiderata:

T Toccare Q> Impostazioni > Blocco schermo & sicurezza > Impronte digitali.
7 Sbloccare in base al metodo di blocco specificato.

3 Nella schermata delle impostazioni dellimpronta digitale, attivare la funzione
desiderata:
+ Blocco schermo: consente di sbloccare lo schermo con un'impronta digitale.

+ Blocco del contenuto: consente di sbloccare un contenuto con un'impronta
digitale. A questo scopo, assicurarsi che sia impostato il blocco contenuto.

Funzioni personalizzate 26



Funzione Multitasking

Finestra multipla
E possibile utilizzare due app contemporaneamente separando la schermata in
finestre multiple.
1 Toccare [ ] dai pulsanti touch della schermata Home.
« Vengono visualizzate le app utilizzate di recente.
2 Toccare S nella parte superiore dell'app desiderata per usare la funzione Multi
Window.
+ Le app selezionate vengono visualizzate nella parte superiore dello schermo.
Oppure,
1 Toccare e tenere premuto [:] mentre si utilizza un'app.
+ Le app utilizzate di recente vengono visualizzate nello schermo diviso.
7 Toccare S nella parte superiore dell'app desiderata per usare la funzione Multi
Window.

« Le applicazioni selezionate vengono visualizzate nella parte inferiore dello
schermo.

E + Per disattivare la funzione Multi Window, toccare e tenere premuto = dal
pulsante touch della schermata Home.

Per regolare la dimensione dello schermo diviso, trascinare = al centro dello
schermo.

« La funzione Multi Window non & supportata da alcune app LG, comprese quelle
scaricate dal Play Store.

Schermate recenti
Le schermate recenti forniscono un'anteprima delle app usate di recente.

Per visualizzare l'elenco delle app usate di recente, toccare [ su Home, quindi
toccare |'app visualizzata.
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Componenti e accessori del prodotto

I sequenti articoli sono forniti in dotazione con il dispositivo.

.

Dispositivo + Caricabatteria
Auricolare stereo + Guida introduttiva
Cavo USB + Spillo di espulsione

Custodia per telefono in gel

A

Gli elementi descritti sopra possono essere facoltativi.

Gli elementi forniti in dotazione con il dispositivo ed eventuali accessori disponibili
possono variare a seconda dell'area e del provider del servizio.

Utilizzare sempre accessori LG Electronics originali. Lutilizzo di accessori di altri
produttori puo influire sulle prestazioni di chiamata del dispositivo o causare
malfunzionamenti. Il servizio di riparazione LG potrebbe non coprire simili
situazioni.

Alcune delle componenti del dispositivo sono fatte di vetro temperato. Se si lascia
cadere il dispositivo su una superficie dura o lo si espone a un urto violento, il vetro
temperato potrebbe danneggiarsi. In questi casi, interrompere immediatamente
['uso del dispositivo e contattare un Centro di assistenza clienti LG.

In mancanza di uno di questi elementi di base, contattare il rivenditore presso cui &
stato acquistato il dispositivo.

Per acquistare altri elementi aggiuntivi, contattare un Centro di assistenza clienti
LG

Alcuni elementi contenuti nella confezione del prodotto sono soggetti a modifica
Senza preawiso.

L'aspetto e le specifiche del dispositivo sono soggetti a modifica senza preawviso.
Le specifiche del dispositivo possono variare a seconda dell'area o del provider del
servizio.

Rimuovere la pellicola protettiva dal sensore di impronte digitali prima di utilizzare
la funzione di riconoscimento delle impronte.
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Panoramica delle parti

Obiettivo fotocamera anteriore —

Tasti volume (+/-) —I:

Tasto Assistente Google —e|

Altoparlante auricolare
Sensore di prossimita/

N luminosita ambientale

C

«— Alloggiamento scheda

_] Nano-SIM/Scheda di memoria

e— Tasto accensione/blocco

Touchscreen

Jack stereo per auricolare

i/)
e

Microfono EE—

)C—

Obiettivi delle fotocamere —
posteriori (sensore macro/
super-grandangolo/
profondita/standard)

-/

Altoparlante —————= T« Microfono

Funzioni di base
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A Non tentare di rimuovere da sé il coperchio posteriore.
Fare cio potrebbe danneggiare gravemente la batteria e il dispositivo, e cio potrebbe
causare surriscaldamento, incendi o infortuni. Il coperchio posteriore e a batteria del
dispositivo non devono essere rimossi o sostituiti da personale non qualificato.

+ Sensore di prossimita/luminosita ambientale

- Sensore di prossimita: Nel corso di una chiamata, il sensore di prossimita
spegne lo schermo e disattiva la funzionalita touch quando il dispositivo
si trova molto vicino al corpo umano. Riaccende lo schermo e attiva la
funzionalita touch quando il dispositivo si trova al di fuori di un campo
specifico.

Sensore di luminosita ambientale: il sensore di luminosita ambientale analizza
lintensita della luce ambientale quando & attiva la modalita di controllo
automatico della luminosita.

+ Tastivolume

- Consentono di regolare il volume delle suonerie, delle chiamate o delle
notifiche.

- Durante [utilizzo della Fotocamera, premere delicatamente un tasto volume
per scattare una foto. Per scattare foto in maniera continua, tenere premuto
il tasto volume.

- Quando lo schermo & spento o bloccato, premere il tasto volume giti (-) due
volte per awiare lapp Fotocamera. Premere due volte il tasto volume su (+)
per awiare Capture+.

+ Tasto accensione/blocco
- Premere brevemente il tasto se si desidera accendere o spegnere lo schermo.
- Tenere premuto il tasto se si desidera selezionare unopzione di alimentazione.
- Tasto Assistente Google

- Il'tuo dispositivo dispone di Assistente Google incorporato. Trovale risposte
e fai cose mentre sei in giro. Per iniziare, basta toccare il tasto Assistente
Google sul lato del telefono.

- Awvio di Assistente Google. Per ulteriori dettagli, consultare Assistente
Google.
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+ Sensore per impronte digitali

- Attivare la funzione di riconoscimento delle impronte digitali per semplificare

E

il processo di sblocco dello schermo. Per ulteriori dettagli, consultare la
sezione Informazioni generali sul riconoscimento delle impronte digitali.

L'accesso ad alcune funzioni potrebbe essere limitato a seconda delle specifiche
del dispositivo.

Sul retro del dispositivo e collocata un'antenna NFC integrata. Prestare attenzione
mentre si maneggia il dispositivo, al fine di non danneggiare o coprire lantenna
NFC.

Non poggiare oggetti pesanti né sedersi sul dispositivo. In caso contrario, il
touchscreen potrebbe danneggiarsi.

La pellicola o accessori di protezione dello schermo potrebbero interferire con il
sensore di prossimita.

Se il dispositivo & bagnato o viene utilizzato in un luogo umido, il touchscreen o'i
pulsanti a sfioramento potrebbero non funzionare correttamente.

Tenete correttamente il dispositivo in mano, come mostrato di seguito. Se coprite
il microfono con una mano, dito o cover protettiva durante ['uso del dispositivo, in
caso di chiamata il suono potrebbe risultare poco chiaro.

Corretto Non corretto

Microfono Non coprite il microfono.

L

@)

/]

Microfono Non coprite il microfono
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Accensione o spegnimento

Accensione
Quando il prodotto e spento, tenere premuto il tasto di accensione/blocco.

E + Quando si accende il dispositivo per la prima volta, viene avviata la configurazione
iniziale. La durata del primo awio dello smartphone potrebbe essere piti lunga di
quella abituale.

Spegnimento
Tenere premuto il tasto di accensione/blocco, quindi selezionare Spegni.

Riavvio del dispositivo

Se il dispositivo non funziona oppure non risponde ai comandi, riawviarlo seguendo
le istruzioni sottostanti.

1 Tenere premuti contemporaneamente il tasto di accensione/blocco e il tasto
volume giti (-) fino a quando il dispositivo non si spegne.

7 Quando viene riawiato il dispositivo, rilasciare il tasto.

Opzioni di alimentazione

Tenere premuto il tasto di accensione/blocco, quindi selezionare unopzione.
+ Spegni: Spegnere il dispositivo.
+ Spegni e riavvia: consente di riawviare il dispositivo.
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Installazione della scheda SIM

Inserire la scheda SIM (Subscriber Identity Module, modulo d'identita dell'abbonato)
fornita dal provider del servizio per iniziare a utilizzare il dispositivo.

A « Utilizzare lo spillo di espulsione con cautela, poiché e dotato di unestremita
appuntita.

1 Inserire lo spillo di espulsione nel foro dellalloggiamento della scheda.

2 Estrarre lalloggiamento della scheda.
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3 Posizionare la scheda SIM sullalloggiamento con i contatti color oro rivolti verso
il basso.

Posizionare la scheda SIM principale sul vassoio della scheda SIM 1 e la scheda
SIM secondaria sul vassoio della scheda SIM 2.
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E + Questo dispositivo supporta solamente le schede Nano SIM.

Nano Micro Standard
L

« Affinché non si verifichino problemi di prestazioni, si consiglia di utilizzare il
dispositivo con il tipo corretto di scheda SIM. Utilizzare sempre una scheda SIM
realizzata in fabbrica, fornita dall'operatore.

« Sesiinserisce lalloggiamento della scheda nel dispositivo mentre & bagnato, il
dispositivo potrebbe danneggiarsi. Assicurarsi sempre che [alloggiamento della
scheda sia asciutto.

Precauzioni per ['utilizzo della scheda SIM

+ Non perdere la scheda SIM. LG non & responsabile di eventuali danni e altri
problemi causati dalla perdita o dal trasferimento di una scheda SIM.

- Fare attenzione a non danneggiare la scheda SIM durante le operazioni di
inserimento e rimozione.

Funzioni di base
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Inserimento della scheda di memoria

Inserire la scheda di memoria nel dispositivo.

A seconda del produttore e del tipo di scheda di memoria, alcune schede di
memoria potrebbero non essere compatibili con il dispositivo.

1 Inserire lo spillo di espulsione nel foro dellalloggiamento della scheda.

2 Estrarre lalloggiamento della scheda.

3 Posizionare la scheda di memoria sullalloggiamento con i contatti color oro
rivolti verso il basso.

I 2 " >

4

I— Scheda di memoria (Opzionale,
venduta separatamente)

Scheda SIM

4 Inserire nuovamente lalloggiamento nello slot.

A « Alcune schede di memoria potrebbero risultare non completamente compatibili
con il dispositivo. Lutilizzo di una scheda incompatibile potrebbe causare il
danneggiamento del dispositivo o della scheda di memoria, oppure la corruzione
dei dati salvati al suo interno.

E Operazioni frequenti di cancellazione e scrittura dei dati possono ridurre la durata
della scheda di memoria.
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Rimozione della scheda di memoria
Per ragioni di sicurezza, disattivare la scheda di memoria prima di rimuoverla.
1 Toccare > Impostazioni > Archiviazione > /\.

2 Inserire lo spillo di espulsione nel foro dellalloggiamento della scheda ed
estrarlo dal dispositivo.

w

Rimuovere la scheda di memoria.

4 Inserire nuovamente lalloggiamento nello slot.

A + Non rimuovere a scheda di memoria mentre il dispositivo sta trasferendo o
accedendo a informazioni. In caso contrario, potrebbe verificarsi la perdita o la
corruzione dei dati, oppure il danneggiamento della scheda di memoria o del
dispositivo. LG non & responsabile di eventuali perdite causate dallabuso o dall'uso
errato delle schede di memoria, compresa la perdita di dati.

Batteria

Carica della batteria
Prima di utilizzare il dispositivo, caricare completamente la batteria.
Caricare il dispositivo con il cavo USB tipo C.

Terminale del cavo diricarica /'
=
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A .

Non utilizzare il terminale esterno, il cavo di alimentazione o l'adattatore di genere
del dispositivo in presenza di umidita. Cio puo provocare incendi, scosse elettriche,
infortuni o il malfunzionamento del dispositivo. In caso di umidita, interrompere
immediatamente [utilizzo e rimuovere completamente ['umidita.

Assicurarsi di utilizzare il cavo USB fornito in dotazione con il dispositivo.

Assicurarsi di utilizzare caricabatteria e cavo di caricamento approvati da LG. Se
la batteria viene caricata con un caricabatteria di terze parti, la batteria potrebbe
esplodere o danneggiarsi.

Il dispositivo e dotato di una batteria ricaricabile interna. Per motivi di sicurezza,
non rimuovere |a batteria incorporata.

L'utilizzo del dispositivo durante il caricamento potrebbe causare scosse elettriche.
Per utilizzare il dispositivo, interrompere il caricamento.

Rimuovere il caricabatteria dalla presa di alimentazione una volta completato il
caricamento del dispositivo. In questo modo si evita un inutile consumo di corrente.
Per caricare |a batteria, & anche possibile collegare un cavo USB tra il dispositivo

e un computer desktop o portatile. Questo metodo puo richiedere piti tempo
rispetto al collegamento delladattatore a una presa a parete.

Non caricare la batteria con un hub USB non in grado di mantenere la tensione
nominale. Il caricamento potrebbe non riuscire o arrestarsi inavvertitamente.

Precauzioni per ['utilizzo del dispositivo
« Assicurarsi di utilizzare il cavo USB fornito in dotazione, non utilizzare cavi USB
o caricabatterie di terze parti con il dispositivo. La garanzia limitata LG non copre
l'uso di accessori di terze parti.

+ Il mancato rispetto delle istruzioni contenute in questa quida e ['utilizzo non
corretto potrebbero portare al danneggiamento del dispositivo.
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Utilizzo efficiente della batteria

La durata della batteria puo diminuire se sul dispositivo sono in esecuzione diverse
app e funzioni contemporaneamente e in maniera continuativa.

Annullare le operazioni in background per aumentare la durata della batteria.
Per ridurre al minimo il consumo della batteria, seqguire questi Consigli:
- Disattivare la funzione Bluetooth® o rete Wi-Fi quando non le si utilizza.
+ Impostare lo spegnimento dello schermo su un lasso di tempo il pit breve
possibile.
+ Ridurre al minimo la luminosita dello schermo.
+ Impostare un blocco schermo quando il dispositivo non & in uso.

+ Controllare il livello della batteria quando si utilizza una qualsiasi delle app
scaricate.

Touchscreen

E possibile imparare a conoscere le modalita di controllo del dispositivo mediante
[utilizzo di gesti touch sul touchscreen.

Toccare

Toccare leggermente con la punta del dito per selezionare o eseguire unapp o
unopzione.
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Tenere premuto

Toccare e tenere premuto per diversi secondi per visualizzare un menu con le
opzioni disponibili.

Toccare due volte

Toccare rapidamente due volte per eseguire lo zoom avanti o indietro su una pagina
\Web o su una mappa.

Trascinamento

Toccare e tenere premuto un elemento, ad esempio un'app o un widget, quindi
spostare il dito in un'altra posizione con un movimento controllato. E possibile
utilizzare questo gesto per spostare un elemento.
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Trascinare

Toccare lo schermo e muovere velocemente il dito senza fermarsi. E possibile
utilizzare questo gesto per scorrere un elenco, una pagina \Web, delle foto, delle
schermate e altro ancora.

Awvicinare e allontanare le dita

Awicinare due dita per esequire lo zoom indietro, ad esempio su una foto o una
mappa. Per eseguire lo zoom avanti, allontanare le dita.

A + Non esporre il touchscreen a eccessivi urti fisici. Il sensore touch potrebbe
danneggiarsi
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Funzioni di base

Se il dispositivo viene utilizzato vicino a materiale magnetico, metallico o
conduttore, potrebbe verificarsi un guasto del touchscreen.

Se si utilizza il dispositivo sotto luci intense come la luce solare diretta, lo schermo
potrebbe non essere visibile a seconda della posizione. Utilizzare il dispositivo

in una posizione ombreggiata o con una luce ambiente non troppo intensa, ma
sufficientemente luminosa da consentire [a lettura.

Non premere lo schermo applicando una forza eccessiva.
Toccare delicatamente l'opzione desiderata con la punta del dito.

Il controllo touch potrebbe non funzionare correttamente se si tocca lo schermo
indossando un guanto o con la punta dell'unghia.

Il controllo touch potrebbe non funzionare correttamente se lo schermo e umido
0 bagnato.

Il touchscreen potrebbe non funzionare correttamente se sul dispositivo &
applicata una pellicola o un accessorio di protezione dello schermo acquistati da un
negozio di terze parti.

La visualizzazione di unimmagine statica per lunghi periodi di tempo potrebbe
causare il fenomeno delle immagini residue o di ritenzione delle immagini.
Spegnere lo schermo o evitare di visualizzare la stessa immagine per un lungo
periodo quando il dispositivo non € in uso.
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Schermata Home

Informazioni generali sulla schermata Home

La schermata Home ¢ il punto di partenza per accedere a diverse funzioni e app
sul dispositivo. Toccare () su qualsiasi schermata per passare direttamente alla
schermata Home.

Sulla schermata Home e possibile gestire tutte le app e i widget. Scorrere sulla

schermata verso sinistra o destra per visualizzare in un colpo docchio tutte le app

installate.

Layout della schermata Home

E possibile visualizzare tutte le app e organizzare i widget e le cartelle sulla
schermata Home.

Barra di stato —]

e _.-

o— Widget di ricerca di Google

B0790n

[ — Icona della pagina

o— Area di accesso rapido

Pulsanti a sfioramento anteriori —< NS

5 + Laschermata Home puo variare a seconda della politica del produttore, delle
impostazioni dell'utente, della versione del software o del provider del servizio.
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Barra di stato: consente di visualizzare le icone di stato, lorario e il livello della
batteria.

Widget meteo: consente di visualizzare le informazioni meteorologiche e
l'orario di una zona specifica.

Widget di ricerca di Google: Digitare o parlare per aprire Ricerca di Google.

Icona della pagina: consente di visualizzare il numero totale di aree della
schermata Home. E possibile toccare licona della pagina desiderata per
accedere alla pagina selezionata. Licona corrispondente allarea corrente verra
evidenziata.

Area di accesso rapido: & possibile fissare le app principali nella parte inferiore
dello schermo in modo che siano accessibili da qualsiasi area della schermata
Home.

Pulsanti a sfioramento anteriori

- <] consente di tornare alla schermata precedente. Consente inoltre di
chiudere la tastiera o le finestre popup.

- (O :toccare per tornare alla schermata Home. Per awiare la ricerca con
Google, tenere premuto.

- [:] ‘toccare per visualizzare un elenco di app utilizzate di recente o eseguire
unapp dallelenco. Per eliminare tutte le app utilizzate di recente, toccare
CANCELLA TUTTO. Per utilizzare due app contemporaneamente con la
funzione Multi window, toccare e tenere premuto il pulsante durante ['utilizzo
di unapp.

- [&2): Scegliere la scheda SIM da utilizzare. Toccare e tenere premute le
impostazioni della scheda SIM duale.
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Cambio dello stile dei pulsanti a sfioramento

anteriori
E possibile cambiare lo stile dei pulsanti a sfioramento anteriori.
1 Toccare > Impostazioni > Display > Pulsanti a sfioramento anteriori.
7 Sotto STILE, selezionare Gesti e pulsanti o Solo pulsanti in base alle
preferenze.
+ Gesti e pulsanti: Sono disponibili il pulsante Indietro < e il pulsante Home
. Per vedere le app recenti, scorrere verso lalto il pulsante Home &.

- Solo pulsanti:<]/ () / [:] sono disponibili. Toccare [:] per vedere le app
recenti.

Modifica dei pulsanti a sfioramento anteriori
E possibile riorganizzare i pulsanti a sfioramento anteriori o aggiungere le funzioni
utilizzate piti spesso in questarea.
Toccare () > Impostazioni > Display > Pulsanti a sfioramento anteriori >
Combinazione di tasti e personalizzare le impostazioni.

+ Sono disponibili diverse funzioni, tra cui QSlide, Notifica o Capture+.

Funzioni di base 46



Nascondere i pulsanti a sfioramento della pagina

iniziale

Puoi nascondere i pulsanti a sfioramento della pagina iniziale per visualizzare uno

schermo piti grande usando una app.

T Tocca > Impostazioni > Display > Pulsanti a sfioramento anteriori >
Nascondi tasti Home.

7 Seleziona le app per nascondere i pulsanti a sfioramento della pagina iniziale
mentre usi l'app, quindi tocca QD).
+ | pulsanti a sfioramento della pagina iniziale scompaiono 3 secondi dopo

['ultimo tocco.

+ Per visualizzare nuovamente i pulsanti a sfioramento della pagina iniziale,
trascina il fondo dello schermo verso l'alto.

Blocca/nascondi icona
Le icone per bloccare o nascondere i pulsanti a sfioramento della pagina iniziale
appaiono sulla parte in fondo a destra dello schermo.

Se vuoi bloccare i pulsanti a sfioramento della pagina iniziale mentre nascondi i
pulsanti, tocca O a sinistra dei pulsanti a sfioramento della pagina iniziale.

Per nascondere i pulsanti a sfioramento della pagina iniziale, tocca duevolte @.

E « Alcune funzionalita potrebbero non essere supportate quando si nascondono i
pulsanti a sfioramento della pagina iniziale.
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Icone di stato

Quando & presente una notifica relativa a un messaggio non letto, un evento del
calendario o una sveglia, nella barra di stato viene visualizzata licona di notifica
corrispondente. Verificare lo stato del dispositivo visualizzando le icone di notifica
presenti nella barra di stato.

p4|

Nessun segnale

Trasmissione di dati tramite la rete in corso

"
[C) Sveglia impostata
n (] Modalita vibrazione attiva

Bluetooth attivo

Collegato a un computer tramite USB

Livello batteria

Modalita Aereo attiva

Chiamate senza risposta

Wi-Fi attivo

Modalita silenziosa attiva

GPS attivo

Hotspot attivo

Nessuna scheda SIM

La modalita NFC ¢ attiva

Alcune di queste icone potrebbero apparire in modo diverso o non apparire
affatto a seconda dello stato del dispositivo. Fare riferimento alle icone in base
all'ambiente e alla zona effettivi in cui si utilizza il dispositivo nonché al provider
del servizio.

Le icone visualizzate possono variare a seconda dell'area o dei provider dei servizi.
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Pannello notifiche
E possibile aprire il pannello notifiche trascinando la barra di stato verso il basso
sulla schermata principale.
- E possibile trascinare verso il basso la finestra di awiso o toccare l'icona della
freccia per aprire l'elenco delle icone di impostazione rapida.
- E possibile toccare £ per aggiungere, eliminare o disporre le icone nella finestra
di awiso.
+ Tenendo premuta licona, viene visualizzata la schermata delle impostazioni
relative alla funzione in questione.

E - E possibile utilizzare il pannello notifiche anche durante il blocco schermo. Trascina
il pannello notifiche quando lo schermo é bloccato per accedere rapidamente alle
funzioni desiderate
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Cambio di orientamento dello schermo

E possibile impostare il cambio automatico di orientamento dello schermo in base
allorientamento fisico del dispositivo.

Nel pannello notifiche, toccare Rotazione nellelenco delle icone di accesso rapido.

In alternativa, toccare () > Impostazioni > Display e attivare Rotazione
automatica.

Modifica della schermata Home

Nella schermata Home, toccare e tenere premuto uno spazio vuoto, quindi avviare
l'azione desiderata da sotto.
+ Perridisporre le aree della schermata Home, toccare e tenere premuta un'area e
trascinarla in un'altra posizione.
+ Per aggiungere un widget alla schermata Home, toccare e tenere premuta
un‘area vuota della schermata Home, quindi selezionare Widget.

+ Per modificare sfondi, temi e icone, toccare e tenere premuta un‘area vuota della
schermata Home, quindi selezionare Sfondo & Tema.

E inoltre possibile toccare () > Impostazioni > Display > Sfondo & Tema,
quindi selezionare sfondi, temi e icone da applicare al dispositivo.
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+ Per configurare le impostazioni della schermata Home, toccare e tenere
premuta un‘area vuota della schermata Home, quindi selezionare Imposta
schermata home. Per ulteriori dettagli, consultare la sezione Impostazioni della
schermata Home.

Per visualizzare o reinstallare le app disinstallate, toccare e tenere premuta
un'area vuota della schermata Home, quindi selezionare Cestino app. Per
ulteriori dettagli, consultare la sezione Cestino app.

Per cambiare la schermata predefinita, toccare e tenere premuta un'area vuota
della schermata Home, spostarsi sulla schermata desiderata, toccare O, quindi
toccare nuovamente la schermata.

e — Schermata predefinita
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Visualizzazione del tema di sfondo

Nella schermata Home e possibile visualizzare solo l'immagine di sfondo
nascondendo app e widget.
Allontanare due dita sulla schermata Home.

+ Per tornare alla schermata originale con la visualizzazione di app e widget,
awicinare le dita sulla schermata Home o toccare <

Spostamento di app sulla schermata Home

Nella schermata Home, toccare e tenere premuta un'app, quindi trascinarla in
un'‘altra posizione.

+ Perinserire le app utilizzate piti spesso nella parte inferiore della schermata
Home, toccare e tenere premuta un'app, quindi trascinarla nell’area di accesso
rapido nella parte inferiore.

+ Per rimuovere un'icona dallarea di accesso rapido, trascinarla nella schermata
Home.
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Utilizzo delle cartelle dalla schermata Home

Creazione di cartelle

Nella schermata Home, toccare e tenere premuta un'app, quindi trascinarla su
un'altra app.

+ Viene creata una nuova cartella e le app vengono aggiunte al suo interno.

Modifica di cartelle
Nella schermata Home, toccare una cartella ed eseguire una delle seguenti azioni.

+ Per modificare il nome o il colore della cartella, toccare il pulsante del nome o del
colore della cartella nellangolo superiore destro.

- Per aggiungere app, toccare e tenere premuta una app, quindi trascinarla sopra
la cartella e rilasciarla.

+ Per rimuovere un'app dalla cartella, toccare e tenere premuta ['app, quindi
trascinarla all esterno della cartella. Se l'app rimossa e ['unica esistente nella
cartella, viene rimossa automaticamente anche la cartella.

- E anche possibile aggiungere o rimuovere le app dopo aver toccato () nella
cartella.

E + Quando si utilizza un tema scaricato, non e possibile modificare il colore della
cartella.

Impostazioni della schermata Home
E possibile personalizzare le impostazioni della schermata Home.
T Toccare > Impostazioni > Display > Sfondo.

7 Personalizzare le sequenti impostazioni:

« Seleziona Launcher: consente di selezionare una modalita per la schermata
Home.

+ Sfondo: consente di cambiare lo sfondo della schermata Home.

- Effetto scorrimento schermo: consente di selezionare un effetto da
applicare quando si passa a un'altra area della schermata Home.
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Aspetto delle icone: consente di scegliere se si desidera che le icone
abbiano gli angoli squadrati o arrotondati.

Feed Google: consente di visualizzare Google Feed a sinistra della
schermata Home.

Ordina le app per:Impostare la modalita di ordinamento delle app sulla
schermata Home.

Griglia: consente di modificare la modalita di disposizione delle app nella
schermata Home.

Nascondi applicazioni: consente di selezionare le app da nascondere nella
schermata Home.

Scorrimento continuo: attivare per consentire lo scorrimento continuo della
schermata Home (ritorno alla prima schermata dopo |'ultima schermata).
Ricerca: consente di effettuare una ricerca scorrendo verso il basso sulla
schermata Home.

Sfondo Lock: consente di impedire che le app o i widget siano spostati o
rimossi.

Blocco schermo

5

Informazioni generali sul blocco schermo

Lo schermo del dispositivo si spegne e si blocca se si preme il tasto di accensione/
blocco. Il blocco awiene anche quando il dispositivo viene lasciato inattivo per un
determinato periodo di tempo.

Se si preme il tasto di accensione/blocco senza limpostazione di un blocco schermo,
viene immediatamente visualizzata la schermata Home.

Per maggiore sicurezza e per impedire 'accesso indesiderato al dispositivo,
impostare un blocco schermo.

« Il blocco schermo impedisce inutili input tocco sullo schermo del dispositivo
e riduce il consumo della batteria. E altamente consigliabile attivare il blocco
schermo mentre non si usa il dispositivo.
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Impostazione di un blocco schermo

Per la configurazione delle impostazioni del blocco schermo sono disponibili varie
opzioni.

1 Toccare O > Impostazioni > Blocco schermo & sicurezza > Seleziona il
blocco dello schermo e quindi selezionare il metodo preferito.

7 Personalizzare le sequenti impostazioni:

5

Nessuno: consente di disattivare la funzione di blocco schermo.
Trascina: consente di scorrere con un dito sullo schermo per sbloccarlo.
Sequenza: consente di disegnare una sequenza per sbloccare lo schermo.

PIN: consente di immettere una password numerica per sbloccare lo
schermo.

Password: consente diimmettere una password alfanumerica per sbloccare
lo schermo.

Impronte digitali: consente di sbloccare lo schermo utilizzando le impronte
digitali.

+ Sesitenta di sbloccare in maniera scorretta il dispositivo per 5 volte, lo schermo
viene bloccato per 30 secondi.

Impostazioni di awvio sicuro
Se si seleziona Sequenza, PIN o Password come metodo di blocco dello schermo, &
possibile configurare il blocco del dispositivo a ogni accensione per proteggere i dati.

+ Finché il dispositivo non viene sbloccato, non e possibile utilizzarne le funzioni,
ad eccezione delle chiamate di emergenza.

+ Se e stata dimenticata la password di decrittografia, non e possibile ripristinare i
dati decrittografati né le informazioni personali.
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Precauzioni per la funzione "Awvio sicuro"

+ Se e stata dimenticata la password di decrittografia, non & possibile ripristinare i
dati decrittografati né le informazioni personali.

+ Assicurati di mantenere le tue password per il blocco schermo separate.

+ Seinserisci una password sbagliata per il blocco schermo piti del numero di
volte consentito, il dispositivo si resetta in automatico, cancellando tutti dati
crittografati e le informazioni personali contenute, che non possono pili essere
recuperate.

- Fare attenzione a non inserire una password sbagliata per il blocco schermo pit
del numero di volte consentito.

Quando accendi il dispositivo subito dopo averlo resettato, viene riawiata
anche la crittografia. Se interrompi volontariamente la crittografia, alcuni dati
potrebbero danneggiarsi. Assicurati di attendere il completamento del reset.

Personalizza Blocco schermo

Puoi personalizzare il blocco schermo.

1 Toccare O > Impostazioni > Blocco schermo & sicurezza > Personalizza
Blocco schermo.

7 Seleziona una funzione che vuoi impostare.
+ Sfondo: Consente di impostare lo sfondo del blocco schermo.

+ Orologio: Consente di impostare il punto in cui posizionare ['orologio sul
blocco schermo.

« Collegamenti: Consente di scegliere le app da esequire sul blocco schermo.
Questa impostazione appare solo quando uno schermo di blocco viene
impostato.

+ Informazioni di contatto per telefono perso: Consente di impostare il
testo da visualizzare sulla schermata di blocco per identificare il proprietario
del telefono.
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Impostazioni di Blocco con sicurezza

Puoi impostare blocchi schermo sicuri.

1 Toccare Q> Impostazioni > Blocco schermo & sicurezza > Impostazioni di
Blocco con sicurezza.

2 Seleziona una funzione che vuoi impostare.
- Rendi visibile la sequenza: Consente di rendere visibile la sequenza.
« Blocco timer: Consente diimpostare l'intervallo di tempo prima che

lo schermo si blocchi automaticamente dopo lo spegnimento della
retroiluminazione (time out a causa di inattivita).

+ Blocco istantaneo con tasto accensione: Attivare questa opzione
per bloccare istantaneamente lo schermo quando si preme il tasto di
accensione/blocco. Questa impostazione supera le impostaszioni del timer
del blocco di sicurezza.

+ Mostra blocco: Consente di visualizzare lopzione del menu di spegnimento
per la disattivazione delle notifiche nella schermata di blocco, il smart lock e
i blocchi biometrici.

+ Smart Lock: Consente di impostare dispositivi, luoghi, voce e/o rilevamento
su corpo affidabili che permettono al tuo telefono di restare sbloccato.

E + I menu che puoi impostare possono essere differenti a seconda dei metodi di
blocco dello schermi che scegli.
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Toc Toc
E possibile accendere o spegnere lo schermo toccandolo due volte.

E + Questa opzione ¢ disponibile solo sulla schermata Home fornita da LG. Potrebbe
non funzionare correttamente su un launcher personalizzato o sulla schermata
Home installata dall'utente.

+ Quando si tocca lo schermo, utilizzare la punta di un dito. Non utilizzare un'unghia.

Per utilizzare la funzione Toc Toc, assicurarsi che il sensore di prossimita/luminosita
non sia ostruito da un adesivo o da un‘altra sostanza estranea.

Accendi lo schermo
Toccare due volte il centro dello schermo.

+ Se sitocca la parte superiore o inferiore dello schermo, a velocita di
riconoscimento potrebbe essere pill bassa.

Spegni lo schermo

Toccare due volte uno spazio vuoto nella schermata Home e nella schermata di
blocco.

In alternativa, toccare due volte uno spazio vuoto sulla barra di stato.

Disattivazione di Toc Toc
Se non si desidera utilizzare la funzione KnockON, impostare come segue:

Toccare () > Impostazioni > Estensioni > Toc Toc e trascinare per disabilitare la
funzione.
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Crittografia della scheda di memoria

E possibile crittografare e proteggere i dati salvati sulla scheda di memoria.
l'accesso ai dati crittografati sulla scheda di memoria non sara possibile da un altro
dispositivo.

T Toccare > Impostazioni > Blocco schermo & sicurezza > Crittografia e
credenziali > Cripta la Scheda SD.

7 Leggere le informazioni generali sulla crittografia della scheda di memoria
visualizzate sullo schermo, quindi toccare Continua per continuare.
3 Selezionare un'opzione e toccare Codifica ora.

- Crittografia del nuovo file: consente di crittografare solo i dati salvati sulla
scheda di memoria dopo la crittografia.

Crittografia completa: consente di crittografare tutti i dati attualmente
salvati sulla scheda di memoria.

+ Escludi file multimediali: consente di crittografare tutti i file ad eccezione di
quelli multimediali come musica, foto e video.

E + Una volta awiata la crittografia di una scheda di memoria, alcune funzioni non
sono disponibili.

Se il dispositivo si spegne mentre la crittografia e in corso, il processo di crittografia
non riuscira e alcuni dati potrebbero danneggiarsi. Occorre percio assicurarsi che il
livello della batteria sia sufficiente prima di awiare la crittografia.

L'accesso ai file crittografati & possibile solo dal dispositivo in cui i file sono stati
crittografati.

« Lascheda di memoria crittografata non puo essere utilizzata su un altro
dispositivo LG. Per utilizzare la scheda di memoria crittografata su un altro
dispositivo mobile, formattare la scheda

« E possibile attivare la crittografia della scheda di memoria anche se nel dispositivo
non é installata alcuna scheda di memoria. Qualsiasi scheda di memoria installata
dopo la crittografia verra automaticamente crittografata.
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Acquisizione di screenshot

E possibile acquisire screenshot della schermata che si sta visualizzando.

Tramite un collegamento rapido

Tenere premuti contemporaneamente il tasto di accensione/blocco e il Tasto
volume giti (-) per almeno due secondi.

+ Gli screenshot possono essere visualizzati nella cartella Screenshots nella
Galleria.

Tramite la funzione Capture+

Nella schermata di cui si desidera acquisire uno screenshot, trascinare verso il basso
la barra di stato, quindi toccare (2,

E + Quando lo schermo e spento o bloccato, e possibile accedere alla funzione
Capture+ premendo due volte il tasto volume su (+). Per utilizzare questa
funzione, toccare O > Impostazioni > Estensioni > Collegamenti e attivare
Apri Capture+.

« Per ulteriori dettagli, consultare la sezione Scrittura di note su uno screenshot.

Immissione di testo

Utilizzo della barra degli strumenti Smart

E possibile usare vari metodi di immissione da tastiera da un'unica posizione. E
possibile selezionare il metodo di immissione desiderato dalla parte superiore della
tastiera.

7 Selezionare il metodo diimmissione da tastiera desiderato dalla barra degli
strumenti Smart.

7 Toccare \/ e selezionare il metodo di immissione da visualizzare nella barra
degli strumenti Smart, oppure riorganizzarli
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strumenti Smart

Tastiera LG non & predefinita nel telefono. E possibile cambiarla dalle impostazioni
della tastiera.

i

I metodi di immissione supportati possono variare a seconda del dispositivo.

E possibile attivare o disattivare la barra degli strumenti Smart dalle impostazioni
della tastiera.

- E possibile anche utilizzare i metodi di immissione da tastiera toccando €§3

- (© :Aggiungere emoji.
- 22 :Aggiungere un disegno.
+  :Toccare O per inserire il testo con la propria voce.

- Per ottimizzare il riconoscimento dei comandi vocali, pronunciarli in modo
chiaro.

- Perimmettere testo con la voce, assicurarsi che il dispositivo sia connesso
aunarete.

- Per selezionare la lingua per il riconoscimento vocale, toccare %% > Lingue
sulla schermata del riconoscimento vocale.

- Questa funzione potrebbe non essere supportata o le lingue supportate
potrebbero variare a seconda della zona di copertura del servizio.

- 33 : Accedere alle impostazioni della tastiera.
. - Aprire Appunti. Per ulteriori dettagli, consultare a sezione Appunti.

. Attivare a tastiera fluttuante quando si usa la funzione Multi Window. £
possibile anche spostare la testiera nella posizione desiderata.
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Utilizzo della tastiera Smart
E possibile utilizzare la tastiera Smart per immettere e modificare testo.

Con la tastiera Smart il testo viene visualizzato mentre lo si digita, senza dover
passare dalla schermata a una tastiera tradizionale e viceversa. In questo modo e
possibile trovare e correggere con facilita gli eventuali errori durante la digitazione.

Spostamento del cursore

Con la tastiera Smart & possibile spostare il cursore esattamente nella posizione
desiderata. Quando si digita un testo, toccare e tenere premuta la barra spaziatrice,
quindi trascinarla verso sinistra o destra.

< Smart keyboard >

E « Questa opzione é disponibile solo sulla tastiera QWERTY.
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Suggerimento di parole

La tastiera Smart analizza automaticamente abitudini di utilizzo dell'utente per
suggerire le parole utilizzate pili spesso durante la digitazione. Quanto piu si utilizza
il dispositivo, tanto pit precisi saranno i Consigli.

Immettere un testo, quindi toccare una parola suggerita o trascinare delicatamente
verso lalto il lato sinistro o destro della tastiera.

+ La parola selezionata viene inserita automaticamente. Non e necessario digitare
manualmente ogni lettera della parola.

Smartphone smart  Smartphones Smartphone  Smart Smartphones

A NEEEEEER L L IALL

Aggiunta di lingue alla tastiera
E possibile rendere disponibili ulteriori lingue per linput tramite tastiera.

T Toccare Q> Impostazioni > Sistema > Lingua e tastiera > Gestisci tastiere
> Tastiera LG > Lingua e Layout tastiera>> Seleziona lingua.

2 Selezionare le lingue che si desidera rendere disponibili.
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Copia e incolla
E possibile tagliare o copiare del testo da unapp, quindi incollarlo nella stessa app. £
anche possibile eseguire altre app e incollare il testo al loro interno.

T Toccare e tenere premuta l'area attorno al testo che si desidera copiare o
tagliare.

7 Trascinare @/ B per specificare l'area da copiare o tagliare.
3 Selezionare Taglia o Copia.
« Il testo tagliato o copiato viene aggiunto automaticamente agli Appunti.

/. Toccare e tenere premuta la finestra di inserimento del testo, quindi selezionare
Incolla.

E « Inassenza di un elemento copiato o tagliato, l'opzione Incolla non verra
visualizzata.

Appunti
Quando si copia o si taglia un'immagine o un testo, tali elementi vengono salvati
automaticamente negli Appunti e possono essere incollati ovunque in qualsiasi
momento.
T Nella barra degli strumenti Smart, selezionare iz}
In alternativa, toccare e tenere premuta la finestra di inserimento del testo,
quindi selezionare Appunti.
2 Selezionare e incollare un elemento negli Appunti.
- E possibile salvare negli Appunti fino a un massimo di 20 elementi.

- Toccare £} per bloccare gli elementi salvati al fine di non eliminarli anche
quando la quantita massima viene superata. E possibile bloccare fino a
un massimo di dieci elementi. Per eliminare gli elementi bloccati, & prima
necessario sbloccarli.

- Toccare {if] per eliminare gli elementi salvati negli Appunti.

E « Gli Appunti potrebbero non essere supportati da alcune app scaricate.
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Condivisione di contenuti

Riproduzione di contenuti da un altro dispositivo
E possibile riprodurre foto, video o canzoni salvate sul proprio dispositivo da una TV,
1 Connettere laTV e il dispositivo alla stessa rete Wi-Fi.

7 Mentre sivisualizza un elemento dell'app Galleria o Musica, toccare & >
Riproduci su un altro dispositivo.

3 Selezionare la TV a cui si desidera connettersi.

E « Per lutilizzo con Chromecast, € consigliabile che i servizi di Google Play siano
aggiornati

Visualizzazione di contenuti da dispositivi vicini

E possibile visualizzare contenuti da diversi dispositivi, come ad esempio un
computer, un dispositivo NAS o un dispositivo mobile, utilizzando le app Galleria o
Musica.

Connessione dei dispositivi

Connettere sia il proprio dispositivo che un altro dispositivo in grado di supportare
la funzione DLNA alla stessa rete wireless.

E « Assicurarsi che la Condivisione file (DLNA) sia attiva sia in entrambi i dispositivi.

Ricerca di dispositivi vicini
E possibile visualizzare un elenco di dispositivi DLNA connessi alla stessa rete
selezionando il menu Dispositivi nelle vicinanze in ciascuna app.

Si possono utilizzare i contenuti di dispositivi vicini come se i si stesse utilizzando
sul proprio dispositivo.
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Invio o ricezione di file

E possibile condividere file tra il proprio dispositivo e un altro dispositivo LG, oppure
un tablet o un computer.

Invio di file

Dalla Galleria o altre app, toccare : > Condividi 0 <&, quindi selezionare un
dispositivo dallelenco di condivisione file.

Ricezione di file
Trascinare verso il basso la barra di stato e toccare Condivisione File.

Se il proprio dispositivo non supporta la funzione di condivisione file, toccare (O >
Impostazioni > Dispositivi connessi > Condivisione File > SmartShare Beam

5 « Assicurarsi che il proprio dispositivo sia connesso alla stessa rete wireless a cui e

connesso il dispositivo destinatario del trasferimento file.

+ Assicurarsi che la Condivisione file sia attiva sia in entrambi i dispositivi.

Funzioni di base 66



App utili



Installazione e disinstallazione di app

Installazione di app
E possibile accedere a uno store di app per cercare e scaricare delle app.

+ Sipuo utilizzare SmartWorld, Play Store o lo store di app fornito dal proprio
gestore del servizio.

E « Alcuni store di app potrebbero richiedere la creazione di un account e la
registrazione.

« Alcune app potrebbero essere a pagamento.

« Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

+ SmartWorld potrebbe non essere supportato a seconda dell'area o del provider
del servizio.

Disinstallazione di app
Disinstallare le app inutilizzate dal dispositivo.

Disinstallazione con il gesto di tocco e pressione lunga

Nella schermata Home, toccare e tenere premuta |'app da disinstallare, quindi
trascinarla su Elimina nella parte superiore dello schermo.

+ Se le app sono state disinstallate nelle ultime 24 ore, e possibile reinstallarle. Per
ulteriori dettagli, consultare la sezione Cestino app.

Disinstallazione tramite il menu delle impostazioni
Toccare (O > Impostazioni > App & notifiche > Informazioni applicazione,
selezionare un'app, quindi toccare Disinstalla.

E « Alcune app non possono essere disinstallate dagli utenti

App utili 68



Disinstallazione di app dallo store di app

Per disinstallare un'app, accedere allo store di app da cui e stata scaricata e
disinstallarla.

Installazione e disinstallazione di app durante il
setup

Quando si accende il dispositivo per la prima volta, e possibile scaricare le app
consigliate.

E possibile saltare alla fase successiva senza linstallazione.

Cestino app

E possibile visualizzare le app disinstallate. E inoltre possibile reinstallare le app che
sono state disinstallate nelle ultime 24 ore.

T Toccare > Gestione > Cestino app.
Si puo inoltre toccare e tenere premuta unarea vuota della schermata Home,
quindi toccare Cestino app.
7 Attivare la funzione desiderata:
« Ripristina: consente di reinstallare lapp selezionata.
- 1] : consente di rimuovere definitivamente dal dispositivo le app disinstallate.

E + Le app disinstallate vengono rimosse automaticamente dal dispositivo 24 ore
dopo la disinstallazione. Se si desidera reinstallare le app disinstallate, & necessario
scaricarle nuovamente dallo store di app.

+ Questa funzione ¢ attiva solamente sulla schermata Home. Se si disinstallano delle
app mentre si utilizza la schermata EasyHome o un altro launcher, queste vengono
immediatamente e definitivamente rimosse dal dispositivo.
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Scorciatoie applicazioni

Nella schermata Home, toccare e tenere premuta l'icona di una app come Chiama,
Invia messaggio, Camera, Galleria e Impostazioni per mostrare un menu di accesso
rapido. E possibile utilizzare le app in maniera pitt semplice grazie alle scorciatoie
per app.

- Toccad] per configurare le impostazioni per la widget che desideri per l'app.

- Tocca () per visualizzaare le informazioni per 'app desiderata.

E + Questa funzione ¢ disponibile solo in alcune app.
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Telefono

Chiamata vocale

Per eseguire una chiamata vocale, utilizzare uno dei metodi disponibili, ad esempio
immettere manualmente un numero di telefono e selezionarlo dall'elenco dei
contatti o dall'elenco delle chiamate recenti.

Esecuzione di una chiamata dal tastierino numerico
1 Toccare O > (®> Componi.
2 Eseguire la chiamata utilizzando un metodo a scelta:

- Immettere un numero di telefono e toccare @@.

« Toccare e tenere premuto un numero di composizione veloce.

« Cercare un contatto toccando la lettera iniziale del relativo nome nell'elenco
dei contatti, quindi toccare 9.

E « Perimmettere "+" quando si esegue una chiamata internazionale, toccare e tenere
premuto il numero 0.

+ Consultare la sezione Aggiunta di contatti per ottenere ulteriori informazioni su
come aggiungere numeri di telefono all'elenco di selezione rapida.

Esecuzione di una chiamata dall'elenco dei contatti

1 Toccare O > (W > Rubrica.

7 Dall'elenco dei contatti, selezionare un contatto e toccare %
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Risposta a una chiamata

Per rispondere a una chiamata, trascinare @ sulla schermata della chiamata in
arrivo.

Se ¢ collegato un auricolare stereo, & possibile eseguire le chiamate utilizzando il
pulsante di chiamata/fine sull'auricolare.

Per terminare una chiamata senza spegnere lo schermo, toccare O >
Impostazioni > Rete & internet > Impostazioni chiamate > Rispondi e
termina chiamate, quindi attivare Termina le chiamate con il tasto di
accensione.

Rifiuto di una chiamata
Per rifiutare una chiamata in arrivo, trascinare ° attraverso la schermata della
chiamata in arrivo.
+ Per inviare un messaggio di rifiuto, trascinare ['opzione del messaggio di rifiuto
per la schermata.

Per aggiungere o madificare un messaggio di rifiuto, toccare O) > Impostazioni
> Rete & internet > Impostazioni chiamate > Blocco chiamata & Rifiuta con
messaggio > Rifiuta con messaggio.

Quando ¢ in arrivo una chiamata, premere il tasto volume su (+), volume giti
(-) ol tasto di accensione/blocco per disattivare laudio della suoneria o la
vibrazione, oppure per mettere in attesa la chiamata.

Verifica di una chiamata in arrivo durante ['utilizzo
di un'app
Quando si riceve una chiamata mentre si sta utilizzando un‘app, & possibile

visualizzare una notifica pop-up nella parte superiore della schermata. Si pud
accettare la chiamatg, rifiutarla o inviare un messaggio dalla schermata pop-up.

5 - Toccare () > Impostazioni > Rete & internet > Impostazioni chiamate > Altre
impostazioni > Pop-up chiamata vocale in arrivo e quindi selezionare il modo in
cui si desidera visualizzare la chiamata in arrivo quando si usa un'app.
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Visualizzazione delle chiamate perse

In caso di una chiamata persa, nella barra di stato nella parte superiore dello
schermo viene visualizzato 4,

Per visualizzare i dettagli della chiamata persa, trascinare la barra di stato verso il
basso. In alternativa, toccare () > (@ > Chiamate.

Funzioni disponibili nel corso di una chiamata

Nel corso di una chiamata e possibile accedere a varie funzioni toccando i pulsanti
visualizzati sullo schermo:

Rubrica: consente di visualizzare l'elenco di contatti durante una chiamata.
Attesa: trattieni una chiamata:

Tastiera: consente di mostrare o nascondere la testiera del telefono.

Vivavoce: consente di attivare la funzione vivavoce.

Muto: consente di silenziare la propria voce in modo che non possa essere udita
dall'interlocutore.

Bluetooth: consente di passare la chiamata a un dispositivo Bluetooth associato
€ Connesso.

- @ :consente di terminare una chiamata.
-+ :consente di accedere a opzioni di chiamata aggiuntive.

E « Levodi delle impostazioni disponibili possono variare a seconda dell'area e del
provider del servizio.
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Esecuzione di una chiamata a tre vie
E possibile esequire una chiamata a un altro contatto nel corso di una chiamata.

1 Durante una chiamata, toccare + > Aggiungi.

2 Immettere un numero di telefono e toccare .
+ Le due chiamate vengono visualizzate contemporaneamente sullo schermo
e la prima chiamata viene messa in attesa.

3 Per awiare una conferenza telefonica, toccare Unisci.

E « Puo essere addebitato il costo di ogni chiamata. Rivolgersi al proprio provider del
servizio per ulteriori informazioni.

Visualizzazione dei record delle chiamate

Per visualizzare i record delle chiamate recenti, toccare O > (8 > Chiamate. £
quindi possibile utilizzare le sequenti funzioni:
+ Per visualizzare i record dettagliati delle chiamate, selezionare un contatto. Per
eseguire una chiamata a un contatto selezionato, toccare ...

- Per eliminare i record delle chiamate, toccare : > Elimina.

E « Ladurata visualizzata delle chiamate potrebbe essere diversa da quella addebitata.
Rivolgersi al proprio provider del servizio per ulteriori informazioni.

La cronologia delle telefonate non puo essere recuperata una volta cancellata.

Stringi due dita o allargale per regolare la dimensione del carattere per i registri
delle chiamate o i contatti.

Configurazione delle opzioni di chiamata
E possibile configurare diverse opzioni di chiamata.
1 Toccare Q> (¥ > Componi o Chiamate.

7 Toccare : >Impostazioni chiamate e quindi configurare le opzioni in base alle
proprie preferenze.
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Messaggi

Invio di un messaggio

E possibile creare e inviare messaqgi ai propri contatti utilizzando lapp di
messaggistica.

E - Linvio di messaggi all'estero potrebbe essere soggetto a ulteriori costi. Rivolgersi al
proprio provider del servizio per ulteriori informazioni.

1 Toccare O> B
2 Toccare G-

3 Specificare un destinatario e creare un messaggio.
- Per usare le opzioni multimediali, tocca ().
« Per accedere alle voci di menu opzionali, toccare .

/A Toccare B> per inviare il messaggio.

Lettura di un messaggio
E possibile visualizzare i messaqgi scambiati organizzati per singolo contatto.

1 Toccare O> B

7 Selezionare un contatto dall'elenco dei messaggi.

Configurazione delle impostazioni dei messaggi
E possibile modificare le impostazioni dei messaqggi in base alle proprie preferenze.

1 Toccare O> 0

2 Toccare : > Impostazioni dall'elenco dei messaggi.
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Fotocamera

Awvio della fotocamera

E possibile scattare una foto o registrare un video per conservare tuttii momenti
memorabili.

Toccare O > (&)
5

Prima di scattare una foto o registrare un video, pulire l'obiettivo della fotocamera
con un panno morbido.

Prestare attenzione a non macchiare [obiettivo della fotocamera con le dita o altre
sostanze.

+ Leimmagini incluse nella presente guida potrebbero essere diverse da quelle
effettive del dispositivo.

« Le foto e i video possono essere visualizzati o modificati dalla Galleria. Per ulteriori
dettagli, consultare la sezione Informazioni generali sulla Galleria.

Funzioni di base dell'app Fotocamera

E possibile scattare foto o registrare video selezionando varie modalita e opzioni
della fotocamera.

1 Toccare Q> (@)

7 Toccare () per scattare una foto, oppure toccare Video > @ per registrare un
video.

Consente di
cambiare langolo
della fotocamera.
Consente di passare
dalla fotocamera
anteriore a quella
posteriore e viceversa
o — Consente di scattare
foto.

Imposta/annulla
limpostazione del timer.

Attivare o disattivare il
flash.

Consente di applicare
un effetto filtro
cinematografico.
Consente di modificare le
opzioni della fotocamera.

sl — Consente di awiare
la Galleria.
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Scatto di una foto

1 Selezionare una modalita fotocamera e toccare il soggetto su cui mettere a
fuoco la fotocamera.
2 Sfiorare () per scattare una foto.

- Einoltre possibile premere il tasto volume su o volume gili per scattare una
foto.

- E possibile scattare una foto durante la registrazione di un video premendo
@ sullo schermo.

E + E possibile aprire (app della fotocamera premendo brevemente due volte il tasto
di accensione. Toccare O > Impostazioni > Estensioni > Collegamenti, quindi
toccare Apri Fotocamera per attivarla.

« Quando lo schermo & spento o bloccato, awiare la fotocamera premendo due volte
il tasto volume giti. Toccare () > Impostazioni > Estensioni > Collegamenti,
quindi toccare Apri Fotocamera () per attivarla

Registrazione di un video
1 Toccare Q> (&) > Video e toccare il soggetto da mettere a fuoco.
7 Toccare . per registrare un video.

+ Per scattare una foto mentre si registra un video, toccare @.

- Per mettere in pausa la registrazione del video, toccare @). Per riprendere la
registrazione del video, toccare e .

+ Mentre registri un video, puoi stringere o allargare due dita per ingrandire o
rimpicciolire.

+ Mentre registri un video, puoi toccare ['area desiderata per regolare la
luminosita.

3 Toccare (= per terminare la registrazione del video.
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Personalizzazione delle opzioni della fotocamera
E possibile personalizzare varie opzioni in base alle proprie preferenze.

Toccare £33 sulla schermata.

E « Le opzioni disponibili potrebbero variare a seconda della fotocamera selezionata
(anteriore o posteriore) e alla modalita fotocamera selezionata.

- [FJ]: Consente di scattare una foto in FullVision.

+ [0]:Consente di selezionare i valori relativi a proporzioni e dimensioni per le foto

da scattare.

+ [X:Consente di selezionare i valori relativi a risoluzione e dimensioni per i video

da registrare.

HDR

Consente di ottenere foto dai colori vividi ed effetti compensati
anche quando le foto sono scattate contro luce. Queste funzioni
sono disponibili grazie alla tecnologia High Dynamic Range
(HDR) integrata nella fotocamera.

Scatto al Cheese

Consente di scattare foto tramite comandi vocali.

Tag posizione

Consente di salvare limmagine completa di dati sulla posizione
GPS.

Consente di visualizzare le griglie di guida in modo da poter

Griglia scattare foto o registrare video in base alle linee di riferimento
orizzontali e verticali.
Consente di selezionare se si desidera archiviare le immagini

Archiviazione e ivideo nellArchivio interno o nella Scheda SD. (Disponibile
quando la scheda di memoria ¢ inserita.)

Guida Fornisce una guida per ciascun menu della fotocamera.

Opzioni aggiuntive sulla fotocamera anteriore

Scatto di selfie

Scatta un selfie selezionando le sue opzioni tra Scatto tramite
gesto della mano e Scatto automatico.

Salva come capovolta

Consente di salvare le immagini come capovolte dopo aver
scattato dei selfie.
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Modifica della modalita della fotocamera
E possibile selezionare una modalita fotocamera che sia adatta allambiente
circostante per scattare una foto o registrare un video in maniera semplice e
comoda.
Toccare O > (&) > Altro, quindi selezionare la modalita desiderata.
- E possibile madificare l'ordine delle modalita di scena spostando licona della
modalita di scena tenendola premuta.

Diverse modalita fotocamera

Panoramica

E possibile creare una foto panoramica spostando la fotocamera nella direzione da

fotografare e unire gli scatti continui di una vista ampia.
1 Toccare Q> (&) quindi toccare Altro >

2 Toccare (), quindi spostare lentamente la fotocamera in una sola direzione.
+ Spostare il dispositivo seguendo la direzione della freccia sulla linea di
riferimento.

3 Toccare @ per interrompere lacquisizione della panoramica.
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Cibo

E possibile scattare una foto o registrare un video, regolando la barra di scorrimento
del colore e il bilanciamento del bianco.

1 Toccare O > (&) quindi toccare Altro > $9.

2 Sfiorare () per scattare una foto.

« Trascinare la barra di scorrimento dei colori sullo schermo per regolare il
bilanciamento del bianco e selezionare il colore migliore.

+ Se non viene visualizzata la barra di scorrimento, toccare Q= per regolare il
bilanciamento del bianco.

Jump-cut flash
Le foto scattate a intervalli regolari sono salvate come file GIF
1 Toccare Q> (&) quindi toccare Altro >R
2 Sfiorare () per scattare una foto.
« Le foto sono scattate ogni 3 secondi e sono salvate come file GIF
- Tocca (@] sullo schermo per selezionare il numero di foto che vuoi scattare.

- Quando scatti foto, tocca @ per creare file GIF cono foto scattate in
precedenza.

Il flash si accende automaticamente e agisce come un timer.

E

Gli scatti realizzati questa volta e il numero totale di scatti vengono visualizzati in
fondo allo schermo.

Tutte le foto scattate sono salvate come file GIF

+ Non puoi modificare la velocita dei GIF né l'ordine delle immagini

Macro
E possibile riprendere un primo piano di un soggetto.
1 Toccare Q> (&), quindi toccare Altro > 8,

7 Sfiorare per scattare una foto.
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YouTube Live

E possibile registrare un video e caricarlo direttamente du YouTube.
T Toccare Q> (&) quindi toccare Altro > ((e)).

7 Toccare e registrare un video.

+ Per usare questa funzionalita, € necessario verificare il proprio numero di
telefono.

E « YouTube Live e disponibile solo quando il proprio dispositivo & connesso a Internet.
Se si utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

Ritratto

Puoi scattare un ritratto applicando un effetto di sfocatura delle lenti per la
fotocamera.

Per ulteriori dettagli, consultare la sezione Ritratto.

Al CAM

E possibile scattare foto o registrare video in modo efficace in quanto la fotocamera
riconosce l'oggetto quando si scatta una foto o si registra un video.

Per ulteriori dettagli consultare la sezione Al CAM.

Altre funzioni utili nell'app Fotocamera

Blocco Esposizione automatica/Messa a fuoco automatica

E possibile fissare il livello attuale di esposizione e mettere a fuoco la posizione
toccando e tenendo premuta lo schermo nella modalita automatica. Per disattivare
la funzione, toccare un‘area vuota sulla schermata.
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E + Questa funzione ¢ disponibile solo in alcune modalita specifiche.

Multiscatto
E possibile riprendere scatti contini di foto per creare immagini in movimento.
Nella modalita automatica, toccare e tenere premuto ().

- Gli scatti continui vengono ripresi a rapida velocita mentre si tiene premuto (.

Passaggio dalla fotocamera posteriore a quella anteriore e
viceversa

E possibile passare dalla fotocamera anteriore a quella posteriore e vice versa in
base allambiente circostante.

Nella schermata della fotocamera, toccare {o} o trascinare la schermata verso
lalto o verso il basso per passare dalla fotocamera posteriore a quella anteriore e
viceversa.

ans

E « Utilizzare la fotocamera anteriore per scattare i selfie. Per ulteriori dettagli,
consultare la sezione Scatto di selfie.
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Zoom avanti o indietro

E possibile eseguire lo zoom avanti o indietro della schermata della fotocamera
mentre si scatta una foto o si registra un video.

+ Nella schermata della fotocamera, awvicinare o allontanare due dita per eseguire
lo zoom avanti o indietro. Oppure, usando la barra di regolazione che appare
quando si trascina (&) / () verso lalto, & possibile ingrandire o ridurre e passare
tra angolo standard e grandangolo.

5 « Lafunzione di zoom avanti/indietro non ¢ disponibile in modalita selfie
(fotocamera anteriore).

+ Questa funzione non e supportata in diverse modalita.

Scatto di selfie

E possibile utilizzare la fotocamera anteriore per visualizare il proprio volto sullo
schermo e scattare selfie.

Scatto tramite gesto della mano
E possibile scattare selfie tramite gesti.
Mostrare il palmo della mano alla fotocamera anteriore e quindi stringere il pugno.
E inoltre possibile stringere il pugno e poi aprirlo verso la fotocamera anteriore.
+ Dopo tre secondi la foto viene scattata.

m

N
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Per utilizzare questa funzione, passare alla modalita fotocamera anteriore, quindi
toccare §83 > Scatto di selfie > Scatto tramite gesto della mano.

i

Assicurarsi che il palmo e il pugno siano allinterno della linea di riferimento in
modo che la fotocamera possa rilevarli.

Questa funzione potrebbe non essere disponibile mentre sono in uso alcune altre
funzioni della fotocamera.

Scatto automatico

E possibile utilizzare la funzione di rilevamento del volto per scattare selfie in
maniera semplice e comoda. Si pud impostare il dispositivo in maniera tale che,
quando ['utente quarda verso lo schermo, la fotocamera anteriore rilevi il volto e
scatti automaticamente un selfie.
+ Quando la fotocamera anteriore rileva il volto, viene visualizzata la cornice guida
di colore bianco. Se il soggetto allinterno della cornice guida smette di muoversi,
la cornice guida diventa blu, quindi la fotocamera scatta una foto.

E - Toccare §83 > Scatto di selfie > Scatto automatico per attivare la funzione
Scatto automatico.

Scatto intervallato
E possibile scattare selfie a intervalli regolari.
Mentre & in uso la fotocamera anteriore, mostrare il palmo della mano alla
fotocamera, quindi stringere rapidamente il pugno per due volte.
+ Vengono scattate quattro foto a intervalli regolari dopo un timer di ritardo di tre
secondi.

Salva come capovolta

Prima di scattare una foto con la fotocamera anteriore, toccare §33 > Salva come
capovolta. Llimmagine viene capovolta in senso orizzontale.

E + Durante [utilizzo della fotocamera anteriore, & possibile modificare le modalita di
scatto dei selfie nelle opzioni della fotocamera. Per ulteriori dettagli, consultare la
sezione Personalizzazione delle opzioni della fotocamera.
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Condivisione rapida

E possibile condividere una foto o un video sullapp desiderata subito dopo averli
ripresi.

1 Toccare O > (&), quindi scattare una foto o registrare un video.

2 Toccare licona dellapp visualizzata sullo schermo per effettuare la condivisione
mediante quellapp.
E inoltre possibile trascinare licona nella direzione opposta per visualizzare le
altre app utilizzabili per la condivisione di foto e video.

17 Icona quick share

8 s

E « Lapp visualizzata sull'icona di quick share puo variare a seconda del tipo e della
frequenza di accesso alle app installate sul dispositivo.

+ Questa funzione é disponibile solo in alcune modalita specifiche.
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Galleria

Informazioni generali sulla Galleria
E possibile visualizzare e gestire le foto e i video salvati sul dispositivo.

T Toccare O> 3

« Lefoto ei video salvati vengono visualizzati in base alla cartella.

7 Toccare una cartella e selezionare un file.

Visualizzare il file selezionato in modalita schermo intero.

Mentre si visualizza una foto, scorrere verso sinistra o destra per visualizzare
la foto precedente o successiva.

Mentre si visualizza un video, scorrere verso sinistra o destra per riavvolgere
o far avanzare velocemente il video.

Puoi visualizzare le foto o i video organizzati per anno, mese o data nella
scheda Foto.

Per visualizzare le foto per la localita in cui la foto e stata scattata, tocca
O> @ > 03 > Tag posizione, quindi Q. Le foto sono automaticamente
raggruppate per localita nella scheda Memoria dell'app Galleria.

E « Alcuni formati file potrebbero non essere supportati a seconda del software
installato.

+ Alcuni file potrebbero non aprirsi a causa della codifica.
« [file di dimensioni superiori al limite massimo potrebbero generare un errore.

« Devi attivare la funzionalita GPS per creare album di Memoria.
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Visualizzazione delle foto

Awviare Google Lens.
Consente di
aggiungere a o

rimuovere dai preferiti

Consente di tornare

alla schermata
precedente. - Consente di accedere
a opzioni aggiuntive.
Consente di awviare la
fotocamera.
Consente di scrivere un ] ] Consente di eliminare
promemoria su una foto. le immagini.
Consente di modificare le Consente di condividere

immagini. le immagini.

E « Per visualizzare le voci di menu, toccare delicatamente lo schermo. Per nascondere
le voci di menu, toccare nuovamente lo schermo.

Riproduzione di un video

Aprire con QSlide.

Consente di riprodurre
o sospendere la
riproduzione del video.

e— Consente di accedere
a opzioni aggiuntive.

Consente di — ey ). 2 — Consente
riawolgere il video. l'avanzamento veloce
del video.

Consente di scegliere — T Consente di bloccare 0

le proporzioni dello sbloccare lo schermo.
schermo.
DTSX 3D Surround Consente di

modificare il video
Realizzazione di un file
GIE

E « Per regolare il volume dell'audio, trascinare in alto o in basso il lato destro della
schermata del video.

Per regolare la luminosita dello schermo, trascinare verso lalto o verso il basso il
lato sinistro della schermata
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Modifica dei video
1 Mentre si visualizza un video, toccare f

2 Utilizzare vari effetti e strumenti di modifica per modificare il video.

Consente di regolare

la risoluzione.
Consente di Consente di creare
ripristinare la modifica. l | automaticamente una
P o] clipvideo di 15,30 o
60 secondi.
Consente di
selezionare una
sezione per cambiare
la velocita di

S mmanaanananls—— _Onsente di regolare

riproduzione. la durata del video.

3 Toccare Salva per salvare le modifiche.

Creazione di un filmato
E possibile creare un nuovo filmato, mettendo insieme immagini e video.
Per ulteriori dettagli, consultare la sezione Creazione di un filmato.

Realizzazione di una GIF
E possibile realizzare una GIF con facilita utilizzando un video registrato.
Per ulteriori dettagli, consultare la sezione Realizzazione di una GIF.
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Eliminazione di file
E possibile eliminare file utilizzando una delle sequenti opzioni:

Toccare e tenere premuto un file nell'elenco, quindi toccare Elimina.

Toccare [11] dall'elenco di file ed eliminare il file desiderati.

- | file eliminati vengono automaticamente spostati nel Cestino e possono essere
ripristinati nella Galleria entro 7 giorni.

- Toccare [x] per eliminare completamente i file. In questo caso, i file non potranno
essere ripristinati.

Condivisione di file
E possibile condividere file utilizzando una delle sequenti opzioni:

- Mentre si visualizza una foto, toccare <& per condividere il file utilizzando il
metodo desiderato.

« Mentre si visualizza un video, toccare > Condividi per condividere il file
utilizzando il metodo desiderato.

- Toccare o< nell'elenco dei file per selezionare i file e condividerli utilizzando il
metodo desiderato.
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Rubrica

Informazioni generali sui contatti
E possibile salvare e gestire i contatti.
Toccare () > Essenziali > Rubrica.

Aggiunta di contatti

Aggiunta di nuovi contatti

T Nella schermata dell'elenco dei contatti, toccare .
« Appare un pop-up che consente di selezionare la posizione di salvataggio del
contatto. Selezionare la posizione desiderata.

7 Immetterei dettagli del contatto e toccare Salva.

Importazione di contatti
E possibile importare contatti da un altro dispositivo di archiviazione.

1 Nella schermata dell'elenco dei contatti, toccare > Gestisci contatti >
Importa.

2 Selezionare le posizioni di origine e di destinazione del contatto che si desidera
importare, quindi toccare OK.

3 Selezionare i contatti e toccare Importa.

Aggiunta di contatti all'elenco di composizione veloce

1 Nella schermata dell'elenco dei contatti, toccare > Selezione rapida.
7 Toccare Aggiungi contatto da un numero di composizione veloce.

3 Selezionare un contatto.

E + Mentre siaggiunge un nuovo contatto, toccare [3{3 per aggiungere un numero di
chiamata rapida.
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Ricerca di contatti
E possibile ricercare contatti utilizzando una delle sequenti opzioni:

+ Toccare la barra di ricerca nella parte superiore della schermata Rubrica e
inserire il contatto o il numero di telefono che si desidera cercare.

« Scorrere |'elenco dei contatti verso lalto o verso il basso.

« Dall'indice della schermata dell'elenco dei contatti, toccare la lettera iniziale di
un contatto.

E + Premendo la barra di ricerca nella parte superiore della schermata Rubrica e
inserendo un contatto o un numero di telefono, vengono visualizzati i risultati della
ricerca integrati dalla cronologia delle chiamate e dall'elenco dei contatti salvati
nel prodotto.

Elenco dei contatti

Modifica di contatti
71 Nella schermata dell'elenco dei contatti, selezionare un contatto.
7 Nella schermata dell'elenco dei contatti, toccare f e modificare i dettagli.

3 Toccare Salva per salvare le modifiche.

Eliminazione di contatti
E possibile eliminare contatti utilizzando una delle sequenti opzioni:

+ Nella schermata dellelenco dei contatti, toccare e tenere premuto un contatto
che si desidera eliminare, quindi toccare Elimina contatto.

- Toccare + > Elimina nella schermata dellelenco dei contatti.

E + | contatti cancellati non possono essere recuperati.
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Aggiunta ai preferiti
E possibile registrare i contatti utilizzati pili spesso come preferiti.
71 Nella schermata dell'elenco dei contatti, selezionare un contatto.

2 Nella schermata dei dettagli dei contatti, toccare sﬁf

Creazione di gruppi

1 Dallelenco dei gruppi di contatti, toccare -

2 Immettere il nome del nuovo gruppo.

3 Toccare Aggiungi iscritti, selezionare i contatti, quindi toccare Aggiungi.

/. Toccare Salva per salvare il nuovo gruppo.

QuickMemo+

Informazioni generali su QuickMemo+

E possibile generare note creative utilizzando una varieta di opzioni su questa
funzione avanzata del blocco note, come ad esempio la gestione immagini e gli
screenshot, che non sono supportati dal blocco note tradizionale.

Creazione di una nota
T Toccare > QuickMemo+.
2 Toccare @ per creare una nota.
+ \/ :consente di salvare una nota.
+ €5 :Annullare le modifiche precedenti.
+ 2 :Applicare di nuovo le modifiche annullate di recente.
« T : consente di immettere una nota utilizzando la tastiera.
-/ :consente di scrivere delle note a mano.
- & :consente di cancellare le note scritte a mano.
- {7 : consente di eseguire lo zoom avanti o indietro, ruotare o cancellare
parte di una nota scritta a mano.
: :Consente di accedere a opzioni aggiuntive.

3 Toccare N/ per salvare la nota.
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Scrittura di note su uno screenshot

1 Mentre sivisualizza la schermata che si desidera acquisire, trascinare la barra di

stato verso il basso, quindi toccare (2,

« Lo screenshot viene visualizzato come tema di sfondo del blocco note.
Nella parte superiore dello schermo vengono visualizzati gli strumenti di
promemoria.

2 Tagliare limmagine (se necessario) e aggiungere note a proprio piacimento.
+ Scrivere delle note a mano sulla foto.

3 Toccare N/ e salvare le note nella posizione desiderata.

« Le note salvate possono essere visualizzate in QuickMemo+ o in Galleria.

« Per salvare le note sempre nella stessa posizione, selezionare la casella di
controllo Usa come predefinita per questa azione. e selezionare unapp.

E + Puoi scattare una foto dell'intero schermo, utilizzando la funzione di scatto di
scorrimento.

+ Quando si utilizza un'app come Invia messaggio o Chrome, trascinare il pannello
notifiche verso il basso, quindi cliccare Capture+ > Esteso per scattare una foto
dell'intero schermo cosi come lo si vede e salvarla in un solo file.

+ Questa funzione e disponibile solo in alcune app che supportano la funzione scatto

di scorrimento.

Stringi due dita o allargale per regolare il layout del promemoria.
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Gestione delle cartelle
E possibile organizzare e visualizzare i promemoria in base al tipo di promemoria.
T Toccare O > QuickMemo+.

7 Toccare = nella parte superiore dello schermo e quindi selezionare la funzione
desiderata.

Tutti i memo: consente di visualizzare tutti i memo salvati in QuickMemo+.
| miei memo: consente di visualizzare i memo creati in QuickMemo+.

Capture+: consente di visualizzare i memo creati usando Capture+.

Cestino: consente di visualizzare i memo eliminati.
- Nuova categoria: consente di aggiungere cartelle.

- /P :E possibile cambiare lordine delle cartelle o aggiungere/eliminare
cartelle. Premendo una cartella, & possibile modificarne il nome.

E + Alcune cartelle non vengono visualizzate al primo awio di dellapp con le cartelle.
Le cartelle inoltre vengono visualizzate solo quando contengono promemoria.

« | promemoria eliminati vengono spostati nel cestino e possono essere recuperati
entro 7 giorni dal giorno in cui sono stati eliminati. Nellapp QuickMemo-+, &
possibile cambiare il tipo di visualizzazione posizionando due dita sullo schermo e
allontanando o awvicinando le dita.

Orologio

Sveglia

E possibile impostare una sveglia in modo che si attivi a un orario specificato.
T Toccare Q> Orologio > Sveglia.

72 Toccare - per aggiungere una nuova sveglia.

3 Configurare le impostazioni della sveglia e toccare Salva.
« Sesi seleziona una sveglia impostata in precedenza, € possibile modificarla.

« Per eliminare una sveglia, toccare E > Elimina nella parte superiore dello schermo.
In alternativa, toccare e tenere premuta la sveglia.

App utili 94



Fusi orari

E possibile visualizzare l'ora attuale delle citta di tutto il mondo.
1 Toccare O> Orologio > Fusi orari.

2 Toccare —|— e aggiungere una citta.

Timer

E possibile impostare il timer in modo da attivare un segnale acustico dopo un
periodo di tempo specificato.

T Toccare Q> Orologio > Timer.

2 Impostare il tempo e toccare Inizio.

« Per sospendere il timer, toccare Pausa. Per riprendere il timer; toccare
Riprendi.

3 Toccare Stop per arrestare la sveglia del timer.

Cronometro
E possibile utilizzare il cronometro per registrare un tempo.
1 Toccare O > Orologio > Cronometro.
2 Toccare Inizio per awiare il cronometro.
« Per registrare un tempo, toccare Giro.

3 Toccare Pausa per sospendere il cronometro.
« Perriprendere il cronometro, toccare Riprendi.

« Per cancellare tutte le registrazioni e awiare di nuovo il cronometro, toccare
Reset.
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Musica

E possibile riprodurre e gestire canzoni o album musicali
T Toccare Q> Essenziali > Musica.

7 Selezionare una categoria.

3 Selezionare un file musicale.

Riprodurre la musica con il flash
della fotocamera che Iampeggla — Consente di impostare effetti
seguendo il ritmo. sonori.

:e—— Consente di accedere a opzioni
aggiuntive.

—— Passare alla playlist.

Consente di tornare alla —s ¢
schermata precedente.

— Consente di riprodurre o
sospendere |a riproduzione.

Toccare per riprodurre il file Toccare per riprodurre il file
corrente dall'inizio / Toccare due successivo / Toccare e tenere
volte per riprodurre il file premuto per avanzare

e

precedente / Toccare e tenere velocemente.

premuto per riawolgere. - P » o«
Consente di riprodurre in ordine ——I L— Consente di selezionare una
casuale. =" modalita di ripetizione.
Consente di regolare il volume ——ea» 7 #e—— Modifica velocita e intonazione.
?

dellaudio.
Consente di aggiungere a o Q

rimuovere dai preferiti.

E « Alcuni formati file potrebbero non essere supportati a seconda del software
installato.

I file di dimensioni superiori al limite massimo potrebbero generare un errore.

| file musicali potrebbero essere protetti dai titolari di copyright internazionali o da
leggi sul copyright. Prima di copiare un file musicale, potrebbe essere necessario
ottenerne |'autorizzazione legale. Per scaricare o copiare un file musicale, verificare
prima le leggi sul copyright del relativo paese.
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Calcolatrice

E possibile utilizzare due tipi di calcolatrici: la calcolatrice semplice e la calcolatrice
scientifica.

1 Toccare O > Essenziali > Calcolatrice.

2 Utilizzare il tastierino numerico per eseguire un calcolo.
- Per ricominciare un calcolo, toccare e tenere premuto il pulsante {X].

ThinQ
E possibile collegare facilmente il prodotto a dispositivi IoT per monitorarli e

utilizzarli comodamente.
Toccare () > Essenziali > ThinQ.

E « Lavatrice, asciugatrice, styler, lavastoviglie, forno e robot aspirapolvere possono
essere registrati solo quando il prodotto & in modalita standby.

« Cercare il marchio ThinQ sul prodotto per vedere se puo essere collegato all'app
ThinQ

« Toccare = per vedere le varie funzioni dellapp ThinQ.

Launcher Del Gioco

E possibile impostare se utilizzare il launcher del gioco, dove & possibile visualizzare
l'elenco dei giochi installati nel prodotto e selezionare le impostazioni di gioco quali
la disattivazione dellaudio multimediale, la limitazione degli awvisi ecc.

1 Toccare Q> Essenziali > Launcher Del Gioco.

2 Selezionare lopzione desiderata.
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Registratore audio
Consente di registrare e salvare la propria voce o quelle di altre persone, ad esempio

durante eventi importanti. | file vocali registrati possono essere riprodotti e condivisi.

1 Toccare O> Essenziali > Registratore audio.

- Per aggiugnere un evento, toccare + > Aggiungi tag > Agg. in Evento.
Quindi, aggiungere un evento alla data desiderata.

- Per salvare i dettagli della posizione della registrazione, toccare + >
Aggiungere tag > Agg. in Posizione.

2 Toccare @.

- Per mettere in pausa la registrazione, toccare @.

3 Toccare @) per terminare la registrazione.
« Ilfile viene salvato automaticamente e viene visualizzata la schermata di
preascolto.

4 Toccare @ per ascoltare la voce registrata.

E - Toccare :_@ per visualizzare i file registrati. E possibile riprodurre un file vocale
registrato dall'elenco.

Centro aggiornamenti

Puoi controllare e installare la versione pit recente dell'app o del software fornito
alG.

Toccare () > Gestione > Centro aggiornamenti.

Smart Doctor

E possibile utilizzare Smart Doctor per esequire una diagnosi dello stato del
dispositivo e ottimizzarlo.

Toccare () > Gestione > Smart Doctor.
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LG Mobile Switch

E possibile trasferire dati con facilita da un dispositivo usato a un dispositivo nuovo

mediante LG Mobile Switch.

1 Toccare O> Gestione > LG Mobile Switch.
In alternativa toccare O) > Impostazioni > Sistema > Backup > LG Mobile
Switch.

2 Sequire le istruzioni visualizzate sullo schermo per selezionare il metodo
desiderato per il trasferimento.

E « | datiin un account Google non saranno sottoposti a Backup. Quando si
sincronizza l'account Google, le app di Google, i contatti di Google, il calendario di
Google, i dati delle app di promemoria di Google e le app scaricate dal Play Store
vengono archiviati automaticamente sull'app Drive.

Caricare completamente la batteria prima del trasferimento di dati per evitare lo
spegnimento involontario durante il processo.

Cestino app

E possibile vedere lelenco delle app disinstallate sulla schermata Home. Le app
eliminate nelle ultime 24 ore possono essere recuperate.

Toccare () > Gestione > Cestino app.

Per maggiori informazioni, vedere Cestino app.
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SmartWorld

E possibile scaricare vari giochi, contenuti audio, app e tipi di carattere forniti da LG
Electronics. Si puo inoltre personalizzare il dispositivo in base alle proprie preferenze
utilizzando temi per la schermata Home e tipi di carattere.

E « Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

+ Questa funzione potrebbe non essere supportata a seconda dell'area o del
provider del servizio.

1 Toccare O > Servizi > SmartWorld.
7 Toccare > Accedi, quindi effettuare accesso.

3 Selezionare e scaricare i contenuti desiderati.

RemoteCall Service

Il dispositivo puo essere sottoposto a diagnostica in modalita remota per risolverne
i problemi. Innanzitutto, eseguire una chiamata telefonica a un Centro di assistenza
clienti LG come segue:

« Per servirsi di questa funzione, & prima necessario accettarne ['utilizzo.

« Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

1 Toccare O > Servizi > RemoteCall Service.
2 Collegare una chiamata al centro di assistenza clienti LG.

3 Al collegamento della chiamata, sequire le istruzioni dell'addetto al servizio per
immettere un numero di accesso a sei cifre.

+ Il dispositivo viene connesso in modalita remota e viene awviato il servizio di
assistenza remota.
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Messaggio CB

E possibile visualizzare trasmissioni di testo in tempo reale su situazioni di
emergenza, come tifoni, inondazioni e terremoti.

Toccare () > Servizi > Messaggio CB.

App di Google

E possibile utilizzare app di Google impostando un account Google. Quando si
utilizza un'app di Google per la prima volta, viene visualizzata automaticamente

la finestra di registrazione dell'account Google. Se non si dispone di un account
Google, crearne uno dal dispositivo. Per i dettagli su come utilizzare un‘app, vedere
la Guida contenuta nell'app.

E « Alcune app potrebbero non funzionare a seconda dell'area o del provider del
servizio.

Chrome

Un browser web veloce, semplice e sicuro, costruito per la rete moderna.

Documenti

Docs e uno strumento collaborativo di elaborazione di testi che aumenta la
produttivita. Usa Docs per creare, modificare e lavorare insieme in tempo reale.

Drive

Drive & un'app di condivisione e immagazzinaggio di file che facilita l'individuazione,
la condivisone e la collaborazione su progetti di lavoro ovunque e in ogni istante.

Duo

Crea video chiamate semplici e di alta qualita verso i tuoi amici e famigliari su
telefoni Android e iPhones.

Gmail

Gmail & un'app facile da usare che tiene al sicuro i tuoi messaggj, rende piti smart la
tua casella di posta e ti aiuta a restare organizzato.
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Google

L'app Google ti tiene aggiornato sulle cose che ti interessano. Trova risposte rapide,
esplora i tuoi interessi e ricevi un feed di storie e aggiornamenti su argomenti
importanti per te.

Note di Keep

Crea, modifica e condividi le tue note di testo e foto con l'account Google.

Maps

Stai andando da qualche parte? Vai con Maps, app con GPS in tempo reale sulla
quale puoi fare affidamento per navigazione, traffico, transito e dettagli su milioni di
luoghi, come recensioni ed eventi popolari.

Foto

La casa di tutte le tue foto e video, organizzata automaticamente per condividere e
salvare le cose piti importanti.

Play Film
Consente di utilizzare il proprio account Google per noleggiare o acquistare film. E
possibile acquistare contenuti e riprodurli ovunque.

YT Music

Un nuovo servizio di streaming musicale da YouTube.

Fogli
Sheets e un foglio di lavoro collaborativo che aumenta la produttivita. Usa Sheets
per importare, organizzare e analizzare informazioni in tempo reale.

Presentazioni

Google Slides & uno strumento per presentazioni in tempo reale che aumenta la
produttivita. Usa Slides per organizzare informazioni, presentare risultati e prendere
decisioni insieme in tempo reale.

YouTube

Guarda i tuoi canali preferiti, ascolta la musica che ami e carica video da condividere
con le persone intorno a te.
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Assistente

Il tuo dispositivo dispone di Assistente Google incorporato. Trovale risposte e fai
cose mentre sei in giro. Per inizare, basta toccare il tasto Assistente Google sul lato
del telefono o tenere premuto il pusante home del telefono.

E - Assistente Google non & disponibile in tutte le lingue o paesi.

Calendario

L'app Calendario consente di tenere traccia del proprio programma di eventi (che &
stato creato), organizzato per Giorno, 3 giorni, Settimana o Mese.

Files
E possibile visualizzare e gestire file salvati sul dispositivo.
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Impostazioni

E possibile personalizzare le impostazioni del dispositivo in base alle proprie
preferenze.

Toccare () > Impostazioni.

E + Inserendo una parola chiave nella finestra di ricerca nella parte superiore dello
schermo, e possibile trovare comodamente gli elementi da impostare

Rete & internet

Dual SIM
E possibile configurare le impostazioni dual SIM.
1 Nella schermata delle impostazioni, toccare Rete & internet > Dual SIM.
2 Personalizzare le seguenti funzioni:
+ Scheda SIM 1: modificare il nome e l'icona della scheda SIM 1.
+ Scheda SIM 2: modificare il nome e l'icona della scheda SIM 2.

« Colore del tema della scheda SIM: modificare i temi del colore per le
schede SIM.

+ Modalita Risparmio: attivare o disattivare la modalita risparmio:In modalita
Risparmio, se si effettua una chiamata a un contatto al quale e assegnata
una specifica SIM, tale SIM viene utilizzata per la chiamata anche se laltra

SIM e attiva, ad esempio in caso di utilizzo dei dati mobili.

- Dati mobili: selezionare una scheda SIM da utilizzare per il servizio dati

cellulare. E possibile anche disattivare questa funzione.

- Roaming dati: selezionare questa opzione per attivare il dispositivo affinché
utilizzi i dati mobili durante il roaming al di fuori dell'area della propria rete

domestica.

- Dati mobili durante le chiamate: Accedere ai dati mobili usando la scheda
SIM dati non predefinita temporaneamente durante una chiamata HD con la

stessa scheda.
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Wi-Fi

E possibile connettersi a dispositivi vicini tramite una rete Wi-Fi.

Connessione a una rete Wi-Fi
1 Nella schermata delle impostazioni, toccare Rete & internet > Wi-Fi.
7 Toccare QD per attivarlo.
+ Vengono visualizzate automaticamente le reti Wi-Fi disponibili.
3 Selezionare unarete.
« Potrebbe essere necessario immettere la password Wi-Fi della rete.

+ Questo processo viene ignorato in caso di reti a cui e gia stato effettuato
l'accesso in precedenza. Se non si desidera esequire automaticamente la
connessione a una determinata rete \Wi-Fi, toccare la rete, quindi toccare
Dimentica.

Impostazioni della rete Wi-Fi
Nella schermata delle impostazioni, toccare Rete & internet > Wi-Fi.
- Passa a rete dati: se la funzione connessione dati mobile & attiva e il dispositivo

non e in grado di connettersi a Internet tramite la connessione Wi-Fi, il
dispositivo si connette a Internet tramite la connessione dati mobile.

E « Questa funzione dipende dal provider del servizio.

-+ :consente di personalizzare le impostazioni della rete Wi-Fi.
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Wi-Fi Direct

E possibile connettere il dispositivo ad altri dispositivi che supportano la funzione

\Wi-Fi Direct per condividere direttamente i dati con essi. Non & necessario disporre

diun punto di accesso. Utilizzando la funzione Wi-Fi Direct, e possibile connettere

pit di due dispositivi.

1 Nella schermata delle impostazioni, toccare Rete & internet > Wi-Fi > >
Avanzate Wi-Fi> Wi-Fi Direct.

« Vengono automaticamente visualizzati i dispositivi vicini che supportano la
funzione Wi-Fi Direct.

2 Selezionare un dispositivo.

« La connessione awiene quando il dispositivo accetta la richiesta di
connessione.

E « La batteria potrebbe scaricarsi piti rapidamente quando si utilizza il Wi-Fi Direct.

Dati mobili

E possibile attivare o disattivare i dati mobili. E inoltre possibile gestirne lutilizzo.

Attivazione dei dati mobili
T Nella schermata delle impostazioni, toccare Rete & internet > Dati mobili.

2 Toccare QD per attivarlo.

Personalizzazione delle impostazioni dei dati mobili
T Nella schermata delle impostazioni, toccare Rete & internet > Dati mobili.
7 Personalizzare le sequenti impostazioni:

- Dati mobili: consente di utilizzare le connessioni dati su reti mobili.

« Limita l'utilizzo dei dati mobili: consente di impostare un limite di utilizzo
dei dati mobili in modo da bloccarli al raggiungimento della soglia.

: :consente di personalizzare le impostazioni dei dati mobili.

+ Il volume di utilizzo dei dati misurato in base al prodotto e il volume calcolato
dal proprio gestore di telefonia mobile potrebbero essere diversi.
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Impostazioni chiamate

E possibile personalizzare le impostazioni di chiamata, ad esempio le opzioni per le
chiamate vocali e per quelle internazionali.

E « Alcune funzioni potrebbero non essere supportate a seconda dell'area o del
provider del servizio.

T Nella schermata delle impostazioni, toccare Rete & internet > Impostazioni
chiamate.

7 Personalizzare le impostazioni.

Tethering
Tethering USB

E possibile connettere il dispositivo a un altro dispositivo tramite USB e condividere
i dati mobili.
1 Connettere il dispositivo e gli altri dispositivi tramite il cavo USB.

2 Nella schermata delle impostazioni, toccare Rete & internet > Tethering >
Tethering USB e quindi toccare Q) per attivarlo.

5

Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei
dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

Quando si esegue la connessione a un computer; scaricare il driver USB da
wwwlg.com e installarlo sul computer:

Non é possibile inviare o ricevere file tra il dispositivo e un computer quando il
tethering USB ¢ attivo. Disattivare il tethering USB per inviare o ricevere file.

| sistemi operativi che supportano il tethering sono Windows XP o versione
superiore, o Linux.
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Hotspot Wi-Fi

E possibile impostare il dispositivo in modo da farlo funzionare come un router
wireless affinché altri dispositivi possano connettersi a Internet utilizzando i suoi
dati mobili.

T Nella schermata delle impostazioni, toccare Rete & internet > Tethering >
Hotspot Wi-Fi e toccare () per attivare la funzione.

7 Toccare Imposta hotspot Wi-Fi e immettere il Nome Wi-Fi (SSID) e la
password.

3 Attivare il Wi-Fi sull'altro dispositivo e selezionare il nome della rete del
dispositivo nell'elenco delle connessioni Wi-Fi.

4 Immettere la password di rete.

E + Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei
dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

« Ulteriori informazioni sono disponibili su questo sito \Web:
http//www.android.com/tether#wifi

Timer per lo spegnimento automatico dell'hotspot Wi-Fi

Se 'hotspot Wi-Fi non viene utilizzato per un determinato periodo di tempo,
viene disconnesso in automatico. Puoi impostare il periodo di tempo per la
disconnessione automatica.

Tethering Bluetooth
Un altro dispositivo connesso tramite Bluetooth puo connettersi a Internet
utilizzando i dati mobili del proprio dispositivo.

1 Nella schermata delle impostazioni, toccare Rete & internet > Tethering >
Tethering Bluetooth e quindi toccare () per attivarlo.

7 Attivare il Bluetooth su entrambi i dispositivi e associarli.

E + Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei
dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

« Ulteriori informazioni sono disponibili su questo sito \Web:
http//www.android.com/tether#Bluetooth_tethering
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Guida

E possibile visualizzare la quida sullutilizzo del tethering e degli hotspot.
Nella schermata delle impostazioni, toccare Rete & internet > Tethering > Guida.

Modalita aereo

E possibile disattivare le funzioni di chiamata e dei dati mobili. Quando questa
modalita e attiva, restano disponibili le funzioni che non implicano il trasferimento di
dati, ad esempio i giochi e la riproduzione di brani musicali.

1 Nella schermata delle impostazioni, toccare Rete & internet > Modalita aereo.

7 Toccare Attiva nella schermata di conferma.

Reti mobili
E possibile personalizzare le impostazioni delle reti mobili.
1 Nella schermata delle impostazioni, toccare Rete & internet > Reti mobili.
7 Personalizzare le sequenti impostazioni:
+ Modalita rete: consente di selezionare un tipo di rete.

+ Nomi punti di accesso: consente di visualizzare o cambiare il punto di
accesso per |'utilizzo dei servizi di dati mobili. Per cambiare il punto di
accesso, selezionarne uno fra quelli disponibili nel relativo elenco.

+ Operatori di rete: consente di cercare gli operatori di rete e di connettersi
automaticamente a una rete.
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VPN

E possibile connettersi a una rete virtuale sicura, ad esempio a una Intranet. £
inoltre possibile gestire |a rete privata virtuale connessa.

Aggiunta di una rete VPN

1 Nella schermata delle impostazioni, toccare Rete & internet > VPN.

2 Toccare—+

E + Questa funzione é disponibile solo se il blocco schermo e attivato. Se il blocco
schermo e disattivato, viene visualizzata una schermata di notifica. Toccare Cambia
dalla schermata di notifica per attivare il blocco schermo. Per ulteriori dettagli,
consultare la sezione Impostazione di un blocco schermo.

3 Immettere i dettagli della rete VPN e toccare Salva.

Configurazione delle impostazioni della rete VPN
1 Toccare una rete VPN nell'elenco VPNS.

7 Immettere i dettagli relativi allaccount utente della rete VPN e toccare
Connetti.

« Per salvare i dettagli dell'account, selezionare la casella di controllo Salva le
informazioni sull'account.

DNS privato
E possibile configurare le opzioni del DNS (Domain Name System) privato.
1 Nella schermata delle impostazioni, toccare Rete & internet > DNS privato.

2 Selezionare lopzione desiderata e toccare Salva.
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Dispositivi collegati

Bluetooth

E possibile connettere il dispositivo a dispositivi vicini che supportano la funzione
Bluetooth per scambiare direttamente i dati con essi. Connettere il dispositivo a un
auricolare Bluetooth e a una tastiera. In questo modo sara pit semplice controllare
il dispositivo.

Associazione a un altro dispositivo

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > Bluetooth.

2 Toccare Q) per attivarlo.
+ Vengono automaticamente visualizzati i dispositivi disponibili.
- Per aggiornare l'elenco dei dispositivi, toccare ().

E + Nellelenco sono visualizzati solamente i dispositivi impostati come visibili.

3 Selezionare un dispositivo dall'elenco.
A Seguire le istruzioni visualizzate sullo schermo per effettuare l'autenticazione.

E « Questo passaggio viene saltato per i dispositivi cui & stato effettuato laccesso in
precedenza.

Invio di dati tramite Bluetooth

1 Selezionare un file.
- E possibile inviare file multimediali o contatti.

2 Toccare <& > Bluetooth.

3 Selezionare un dispositivo di destinazione per il file.
« Il file viene inviato non appena viene accettato dal dispositivo di destinazione.

E « | processi di condivisione di file potrebbero differire, a seconda del file.
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NFC

E possibile utilizzare il dispositivo come tessera dei trasporti o carta di credito. E
inoltre possibile condividere dati con laltro dispositivo.

T Nella schermata delle impostazioni, toccare Dispositivi connessi > NFC.

2 Toccare ) per attivarlo.

- Mettere a contatto il proprio dispositivo con laltro dispositivo che supporta
NFC per consentire la condivisione di dati.

E « Lantenna NFC potrebbe essere situata in una posizione diversa a seconda del tipo
di dispositivo. Per i dettagli relativi allarea dellantenna NFC, vedere Panoramica
delle parti.

Android Beam

E possibile condividere file mettendo a contatto il retro di due dispositivi. E inoltre
possibile condividere file tra cui file musicali, video o contatti e aprire una pagina
Web o awviare unapp dall'altro dispositivo.

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > Android
Beam.

72 Mettere a contatto il retro del dispositivo con un altro dispositivo.

E « Lantenna NFC potrebbe essere situata in una posizione diversa a seconda del tipo
di dispositivo. Per i dettagli relativi allarea dellantenna NFC, vedere Panoramica
delle parti.
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Pannello di condivisione

E possibile condividere i contenuti delle app Galleria, Musica e File Manager con i
dispositivi nelle vicinanze. Inoltre, & possibile condividere contenuti con delle persone
specifiche nelle app che utilizzano Google Direct Share.

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > Pannello di
condivisione.
2 Toccare @  per disattivare ciascuna opzione.

- Dispositivi nelle vicinanze: E possibile visualizzare i dispositivi nelle
vicinanze con cui e possibile condividere i contenuti delle app Galleria e
Musica.

+ Condivisione diretta: Da unapp che supporta Google Direct Share, e
possibile visualizzare un‘icona che consente di condividere contenuti con
persone specifiche.

Condivisione File
E possibile inviare e ricevere file scambiandoli tra il dispositivo e altri dispositivi o
tablet LG.
7 Nella schermata delle impostazioni, toccare Dispositivi connessi >
Condivisione File.
2 Personalizzare le seguenti impostazioni:
+ K51S: consente di modificare il nome del dispositivo.

« Salva in: consente di impostare la cartella di destinazione in cui salvare i file
inviati da altri dispositivi.

+ Condivisione File: consente la ricezione di file inviati da altri dispositivi.

- SmartShare Beam: consente di condividere file con altri dispositivi tramite
SmartShare Beam.

- Guida: consente di visualizzare la guida alla condivisione dei file.
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Stampa
E possibile connettere il dispositivo a una stampante Bluetooth e stampare foto o
documenti salvati sul dispositivo.
Nella schermata delle impostazioni, toccare Dispositivi connessi > Stampa.
+ Toccare Servizio di stampa predefinito per cercare le stampantia cui &
possibile connettersi. Oppure, toccare * > Aggiungi stampante per aggiungere
manualmente una stampante.

- Toccare (+) Nuovo servizio per scaricare lapp della stampante desiderata.

E + Questa funzione é disponibile sono quando ¢ attiva la funzione di rete mobile o
Bluetooth.

Per scaricare [app della stampante in (+) Nuovo servizio, & necessario prima

accedere al proprio account Google.

Suono

E possibile personalizzare le impostazioni relative a suono, vibrazione e notifiche.

Nella schermata delle impostazioni, toccare Suono e personalizzare le sequenti
impostazioni:

Profilo audio: consente di passare alla modalita audio Suono, Vibrazione o
Silenzioso.

Volume: Consente di regolare il volume dellaudio di diversi elementi.

Suonerie: consente di selezionare una suoneria per le chiamate in arrivo. E
possibile aggiungere o eliminare suonerie.
Suono di notifica: consente di selezionare una suoneria per le notifiche. E

possibile impostare un brano musicale salvato sul dispositivo come suoneria di
notifica.

Suoneria con vibrazione: consente di impostare sul dispositivo la vibrazione e la
riproduzione di una suoneria in contemporanea.

Suoneria contatto: consente di creare una suoneria per una chiamata in arrivo
da un determinato contatto.

Allerta flash per le chiamate in arrivo:imposta il lampeggiamento secondo la
suoneria LG.
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Non disturbare: consente di impostare il tempo, l'intervallo e il tipo di app per
cui ricevere messaggi di notifica. E possibile ricevere messaggi di notifica solo in
particolari giorni della settimana.

Qualita del suono ed effetti: Usare la funzione per impostare la qualita e gli
effetti audio quando si riproduce una canzone o video.

Tipo vibrazione: consente di selezionare il tipo di vibrazione per le chiamate in
arrivo.

Suono della tastiera di composizione: attiva ['effetto sonoro del tastierino.
Suono della tastiera LG: attiva 'effetto sonoro della tastiera LG.
Suono touch: attiva un effetto sonoro per quando si tocca un elemento.

Suoni di blocco schermo: attiva un effetto sonoro per quando lo schermo viene
bloccato o sbloccato.

Display

E possibile personalizzare le impostazioni dettagliate di ogni tipo di schermata.

Nella schermata delle impostazioni, toccare Display e personalizzare le seguenti
impostazioni:

Sfondo: consente di personalizzare le impostazioni per la schermata Home. Per
ulteriori dettagli, consultare la sezione Impostazioni della schermata Home.
Sfondo & Tema: seleziona un wallpaper, tema e icona per lo schermo del tuo
dispositivo.

Carattere: modificare dimensione, grassetto, o facciata.

New Second Screen: selezionare 'aspetto della barra dello stato e dell'angolo
delleapp.

Pulsanti a sfioramento anteriori: consentono di impostare lo stile dei pulsanti
a sfioramento anteriori. Per ulteriori dettagli, consultare la sezione Cambio dello
stile dei pulsanti a sfioramento anteriori.

Vista comfort: consente di ridurre la quantita di luce blu sullo schermo del
dispositivo per limitare |'affaticamento degli occhi.

Modalita notte: Di notte & possibile applicare un tema dello schermo oscurato
per evitare ['abbagliamento.

Ridimensionamento della app: consente di regolare le dimensioni sullo
schermo delle app.
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Dimensioni display: consente di impostare gli elementi presenti sullo schermo
su dimensioni facilmente visibili per [utente. Alcuni elementi potrebbero
cambiare posizione.

Luminosita: utilizzare la barra di scorrimento per madificare la luminosita dello
schermo.

Automatico: consente di impostare la regolazione automatica della luminosita
dello schermo in base allintensita luminosa dellambiente.

Timeout schermo: consente di disattivare automaticamente lo schermo
quando il dispositivo viene lasciato inattivo per un determinato periodo di
tempo.

Rotazione automatica: consente di ruotare automaticamente lo schermo a
seconda dellorientamento del dispositivo.

Screen saver: consente di visualizzare uno screen saver quando il dispositivo e
collegato al supporto o al caricabatteria. Selezionare un tipo di screen saver da
visualizzare.

Vista mini: Ridurre le dimensioni dello schermo in modo da poter utilizzare il
dispositivo con una sola mano. Trascinare il pulsante a sfioramento Home verso
l'angolo inferiore sinistro o destro dello schermo.

Blocco schermo & sicurezza

E possibile personalizzare le impostazioni della schermata di blocco e della
sicurezza.

1

Nella schermata delle impostazioni, toccare Blocco schermo & sicurezza.

7 Personalizzare le impostazioni.

+ Google Play Protect: scansiona giornalmente il dispositivo per scoprire app
potenzialmente nocivi.

« Trova il mio dispositivo: Tracciare a distanza la posizione del dispositivo.
Puoi anche proteggere i tuoi dati in modo sicuro se hai smarrito il tuo
dispositivo.

- Aggiornamento sicurezza: controlla gli aggiornamenti software e configura
le impostazioni di installazione automatiche.

+ Seleziona il blocco dello schermo: Seleziona il metodo di blocco schermo

desiderato. Per ulteriori dettagli, consultare la sezione Impostazione di un
blocco schermo.
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+ Personalizza Blocco schermo: modifica le informazioni visualizzate sullo
schermo bloccato.

- Impostazioni di Blocco con sicurezza: modifica le impostsazioni di blocco
sicuro.

Impronte digitali: consente di usare impronta digitale per sbloccare
lo schermo o il contenuto. Per ulteriori dettagli, consultare la sezione
Informazioni generali sul riconoscimento delle impronte digitali.

+ Blocco del contenuto: consente di impostare un tipo di blocco (password o
disegno) per i propri file QuickMemo+ e Galleria.

Posizione: £ possibile personalizzare ['utilizzo da parte di determinate app
delle informazioni sulla propria posizione.

Crittografia e credenziali: configura le impostazioni per la cifratura e le

credenziali della scheda SD.

- Cripta la Scheda SD: consente di crittografare la scheda di memoria per
impedire ['utilizzo su un altro dispositivo. Per ulteriori dettagli consultare
la sezione Crittografia della scheda di memoria.

Awvio sicuro: consente di proteggere il proprio dispositivo con un blocco
allaccensione. Per ulteriori dettagli, consultare la sezione Impostazioni di
awio sicuro.

Protezione delle credenziali: consente di visualizzare il tipo di memoria
su cui sara salvato il certificato di sicurezza.

- Credenziali di fiducia: visualizza i certificati CA root e i certificati CA
installati dall'utente del tuo sistema.

Credenziali dell'utente: visualizza e modifica le informazioni dei
certificati sicuri conservati sul tuo dispositivo.

- Installa dalla memoria:installare un certificato sicuro da un archivio.

Cancella archivio: cancella i certificati sicuri installati da utente e le
credenziali relative.

+ Impostazioni blocco SIM: consente di bloccare o sbloccare la scheda USIM
o di modificare la password (PIN).

Rendi visibili le password: attivare questa opzione per visualizzare
rapidamente ciascun carattere della password mentre si digita per vedere
cosa si sta immettendo.

- Amministratori dispositivo: consente privilegi per limitare il controllo o
[utilizzo del dispositivo a determinate app.
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« Trust agents: consente di visualizzare e utilizzare agenti attendibili installati
sul dispositivo.

+ Puntina schermo: consente di fissare la schermata dellapp in modo che sia
possibile utilizzare soltanto lapp attiva al momento.

+ Accesso all'utilizzo: consente di visualizzare i dettagli sull'utilizzo delle app
sul dispositivo.

Estensioni

Smart Doctor

E possibile utilizzare Smart Doctor per esequire una diagnosi dello stato del
dispositivo e ottimizzarlo.

Nella schermata delle impostazioni, toccare Estensioni > Smart Doctor.

Gaming
E possibile configurare le impostazioni di gioco per gli strumenti, la grafica e il
risparmio energetico.

T Nella schermata delle impostazioni, toccare Estensioni > Gaming.
7 Personalizzare le seguenti impostazioni:
- Launcher Del Gioco: Toccare QD) per usare la funzione Launcher Del Gioco.

- Strumenti di gioco: E possibile eseguire la funzione durante il gioco
toccando l'icona degli strumenti di gioco tra i pulsanti a sfioramento anteriori.

- Grafica di gioco: Regola la grafica di gioco.
E « Se si modifica la risoluzione video di alcuni giochi, le funzioni di visualizzazione dello
schermo potrebbero non funzionare correttamente.

+ Questa funzione potrebbe non essere disponibile per alcune app di gioco.

+ Tempo di pausa: Riduce la luminosita dello schermo e e prestazioni, ogni
volta che si abbandona il gioco per piti di 5 minuti.
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Dual App

E possibile installare app di messaqgistica duplicate nel prodotto e utilizzare due

account contemporaneamente.

T Nella schermata delle impostazioni, toccare Estensioni > Dual App.

2 Dopo aver letto la dichiarazione di non responsabilita, toccare Conferma.

3 Nell'elenco delle app disponibili, toccare Installa per installare una copia dellapp
desiderata e sequire le istruzioni visualizzate sullo schermo.

+ Sullo schermo viene visualizzato lelenco delle app duplicate disponibili.
Durante linstallazione, sulla schermata Home vengono generate le icone
delle app.

Collegamenti
E possibile utilizzare pulsanti quali accensione/blocco, volume e Assistente Google
per esequire direttamente determinate app o funzioni.

71 Nella schermata delle impostazioni, toccare Estensioni > Collegamenti.

7 Personalizzare le seguenti impostazioni.

+ Visualizza il pannello di notifica: scorri in alto/in basso il sensore delle
impronte digitali per il pannello delle notifiche.

+ Apri Fotocamera: Premere il tasto di accensione due volte per awviare la
Fotocamera.

« Apri Capture+: Quando lo schermo e bloccato o spento, premere due volte il
tasto volume su (+) per awiare Capture+.

+ Apri Fotocamera: Quando lo schermo e bloccato o spento, premere due
volte il tasto volume gili (-) per avviare Fotocamera.

- Apri Assistente Google: Premere il tasto Assistente Google sul lato del
telefono.

« Parla con Assistente Google: Tenere premuto il tasto Assistente Google
per parlare rapidamente con [Assistente.

+ Mostra l'istantanea visiva: Premere due volte il tasto Assistente Google
per vedere unistantanea della giornata nellapp Assistente Google.

E « Assistente Google non supporta alcune lingue.
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Toc Toc
Esequire un doppio tocco sullo schermo per spegnerlo o accenderlo.
Per ulteriori dettagli, consultare la sezione Toc Toc.

Benessere digitale e Controllo
genitori

E possibile visualizzare il tempo di utilizzo del prodotto e impostare il timer per
ciascuna app. E possibile inoltre gestire il tempo di utilizzo del telefono cellulare
utilizzando la modalita di preparazione al sonno e la modalita di messa a fuoco.

Nella schermata delle impostazioni, selezionare Benessere digitale e Controllo
genitori e impostare la funzione desiderata.

App & notifiche

E possibile controllare lelenco delle app installate e configurare le impostazioni per
notifiche, autorizzazioni delle app e altro ancora.

1 Nella schermata delle impostazioni, toccare App & notifiche.

2 Personalizzare le impostazioni.

Batteria

E possibile visualizzare le informazioni sulla batteria corrente o attivare la modalita
risparmio energetico.

T Nella schermata delle impostazioni, toccare Batteria.

7 Personalizzare le seguenti impostazioni:

- Utilizzo della batteria: consente di visualizzare i dettagli sull'utilizzo della
batteria.

+ Percentuale della batteria sulla barra di stato: consente di visualizzare il
livello della batteria residua come percentuale sulla barra di stato.

- Batteria adattativa: consente di risparmiare |a batteria impedendo
lesecuzione in background delle app.
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- Limitazione sfondo: abilitare questa opzione per limitare le app in
background e risparmiare la batteria durante ['uso del dispositivo. Le app
con limitazioni per il risparmio energetico potrebbero non funzionare
correttamente o potrebbero non inviare notifiche.

- Risparmio energetico: consente di ridurre il consumo della batteria

riducendo alcune impostazioni del dispositivo, come la luminosita del display,
la velocita e lintensita della vibrazione.

Eccezioni del risparmio energetico: Seleziona le app che vengono
utilizzare senza alcuna restrizione in modalita di risparmio energetico o di
ottimizzazione della batteria.

Archiviazione

E possibile visualizzare e gestire la memoria interna sul dispositivo o lo spazio di
archiviazione della scheda di memoria.

T Nella schermata delle impostazioni, toccare Archiviazione.

7 Personalizzare le seguenti impostazioni:

« Archivio interno: consente di visualizzare lo spazio di archiviazione totale
e lo spazio libero nella memoria interna del dispositivo. Visualizza un elenco
delle app in uso e la capacita di archiviazione di ciascuna app.

+ Scheda SD: consente di visualizzare lo spazio di archiviazione totale e lo
spazio libero nella scheda di memoria. Questa opzione compare soltanto
quando viene inserita una scheda di memoria. Per disattivare la scheda di
memoria, toccare

Account

E possibile aggiungere utenti con i quali condividere e registrare un account cloud.
71 Nella schermata delle impostazioni, toccare Account.

2 Personalizzare le impostazioni.
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Google

E possibile utilizzare le impostazioni di Google per gestire le proprie app e le
impostazioni dell'account di Google.

Nella schermata delle impostazioni, toccare Google.

Sistema

Centro aggiornamenti

Puoi controllare e installare la versione pili recente dell'app o del software fornito
alG

1 Nella schermata delle impostazioni, toccare Sistema > Centro aggiornamenti.

7 Personalizzare le sequenti impostazioni:
- Aggiornamento applicazione: controlla se e disponibile un aggiornamento.
Se disponibile, puoi installare 'aggiornamento.

- Aggiornamento software: controlla se e disponibile un aggiornamento
software. Se disponibile, puoi installare ['aggiornamento.

Lingua e tastiera
E possibile personalizzare le impostazioni di lingua e tastiera del dispositivo.
T Nella schermata delle impostazioni, toccare Sistema > Lingua e tastiera.
7 Personalizzare le seguenti impostazioni:
« Lingua: consente di selezionare una lingua da applicare al dispositivo.

- Gestisci tastiere: £ possibile modificare le impostazioni di base della tastiera
del prodotto, impostare gli ambienti di utilizzo per la tastiera LG o altre
tastiere installate e impostare la funzione di riconoscimento vocale per i
comandi con Google Voice. E possibile inoltre impostare se visualizzare il
pulsante della tastiera nell'area dei pulsanti a sfioramento della schermata
Home, in modo da poter passare rapidamente a un‘altra tastiera.

- Tastiera fisica: selezionare per usare |a tastiera fisica, o controllare i tasti dei
collegamenti da tastiera.
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+ Servizio Compilazione automatica: azionare questa opzione per inserire le
informazioni salvate nel proprio account come password, indirizzo, o numero
di carta di credito con un singolo tocco. Puoi anche disattivare questa
opzione, usare Google Autocomplete, o aggiungere un nuovo account di
servizio.

« Lettura text-to-speech: consente di configurare le impostazioni delloutput
sintesi vocale.

Velocita del puntatore: consente di regolare la velocita del puntatore di un
mouse o trackpad.

Inverti i pulsanti del mouse: consente di invertire il pulsante destro del
mouse in modo che esegua le principali azioni di manipolazione diretta.

Data e ora
E possibile personalizzare le impostazioni di data e ora del dispositivo.
T Nella schermata delle impostazioni, toccare Sistema > Data e ora.

) Personalizzare le impostazioni.

Memoria

Consente di visualizzare la quantita media di utilizzo della memoria in un
determinato periodo di tempo e la memoria occupata da unapp.

1 Nella schermata delle impostazioni, toccare Sistema > Memoria.

2 Toccare w per impostare una fascia oraria per il recupero dei dati.

Backup

E possibile esequire il backup dei dati salvati sul dispositivo su un altro dispositivo o
account.

71 Nella schermata delle impostazioni, toccare Sistema > Backup.

7 Personalizzare le sequenti impostazioni:

+ LG Mobile Switch: consente di trasferire i dati da un vecchio dispositivo LG a
quello nuovo. Per ulteriori dettagli, consultare la sezione LG Mobile Switch.
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+ Backup e ripristino: consente di eseguire il backup dei dati del dispositivo o
ripristinare i dati di un backup nel dispositivo.

A « |lripristino del dispositivo potrebbe eliminare i file di backup salvati nellarchivio.
Assicurarsi di copiare e salvare i file di backup importanti nel proprio PC.

- Google Backup: modifica le impostazioni di backup di Google. E possibile
anche controllare 'account di backup attualmente usato, o aggiungere un
nuovo account di backup.

Riavvio & Ripristino
E possibile ripristinare il dispositivo, includendo le impostazioni di rete e app.
71 Nella schermata delle impostazioni, toccare Sistema > Riavvio & Ripristino.

7 Personalizzare le sequenti impostazioni:

+ Riavvio automatico: Riawvia e ottimizza automaticamente il telefono all'ora
impostata. Toccare QD) per attivare la funzione. Il dispositivo si riawia
automaticamente all'ora impostata e si ottimizza. Seleziona la data e l'ora
del riawvio.

E « Puoiimpostare il dispositivo affinché si riawii una volta la settimana. Il dispositivo
si riavvia automaticamente entro un'ora dall'ora impostata.

Una volta che il dispositivo si riawia, le notifiche e i badge sono cancellati. Salvare i
dati importanti prima dell'ora preimpostata.

+ La funzionalita di riavvio automatico non e attivata nelle seguenti situazioni.
Quando lo schermo ¢ acceso, quando il dispositivo & in uso, quando il livello della
batteria & il 30% o meno, quando la scheda USIM é bloccata, o quando il blocco del
dispositivo e attivo durante ['accensione del dispositivo.

- Aseconda del fornitore del servizio di telecomunicazione, la funzione di riawio
automatico potrebbe non essere disponibile.

Ripristino delle impostazioni della rete: consente di ripristinare Wi-Fi,
Bluetooth e altre impostazioni di rete.

Ripristina preferenze applicazione: ripristina le impostazioni dio un'app. |
dati salvati nell'app non saranno cancellati.
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- Ripristino dati di fabbrica: consente di ripristinare tutte le impostazioni del
dispositivo ed eliminare i dati.

E « |lripristino e il riavvio del dispositivo elimina tutti i dati presenti sullo stesso. Inserire
nuovamente il nome del dispositivo, laccount Google e altre informazioni iniziali.

« Dopo linizializzazione dei dati, i dati non possono piti essere recuperati.

Info sul telefono

E possibile visualizzare informazioni sul dispositivo, come nome, stato, dettagli
software e informazioni legali.

Nella schermata delle impostazioni, toccare Sistema > Info sul telefono e
visualizzare le informazioni.

Normative & Sicurezza

E possibile visualizzare i certificati normativi e le relative informazioni sul proprio
dispositivo.

Nella schermata delle impostazioni, toccare Sistema > Normative & Sicurezza.

Accesso facilitato

E possibile gestire i plugin di accessibilita installati sul dispositivo.
T Nella schermata delle impostazioni, toccare Accessibilita.

7 Personalizzare le seguenti impostazioni:

Visione > TalkBack: consente di impostare il dispositivo in modo da
notificare lo stato dello schermo o le azioni tramite voce.

Visione > Notifiche vocali:impostare sul dispositivo la lettura delle
informazioni del chiamante tramite voce.

Visione > Carattere: modificare dimensione, grassetto, o facciata.

- Visione > Dimensioni display: consente di impostare gli elementi presenti
sullo schermo su dimensioni facilmente visibili per l'utente. Alcuni elementi
potrebbero cambiare posizione.

- Visione > Zoom touch: consente di eseguire o zoom avanti o indietro
toccando lo schermo tre volte.

Impostazioni 126



Visione > Zoom della finestra: consente di eseguire lo zoom avanti o
indietro allinterno di una finestra e invertire il colore.

Visione > Puntatore del mouse grande: consente di ingrandire il puntatore
del mouse.

Visione > Schermo ad alto contrasto: consente di modificare il colore di
sfondo in nero per uno schermo ad alto contrasto.

Visione > Inversione del colore dello schermo: consente di aumentare il
contrasto del colore del display per le persone ipovedenti.

Visione > Regolazione del colore dello schermo: consente di regolare il
colore del display.

Visione > Monocromatico: consente di far passare lo schermo alla modalita
scala di grigi.

Visione >Termina le chiamate con il tasto di accensione: consente di
terminare una chiamata premendo il tasto di accensione/blocco.

Udito > Didascalia: consente di attivare il servizio dei sottotitoli durante la
riproduzione di video per non udenti.

Udito > Flash allarme: consente di impostare il dispositivo in modo da
notificare all'utente le chiamate in arrivo, i messaggi e le sveglie con una luce
lampeggiante.

Udito > Disattiva tutti i suoni: consente di disattivare tutti i suoni e
abbassare il volume sul ricevitore.

Udito > Canale audio: consente di selezionare il tipo di audio.

Udito > Bilanciamento del suono: consente di regolare il bilanciamento
dell'uscita audio. Consente di utilizzare la barra di scorrimento per modificare
il bilanciamento.

Movimento & cognizione > Touch assistant: consente di attivare il pannello
touch per facilitare lutilizzo di pulsanti e gesti.

Movimento & cognizione > Input tattile: consente di immettere il testo
toccando e tenendo premuto lo schermo, o di modificarlo semplicemente
toccando lo schermo.

Movimento & cognizione > Tastiera fisica: consente di personalizzare le
impostazioni della tastiera.

Movimento & cognizione > Click automatico del mouse: consente di
cliccare il puntatore del mouse automaticamente in caso di assenza di
movimento.
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+ Movimento & cognizione > Tocca e tieni premuto per le chiamate:
consente di rispondere o rifiutare le chiamate toccando e tenendo premuto il
pulsante di chiamata, invece di trascinarlo.

+ Movimento & cognizione > Timeout schermo: consente di disattivare
automaticamente lo schermo quando il dispositivo viene lasciato inattivo per
un determinato periodo di tempo.

+ Movimento & cognizione > Aree di controllo tattile: consente di limitare
l'area touch in modo che soltanto una determinata porzione dello schermo
possa essere controllata dall'inserimento touch.

- Collegamento alle funzioni di accessibilita: consente di accedere
rapidamente a una funzione utilizzata di frequente toccando O tre volte.

- Rotazione automatica: consente di cambiare automaticamente
lorientamento dello schermo a seconda della posizione fisica del dispositivo.

Seleziona per ascoltare: consente di toccare gli elementi e ricevere una
risposta vocale.

+ Switch Access: consente di creare combinazioni di tasti per controllare il
dispositivo.
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Impostazioni della lingua

E possibile selezionare una lingua da utilizare sul dispositivo.
- Toccare > Impostazioni > Sistema > Lingua e tastiera> Lingua > Aggiungi
lingua, quindi selezionare una lingua.
- Toccare e tenere premuta = quindi trascinarla in cima allelenco delle lingue
per impostarla come lingua predefinita.

LG Bridge

Informazioni generali su LG Bridge

LG Bridge e unapp che aiuta a gestire comodamente dal proprio computer le foto,
la musica, i video e i documenti salvati sullo smartphone LG. E possibile eseguire

il backup dei contatti, delle foto e di altri elementi sul computer o aggiornare il
software del dispositivo.

E « Peridettagli vedere la guida di LG Bridge.
« Le funzioni supportate possono variare a seconda del dispositivo.

« Il driver USB LG e un programma necessario per connettere o smartphone LG con
il computer e viene installato quando si installa LG Bridge.

Funzioni di LG Bridge

- Consente di gestire i file presenti sul dispositivo da un computer tramite una
connessione Wi-Fi o una connessione dati mobile.

+ Consente di esequire il backup dei dati dal dispositivo a un computer o
ripristinare i dati da un computer al dispositivo tramite un collegamento con
cavo USB.

- Consente di aggiornare il software del dispositivo da un computer tramite un
collegamento con cavo USB.
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Installazione di LG Bridge su un computer
1 Andare sul sito wwwlg.com dal proprio computer.

7 Selezionare la regione.

3 Fare clic su Supporto > Software e firmware.

4

Immettere il nome del dispositivo.
OPPURE
Selezionare Categoria prodotto.

5 Andare a Sync PC > LG Bridge per scaricare il file di installazione.

+ Andare su Dettagli per visualizzare i requisiti minimi per l'installazione di LG
Bridge.

Aggiornamento software del telefono

Aggiornamento software del telefono LG Mobile da

Internet

Per ulteriori informazioni sull'utilizzo di questa funzione, visitare
http//wwwi.lg.com/common/index,sp, selezionare il paese e la lingua.

Questa funzione consente di aggiornare facilmente il firmware del telefono a
una versione pitl recente da Internet senza la necessita di visitare un centro

di assistenza. Questa funzione sara disponibile solo se e quando LG mette a
disposizione una nuova versione del firmware per il dispositivo.

Poiché laggiornamento del firmware del telefono cellulare richiede la massima
attenzione da parte dell'utente per tutta la durata del processo di aggiornamento,
assicurarsi di controllare tutte le istruzioni e le note visualizzate a ogni passaggio
prima di procedere. Si prega di notare che la rimozione del cavo USB durante
laggiornamento puo danneggiare gravemente il telefono cellulare.

E « LGsiriserva il diritto di rendere disponibili aggiornamenti del firmware
esclusivamente per modelli selezionati a propria discrezione e non garantisce la
disponibilita della versione piti recente del firmware per tutti i modelli di cellulari.
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Aggiornamento software del telefono LG Mobile
tramite Over-the-Air (OTA)

Questa funzione consente di aggiornare facilmente il software del telefono a una

nuova versione tramite OTA, senza collegamento di un cavo USB. Questa funzione
sara disponibile solo se e quando LG mette a disposizione una nuova versione del

firmware per il dispositivo.

Per eseguire [aggiornamento del software del telefono,

Impostazioni > Sistema > Centro aggiornamenti > Aggiornamento software >
Controlla aggiornamenti.

E « | dati personali dell'utente presenti sulla memoria interna del telefono, ivi comprese
le informazioni relative allaccount Google e qualsiasi altro account, i dati e le
impostazioni di sistema/applicazioni, le app scaricate e la licenza DRM potrebbero
andare perduti nel processo di aggiornamento del software del telefono. Pertanto,
LG consiglia di eseguire il backup dei dati personali prima di aggiornare il software
del telefono. LG non si assume alcuna responsabilita per eventuali perdite di dati
personali.

+ Questa funzione dipende dallarea e dal provider del servizio.
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Guida antifurto

Configurare il dispositivo per impedire ad altre persone di utilizzarlo se é stato
ripristinato alle impostazioni di fabbrica senza permesso. Ad esempio, in caso
di smarrimento, furto o cancellazione dei dati del dispositivo, solo qualcuno in
possesso delle informazioni sullaccount Google o delle informazioni sul blocco
schermo puo utilizzare il dispositivo.

Per assicurarsi che il dispositivo sia protetto e sufficiente:

+ Impostare un blocco schermo: Se il dispositivo viene smarrito o rubato, ma
si dispone di un blocco schermo, il dispositivo non puo essere cancellato

utilizzando il menu Impostazioni a meno che lo schermo non venga sbloccato.

Aggiungere il proprio account Google sul dispositivo: Se il dispositivo viene
cancellato, ma e presente un account Google su di esso, il dispositivo non
puo terminare il processo di configurazione fino a quando le informazioni
dellaccount Google non vengono nuovamente inserite.

Dopo aver protetto il dispositivo, & necessario sbloccare lo schermo o immettere la
password dellaccount Google, se & necessario effettuare un ripristino di fabbrica.

Questo fa si che il ripristino venga effettuato da una persona di fiducia.

E + Non dimenticare account Google e la password aggiunti al dispositivo prima
di eseguire un ripristino di fabbrica. Se non & possibile fornire le informazioni

sullaccount durante il processo di configurazione, non sara possibile utilizzare il

dispositivo dopo aver esequito il ripristino di fabbrica
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Informazioni avviso software Open
Source

Per ottenere il codice sorgente contenuto in questo prodotto secondo quanto
consentito dalle licenze GPL, LGPL, MPL e altre licenze Open Source, visitare
http://opensource.lge.com.

In aggiunta al codice sorgente, sono disponibili per il download tutti i termini di
licenza, le esclusioni di responsabilita e e relative note di copyright.

LG Electronics fornira anche il codice open source su CD-ROM su richiesta tramite
e-malil all'indirizzo opensource@I|ge.com addebitando il costo delle spese di
distribuzione (ad esempio il costo di supporti, spedizione e gestione).

Lofferta e valida per un periodo di tre anni a partire dalla nostra ultima spedizione
di questo prodotto. Lofferta e valida per gli utenti che avranno ricevuto queste
informazioni.

Informazioni sulle normative
(Numero ID normativa, etichetta
digitale ecc.)

Per informazioni sulle normative, andare in Impostazioni > Sistema > Normative
& Sicurezza.
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Marchi di fabbrica

« Peribrevetti DTS, vedere http//patents.dts.com. Prodotto sotto licenza da DTS
Licensing Limited. DTS, il relativo simbolo e DTS e il simbolo insieme, DTSX e il
logo DTSX sono marchi commerciali o marchi commerciali registrati di DTS, Inc.
negli Stati Uniti e/o in altri Paesi. © DTS, Inc. Tutti i diritti riservati.

+ Copyright ©2020 LG Electronics Inc. Tutti i diritti riservati. LG e il logo LG sono
marchi registrati del Gruppo LG e delle sue entita correlate.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android,
Chrome, Google Photos, Google Play Protect, Google Calendar, Google Docs,
Google Drive, Google Sheets e altri marchi e logo correlati sono marchi di Google
LLC.

- Bluetooth® & un marchio registrato di Bluetooth SIG, Inc. nel mondo.
- Wi-Fi® e il logo Wi-Fi sono marchi registrati di Wi-Fi Alliance.
« Tutti gli altri marchi sono di proprieta dei rispettivi titolari.

HE HEVC \dvance”

Covered by Patents at patentlisthevcadvance.com
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Dichiarazione sulla sicurezza del laser

Attenzione!

Questo prodotto utilizza un sistema laser. Per garantirne un utilizzo corretto,
leggere attentamente il presente manuale dell'utente e conservarlo come
riferimento per il futuro. Se 'unita richiede manutenzione, contattare un centro di
assistenza autorizzato.

Lutilizzo di controlli e regolazioni o lesecuzione di procedure diverse da quelle
specificate puo provocare lesposizione a radiazioni pericolose.

Per evitare lesposizione diretta al fascio laser, non tentare di aprire l'involucro o
entrare in contatto diretto con il laser.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER

DICHIARAZIONE DI CONFORMITA

Con il presente documento, LG Electronics dichiara che il prodotto
LM-K510EMW e conforme ai requisiti essenziali e alle altre disposizioni della
Direttiva 2014/53/EU.

Una copia della Dichiarazione di conformita e disponibile allindirizzo
http7//wwwi.lg.com/global/declaration

Contattare 'ufficio relativo alla
conformita del prodotto

LG Electronics European Shared Service Center BV.
Krijgsman 1, 1186 DM Amstelveen, The Netherlands
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Ulteriori informazioni

Parti in vetro temperato

Le parti in vetro temperato di questo dispositivo non sono permanenti e possono
usurarsi col passare del tempo.

+ Se silascia cadere il dispositivo su una superficie dura o lo si espone a un urto
violento, il vetro temperato potrebbe danneggiarsi.

In questi casi, interrompere immediatamente 'uso del dispositivo e contattare
un Centro di assistenza clienti LG.

+ Sul mercato sono disponibili apposite custodie per proteggere il dispositivo da
eventuali danni.

Tenere presente che tali custodie protettive non sono coperte dal servizio di
garanzia fornito da LG Electronics e non ne viene garantita la sicurezza.

Proporzioni
Alcune app scaricate potrebbero non supportare alcune proporzioni.

In tal caso, selezionare le proporzioni dello schermo pili adatte allapp o consultare il
provider dellapp per ulteriori informazioni.

CUSTOMER CARE

c 199600044

Per conoscere gli orari di apertura e i relativi costi ti invitiamo a visitare il sito di LG
Italia wwwlg.com/it
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Guida al trasferimento dati

+ Per i dati trasferibili tra dispositivi LG e tra un dispositivo LG e un dispositivo di
parti terze, vedere lo schema seguente.

Dispositivo lz\':z:;:;“;? Dispositivo
LG - i0S
parti terze
Tipo Dettagli dell'elemento — N —
DISpféItIVO Dispositivo Dlspféltlvo
LG
Contatti, messaggi, registri
chiamate, calendario, 6] 0 0
Dati registrazioni audio
i
personat Promemoria X 0
Sveglie
Datll - Foto, \Adeg canzoni, 0 0 0
multimediali | documenti
Impostazioni della schermata
) 0 X X
home (cartelle e widget)
dischermo Impostazioni della schermata
di blocco (impostazioni di 0 X X
blocco schermo escluse)
App scaricate 0 0
Applicazioni | Dzt personali contenuti nelle 0 X -
app scaricate
Certificato pubblico 0 0 X
Altri Impostazioni (Wi-Fi,
Bluetooth, chiamate, suoni
o AN 0 X X
e notifiche, accessibilita,
batteria)
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E « Alcune dati potrebbero non essere trasmessi a seconda della versione del
software, della versione delle app, del sistema operativo, e delle politiche del
produttore del dispositivo o del gestore del servizio.

Bande di frequenza supportate Potenza in uscita trasmettitore

GSM 900 34.0dBm
GSM 1800 31.0dBm
WCDMA B1 250dBm
WCDMA B8 250dBm

LTEB1 250dBm
LTEB3 250dBm
LTEB7 24.0dBm
LTEB8 250dBm
LTEB20 250dBm
LTEB28 250dBm
LTEB38 24.0dBm
BT 2.4GHz 9.5dBm
WLAN 2.4GHz 19.0 dBm

NFC -33dBuA/m

Le informazioni sulladattatore da viaggio si possono trovare su
http7/wwwi.lg.com/global/support/cedoc/cedoc
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Smaltimento delle apparecchiature obsolete

1. Tutte le apparecchiature elettriche ed elettroniche, contrassegnate da
questo simbolo ("bidone della spazzatura barrato da una croce”), devono
essere raccolte e smaltite separatamente rispetto agli altri rifiuti urbani
misti mediante impianti di raccolta specifici installati da enti pubblici o dalle

I autorita locali. Si ricorda che gli utenti finali domestici possono consegnare
gratuitamente le apparecchiature elettriche ed elettroniche a fine vita presso
il punto vendita all‘atto dellacquisto di una nuova apparecchiatura equivalente.
Gli utenti finali domestici possono inoltre consegnare gratuitamente
apparecchiature elettriche ed elettroniche di piccolissime dimensioni (non
eccedentii 25 cm) a fine vita direttamente presso un punto vendita a cio
abilitato, senza obbligo di acquistare una apparecchiatura nuova di tipo
equivalente. Si prega di informarsi previamente presso il punto vendita
prescelto circa tale ultima modalita di conferimento dellapparecchiatura a fine
vita.

2.1l corretto smaltimento dell'unita obsoleta contribuisce a prevenire possibili
conseguenze negative sulla salute degli individui e sullambiente. Una gestione
responsabile del fine vita delle apparecchiature elettriche ed elettroniche
da parte degli utenti contribuisce al riutilizzo, al riciclaggio ed al recupero
sostenibile dei prodotti obsoleti e dei relativi materiali.

3. Per informazioni piti dettagliate sullo smaltimento delle apparecchiature
obsolete, contattare ['ufficio del comune di residenza, il servizio di
smaltimento rifiuti o il punto vendita in cui & stato acquistato il prodotto.
(www.lg.com/global/recycling)

Smaltimento delle batterie/accumulatori

1. Questo simbolo potrebbe essere associato ai simboli chimici del mercurio (Hg),
cadmio (Cd) o piombo (Pb) se la batteria contiene piti di 0,0005% di mercurio,
0,002% di cadmio 0 0,004% di piombo.

2. Tutte le batterie e gli accumulatori devono essere smaltiti separatamente
rispetto alla raccolta differenziata municipale, mediante impianti di raccolta
specifici designati dal governo o dalle autorita locali.

3.l corretto smaltimento di batterie e accumulatori obsoleti contribuisce a
prevenire possibili conseguenze negative sullambiente, sulla salute degli
individui e su tutte le altre specie viventi.

4. Per informazioni piti dettagliate sullo smaltimento di batterie e accumulatori
obsoleti, contattare ['ufficio del comune di residenza, il servizio di smaltimento
rifiuti o il negozio in cui & stato acquistato il prodotto.
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FAQ

In questo capitolo sono descritti alcuni problemi che potrebbero verificarsi durante
l'uso del dispositivo. Alcuni problemi richiedono una chiamata al provider del
servizio, ma la maggior parte e facilmente risolvibile in autonomia.

Surriscaldamento dispositivo

Il dispositivo si surriscalda quando & usato.

Nei casi sequenti, il consumo della batteria aumenta e il dispositivo potrebbe
surriscaldarsi:

+ Quando si accende il dispositivo per la prima volta o si eseqgue il back up dei dati
+ Quando sono esequite pill app contemporaneamente
- Quando piti app sono eseguite in background

- Quando si scaricano file di grandi dimensioni durante una video chiamata o la
registrazione di un video

+ Quando si usano funzionalita che richiedono molta potenza

- Quando si guarda uno streaming video su internet, o si registra un video di
grande durata

- Quando si gioca a giochi dai requisiti elevati per molto tempo

- Quando si usa il dispositivo con a luminosita dello schermo al massimo per
molto tempo

- Quando si usano molti dati mobili
- Quando si usano hotspot Wi-Fi o tethering
- Quando si sincronizzano i dati per pili account contemporaneamente
+ Altri casi
- Quando si eseque il roaming oltremare
- Quando si usa il dispositivo in aree con segnali deboli 0 assenza di ricezione

- Quando si ricarica il dispositivo con la porta del cavo USB/caricatore
danneggiati o contaminati da sostanze esterne.

E « Alcuni dei casi indicati potrebbero non applicarsi a seconda di funzionalita e app.
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Il dispositivo si surriscalda quando viene ricaricato.

« Ildispositivo e il caricatore potrebbero riscaldarsi durante il caricamento. Durante
il caricamento wireless o veloce, il dispositivo potrebbe riscaldarsi ancora di piti.
Se la temperatura della batteria si alza al di sopra di un certo livello, il dispositivo
potrebbe smettere di ricaricarsi.

- Disconnettere il caricatore dal dispositivo e chiudere tutte le app in
esecuzione. Lasciare raffreddare il dispositivo prima di caricare il dispositivo o
eseguire nuovamente una app.

- Arrestare il caricamento se la porta del cavo USB/caricatore nella parte
inferiore del dispositivo si surriscalda, e visitare il Centro di assistenza ai clienti
LG piti vicino.

Come risolvere il surriscaldamento del dispositivo.

Chiudere tutte le app o funzionalita in esecuzione e lasciare raffreddare il
dispositivo.

Aggiornare sempre il software alla versione pili recente.

Disattivare la funzione Bluetooth, Wi-Fi o GPS quando non le si utilizza.

Chiudere le app non utilizzate.

Quando si usa il dispositivo con la luminosita dello schermo al massimo, ridurre
la luminosita.

Se il dispositivo si surriscalda per un periodo prolungato, interromperne ['uso
per qualche tempo. Se il dispositivo continua a surriscaldarsi, visitare il Centro di
assistenza ai clienti LG.

Limitare l'uso quando il dispositivo si surriscalda.
Se il dispositivo si surriscalda quando viene usato o ricaricato, alcune funzionalita,
app, o persino il dispositivo potrebbero spegnersi.
Si tratta di una normale operazioni per i dispositivi che supportano questa
funzionalita.
+ Se latemperatura del dispositivo si alza al di sopra di un certo livello, appare un
messaggio di awiso.
- Quando si gioca a giochi con requisiti elevati, si registrano video, o si caricano
grossi file, il dispositivo potrebbe surriscaldarsi per un periodo prolungato.
In questo caso, un messaggio di awiso potrebbe apparire per awisare
dellarresto automatico.
Spegnere il dispositivo o chiudere tutte le app o funzionalita in esecuzione e
lasciare raffreddare il dispositivo.
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+ Laluminosita dello schermo e la velocita delle operazioni potrebbe essere
limitata per raffreddare il dispositivo. Tutte le app o funzionalita potrebbero
rallentare o arrestarsi. | dispositivo potrebbe interrompere la ricarica.

Errore scheda SIM

Assicurarsi che la scheda SIM sia inserita correttamente.

Nessuna connessione alla rete o connessione di rete interrotta
Il segnale & debole. Spostarsi verso una finestra o in uno spazio aperto.
Sei al di fuori dellarea coperta dal fornitore di rete. Spostati e controlla la rete.

Le chiamate non sono disponibili
Nuova rete non autorizzata.

Assicurati di non avere impostato il blocco chiamate dal numero che effettua la
chiamata.

Assicurati di non avere impostato il blocco chiamate dal numero che stai
chiamando.

Non é possibile accendere il dispositivo
Quando la batteria & completamente scarica, il tuo dispositivo non si accende.
Ricaricare completamente la batteria prima di accendere il dispositivo.

Errore di caricamento

Assicurarsi che il dispositivo sia in carica a una temperatura normale.
Controllare il caricabatteria e il suo collegamento al dispositivo.
Utilizzare solo gli accessori forniti autorizzati da LG.

La batteria si scarica piu rapidamente rispetto a quando &
stata acquistata

Esponendo il dispositivo o la batteria a temperatura molto alte o molto basse, la
durata della batteria potrebbe ridursi.

Il consumo della batteria aumenta quando si usano certe app o funzionalita, come
GPS, giochi o internet.

La batteria & usurabile e la sua durata si riduce nel corso del tempo.
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Messaggi d'errore vengono visualizzati quando si avvia la
fotocamera.

Ricaricare la batteria.

Liberare memoria trasferendo i file a un computer o cancellando i file dal proprio
dispositivo.

consente di riawviare il dispositivo.

Se i problemi con app della fotocamera persistono dopo avere tentato con questi
suggerimenti, contattare il centro di assistenza LG Electronics.

La qualita delle foto & bassa.

La qualita delle foto potrebbe variare, a seconda dellambiente e delle tecniche
fotografiche usate.

Quando si realizzano foto e video, la qualita angolare standard & migliora rispetto al
grandangolo.

Realizzando foto in posti bui, di notte o interni, potrebbero essere presenti disturbi
o le immagini potrebbero essere sfocate.

In caso di problemi, azzerare le opzioni.

Lo schermo tattile risponde lentamente o in modo non
corretto

Collegando una protezione per lo schermo o accessori opzionali allo schermo tattile,
potrebbe non funzionare correttamente.

Indossando guanti, se le mani non sono pulite quando si tocca lo schermo tattile o
si sfiora lo schermo usando oggetti affilati o le punte delle dita, lo schermo tattile
potrebbe non funzionare.

Lo schermo tattile potrebbe non funzionare correttamente in condizioni di umidita
0 quando & esposto allacqua.

Riawviare lapparecchio per annullare eventuali bug del software.

Se lo schermo tattile e graffiato o danneggiato, visitare un centro di assistenza LG
Electronics.
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Chiude la chiamata o si blocca

Riavviare il dispositivo.
« Se il dispositivo si chiude la chiamata o si blocca, potrebbe essere necessario
chiudere le applicazioni o spegnere del tutto il dispositivo e riaccenderlo.

Eseguire un riavvio
- E possibile utilizzare un ripristino superficiale del dispositivo se lo schermo
si blocca oppure se i pulsanti, lo schermo a sfioramento o il dispositivo non
rispondono pill in modo corretto.
+ Per esequire un ripristino superficiale del dispositivo, tenere premuti i tasti
Volume giti e Power fino a quando il dispositivo non si riavvia.

Azzerare il dispositivo
+ Seimetodiillustrati sopra non risolvono il problema, esequire un ripristino dati
di fabbrica.
+ Nella schermata delle impostazioni, toccare Sistema > Riavvio & Ripristino >
Ripristino dati di fabbrica.
- Questo metodo consente di ripristinare tutte le impostazioni del dispositivo
ed eliminare i dati. Prima di esequire il ripristino dei dati di fabbrica, effettuare
copie di backup di tutti i dati importanti salvati nel dispositivo.

- Seil dispositivo & associato a un account Google, effettuare laccesso allo
stesso account Google dopo il ripristino.
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L'apparecchio Bluetooth non € localizzato
Assicurarsi che la funzionalita wireless Bluetooth sia attivata sul dispositivo.

Assicurarsi che la funzionalita wireless Bluetooth sia attivata sul dispositivo a cui
vuoi connetterti.

Assicurarsi che il dispositivo e altri dispositivi Bluetooth siano nellarea massima del
Bluetooth (10 m)

Se i suggerimenti indicati non ti hanno aiutato a risolvere il problema, contatta un
centro di assistenza LG Electronics.

Quando colleghi il tuo apparecchio a un computer, non viene
stabilita una connessione.
Assicurarsi che il cavo USB che stai usando sia compatibile con il tuo apparecchio.

Assicurarsi che sul proprio computer siano installati e aggiornati i driver nella
versione corretta.

Un'applicazione scaricata sta causando molti errori.
L'applicazione presenta dei problemi.
Rimuovere e reinstallare applicazione.
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EAAHNIKA
MAnpo@opieg OXETIKA UE AUTO TO

gyxepidio xpnong

Yag euxaploToUpE Tou eMAEEaTE AUTO To TTPOIOV LG. Nal Tnv ao@ali Kat owoTn
XPrion TG CUOKEUNG, TAPAKAAEIOTE va SIaBACETE MPOTEKTIKA AUTO TO EYXELPISI0
TIPWV XPNOIHOTOIOETE TN CUCKEUH yla TIPWTN QOPA.

- Na xpnotpomoleite mavtote yvriola agecoudp LG. Ta mapexopeva e§apTripata
TipoopiCoval AmOKAEIOTIKA YIal XPrioN HE AUTHY TNV GUOKEUN Kal EVOEXETaL va
unv eivat oupBatd pe AMNEG CUOKEUEC,

« Otmeplypagéc Bacifovtal oTig MpoemAeYUEVEG PUBIOELS TNG OUOKEUNG.

OL TIPOEYKATECTNHEVES EPAPLIOYEG 0T GUOKEUK UTIOKEIVTAL OE EVNUEPWOELG,
Kal 1 TTapoxT| UMOOTAPIENG VIO AUTEC TIC EQAPHOYES EVOEKETAL VA SLOKOTTE
Xwpi¢ mpoeidomoinon. Ev éxeTe EpWTHOELC OXETIKA LIE L0l EQAPLOYI TIOU
TIAPEXETAL LIE Tr) OUOKEUN), EMKOWVWVAOTE PE éva KEvTpo emokeuwv TG LG.
TXETIKA HE EQAPHOYE TIOU EXOUV EYKATAOTABEL A6 TOV XPHOTN, UMOPEITE Val
ETMIKOWWVIOETE PIE TOV APHOSIO TIAPOXO UTINPECIWV.

+ H tpomomoinon Tou A&lToupykoU GUGTAKATOC TNG CUOKEUNG 1 N EYKATAOTACN
MOyIopIKOU amo avemionpeg myég umopei va mpokahéoel BAABN oTn ouokeur
Kat va 0dnynoel o€ Kataotpo®n 1 anwAela Sedopévwvy. Tétolou gidoug
evépyelec anmoteholy mapaBiaon g adelag xpriong e LG Kat €xouv w¢
QmOTENEGHA TNV AKUPWON TG EYYUNONG 00G.

Kdmolo meplexOpeVo Kal EIKOVEC UMopE( va Sla@épouv oe axéon He TN
GUCKEUN 00C, avAAoya LE TNV TIEPLOKT, TOV TIAPOXO UTINPESIWY, TV €KSoon
TOU AOYIGUIKOU 1 TNV €KS00N TOU AEITOUPYIKOU CUOTAKATOC, KAl UMOpEi va
aMdG€ouv xwpic mpoeidomoinon.

+ To MoyIOUIKO, OL XOl, Ol TATETOAPIEC, Ol EIKOVES Kat BAAA Uéoa TTou TIapExovTal
padi pe Tn GUOKELN 0ag ouVOSEVOVTAL OO AGEL VIO TIEPIOPICUEVN XPriON.
Tuxdv e€aywyn Kat Xprion autwv Twv VMKWV Yia UTopIKoUG r AAOUG OKOTIOUG
evOEXETAL VO OLVIOTA TTAPABIcN TWV VOUWY TERT TIVEUMATIKWV SIKAUWUATWV.
Q¢ TENKOG XPAROTNG, EXETE TNV TP EUBUVN yia TUXOV TTAPAVON XPHoN TwV
HEOWV QUTWV.

EvSéyetat va umdpyouv mpAoBeTeS XpeWTELS yia TN peaieg SeSopévwy, OTwG
Yia TIC U peoieg avTaAayng INVURATWY, T @opTwon i T Mjwn Sedopévwy,
TOV QUTOHATO CUYXPOVIOUO Kal TIG UTinpeaieg TomoBeaiag. MNa va unv
€MBOPUVEDTE Ue MPOOBETEC XPEWTELC, EMAECTE éva TpOypappa dedopévwv
TI0U VOl KAAUTITEL TIG AVAYKEG GG, ETTIKOIVWVIOTE L TOV IAPOXO UTTNPECIWV 0O
Y10 TTEPIOOOTEPEC NETTTOUEPELEG,



- To mapdv eyxelpidio xpriong éxet ouvtayBei oTig BaoikéC Y\wWooeC yia KdBe
Xwpa. Avaloya pE T YAWooa TTou XPnOLHOTIOLEITAL, TO TIEPLEXOUEVO EVEEKETAL
va Slagoporoleital.

ZUUBOVAEUTIKEG AVAKOIVWOELG

MPOEIAONMOIHZH: KaTtaoTACEIS TIOU PITOPEL VOl TIPOKANEGOLV TPAUUATIONO
TOU XPAOTN KAl TPITWV.

A MPOXOXH: KATAOTAGEIG TOU UMOPE( VAl TTPOKAAETOUV ENAPPU TPAUUATIOHO 1)
{nWa ot CUOKELN.

5 THMEIQZH: avakovwoelG 1) TPOOOETEC TANPOPOPIEC.

MAnpo@opieg OXETIKA PE AUTO TO EYXELPISIO XPrIONG



Mivakag mePLEXOUEVWV

5

08nyieg yla ao®alr Kal amoTEAEGHATIKA Xprion

)

Eid1kég AerToupyieg

15 XapaktnploTikd kapepag

18 Aertoupyieg TG EQapHOYAS
Ahumoup

21 TModtnTa Kal EMMTWOELG Tou f)ou
XOPAKTNPLOTIKA

21 Google Assistant

23 Avayvipion SaKTuNKQOV
QAMOTUMWUATWY

27 Neoupyia mohudiepyaciag

02

Baoikég Aettoupyieg

29 E€aptripara kat aecoudp Tou
TIPOIOVTOG
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EPAPHOYWV

69  Zxoumidia epappoy
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71 TnAégwvo

75 MAvupa

76 Kapepa

86 Alumoup

90 Emagég

92 QuickMemo+

94 Polot

96 Movuoaikn



97 ApBuopnyaviy

97  ThinQ

97 Npdypappa Ekkiv. Mayvid.
98 Eyypagn fixou

99  Kévtpo evnpépwong
99 Smart Doctor

99 LG Mobile Switch
100 Zkouridla epappoy.
100 SmartWorld

101 RemoteCall Service
101 Exmopr KUPENNG
102 E@appoyég Google
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PuBpioeig

106 PuBpioceig

106 Aiktuo & Internet

113 Tuvdedepéveq OUOKEVE

116 Hyog

117 MpoPol
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Evnuépwaon Moylopikol
AEQWVOU

08nyd¢ katd e KAommg
MAnpogopieg onpeiwong yia 1o
MOYIOLIKO QVOIKTOU KWSIKA
MANPoQopieg OXETIKA HE
TOUG KavoVIGHOUG (ApIBuog
QVOYVWPLOTIKOU KAVOVIOLOU,
NAEKTPOVIKEG ETIKETEG KNTT.)

Epmopikd ofpata
An\won aoealelag Aéwlep
AigvBuvan evnuépwong yia

Béuata CUUUOPEWONG WG TIPOC TN

XPrion Tou mpoidvtog
MeploodTepeg MANPOYOPIES
JUXVEC EPWTAOELS



0d6nyiec yia ac@aln Kat amoteAEGUATIKA
Xpnon

AlaBaoTe TIg mapakdtw amég odnyieg. H un tpnon autwv Twv odnyiwv pmopei va
amnofei emkivéuvn 1 mapdvopn.

Y& MePIMTWon oQAAUATOE, N GUCKELN 0ag SlaBETel éva epyaleio Aoyiopikol Tou Ba
SnuioupyroeL éva apyxeio kataypagrg o@aiuatog. To epyaleio cuMéyel Sedopéva
€151KA Y10 TO CUYKEKPIUEVO OPAAua OTIwG Ta £€AG: LoxUG onpatog, cell ID position

0€ TIEPIMTWON AmPACHEVNG AMOPPIYNG KARONG KAl EQAPHOYEG TTOU UTIAPXOULV 0T
GUOKeUN. To apXEio KATaYPAPrG XPNOIUOTIOLETAL AMTOKAEIOTIKA YI0l TOV TPOGSIOPIoHO
NG AITiag Tou OQAAUATOG. AUTA Ta OPXEQ KATAYPAPG Eival KpUTTToypag@nuéva Kat n
TIPOORacn o€ auTd gival EPIKTH POvVo amd e€0uCIoS0TNHEVA KEVTPA EMIOKEVAG TNG LG,
O€ TIEPITTTWON TIOU XPELOOTEL Va EMOTPEWETE TN OUOKEUR OAG VIO ETIIOKEVN.

'EkBeon ot evépyela padloocuyvoTritwy

MAnPoPopieC OXETIKA HE TNV €KBETN O€ PASIOKUHATA Kall TO GUVTENEDTH EIOIKIG
amoppd@nong (XEA).

AuTH N GUOKEUN €XEl OXESIAOTEL WOTE VOl GUMUOPPWVETAL LE TIG LOXUOUOEG AMAITHOELS
aopaleiag yia tnv ékBeon og padiokupata. Ot amartioelg autég BaciCovtal og
EMOTNUOVIKEG 0dnyieg Tou ephapBavouv mepBwpLa aopaleiag yia Ty TPooTasia
OAWV TWV aTOPWY, ave€apTnTa amod TNV NAKia fj TNV KATtdoTaon TG Uyeiag Toug.

+ XTI 08nYieg OXETIKA pE TNV éKBEDN OE PASIOKUHATA XPNOIMOTIOLETA Miat HovASa
UETpNOoNG N omoia gival yvwoTh w¢ CUVTENEDTAG EISIKNG amoppoenang i XEA. Ot
é\eyyol yla 1o XEA Sie§dyovtal pe Tumomoinpéveg HeBdS0UC, e Tn GUOKEUN va
EKTTENTTEL OTO PEYIOTO TIIOTOMOINMEVO ETMESO 10XVOG O ONEG TIC {WVES CUXVOTATWY
TIOU XPNOIUOTIOLE.

« Av Kal umopei va umapyouv Sla@opég petady Twv emmédwv Tou LEA yia
S1apopa povTéNa BUOKEUWV TNG LG, OAa Ta HovTéAa €xouv oXedIOTEl WOTE Va
QVTATIOKPIVOVTaL OTIG OXETIKEG 0dNYiEG yia TV ékBeon o€ padlokupata.

« To 6pto Tou ZEA mou ouviotatat amd t Alebvr) Emtporm Mpootaciag améd  Mn
loviCouoa AktivoBoAia (ICNIRP), givat 2 W/kg pe Bdon Tov UMoAoYIoHS TG HENG
TG ya 10 ypappdpla owpatikol 10Tou.

+ HuynAotepn T tou ZEA yia autd To povTého, Omwe éxel eheyxDei yia xprion oto
auri, givat 0,501 W/kg (10 g) kat yia xprion oto owpa givai 1,335 W/kg (10 ).



« AutA n cuokeur MAnPEOI TIG MPOUTTOBETELS Yia TN ékBEaN OE PadlooUXVOTNTEG
€iTe TAV XpNolHomolETal TNV Kavovikr Béon xpriong Sima ato auri gite dtav
Bpioketal og amdoTacn TouAdxioTov 5 mm amnd to owpa. Otav xpnotpomnoleital
BrKn petagopdg, KA {wvng fi Brkn yia xprion oto owua, Sev mpémel va
mepthapBavel pETAMIKA oTolxEla Kal TTPETEL VO GUYKPATEL TO TIPOIOV G€ amdoTaon
TOUAdXI0TOV 5 mm amd To owpa oac. Na tn petadoon apyeiwv Sedopévwy iy
UNVUPATWY, N GUOKELR amaitei Tnv Umapén moloTikA¢ oUvEeonc oTo Siktuo. Xe
OPIOHEVEG TIEPITTTWOELG, N METAS00N apyeiwv SeSopEVWY 1} UNVUPATWY UMOpPEi
va kaBuoTteproel éwg 6Tou givat Slabéoiun pia Tétota ouvdeon. Beaiwbeite ott
TNPOUVTAL Ol IAPATTAVW 08NYIEG OXETIKA HIE TNV AMAOTACK AT TO CWHA UEXPL VA
olokAnpwbei n petadoon.

MAnpo@opieg oxeTIKA pe TNV KON GE PASIOCUXVOTNTES
ané tnv Opoomnovdiakn Emrpornn Emkowvwviwy twv HIMA

Tov AlyouoTo Tou 1996, n Opoomovdiakr Emtporr Emkowwviwv (FCC) Twv Hvwpévwv
MoNTewwv, pe tn Spdon tng Report and Order FCC 96-326, ui0B£tnoe éva evnuepwpévo
TPATUTIO AOPANELQG YIa TNV €KBEON TOU AVBPWTTOU OTNV NAEKTPOUAYVNTIKY EVEPYEL
padioouyvotitwy (RF) mou ekméumeTal amd MOUMOUE ot 0TToiot TEAOUV UTIO ToV
puBpIOTIKG éNeyxo TnG FCC. Ot odnyieg auTEC €ival CUVETEIG HIE TOUG KAVOVIOHOUG
acpaleiag mou eixav 1ebei 0To MapeN@OV amd Ta Siebvny Kal apepikavika mpotuma. H
oxediaon auTrg TG CUOKEURG CUMHOPPWVETAL UE TIG 0dnyieg Tng FCC kat pe autd ta
S1ebvry mpdruma.

AnAwon Part 15.19

AUTH 1 CUOKEUH} CUHHOPPWVETAL HE TO ApBpo 15 Twv Kavoviopwv T FCC. H xprion
UMOKEITal 0TI akoAouBe¢ 500 mpoUmoBEéaelc:

(1) AutA n cuokeun Sev pmopei va mpokaléoel emPBAaPeic mapepBoAEC kat

(2) auTr n ouokeun Mpémel va amodéxeTal omoladnmoTe MAPEUPOAN,
oupnepAapBavopévwy mapeUBOAWV TIOU HITOPET va IPOKAAEGOUY avemBUpnTn
Aertoupyia.

AnAwon Part 15.21

Tuxov ahayég iy TPomoTToloEI TToU GV EYKPIVOVTAL PNTA amd TOV KATAOKELAOTH
MIOPOUV VA AKUPWOOUV TO SIKaiwua xpriong Tou e§omAiopoU.
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Xpnon oto cwpa

AUTH 1 OUOKEUT €XEL ENeYXDE( Y10 TUTIIKN XPriON OTO OWHA, HE TO TTOW MEPOC TNG

og anéotaon 0,39 vtowv (1 cm) amoé To oW Tou XPHOTN. [a CUPHOPPWON PE TIG
anaitrioelg g FCC yia tnv ékBeon o€ padioouyvdtnteg, mpémel va Statnpeitat eNdyiotn
anéotaon 0,39 vtowv (1 cm) avapesa To WA TOU XPROTN KAl TO THow PéEPOG TNG
OUOKEUNG.

Evééxetat va pnv pmopolv va xpnaotpomotnBouv KA otipténg oe {wvn, Brikeg kat
napepepn afeaoudp mou Slabétouv peTarika e§aptripata. Ta afecoudp yia xprion
0TO OWHa 1o Sev umopouv va Slatnpricouv amdotaocn 0,39 vtowv (1 cm) petady

TOU OWHATOG TOU XPHOTN KAl TOU TToW MEPOUG TNG CUOKEUNG Kall Ta ortoia Gev €xouv
GOKIHOOTEL yia TUTTIKEG XPROEIG 0TO OWHA, EVOEXETAL va Uy TANpolv Ta 6pia T FCC yia
Vv €kBeon o€ PadlooUXVOTNTEC Kall TIPETEL VOl AMTOPEVYOVTAL.

AfAwon Part 15.105

AUTOG 0 £EOMANIGHOG ExEL ENEYXBEL KOl CUUOPPWVETAL LIE TA OPLA VIO TIG PNPLAKES
OUOKEVEG Katnyopiag B, cuppwva pe To Part 15 twv kavoviouwv FCC. Autd ta 6pta
eival oxedlaopéva yia va Tapéxou EMAPKI TPOOTAsia évavTt eMPAABWY mMapepBoAwY
o€ OIKIaKr eykatdotaon. O €0mNOHOC QUTOG TTAPAYEL XPNOILOTOLE KAl MMTOPE( val
EKTTEUDEL EVEPYELD PASIOOUXVOTHTWY Kal, av Sev eyKaTaoTabe( Kat xpnotpomoindei
oUpPWvVa pe TIG 0dnyieg, umopei va mipokahéoel empPAapeic mapepBolég oTig
padioemkowwvieg. QaTo00, Sev uTApxEL £yyunon 6Tt Sev Ba undp&ouv mapepPoAEG
O€ M0 GUYKEKPIPEVN EYKATAOTAON. AV auTOG 0 EE0MAIOHOG TIPOKaNEDEL emPAapEic
TIAPEUPONEG OTNV TNAEOTTIKA AN, YEYOVOG TTOU UMOpPEi vat SlamoTwOei pe Thv
amevepyomoinon kai evepyomoinan Tou eE0mAIGHOU, 0 XpoTng evBappuvetal va
Sokipaoel va SlopBuwoel Tic mapepBolég Ue éva 1y eploodtepa amd Ta e§RG PETPa:

AMGETE TV TPOsaVATONOHO 1y TN Béon TG Kepaiag ARYnG.

Auénote v amdotacn petal eEomiopou Kat SkTn.

« ZuvdéaTe Tov e§0MAIOUO o€ TIPIla TTOU AVIAKEL 08 AANO KUKAWHA QO QUTO WE TO
ormoio eival ouvSeSepEvog 0 SEKTNC.

+ YUMPOUNEUTEITE TO METAMWANTH 1} évav EUTTEIPO TEXVIKO pado@uvwv/TnAedpaonc
yia Boribela.

Opovtiba kal GUVTHPNON TOU TIPOIOGVTOC
+ Na xpnotporoleite pdvo ta e€aptrpata mou mepthapBdvovtat 0Tn CUCKELATia Kal
eival e§ovatodotnuéva amod v LG. H LG Sev mapéyel eyyunoelg yia Tuxov BAapes
anotuyieg Aettoupyiag mou opeilovtal o€ e£apTAHATA GAWY KATAOKEUATTRV.

+ Oplopéva meplexdpeva Kat EIKOVEG eVOEXETAL VA S10QEPOLY armd T OUOKEUN 0ag
Xwpic mpogidomoinon.
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+ Mnv amoouvappo)oyeite Tn povada. Otav amattolvTal EPYaieq EMOKEUNG,
TAPASWOTE TNV OF ECEIBIKEVHEVO TEXVIKO.

« Katatn Slakprtikn euxépela tng LG, ol emMOKeVEG Tou KAAUTITOVTAL AT ThV £yyUnon
evdéxeTal va mepAapBavouv Ty TomoBETNon avTaMAKTIKWV LEPWV f TIIVAKWV (€iTE
KOVOUPIWV EITE EMOKEVAOHUEVWV), LIE TNV TTIPOUTTOOECN 0TI N AEITOUPYIKOTNTA TOUG
€lval 10050vaun e TN AEITOUPYIKATNTA TWV PEPWV TIOU AVTIKATAOTAONKAV.

« Kpatdre T ouoKeun HOKPLd amd NAEKTPIKEG CUOKEVES OTIWG TNAEOPATELC,
PadIo@WVa Kal UTTONOYIOTEG,

« H ouokeur| mpémet va QUAACOETAL LOKPLG OO TNyEG BepUOTNTAG, OTIWG KANOPIPEP 1)
NAEKTPIKEC KOUTiveC.

« Mpoo€€Te va pnv méoel.

+H ouokeun Sev mpémel va UTTOKEITaL OE PnXavIKéG SOVATELG I} Kpadaopoug.

+ ATevepyomoIEiTE T OUOKEUN OTIG TIEPIOXEG OTTOU AMAYOPEVETAL N XPRON TG
OUUPWVA HE EIBIKOUC KAVOVIOHOUG. Ma TapdSelypa, LNV XPNOILOTIOLEITE TN GUOKEUN
0€ VOOOKOUE(a, kaBuwg n xprion TG pmopei va ennpedoet uaiobnTo 1aTpiko
€§OMAIONO.

+ Mnv mdvete T ouokeun pe Bpeyuéva xépla, otav goptilel. Mmopei va mabete
nAektpomAnéia kat va mpokAnBei coPapri BAABN otn cuokeun.

+ Mnv @oprilete T0 TNAEPWVO KOVTA O EVPAEKTA UAIKG, KaBWG evOéxeTal va
BepuavOei kat va dnuovpynBei Kivuvog mupkayldag.

+ Xpnowormotjote éva oTeyvo mavi yia va KaBapioeTe To mePIBANUa TG OUOKEUNG
(Hnv xpnotpomoteite SlaNuTeg OMwG Bev{ivn, SIGAUTIKS 1) OVOTVEUHA).

+ Mn @oprtilete T ouokeun 6Tav BpioKeTal MAVW 08 HOAAKA LPAcUATa.

+H ouokeun mpémet va gopTiletal og KaAd agpt{Opevo XWwpo.

+ Mnv a@rVeTe Tn GUOKEUN OE XWPOUG LE UTIEPBONKS Kamvo 1 okovn.

+ Mnv tomobeteite T cUoKeLN SiMAa OE MMOTWTIKES KAPTEG N EIOITHPIA MECWV
HETaQOPAg. Mmopei va emnpedoel TIC TANPOPOPIEC TTOU TIEPIEXOVTAL OTIG HAYVNTIKEG
TAWVIEC.

+ Mnv xtumdte tnv 086vn e agpuned aVTIKEMEVa, KABWGS EVEEXETAL VA TIPOKANEDETE
BAApn ot cuokeun.

+ Mnv ekBéteTe Tn cUOKEUN O€ LypPA 1y uypacia.

+ XPNOIMOTIOLEITE PE TTPOTOXT Ta AEECOUAP, OTIWG TT.Y. TA AKOUGTIKE. Mnv ayyilete
AoKoma TV Kepaia.

+ Mnv XpnOlWOTIOLEITE, UNV ayyi(ETE Kal PNV TPOOTIABEITE VOl AQAPETETE 1 va
embI0pBWOETE OTIAOUEVO, KOUUEVO 1} paylopévo YUaAi. H eyylnon dev kahumtel
BAaeg mou ogeilovTal o€ Kakh xprion Tng yuahivng 08ovng.
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«H ouokeun givat n\ektpovik Kat mapdyet OepudTnTa Katd T SIGPKELA TG KAVOVIKAG
Aerroupyiac, H mapatetapévn, dpeon emagn pe 1o dépua oag umo cuvenkeg
avenapkoUg e§aepIopoU evEEXETaL VO EM@PEPEL SUCPOPI 1 MIKPA EYKAUHATA.
YUVETTWG, XEIPIOTEITE PE TIPOOOKT] T OUCKEUI 0ag KATd T AgiToupyia 1 apécwe META.

+ Av Bpaxei n GUOKEUN, AMOCUVSEDTE TNV APECWE KAl OTEYVWOTE TNV KaAd. Mnv
ETTIXEIPIOETE VOl EMOTTEVOETE TO OTEYVWHA KE LDt EEWTEPIKA TINYR BEPUOTNTAC, OTTWE
€lval o1 poUPVOoL, Ol POUPVOL LIKPOKUHATWY 1 Ol OTEYVWTAPEG LOANIWV.

« To uypd 0N Ppeypévn ouokeur AAALEL TO XpWHA TNG ETIKETAC TOU TTPOIOVTOG
0TO EOWTEPIKO TNG OUOKEVNC. H eyyUnon Sev kahumTel BAABEG TG GUOKEURAE TTOU
o@eilovtal otnv €kBeor TG o€ Lypd.

M @opn T cuoKeun amaitei owoTH KUKAo@opia aépa yia tn Sidyuon tng
Bepuotntag. H dueon emagr pe 1o Sépua Kat n avemapKrig KUKAOQopia Tou aépa
0T OUOKEUN propei va odnynoet o uniepBéppavar tng. H ouokeur) Ba mpémel va
Bpioketal og amdoTacn TouldxioTtov 1,0 cm amd To oWHa Tou XPROTN.

« Eumodiote v gicodo okdvng ) AMwv EEvwv ouaiiv 0T BUpa Tou PoPTIoTH/ToU
kaAwdiou USB. Evoéxetat va mpokAnBei umepBéppavon i mupkayld.

+ Amo@UYETE TNV €KBEDN TNG CUOKEUNG OE XAUNAY ATHOOQAIPIKY TTiEON OE UPNAG
peyaro uPSpETPO.

+ Mnv ekBETETE TN CUOKELN OE TTONY XAUNAR ATHOGQAIPIKR THEDT. AlOQOPETIKE,
umopei va mpokAnBei ékpnén g prmatapiag f Slappor) EVPAEKTOU LYPOU 1 aEpiou.

« OpovrioTe va pnv £pbet To MPoidv o emagr pe bypd. Mnv xpnotuomoleite 1y
enavapopTi(ete To MPOIdV av éxel umooTei {npid. Av To ipoidv Bpaxei, n Auxvia BAABNG
and uypd Ba aMagel xpwpa. AGBETe umOYN oag 6Tt o€ auTrv TV Tiepimwon Sev Ba
SIKAIOVOTE TIG SWPEAV UTINPETIEC EMOKEUNG TOU KAAUTITOVTAL OITd TNV €yyUnon.

Anoteleopatiki Xprion TG CUOKEVNG

HAEKTPOVIKEG OUOKEVEG
'OAeG 01 GUOKEVEG pmmopei va G€xovTal TapePBOAEG Tou emmpealouv Ty anddoor Toug.

+ Mnv XPNOIUOTIOLEITE TN GUOKEUI KOVTA OF 1ATPIKO £60MAIOUO XwpiG va €xeTe Addfel
OXETIKN ASel. ZUUBOUNEUTEITE TO yITPS GG yia va SIAMOTWOETE av N AeToupyia
TNG OUOKEUNG UMopei va TpokaAéael TAPEUBOAEC 0T AEToUpYia TG LOTPIKAG 0aG
OUOKEUNG.

+ Ol KATAOKEVAOTEC BNUATOSOTWY OUVIOTOUV ENAXIOTN amdoTaon 15 cm petad
ANV OUCKELWV Kal TOU BnuatodoTn, yia Ty amo@uyr moavwv mapeUBoAwv.

+ AUTHA ) GUOKEUN MITOPE( VAl TIAPAYEL EVTOVO PWG 1) YWE TOU avaBooprivel.
+ Opiopéva BonBruata akong evééxetal va veioTavTal MaPEUPBONEG Amd GUOKEVEG.
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+ MiKpEG apepPBONEC EVOEXETAL VO ETNPEACOUV OUOKEVEC, OTTWG TNAEOPATEL,
pad10QWVA, UTTONOYIOTEC K.ATT.

+ Av givai Suvato, XpnolpomoloTe T oUCKeUN o€ Beppokpaaieg petagu 0 °C kat
40 °C. H €kBeon NG OUOKELNG O TIOAU XapnAéG i uPnAég Beppokpaaieg evoéxetal
va mpokahéael {nuid, Suohertoupyia fy akdua Kat €kpnén.

048Ik ao@alela
ENéy€Te TOUG VOMOUG Kl TOUG KAVOVIGHOUG VIO TN XPr 0N OUCKEUWY OTAV OONYEITE.
+ Mnv XPNOIUOTIOLEITE TTOTE GUOKEUN XELPOG OTAV OSNVYE(TE.
« Eotiaote 6An oag v mpogcoxr otV odrynon.
+ ZTOPATAOTE OTNV dKpn Tou SpdpoU Kal oTABUEVOTE To OKNUA oag Tpv
TIPQYHOTOTOIOETE 1} AMAVTACETE O€ pia KO, EQV TO Amaitouv ot uvOrKeg 0drynong.
+ Hevépyela padloouxvotrTwy evOEKETAL VA EMNPEACEL OPIOUEVA NAEKTPOVIKG GUOTHAMATA
070 OXNHA 6ag, OMwE T PASIGPWVO TOU AUTOKIVATOU Kal ToV £§0TAOUS aopaeiag.
« Edv 10 6xnpa oag ivat §omAiopévo e évav 1y TIEPIGOATEPOUG AEPOTAKOUCG,
unv eykabioTdte Kat pnv tomobeteite aclppato eomiiopd o onpeia dmou Ba
epmodietal n Aerroupyia Tou agpooakou. Evaéxetal va mpokAnBei Suohettoupyia
TOU 0EPAOAKOU 1 00PaPAC TPAUUATIONAS AGYw aKATAANANG anddoonc.
‘Otav akoUTE HOVGIK ev) BpiokeoTe é§w, PePaiwbeite OT1 éxeTe pubuioel Tnv
£€vtaon og éva Moyiko eminedo, yla va €xeTe emiyvwon Tou Tt cupfaivel yopw oag.
AUTO gival IBLAITEPA ONUAVTIKO OTAV KIVEIOTE KOVTA 0€ SPOUOUC.

MpdkAnon BAAPNG otV aKor cag
Ta va mpo@uhayteite amd mBavr) PAGPN TG akorig oag, amo@UyeTe TV
aKkpdaon o€ UPNAG emimeda O yia PeyANa XpovIKA SlaoTrparta.

Evoéxetat va mpokAnBei BAGPN otnv akor) oag eav ektiBeote oe Suvatd fixo yia
TIOPATETAUEVO XPOVIKS SlaoTnua. EMopéVwg, 0aG CUVIOTOULE VA UNV EVEQYOTTOLEITE
1) AIEVEPYOTOLEITE TO TNAEPWVO KOVTA 0Ta AuTid oag. Emiong, oag ouviotoupe va
PUBpileTE TNV €VTaoN TNG LOUGIKAG KAl TOU iX0U KAoNG o€ éva AoyIKo enimedo.
« 'OTav XPNOIUOTIOLEITE AKOUOTIKE, VA PEWWVETE TNV EVTAGH TOU XOU av Sev aKoUTE
000UC LINOUV YUpW GaE 1) Qv TO ATOWO TToU KABeTal SimAa 0ag UIMopEi va akoUoel
auTO TTOU OKOUTE.

E « H umepBONIKr NXNTIKI TTiEN A6 T AKOUOTIKA UMOpE( va IPOKAAETEL
AMWAELD TN AKOAG.
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ludhiva e§aptrpata

Oplopéva P€pn TNG CUOKEUNG 00C Eival KATAOKEUAOHEVA amd YUANL To yuai pumopei

VOl OTIAOEL AV I CUOKEUT 00 TTECEL TIAVW OE OKANPEN EM@AVELD 1) SEXTEL IOXUPOUG
Kpadaopoug. EGv omdoel kdmoto YuaAvo e€ApTNHa, KNV TO ayYIEETE Kat pnv
ETTIKEIPHOETE VA TO APAIPECETE. TAHATHOTE VO XPNOIHOTIOLEITE Tr) CUCKEUH 0ag PéXPL VA
avTikataoTaBei To Yuahi amo e0uatoSoTnuévo TTAPOYO UTTNPECIWV.

Media avativaéewv

Mnv xpnotpomolgite Tn CUOKEUN O TTEPLOXES 0oL YivovTal avaTtivaelc. Na akohouBeite
TOUG TTEPLOPIOUOUG KAl OTTOLOUG KAVOVIGHOUG 1) KAVOVEG LOXUOUV.

MepiBdarovta 6mou umdpyel Kivduvog ekpnéewv
+ Mnv XpNOILOTOIEITE TN OUOKEUN OE ONEI QVEPOSIAGHOU KAUGTUWV.
+ Mnv XpnOIHOTOLEITE TO TNAEPWVO KOVTA OE KAUGIHA 1} XNHIKA.

« Mnv pETaQEPETE Kal Pnv amoBnKeVETE EVPAEKTA AEPLD, UyPd 1} EKPNKTIKA OTOV iS10
XWPO TOU AUTOKIVATOU 0agG OTIOU TOTOBETEITE TN GUCKEUN 1} TA a§E0OUdp TNG.

Xpnon o€ agpooKAPog
O1 00UPUATEG CUOKEVEG UMOPOUV VA TIPOKAAEGOUV TIAPEUBOAEG OTA CUOTAHATA
AEPOOKAPWV.

« MNpw empPiBaoTeite o€ AEPOOKAPOG, OTTEVEPYOTIOIOTE TN GUCKEUN).

+ ‘000 TO aEPOOKAPOG BPICKETAL OTO £50POG, UNV XPNOILOTOIEITE TO TNAEPWVO XWPIG
adeia amd o mMipwya.

MNadia

Oulagte Tn ouoKeur Og AoPANEG HéPOG, pakpla amod maudid. MepapPavel e§aptrhpata
MIKPOU pEeYEBOUG TTOU EVOEXETAI VAl TIPOKANETOUV KiVEUVO TIVIYHOU EQV AMTOOTIAOTOUV
amé 1o TNAéQwvo.

Eneiyouoec KA\OEIC

O1 emeiyouoeg KANOELG evEéxeTal va pnv ivat Slabéotpeg og OAa Ta Siktua KIvnTrg
Aepwviag, Ma to Adyo auto, Sev mpémel va Bacileate amokAEIOTIKA OE auTr TN
GUOKEUN YIa EMEIYOUTEG KANTELC. ETIKOIVWVIAOTE HIE TOV TOTTIKO TIAPOXO UTINPETIAV Yial
Va EVIUEPWOEITE OXETIKA UE AUTO TO Bépa.
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H)\npmpoplac Kal @PovTida pumataplwv
Aev ival amapaitnTo va anogopTioTel Mpw N ratapia yia va Ty
EMAVAPOPTIOETE. Z& avTiBeon pe GAa ouoTApaTa prataplwy, Sev epgavifetal 1o
QAIVOLEVO UVIALING TTOU UMTOPE VOl EMNPEACEL TNV amdS00n TNG Unatapia.

« Xpnoworoleite uovo pmatapieg kat opTioTég LG. Ot popTioTéq LG éxouv oxediaoTei
UE TPAOTO TETOI0, WOTE Va peyloTomololy Tn Sidpkela {whg TG Prmatapiod.

+ Mnv amoouvappoNoYEiTe Kat unv BPOUKUKAWVETE TV Pmatapia.

« Alotnpeite KaBapEG TIG METAANKES EMOPES TNG PmaTapiag.

« AvtikaBiotdre v pmatapia otav pelwdei onuavtika n anddoon e, H umatapia
UMOPEL VOl POPTIOTEL EKATOVTASES POPES LEXPL VA XPEIAOTE AVTIKATAOTAON.

« Edav n umatapia Sev éxel xpnotpomoindei yia moAl kaipd, popTioTe T yia va
UEYIOTOMOINOETE TN SIAPKEL XPAONG TNG.

+ Mnv a@rivete ekTeBeIpévo To PopTIoTH TG umatapiag ameubeiag otnv nAakn
QKTIVOBONIC Kall NV TOV XPNOIMOTIOLEITE OE XWPOUG HE TTOAR LYPAGia, OTTWE TO
umavio.

+ Mnv a@rivete v pratapia og Beppolc i KPUOUG XWPOUE, KaBWG evaéxeTal va
pewwbei n amdédoor e,

« Eav avtikataotiioete T pratapia pe AavBaopiévo TOmo pmatapiag, umdpyel
Kivouvog ékpnéng. H amdppudn Twv XpnotuomotnuéVWY Hmatapliv PEMEL va yiveTat
oUPPWVa PE TIG 08nyieC.

« o va amo@UyeTe TNV AOKOTIN KATAVAAWGN EVEPYELAG AMTO TO YOPTIOTH, VA TOV
QmoCUVSEETE TAVTOTE Mo TNV TPICa META TNV T PN YOPTION TNG CUCKEUNC.

H mpaypatikn Sapketa {wng Tng umatapiog e§aptdatat amoé t Slapdpewon Tou
SIKTUOU, TIG PUBHITELG TV TTPOTOVTWY, TIC CUVIBELEG XPrONG, TV MmaTapia Kat Tig
TEPIBANNOVTIKEG OUVORKEG,

BePawBeite mwe n pumatapia dev Epyetal o€ EMAQN UE AXUNEA QVTIKEMEVA, OTIWG
Sovtia {wwv 1 kap@ld. Ydpyxel Kivduvog avaphegne.

Ac@QANELQ TIPOOWTTIKWV GTOIXEIWV

+ Na TIpooTATEVETE TIAVTA TA IPOCWTTIKA GO OTOIKEID, WOTE VA EUMOSIOETE TUXOV
Slappoég Sedopévwy iy Kataxpnon evaiocdnTwv MANPOPOPILV.

+ Na énpioupyeite mavta avtiypaga ac@aleiag Twv onpavtikwv oag Sedopévwv dtav
Xpnotporoleite Tn ouokeur. H LG Sev givat umelBuvn yia Tuxdv amwAeleg GeSopévwv.

« Mpwv meTd&eTe TN OUOKEUR, va SNUIOVPYATETE avTiypaga ao@aleiog OAwv Twv
Sedopévwv Kal va KAVETE EMavapopd TG CUOKEUNG WOTE Va EPMOSIOETE TUXOV
Katdypnon euaicbnTwv MANPOPOPIWV.
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« 'Otav katePalete pappoyég, va SlaPalete MPOOEKTIKA TNV 006V TwV SIKAIWHUATWV.

+ Na €ioTe MPOOEKTIKO{ OTAV XPNOILOTOIEITE EQAPHOYES TIOU €xOUV TTPOORacH oe
TIOMEG NETOUPYIEC 1) OTA TTPOCWTTIKA 0O OTOIXEICL.

+ Na eNéyxeTe TAKTIKG TOUG TTPOOWTTIKOUE GOG AOYOPLACHOUG. AV EVTOTIIOETE TUXOV
€eVOEICEIC KATAYPNONG TWV TTPOCWTTIKWY GAC OTOIXEIWY, {NTAOTE amod ToV TAPOXO TNG
umnpeoiag va dtaypayet ry va aMdgel Ta oTolyeia Tou Aoyaplaopol oag.

« Av n ouokeun oag xabei ) Kharei, aMate Tov Kwdiko MpdoPacng Tou Aoyaplacpou
00G WOTE Va SI00PANCETE Ta TIPOOWTTIKA 0AG OTOIXE(Q.

+ Mnv xpnolHOTIOLEITE EPOPHOYES TTOU TIPOEPKOVTAL ATTO AYVWOTES TINYEG.

A El&onotnon Y10 TV QVTIKATAGTACT TG pratapiag
H pmatapia ovtwv Aibiou eivat emkivéuvn KaBwg Umopei va mpoKaNEDEL
TPOUUATIOO.

+ H avtikatdotaon g umatapiag amo pUn KATapTIoHEVO EMAyYEAUATIa pmope
Vol TIPOKAAEGEL {NIA 0T GUCKELN GO,
Mnv avtikaBiotdte T umatapia pévot oag. Mmopei va mpokAnBei BAABNn ot
umatapia mou Ba 0dnyroel o€ uepOEpavan Kat TpavpaTiopd. H pmatapia
TIpEMEL va avTiKataoTaBel amd katapTiopévo enayyeAuatio. H pmatapia
TIPEMEL VA AVOKUKAWVETAL 1) VO AMTOPPITTTETAL EEXWPIOTA aTTd Tal OIKIAKA
amoppippata.
«+ XNV mepimTwon mou To oidv S1abétel evowpatwpévn pmatapia mou de
umopei va agaipebei amd to xpriotn, n LG oag mpoteivel va ameuBuvBeite
O€ EMAYYEAUATIA YIO TNV AQAipEDN TNG UraTapiag, av mpdKeTal va T
QVTIKATAOTAOETE I Va TN OTEINETE Yia aVaKUKAWON 0T0 TENOG TG (wiig TG,
MNa v mpoAnyn BAGPNG oTo mPOIdY, Kal yia TV ac@AAELd TOU XPHOTN,
UNV EMIXEIPHOETE VO APAIPECETE TN prmatapia. AmeuBuvBeite otn Mpauun
BonBeiag ¢ LG, fj og Mo emayyehpartio.
H agaipeon tng pmatapiag mpoumoBétel amoouvapuoAdynon
TOU TEPIBAALATOG TOU TTPOIOVTOG, AMOCUVEEDN TWV NAEKTPIKWV
KaAwdiwv/ EMaQWy, Kal MPOCEKTIKN AMOPAKPLVON TG MraTapiag
e e€e1dikeupéva epyaleia. EQv xpeldleoTe TIG EmayyEAUATIKES
odnyieg yla TV agaipeon g pnatapia, emokepOeite T SievBuvon
http://www.lge.com/global/sustainability/environment/take-back-recycling.

Od8nyieg yla ac@alr) Kat amoTEAECHATIKN XPrion 13
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XapaktnPIoTIKA KApEPaG

Evpuywvia kdpepa

Mriopeite va TpaPriete pwtoypagieg iy va eyypdpete Bivieo o peyahiTepo P0G
and 1o TPAyHaTIkO Tedio HpacnC XPNCILOTIOIVTAS TV EVPEIX Ywvia oTN TTow
KApepa.

Ayyi€re 1a ewovidia O > (&) kat émerta Siadoyikd ta eikovidia (2) / (#) yia
evahhayr| HETagy TNG TUTTIKAC Kall TNG EVPEING ywviag.

AAAayR NG ywviag
KAPEPAG.

Miow kapepa

« Ta Aemrtopépeleg, avatpé€te oty evotnta EKKivnon ¢ KApEPag.
« Mmopeite va aMEEeTe PETASY TWV TUTTIKWY KAl EVPUYWVIWY QAKWY KAMEPAS
oTNV oW KAUEPA POVO.
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Moptpaito
Mriopeite va TpaPri&ete va euKpIVEC TOPTPETO £QAPUOLOVTAC TO PAVOUEVO
BOAwoNG Pakoy TNG KAPEPAG.
T Ayyi€e ta ewoviia O > (&) kat émerta emhé€e Moptpaito.
7 Matiote () yia va BydheTe pia pwtoypagia.
« Nava puBpioete T dOvaun tng BoAdtnTag, oupeTe T PARSO oAioBnong
TIPOG TA APLOTEPA 1) TIPOG Ta OEEIE.

E + AlaTtripnoe TV amdoTaon TOU VTIKEIPEVOU oou o€ amootaon 1.3 ~ 5.0
TIOSIWV VW XPNOIUOTIOLEITE TNV TTOW KAUEPQ.

+ AutA n Aertoupyia Sev eivat S1abéoipn o€ TOM) OKOTEWVO TIEPIBANOV.

« Metd v epappoyn autig g Suvatdtntag, matioTe oty EMOUUNTH
6éon otV 006V TIPOEMOKOTNONG YI0 VOl EQAPUOCETE AUTOUATA TNV TN
€KBeoNG Kal TV €0Tia0N OTAV XPNOILOTOIETE TV THOW KAPEPQ, 1 TV TIUA
€KBEONG UOVO GTAV XPNOIUOTIOLEITE TNV MIMTPOCTIVH KAPEPQ.
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Al CAM

Mriopeite va Byalete 16avikéC pwToypagieg iy Biveo kabwg n kdpuepa avayvwpilel
TO QVTIKEIPEVA KOTA TN pwToypagia rj To Pivteo.

1 Ayyi&re 1o O> (&) kay, ot ouvéxela, matriote Al CAM.

7 'Otav avayvwploTE] T QVTIKEIUEVO, XPNOILOTOLETAL TO KAAUTEPO EPE YA TO
OKNVIKO.

+ Ta va xpnotpomoloete AANa @€, TATAOTE TO EIKOVISIO OKNVIKOU.

+ Katotkibio, mdAn, Aouho0dt, gaynto, Tomio, mpoowna, nAtoacilepa,
QUTOMATO, CUVOAIKA UITOPOUV VO QVAYVWPLOTOUV QUTOHATA 8 KATNYOPIES.

Auon nAiou AouAoudi

E + To amoTéAeopa TG avayvwplong TnG okNvAG iowg va Slagpépel avahoya Tov
QWTIONO Ay TV Béan Tou avTiKeuévou v Bydlelc pwtoypagies. Ot Aé€elg
KAeWd1a Sev eppavifovTal oTIC amobnKeupéves pwtoypagieg i Bivteo.
+ Autij n Suvatdtnta eivat Slabéoiun udvo dtav ot EUPAE Kal THOW KAUEPES
Bpiokovtal o€ Autopatn Asrtoupyia.
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Nertoupyieg ™G e@appoyng AAUTOUp

Anovpyia Tawviag

Mriopeite va dnpioupynoeTe pia véa tavia cuvéualovtag ikOveg kat Biveo.

1 Natote O > > kaptéha wToypagieg Kat, 0N CLVEKELD, TOTHOTE + >
Anpoupyia Tauviag.
Mnopeite emiong va natioete O > [N > kaptéha Avamap., 0T OUVEKELD,
natote > Anwoupyia Tawiag.

7 Em\é€te TIC e1kdveC A Ta Bivieo ou BéAeTe va oupmepIAIBETE 0TV Tawvia oag
Kat matrjote Emop.

3 Ene€epyaoTeite TIC EIKOVEC Kol Ta BIVTED TIOU EXETE EMAECEL KO TIATAOTE
Emopevo.
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Awaypagn apxeiwv
Mriopeite va emAé€eTe €lkVeC 1 Bivieo mou BéNeTe va Slaypdyete amo To Bivied
oag mat@vTag To Koupri ) e Pikpoypagiag mou avTioTolyel 0To kaBéva.

MpocBrikn apyeiwv

Mmopeite va ipooBéoete eIkoveC 1y Bivieo mou BéNeTe matwvTag 1o kouuni 4 oto
KATW Pé€POG TG 080vNG. Mmopeite emiong va emMAEEETE €IKOVEC 1) BivTeo TTOU €xeTeE
1on mpoobéoel.

E « MNatfjote mapateTapéva mavw o€ éva apyeio Kal EMerta mavw o€ éva GAAo yia
moMamAf emAoyr apxeiwv.

Avadidraén apyeiwv

Mo va aMNGEeTe T S1aTagn Twv eKOVWY Kat Twv Pivieo, TATHOTE KAl KPATAOTE
TIOTNHEVO TIAVW OTO OPXEIO TTOU BENETE VOl ETAKIVIOETE Kol GUPETE TO OTNV
TomoBeoia mou BéNeTe.

Emavagopd Twv pubpicewv taviag
Mriopeite va avakahéoeTe TIG PUBIOELS TIOU EXETE OpioEL OTNV Tavid (TT.Y. XpOVOS
QVanapaywyric) ATWVTAG T0 KOUpTi &).

Mpoemaokomnaon apyeiov

Agite T0 Bivteo TOU SnIOUPYROATE TIPIV TO AMOBNKEVCETE, MATWVTAC TO
koupri (»). Otav ohokAnpwBei N avamapaywyn, Tpaypatomoleital autdpaTa
avanapaywyn Tou EMOUEVOU ApXEiov.

E « ot Snpiovpyia Bivteo, pumopeite va xpnolomoIfoeTe £wg 50 EIKOVEG Kal
Bivreo.
O mpoemAeyHEVOG XPOVOG avamapaywyng yia pia eikova givat 3
Seutepoherta kat Sev pmopei va aAd€el. H Sidpketa twv Bivieo pmopei va
HEIWBED o €wg 1 SeuTepONeTTO.
« Autij n SuvatdtnTa prmopei va unv umootnpilel OpIoHEVES LOPPEG EIKOVWY
1 Bivteo.
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Anuovpyia GIF
Mmopeite ebkoha va SnuoupynoeTe éva apyeio GIF xpnotpomolwvag
€yyeypappéva Bivieo i pwtoypapied.

Kavovtag éva GIF xpnoipomowwvtag Ta eyyeypappéva Bivteo
1 Tnouypr mou Ba emAé€ete otnv apyr TG MPoPoi¢ evog Bivieo, matrote G).
7 Em)\é€te 1o urikog Tou GIF iou B4AeTe va SnuioupynoeTe.
+ To GIF dnuioupyeitat yia 1o Xpovikd S1dotnpia mou éxel emAeYei amé Ty
TPEKOUOA WPA.
« Ta Bivreo pe Sidpkela Aiydtepo amo 5 SeutepoAemta, ot eikoveg GIF
SnioupyoLVTaAL AUTOMATA Yia TV UTIOAOITN WPA.

Anpiovpyia evog GIF xpnoipomolwvTag gwtoypapieg

T Katédmy mpoBohr evog dhpmouy, em\é€te & > Anpioupyia GIF.

7 Em\é€te TIC emBUPNTEC WTOYPaieC yia va Snuioupyrnoete éva apxeio GIF kat
énerta motjote Emopevo.

+ Mnopeite va mpooOEoETe IEPIOOOTEPES EIKOVEC KAl VA TIPOCAPUOCETE TV
TaxutnTa Tou GIF, Tov Adyo 006vNn¢ Kal T O€lpd TwV apXEiwV.

A « Mmopeite va XpnOILOTOICETE AUTAV T SLVATATNTA HOVO Yia SNUOUPYIKES
16éec. Tuydv xprion autrig g Suvatdtntag mou odnyei o€ mapaiaon
TV SIKAWUATWY TPITWY, OTIWG SNAWOEIC YIal TIVEUMATIKA SIKathuaTa 1y
SUOENUIOTIKEG 1 UBPIOTIKEG SNAWOELS, SUvaTal VA EMPEPEL KUPWOELG
yla TNV anmd800n TMONTIKWY, TIOWIKWV 1) SIOIKNTIKWY uBuvV®V r/Kat
ANEC KUPWOELG CUPPWVA PE TNV IoXUoUGA VopoBeaia. Amayopeletal n
avtiypaen, n avamapaywyn, n Slavopr Kat Kabe GAAn mapdvoun xerion
OAwV TwV LAIKWV TTou SIEmovTal amd MIVEVHATIKA SIKAIWHATA XwPig ThV
A€ TOU VOUIMOU KATOXOU TOUG 1} TOU SIKAIOUXOU TIVEUHATIKNAG IG10KTN GO
370 péytoTo Babud mou emrpémetatl amd 1o Epappootéo Sikato, n LG
Electronics amomoleital Kabe pNnTr¢ Kal SlwInprg yyunong Kat UoxPEéwong
TIOU AQOPd TO TTAPOV.

« Tatn dnpiovpyia apxeiou GIF, pmopeite va xpnaotpomolroete éwg 100

EIKOVEC,
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MoétnTa Kat EMMTWOELG TOU IOV
XOPAKTNPICTIKA

DTS:X 3D Surround

Mmopeite va avamapaydyete éva tpayoldi r éva Bivteo oe tpiodidotato, {wvtavd
Kat {wvtavd fyo. Ma va xpnolUomoICEIG AUTO TO XOPAKTNPLOTIKO, OUVOEDE
OKOUOTIKG, NXEIO 1) ANEG EEWTEPIKEG CUOKEVEC XOU OTN GUOKEUH GOU.
Napakévnon O > PuBpiceig > Hyog > Motdtnta Axou Kat epé > DTS:X 3D
Surround, otn ouvéyela, matote D) yla va EVEPYOTIOINCETE QUTH TN AerToupyia.

PUOon ¢ katewBuvong riyou

Mriopeite va puBpioeTe TV KaTeLBUVON TOU XOU CUHPWVA HE TNV EMBUIA 0aG.

1 Natiote O > Pubpioeig> Hyog > Modtnta fixou Kai £@é > DTS:X 3D
Surround.

7 Em\é€te v kateuBuvon rxou.

Google Assistant

Google Assistant Emokomnnon
Mrmiopeite va EEKIVAOETE 1) Val XPNOUOTIOIOETE TIG EPAPHOYEC TTOU BENETE e T
Qwvn 0.

5 + [lava XpnoIHOMOINCEL AUTO TO XAPAKTNPIOTIKY, TPWTA GUVEEGOU OTO
S1adiktuo Kal Kave ioodo e Tov Aoyaplaopd cou ato Google.
« Autr n Aertoupyia Sev UMOpE( va AEITOUPYIOEL CWOTA OE QUTEG TIG TIEPIOXEG
1\ N akpiBela avayvwplong RXou Umopei va gival MKpoTepn dtav n 1oxUg Tou
Wi-Fi fj Tou 6rjpatog Tou Kivtou SIKTUoU &ivat aobevic.
« Auti n Aertoupyia pmopei va pnv umoatnpiCetal, fj ol uMooTNPI{OUEVES
YAWOOEG eVOEXETAL Va SIOQEPOLV AVANOYQ PE TNV TTEPIOKT.
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Ekkivnon tou Google Assistant.

1 Natiote napatetapéva O amd v Apxikr 086vn yia va Eekivrjoete Google
Assistant.

7 Ayyi€te to ZEKINHETE.

3 AkohouBriote Tig 08nyie mou epgavilovtat otnv 086vn kat ieite “Ok Google”.
+ H ouokeur amoBnkevel Ta wvnTiKa oag Sedopéva yia avayvwplon.

/. EmAé€te AmoBrikeuon.

Ekkivnon tou Google Assistant pe Tn @wvr cag

T Neite “Ok Google” dtav n 086vn gival evepyomoinpévn.

7 Meite pia eviolr f EpWTNON 6TaV EUPAVIOTE To TTapaBupo Tou Bondou Tn¢
Google otnv 066vn.

Ekkivnon tou Google Assistant amé tnv Apxikr 006vn

1 Natiote napatetapéva O) oty Apyiki 086vn.

7 Meite pia eviolr A pWTNON 6TaV EUPAVIOTE To TTapaBupo Tou Bondou Tn¢
Google otnv 066vn.

E « Eav piNate pe Sipopoupevn gwvr 1 B6pufo ToTe N akpifeta avayvpiong
QWVNAC UMopei va pelwBei. Otav xpnolpomoleite Tn Aetoupyia avayvwpiong
QWVNAG, AVENOTE TNV AKPIBEd TG MIAWVTAG pE KaBapr Gwvr O€ Jia ouxn
TomoBeaia.
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Avayvwpion SAKTUAIKWV amoTUNTWHATWV

Avayvwpion SaktuAikwv amotunwpdatwy - Mapouaciaon
MpoToU XPNOILOTOINCETE TN A&lToUpyia avayvwplong SAKTUAKWY amoTunwpdtwy,
TIPETEL VO KATOXWPIOETE TA SAKTUAIKA GO AMOTUTIWHATA 0TI CUOKEUN.

Mriopeite va XpnolomoloeTe TN AelToupyia avayvwpiong SOKTUANKWV
AMOTUNWUATWY OTIG AKONOUBEC TIEQIMTWOELG:

« Ta Eexeibwpa tng 086vNg.

+ Ta va deite 10 KAelbwuévo meplexopevo oto QuickMemo-+.

- Ta emPefainon pag ayopdg péow TG oUVOEDNC OE Ia EQApHOYA i

TaUTOMoiNONG ME To SAKTUAIKG 0a¢ AmOTUNTWHA.

E + H ouokeur umopei va xpnotuomolei To SaKTUNKO 0o amotunwia yia
Adyoug Tautomoinong. O aleBnTPAg SAKTUNKWY AmOTUNTWHATWY UmopE(
va pnv &exwpilel SAKTUNKA amOTUTTWHOTA TTOU AVIKOLV O€ SIOQOPETIKOUG
XPOTEC AANA EXOUV TIOMEG OHIOIOTNTEG, Kall VAl Ta avayvwpilel wg To iSlo
amoTOMWHAL.

+ Avn ouokeur} Sev avayvwpiel Ta SaxTUNKA 0ag AmOTUNIWHATA 1 av
EexaoeTe TNV KABOPIGPEVN TIUF YIO TNV KATAXWPLON, EMOKEPTEITE TO
mnatéotepo Kévtpo e§umnpétnong mehatwv g LG mpookopifovtag
OUOKEUN KAl TV TAUTOTNTA 0aG.

Mpo@uldéelc yia Tnv avayvwplon SAKTUNKWY OTOTUMTWHATWY
H akpiBela avayvipiong SAKTUNKOU QmoTUMWUATOC UMOpE( va pelwBsi yia
S1apopoug Mdyouc. Na va peyiotomoinBei n akpifela tg avayvwplong, eAEyETe Ta
akoAouba LV XPNOIUOTOOETE TN GUOKEUN.

+ H ouokeun diabétel aioBntrpa SakTUAIKWY amotunwudtwy. BeBaiwdeite
6T1 0 AloBNTAPAG SAKTUNKWY OMOTUNTWUATWY Sev €XEL UMOOTEL (LA amo
0moloSNTOTE HETONNKO QVTIKEIEVO, OTIWG Vopiopata i KAESIA.

+ 'Otav oto M\RKTPOo AloONTAPAC SAKTUNKWY AmOTUNTWHATWY 1} TO SAKTUAG
00C UTIAPXEL VEPD, okAVN 1y GAAN §€vn ouaia, n kataywplon SAKTUAKOU
QIOTUTTWUATOG ) N AVaYVWPLON eVEEXeTaL va LN Agttoupyolv. KaBapiote
Kall OTEYVWOTE To SAKTUNG GO TIpLV EEKIVAOETE TN SladIKaoia avayvwplong
GOKTUAKOU OITOTUTTWHATOG,
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‘Eva SakTUNIKO amoTUnwua Sev Umopei va TauTtomoinBei owoTd £4v n em@Avela
Tou SaKTUAOU 00 éxel Wia ouAn 1y Sev gival Aeia emeldn xel peivel TOAA wpa
UEDQ O€ VEPO.

Edv \uyiCete To SAKTUNS GG 1 XPNOILOTOLEITE UOVO TNV dKP TOU SAKTUAOU
00, T0 SAKTUAIKS amoTUMWHA 0ag EVOEXETAI VA PNV avayvwploTei. BeBalwBeite
OT1 T0 SAKTUNG GaG KAAUTTTEL OAOKAN PN TNV EMIPAVELD TOU aloBnTrhpa
SGOKTUNIKWV OMOTUTTWHATWV.

YapwoTe Hovo éva SAKTUAO yla Kabe kataywplon. H 6apwaon meplocoTepwv
SakTUAwV pmopei va éxel emmwoelg 0t Sladikacia Kataywpelong Kat yypagic.
H ouokeun evoéxetal va SnUIOUPYEl 0TATIKO NAEKTPIOWO OF TEPIMTWon mou
Aertoupyei o€ mepIBANov pe Enpd aépa. EGv o aépag oto mepiBaNov ival
ENPOC, AMOPUYETE TN 0APWON TOU SAKTUAKOU GO AMOTUNIWHATOC 1 ayYi€te
€Vl LETAANIKO QVTIKEIPIEVO, OTIWG €va VOO 1} éva KAELSI, TPV T 6dpwaon Tou
SGOKTUANIKOU OmOTUTIMATOC YIal VA EE0UOETEPWOETE TOV OTATIKO NAEKTPIOHO.

Kataywpion SAKTUMKWY amoTUNWHUATWY

Mropeite va KataywpioeTe Kal va amoBnKeVoETe T SAKTUANKS GaC amoTUNwia 0N

GUOKEUN YIa VA TO XPNOILOTIOLEITE IE TNV aVayVWPLON SAKTUAIKWY AmOTUNTWHATWY.

1 Natote O > Pubpioeig > K\eibwpa 086vn¢ & acpdhea > Aaktul.
Amotunwpara.

5 « [la va XpnoIHOMOICETE AUTHY TN AEITOUpYia, TPEMEL VAl EXETE OPIOEL
KAeibwpa 006vNg.
« Edav 1o KAeidwpa 086vng Sev gival evepyomolnpévo, SIapopPWOTE TIG
pubuioelg KAebwpaTog 006vNg akoAouBwvTag TG 0dnyieg tng 08vne. Na
AemTopépeleg, avaTpé€Te 0TV evotnta PUBLIoN kKA&idwuatog 08ovng.
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7 Evtomiote Tov alobntipa SaKTUAIKWOV amoTunwUdTwy 0To Tow PEPOC
TNG OUOKEUNG KAl AKOUUTTOTE amaAd To SAKTUAO YIa VO KATOXWPIOETE TO
Saktulikd oag amoTimwua.

« [athote eAag@pd To MAKTPo AloBNTAPAC SAKTUNKWY amOTUMWUATWY WOTE
0 aIoBNTAPAG va avayvwpioel To SAKTUNKG Gag amoTunwpa.

+ BePawboou 611 1o akpoSaxTuAG aou KaAUTTTEL OAOKANPN TNV EMPAVELD TOU
aledNTAPA AMOTUNIWUATOG,

000

3 AkolouBriote Ti 08nyie¢ mou epgavilovtal atnv 08évn.
+ Emavalapete T 6dpwon Tou SAKTUAKOU AmOTUNTWUATOC LETAKIVWVTAC TO
SAKTUNG GaC Olya-Olyd EXPL VA OMokANpwBEi n kataxwpton.
/I "Otav n kataywpion Tou SaKTUAIKOU amoTumwpatog oAokAnpwOei, matote OK.
+ Matiote Mpoodrkn emmA. yia va Kataxwpioete MO SAKTUAIKO amoTUNWHAL.
Edv éyete kataywpioel povo éva GAKTUNIKO amoTUNIWUA Kall TO QVTIOTOLXO
SaxTulo Sev eivat o€ KaTAANAN katdataon yia adpwarn, n avayvwpeion
evdéxeTal va pn Aertoupyroet owoTd. Q¢ PETPO AMOTPOTING HIAG TETOLAG
KATAOTAONG, OLVIOTATAL VOl KATaXWPIOETE TOMA SAKTUNKA OmOTUMWHATA.
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Alayeipion SAKTUNIKWY AmOTUNTWHATWY

Mriopeite va emefepyaoTeite 1 va SlaypAPeTe KataywpIopéva SAKTUAIKA
AMOTUMWUATAL.

1

2
3

Natiote O > PuBpioeig > Kheidwpa 006vng & acpaheta > Aaktul.
Amotunwpara.

Zex\eldwoTe oUPPWVA LE TNV kaBoplopévn LEBodo KAEIBWHATOC.

Am6 T NioTa Twv SAKTUNKWY AIMOTUTIWHATWY, TIATAOTE MAvw o€ éva
SAKTUAIKO OmOTUTIWA VIO VO TO HETOVOHAOETE. [1a va To SlaypAYETE, TATAOTE
0 KoUTTi {ii].

Zexkheibwpa tng 006vNG pe Xprion SakTUAIKOU amoTUIWHOTOG
Mmopeite va Eekheldwoete Ty 080N i va Seite T0 KAEIOWHEVO TEPIEKOHEVO
XPNOILOTOIWVTAG To SAKTUNIKG oag amotumwyia. Evepyomoinon emBupntrig Aemoupyiag:

1

2
3

Natiote O > PuBuioeic > Kheidwpa 086vng & ac@dheia > AakTtul.

Anotunwyara.

Zex\eldwoTe oUPPWVA e TNV kaBoplopévn PEBodo KAEISWHATOC.

YV 086vn pubpicewv SaKTUNKWY amOTUNTWHATWY, EVEPYOTIOIOTE TV

emOuunTn Aettoupyia:

- Kheibwpa 006vng: yia va Eexheldwvete tnv 006vn He Xprion GOKTUAKOU
QAMOTUTIWHATOG.

+ Kheibwpa mepieyopévou: yia va EEKAEIGWVETE TO TIEPIEXOIEVO HE XPAON
SaKTUNKOU amoTunwpaTog. Ma va To kdvete autd, BePatwbeite 0TI éxel
£pappooTel KAeidwpa meplEXOUEVOU.
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Aertoupyia moAudiepyaciag

MoA\amAd mapdaBupa
Mriopeite va xpnotporoleite U0 epappoyE Tautoxpova xwpiovtag tnv 08évn
o€ moAam\d mapdBupa.
1 And tamviktpa agric oty apxikr 086vn, matiote [ ].
+ Epgavi{ovtal ol IpdoeaTa XpNOIUOTIOINUEVES EQAPHOYEC.
7 Z10 mavw péPoG TG epapuoync ou BéNete, matiote S yia va
Xpnotpomooete T Suvatdtnta MoMamd mapdbupa.
+ HemMeypévn epappoyn Ba eppavioTei 0To mavw piod g 0Bdévne.
Eva\akTikd,
1 matiote kot KpaTHOTE MATNPEVO TO MARKTPO [:] £VW) XPNOIUOTIOLEITE A
€appovn.
+ O1mpdoeaTa XPNOILOTIOINUEVES EQAPHOYEC Epavifovtal 0T
Slaywplopévn 0Bovn.
7 Z10 mavw péPOG TNG papuoync ou BéNete, matiote S ya va
xpnotpomonoete tn Suvatdtnta MoMamda mapdbupa.
+ HemMeypévn epappoyr) Ba epeavioTei 0To Kdtw piod tng 08évne.

E « Tla va amevepyomolroete Tn Suvatotnta MoAamAd mapdBupa, TaTHoTE Kal
KQOTAOTE MATEVO VW 0To MAAKTPO = otV 086vn agrc.
+ Tla va mpooapuooETe To PéyeBog Twv TUNHATWY 0Tn Staywplopévn 086vn,
OUPETE TO EIKOVISIO — OTO KEVTPO TNG 086VNG.
« H duvatotnta MoMam\d mapdBupa Sev umootnpiletal amod oplopéveg
£PAPHOYEC LG Kat amd Ti¢ epappoyég mou katePalete amo To Play Store.

Mpoogpateg 006veg

A6 Ti¢ Mpoo@arteg 000VES EXETE LA EMOKOTINON TwV MPOoPATA
XPNOIHOTIOINUEVWY EPAPUOYWV.

MNa va Seite T NioTa TwV MPOCPATA XENOILOTOINUEVWV EQAPHOYWY, TATHOTE TO
koupmi [_] otnv Apxikr 08vn Kai, 0T GUVEXELD, TTATAOTE TV EQAPHOYH.
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E€aptipata kat a§eocovdp Tou mpoidvtog

Ta mapakdtw otolyeia mepNapBdvovTal 0Tn GUOKEUH GO,

+ ZUoKeun + QopTioTAG
+ ZTEPEOPWVIKA OKOUOTIKA + 08nydc ypriyopng ekkivnong
+ KaAwdio USB + Kapeitoa e€aywyng

+ Onkn TAepwvou Jelly

A + Ta oTolxEia TOU TIEPLYPAPOVTAL TTLO TTAVW UITOPEL VAl ElVal TTPOAIPETIKA.

+ Ta OTOIXElD TTOU TTAPEKOVTAL LIE TN CUOKELN Kal TUXOV SlaBéotpa ageooudp
umopei va S10pE€Pouv, avaloya e TV TIEPLOXT| KL TOV TIAPOXO UTTNPEGIWV.

+ Na xpnotporoleite mavtote yvriola ageoouvdp LG Electronics. H xprion
a§eooudp ANWVY KATAOKEUAOTWY EVOEXETAI VOl ETTNPEACEL TV AmOS00N
TwV KAOEWV OTN GUOKEUN 00 I VO TIPOKAAEDEL TTPOBAAATA KATA TN
Aertoupyia. H emokeur) evog TEtolou mpoBARaTOG EVOEXETAL VAL PNV
KOAUTTITETAL ammd TNV UTINPETia EMOKeVWV TG LG.

+ Mepikd amé ta pépn TG CUOKEUAG £X0UV KATAOKEUAOTE OO EVIOXUHEVO
Yuohi. EQv n GuoKeur| 0ag mECEl Tavw O€ Jia OKANpr EM@AveLa i
TIPOOKPOUGEL KATTOU e UV, umopei va TpokAnBei {nuid oto
OKANPUPEVO YUONL. Z€ QUTHV TV TIEPITWOT, SIKOYTE apéowE TN XPrion TG
GUOKEUNG Kal EMKOWVWVAOTE UE éva Kévtpo e§umnpétnong mehatwv tne LG.

5 « Edv \eimel omolodrmote amd autd Ta BACIKA GTOIXEID, ETTIKOIVWVIOTE UE TOV

avTImPAoWTo amd ToV OToi0 AYOPACATE T GUOKEUN).

« [la va ayopdoete mpOcOETa OTOIXE(Q, EMKOIVWVAOTE e éva KEvipo
efunnpétnong mehatwv g LG.

+ Oplopéva oTolxeia ou mepIAapBavovTal 0Tn CUCKELAGia Tou TTPOIOVTOG
evbéxetal va aMda&ouv xwpig mpogidomoinon.

+ Hepgpavion Kat ol mpodiaypagEg TG CUOKEURG oag vOEXETal va aAdSouv
Xwpig mpogidomoinon.

+ O1mpodiaypapEg TNG CUOKEUNG EVOEXETAL Va SlapEPOLY, avANoya HE TV
TIEQLOXN 1 TOV TTAPOXO UTINPECIWV.

+ AQQIPEDTE TNV TPOOTATEVTIKN UeUBpdavn amd Tov aiodntripa SAKTUNKWV
QMOTUTIWHATWY TIPOTOU XPNOILOTOIOETE TN AElToupyia avayvwplong
SAKTUNKWY OMOTUTTWUATWV.
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Emokoénnon otoiygiwv

. . o 144 = ‘
Dakdg PTTPOCTIVAG KAPEPAG — 14D W

MAAKTpa éviaong fxou (+/-) —[

Google Assistant KAeidi —|

YTT030)[| OTEPEOPWVIKWV
QAKOUOTIKWY

AKOUOTIKO
Aigbnmipag
£YyUTNTOAG/QWTIOLOU
TepIBAAOVTOg

+— OrKn Kaprag

_] Nano-SIM/pviiung

o— 1oxUG/MARKTPO KAEIBWHOTOG

086vn agig

e
)

() jd

Mikpdpuwvo ——

dakoi Tiow Kapepag —

(cuoBnTAPag
MakpogwToypagiog/YTepe
upeiag/Baboug/TuTrikog)

Hygio ————=

Baoikég Aertoupyieg

)

@

./

OUpa goprioTh/KaAwdiou USB

— ®Aag

— AI0BNTAPAG SAKTUNKWV
ATTOTUTTWHATWV

— [Meplox NFC

 Mikpdpwvo

30



A MHN emiyelprioeTe va a@alpEGETE POVOL 0AG TO TTOW KAAUHAL.
Y& SlaQopETIKN TEPITTWON, eVOEXETaL va umooTel coBapr (nuid n pmatapia
Kall | OUOKEU TIou UMOpE va 08nyr ol o€ urepBépuavon, upKayld Kat
TpavuaTiopd. To mow KAAUPUA KAl N JImaTapia auTrg TG CUOKEUNG Sev Tpémel
va agaipolvTal i va avikabiotavTal amd pn KatapTIopEVO EmayyeAaTia.

+ Alobntrpag eyyUtnTac/Qwtiopou mepiBAAhovTog

- AeBntpac eyyutnTac Katd tn Sidpkela pag KAong, o aiodntipag
€yyUTNTOG amevepyoolei Tnv 086vn Kat T duvatdtnTa agrg, dtav
1 OUOKEUN| BPIOKETAI OE MIKPT) ATOOTACN A6 TO WA TOU XPHROTH.
Evepyorotei Eavd tnv 066vn Kat T SuvatdtnTa agrg 6Tav n GUOKEUN
Bpioketal £€w amo P CUYKEKPIEVN EUPENELD.
AloONnTHPAg PWTICHOUL TTEPIBANOVTOC: 0 AIOONTHPAG PWTICHOU
TIEPIBANOVTOC AVAAUEL TNV €VTAON TOU QWTIOHOU TEPIBANOVTOC OTav €ival
EVEPYOTTOINEVN N AEITOUPYIC AUTOHATOU EAEYXOU QUITEIVOTNTAG.
« MAAKTpa évtaong fxou

- Mmopeite va TpOCAPHOCETE TNV £VTAON TWV RXWV KAONG, TwV KARCEWV i
Twv e1domoIoEwV.
EvW XpNOILOTIOIETE TNV KAPEPQ, TIATAOTE AMaAd KATTOLO amd Ta MARKTPA
€vTaong NXoU yia va TpaPi&eTe pia gutoypagia. Ma ouveyeic Muelg, ayyi€te
Kall KOATAOTE TO MARKTPO €VTaong fxou.

- o va ekkivioeTe Ty egapuoyn Kapepa dtav n 086vn eival kKAeldwpévn
QTTEVEPYOTIOINHEVN, TIOTAOTE TO MAKTPO pEiwoNg TG évtaong rixou (-) duo
@opég. MNatroTte To MAKTPo alénong tng évtaong fixou (+) SUo Yopéq yia va
€KKIVAOETE TNV e@appoyn Capture+.

+ lox0¢/MARKTPO KAEISWHATOG

- MotAote oOVTOUa TO MARKTPO OTav BENETE VAl EVEPYOTTIOINOETE 1 va
QMEVEPYOTIOIOETE TNV 0B4VN.

- MotAoTe To MARKTPO TapATETApEVA OTAV BENETE Va EVEQYOTTOINOETE A
emMoyn eNéyxou Aertoupyiag.

- Google Assistant Khedi

- H ouokeun oag éxel Tov BonBd Google evowpatwpévo. Bpeite amavtioeig
Kalt kdve mpdypata otnv mopeia. Na va EekvioeLg, amd mdta o KAelSi
BonBd¢ Google otnv meupd Tou TNAEPWVOU.

- Evepyomoijote 1o Google Assistant. Aeg To Google Assistant yial
AEMTOEPELEC.

Baoikég Aertoupyieg 31



+ AlobNnTPpag SAKTUNIKWY AMOTUNIWHATWY
- Evepyomotjote T Aettoupyia avayvwplong SaKTUNKwY amotunwpdtwy yia
va amorolroete T Sladikacia EeKAeIdWUATOC TN 080vNC. Mol AemTopépele,
avatpé€te otV evotnta Avayvwplon GaKTUAIKWY amoTumwidtwy - [lapouoiaon.

5 + Avahoya pe TIG TPodIaypapEg TG CUCKEUNG, EVOEXETAL VA UNV EMITPEMETAL N
TIPOOROCN O€ OPIOEVEG NEITOUPYIEG,

+ XT0 Tiow PéPog, n ouokeun S1abétel pa evowpatwpévn kepaia NFC. Na
€[0TE IPOOEKTIKOI KATE TOV XEIPIOUO TNG OUOKEUNG WOTE VA AMOPUYETE TV
mpdkAnon BAARNG otnv kepaia NFC ) tv kAP TG,

+ Mnv TomoBeteite Bapld avTIKEipEVA TTAVW 0T CUOKEUN 1} PNV KABeoTe Mavw
0€ QuTrv. X avtibetn mepimwon, umopei va mpokAnBei BAGRN otnv 08évn
apnc.

+ Hxprion mpootateuTikig MepBpdvng 086vng fy agecoudp evdéxetal va

TipoKaAéaouv mapePBOAEG aTov alebnTripa eyyoTnTag.
Edv n ouokeun oag givat uypn A xpnolUoToLEiTaL 08 PéPOG e LYPAaia, N
086vn 1} Ta Koupmd agrg evoéxeTal va unv Aeiltoupyolv owoTd.

MidoTe 6WOTA TN CUOKELH, OTTWE PAIVETAL TTAPAKATW. AV KAAUTITETE TV

OTT LIKPOPWVOU E TO XEPL, TO SAXTUAO 1 TNV IPOOTATEUTIKY BriKn 6Tav
XPNOUIOTIOLEITE Tr) CUOKEUN, UMOPEL va unv akoUyeTal kaBapd n ewvr 6ag Katd
S1dpketa Tng KA\jone.

ZwoTo Ad6og
Mikpopwvo MnV KaAUTITETE TO HIKPOPWVO.

L

S~

Mikpdpwvo Mnv KGAL’JmETé TO HIKPOPWVO.
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Evepyomnoinon 1) amevepyonoinon

Evepyonoinon
‘OTav n OUCKEUN Eival ATIEVEPYOTTOLNEVN, TIATAOTE TTAPATETAUEV TO TTARKTPO
evepyomoinon/KAEIOWHATOG.

5 + 'Otav n oUOKEUR evepyomolLEiTal YIa TTPWTN POoPA, TTPAYUATOTOLETAL N

apxikn Slapopewon. H mpwtn ekkivnon tou smartphone evééxetal va
Sl0PKETEL TTEPIOOOTEPN WPA ATTO O,TL CUVIHBWG.

Amevepyomoinon

MaTAOTE Kal KPATHOTE TATNHEVO TO TANKTPO EVEPYOTTOINONG/KAEIGWHATOG KAl
emAé€te Amevepyomoinon.

Emavekkivnon tng GUOKEURG

‘Otav n cuokeur 6ev AeITOUPYE OWOTA ) GV AVTATIOKPIVETAL, EMAVEKKIVAOTE TV
aKoAoUBWVTAC TIG TAPAKATW 08nyieC.

1

MoTAoTE Kat KPATHOTE TATNUEVO TO TTARKTPO EVEPYOTTOINONG/KAEIOWHATOG
KOl TO MARKTPO MEIGCNG TNG £VTAONG X0V (-) TAUTOXPOVA LEXPL N GUOKEUN Val
amevepyomolnOei.

7 ‘Otav n ouokeun emavekkivnBei, aprioTe Ta MAAKTPA.

EmMoyéc eAéyxou Aettoupyiag
MaTAOTE Kal KPATHOTE TATNHEVO TO TTARKTPO EVEPYOTTOINONG/KAEIGWHATOC Kal, 0TN
GUVEXELQ, EVEPYOTIOINOTE LI ETMAOYH.

« Amevepyomoinon: ATievePYOTTOLEl TN CUOKEUN.

+ Amevepyomoinon Kat EMaveKKivnon: EMaVEKKIVE] T OUOKEUH.
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TonoBétnon tn¢ kaptag SIM
TomoBetriote tnv kdpta SIM (Subscriber Identity Module) mou oag éxet

TIPOUNOEVGEL 0 TAPOXOC UTNPETIAV YIa VA EEKIVIOETE VA XPNOILOTOLEITE TN
OUOKEUN 00,

A + Na €i0Te TPOOEKTIKOI KATA TOV XEIPIOHO TNG KAPPITaaC §aywyng KaBuwg éxel
aunen akpn.

1 TomoBetiiote v Kapeitoa efaywyrg otny omr mou Ppioketal otnv umodoyxr
NG KAPTAG.

7 Tpapr&te mpog ta £&w v LMOSOKH TG KAPTAC.
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3 TonoBetiote TV K&pTa SIM aTNV UTTOSOKA TNC KAPTAC ME TIC XPUOEC EMAPEC
OTPOMMEVEC TTIPOG T KATW.
TomoBetriote TV Kupla kdpta SIM otn Brikn kaptag SIM 1 kat
Seutepevouoa kapta SIM otn Orikn kdptag SIM 2.
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E « Auti) n cuokeur) umootnpiel povo kapteg Nano SIM.

Nano Micro Kavovikr
L

« Ta amedoon Xwpig MPoBAATA, CUVICTATAL VA XPNOILOTIOLEITE TN
OUOKEUN e ToV owaoTo TUMO TG KdpTag SIM. Na xpnaotuomoleite mavta tnv
£PYOOTAOIOAKIG KATAOKEUNG KapTa SIM TTou mapéxeTat amd Tov mdpoyo.

« Edv tomoBetrioeTe TN Brikn KAPTAG 0T GUOKELR 6ag eV N Brikn KApTag
eivat uypn, n cuokeunr oag umopei va umootei BAABN. Na @povtilete mavtan
BrKkn Kaptag ivat oTeyv.

Mpo@uldgerg kata tn xprion ¢ kaptag SIM
+ Mnv xdoete TV kapta SIM. H LG Sev @épet kapia euBuvn yia PAARE kat dha
TPORAAHATA TTOU TTPOKAAOUVTAL A6 TNV amWAELd ) TN HeTaBifaon Tng KapTag
SIM.
+ Kata tv eloaywyn i Ty agaipeon g kaptag SIM mpénet va €iote mpooeKTIKol
yla va pnv mpokAnOei {nud.
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TonoBétnon tng Kaptag PvMNG

TomoBeTAOTE TNV KAPTA UVIUING 0T GUOKEUN 00C.

AvAloya L TOV KATAOKEUAOTH KAl TOV TUTTO TNG KAPTAG MVANG, KATTOLEG KAPTEC

MVIALING UITOPEL va PNV €ival CUMBATEG LE TN GUOKEUH 0.

T TomoBethote v Kap@itoa e§aywyrg oTn omr Tiou Bpioketal otny umodoxr
NG KAPTAG,

2 Tpapréte mpog ta £&w v umodoxn T¢ KApTac.

3 TomoBetAoTE TNV KAPTA UVAKNG 0TV UTIOS0X TNE KAPTAG KE TIC XPUTEC
EMAPES OTPAUUEVEG TIPOG TA KATW.

I— Kapra pviung
(TTPOQIPETIKA-TTWAEITAI
EEXWPIOTA)

Kdpta SIM

A Emotpéyte Ty umodoxr TS KAPTaAg oTnv apyIkr g Béon.

A + OpIOEVEG KAPTEC UVAUNG MITOPEL va UV gival MAPWS CUUBATEG UE TN
ouokeun. H xprion piag pn oupBartric kaptag pmopei mpokaréoel BAGBN e
OUOKEUNG ) TG KAPTAG MVANG, 1 va KaTaoTpéel Ta Gedopéva mmou givat
amoBnKeupéva O AUTHV.

E + Houyvi eyypaen Kat Slaypagri SeSopévwv pmopei va UEICEL Tn SIApKELa
QWG TNG KAPTAG UVAHNG.
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A@aipeon TG KAPTAG UVIUNG

la AOyouc ao@aleiag, amevepyomoloTe TV KAPTA UVAKING, TIPV TNV AQAIPEDETE.

1 NatAote O > Pubpioeig> AmoBNKeUTIKOG XWPOG >

7 TomoBetriote T kap@itoa e€aywyng otnv omr mou Bpioketal oTnv umodoxn
NG KApTag Kat émetta TPAPAETE TN BrKN TG KAPTAC TTPOE Ta £§W.

3 AQaIpéoTe TNV KAPTA PVAUNG amé Tn Brkn KapTag.

/A Emotpéyte Ty umodoxn TG KAPTag oTnv apyIkn g B£on.

A + Mnv agaipeite TNV KAPTA PVARING, EVW N CUCKEUN HETAPEPEL f XPNOIHOTOLE!
Sedopéva. Mmopei va pokAnBei amwAela iy KataoTtpor dedopévawy, iy
BAGPN NG KAPTAG PVAKNG 1 TNG ouoKeUNG. H LG dev euBuvetal yia amwAeleg
TIOU €ivall AMOTEAEGHA KAKIG ) AKATAMNANG XPrioNG TWV KAPTWY UVIAKNG,
oupmepAapBavopévng tne anAelag SeSopévwv.

Mnatapia

DopTtion TG prarapiag
TPtV XPNOILOTIOICETE TN GUOKEUN, POPTIOTE IAPWCE TNV pratapia.
Doprtiote T cuokeur pe To kahwdio USB tumou C.

Akpodéktng KaAwdiou PdpTtiong NS

Baoikég Aertoupyieg 38



A + Mnv ouvSEeTe T GUOKEUN O€ EEWTEPIKS TEPUATIKG, KAAWSIO POPTIONG
1) dtav umapyeEl vypaoia. Yapye! kivduvog mupKaytdg, nAektpomngia,
TpaupatiopoL fi PAGPNG TNG CUOKEUNG. Z€ TIEPIMTWON LYPAGIAC,
OTOMOTAOTE QPEOWG VA XPNOIOTIOIEITE TN OUOKEUN KOl AMOUAKPUVETE Ta
oTolxEia Lypaoiag.

+ OpovrioTe va xpnotpomnoleite To kKaAwsio USB mou mapéxetal Ue T GUOKEUN

0.

+ Na xpnotpomoleite mavTa YopTIoTH Kat KAAWSIO POPTIONG TTOU XLV
eykp1Bei amd v LG. H pdpTion g umatapiag Ue ¢opTioTh Tpitou
KATOOKEVAOTH Umope( va pokaAéoel ékpnén tng umatapiag i BAGRN otn
OUGOKEUN.

H ouokeun oag Slabétel eowTepikn emavagopTi{dpevn pmatapia. Ma Sikr
00G AOPANELQ, LNV APAIPEITE TNV EVOWUATWHEVN PmaTapia.

Y€ TEPIMTWON XPrONG TG OUOKEUNG VW auTr) YopTilel, evoéxeTal va
mpokAnBei n\ektpomAnéia. MNa va XpnOIHOTOIOETE TN GUOKEUT, OTAHOTHOTE
TN POpTION.

AQaIPEDTE TOV POPTIOTH Ao TV TPICa a@ol oAokAnpwBEL n EOPTION TG
OUOKEUNG. ETOL amoTpémeTal n AOKOTTN KaTavaAwaon VEPYELQG.

‘Evag AMog TpOTIoC yia va QopTiOETE Ty umatapia ivat va ouvdéoete

éva kaAwd10 USB petal Tng ouokeung Kat evog emrpamédiou 1y gopntou
umohoyloTn. H evépyela auTr| Umopei va ival IEPIocOTEPO XpovoRdpa amod
TN QOPTION TNG PmaTapiag o€ emroixia mpila.

Mn @opriCete Tnv pmatapia xpnotpomolwvtag USB hub mou dev

Suvarat va Slatnpriogt atabepr| TNV ovopaoTIKn Tdon. Evoéxetat va unv
mipaypatomoinBei @opTion 1 va Slakorei.

i

Mpo@ulagerg katd ™ Xprion TNG CUCKEUNG

- BeBawwBeite oTt xpnopomoleite To mapexdpevo Kahwdio USB. Mnv
xpnotporoteite kaAwdia USB A ¢opTIOTES TPITWV KATAOKEUAOTWY UE TN
OUOKeN 060G, H meploptopévn eyyunon g LG Sev KahUTTel T Xprion
afeooudp TPITWV KATAOKEUAOTWV.

Tuxdv aduvapia Thpnong Twv odnylwv mou mephapBdvovTal oTo mapdv
€YXELPIBI0 Xpriong Kat n akatdMANAN Xprion EVEEXETAL VA €XOLV WG ATTOTENECHA
TNV mpdkAnon BAAPNG 0Tn GUOKEUH.
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Amnoteleopatiki Xprion Th¢ pmatapiog

H didpketa {wng TnG Umatapiag Umopei va UelwBel av 0Tn GUOKEUR eKTENOLVTAL

TIOMNEG EQAPLIOYEG Kall AEITOUPYIE TAUTOXPOVA KAl OUVEXWG.

Ma va auvénoete tn Sldpkela (whg TNG Umatapiag, TEPUATIOTE TI AEIToupYieS Tou

EKTENOUVTAL GTO TTAPACKAVIO.

Mo va ENaKIOTOTOINOETE TNV KATAVAAWON TNG LoXVOE TNG Umatapiag, akohoubnote

TIC TAPAKATW GUUBOUAEG:

Na amevepyoroteite T Aertoupyia Bluetooth® rj Siktiou Wi-Fi 6tav Sev T

XPNOIUOTIOLE(TE.

PuBpioTe To XpoviKo 6plo TNG 006vNG 0T KIKPATEPN duvath TIur.

+ PuBpiote T QwtevotTa TG 086VNG 0T0 EAAXIOTO.

Evepyomoiriote To KAeidwpa TG 086vng OTav Sev XPNOIUOTOIETAL I GUCKEUN.

+ EAéy&Te Tn 0TdBun pmatapiog evw XPNOLUOTIOLEITE EQAPHOYEG TTOU EXETE
KateBAaoeL.

006vn apni¢

Mriopeite va e§oikelwBeite Pe TOV ENeYXO TNG CUOKEUAC GAG XPNOILOTOIWVTAG TIG
KIVI|OEIG TTOU UMTOPE(TE VA KAVETE e Ta SAKTUAG 0aG 0TV 086VN aprG.
Matnpa

Motrote eENappd 1o SAKTUNS GaC yia va KAveTe pia emhoyn fj va emAEEETE kat va
EKTENEDETE IO EQAPMOYN.
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Mapatetapévo matnua
Mo va ePPAVIOTEL TO PevoU pe TIC SLaBETtEG EMAOYEG, ) EVEPYELD TIOU amalITELTaL
€lval TO dyylypa Kot To KpATNUA YIa APKETA SEUTEPOAETTAL.

A6 matnua
MatAoTe ypryopa SU0 YOPEC yia val LEYEDUVETE 1 va OUIKPUVETE Ui LOTOOEAISA 1y
€vav xaptn.

Metakivnon

Ayyi€te kat KpatioTe éva oTolxeio, OTTWG M pappoyn i éva widget Kai, ot
OUVEXELD, METOKIVIOTE To SAXTUNG 0ag og Ao onueio akolouBwvtag pia
eheyxopevn kivnon. Mmopeite va xpnotpomoloeTe autrv Ty Kivnon yla va
UETAKIVAOETE €Val OTOIXEIO.
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KaBetn kOhion

Ayyi€te TV 086vn pe To SAXTUAO 0aG Kat HETAKIVAOTE TO YPYopa XWpIg Kapia
mavon. Mmopeite va XpnoILOTOICETE QUTH TNV Kivnon yla va UETaKIVNOEeiTe Ot pia
NioTa, pia 1oTooeNiBa, TIC WTOYPAPIE, TIC 0B8OVES Kat GAAa.

Avolypa Kat KAgio1po Twv SaKTUAWV

K\eiote Ta 6U0 SAKTUAA 0OC Yia va UYETE MO [Ia EQappoyr, OTIwE yia
TapAdelypa amd pia ewtoypagia ri évav xaptn. MNa va pueyeBOveTe KAolo oTolyeio,
avoi€te ta SAKTUAA oac.

/,'

A « Mnv exBétete TV 086vn agrg o€ umepBoAikd duvatolc kpadaopoug.
Mrmiopei va mpokAnOei BAGBN otov alodntripa agnic.
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5

Baoikég Aertoupyieg

Y€ EPIMTWON XPHONG TNG OUOKEUNG KOVTA O€ MaYVNTIKOG, HETAANIKS iy
aywylHo LAIKO, n 086V agrig eVEEXETAL va unv amoKpiveTal.

Z€ MEPIMTWON XPHONG TNG CUOKEUNG KATW Omd €VTOVO QWTIOHO, OTIWG TO
apeco NNako euwg, n 086vn pmopei va pnv givat opatry, avaloya pe ™ Béon
0aG. XpNOIHOTIOLEITE TN GUOKEUN OE pial OKIEPH TomoBeaia iy pia TomoBecia
JE HETPIO QWTIONO, O€ EVTAON TIOU APKEL yia TNV avdyvwon evog BiAiou.

+ Mnv matdre mdvw otnv 086vn pe umepBoNikr Svvapn.

Motrote amald pe 1o SAKTUNG 6ag TV MOy TIoU BENETE.

O éNeyx0G aPriG EVOEXETAL VAl UNV AEITOUPYOEL CWOTA OE TIEPITTWON TTOU

(QPOPATE YAVTIA 1} TTATATE IE TO AKPO TOU VUXIOU 0a.

+ 0 éNeyX0G a@riG EVOEXETAL VO NV AETOUPYNOEL OWOTA GV 0TV 086V €xel

oXNMaTIOTEl bypacia.

+ H 08dvn agrig evdéxetal va pnv AelToupyei owoTd €V 0T OUCKEUN €XEL

TomoBeTnBel MPOOTATEVTIKNA HEUBPAVN 1) a§ECOUAP TIOU TIPOUNOEVTAKATE
amné TpiTo KATaoTNHa.

+ HeppAavion piag oTaTIKiG EIKOVAG Yia TTAPATETAPEVA XPOVIKA SlaoTApaTA

umopei va 08nyroel 0tn Snpioupyia HETEIKAOHATOG 1 E6WAOL 0TV 086V,
AmevepyoroljoTte Tnv 086vn 1) amo@UyeTe Tnv mPoBoAr Tng idlag eikévag
yiat peydho Slaotnpa otav Gev XpnOILOTIOIETE T CUOKEU.
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Apxiknj 086vn

Apyxikny 006vn - Mapouaiaon

H apykr) 08évn gival To onpeio ekkivnong yia tnv mpoopaocn o S1apopeg
ettoupyieg kai epapoyég ot ouokeun oag. Matriote To koupni O og
omoladnmote 086vn yia va petapeite aneubeiag otnv apxikry 08ovn.

Mmopeite va SlaxelpIoTEiTe ONEG TIG EQAPUOYEC Kal Ta widget aTnv apyikr 08ovn.
JUpeTe T0 SAKTUNG 0ag 0TV 086vN TIPOC Ta aploTePd 1y Pog Ta Se€1d yia va Seite
ONEG TIG EYKATETTNHEVES EQAPHOYEG ME HIOL HOTIA.

Adtagn apxikng 066vng
Mmopeite va Seite ONeG TIC EQAPHOYEG KAl VO OPYAVWOETE Ta widget Kat Toug
(QaKENOUC 0TV apxIKr 006V,

Mpappn katGoTaong —e R T I
e —

Hosetiaped _.-

-— pagikd atoixeio Avaditnong
Google

Eikovidio ogAidag

ESOEIN 6 | ooy vorivopns

L

E + Hapyxikr 086vn evoéxetat va Slagpépel avaAoya pe Ty TONITIKI TOU
KOTAOKELAOTH, TIG PUOLITELS XprioTn, TNV ékS0on Tou AoyIopIKoU i) ToV
TIAPOXO UTINPECIWV.
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- Tpappn katdotaong: eppavilel eikovidia KaTdoTaong, TV WEA Kal T oTAdun

NG pmatapiag.

Widget KatpoU: egavion mMnpo@opiiv Kalpol Kat XpOVOoU Yia GUYKEKPIHEVN

TIEPLOXN.

- Tpagiko atoiyeio Avalritnong Google: MAnkTpoAoynoTe 1) LIAAOTE yia va
avoiete v Avartnon Google.

« Eikoviblo oghidag: eppavion Tou ouvolikou aplBuou Twv KapBddwv otnv
apxikr 086vn. Mmopeite va ayyi&ete To emBupnTo elkovidio oehidag yia va
petapeite otn oehida TG emAoync oac. Oa emonuavOei To ekovidlo mou
eppaviCel Toug KapBASEC eKeivNG TG OTLYUNG.

- Meproxn ypriyopng mpdcBaong: 1omoBetrioTe PACIKES EQAPHOYEC OTO KATW

UéPOG TG 086VNG yia va gival Suvath n mpdoRaon oe AUTEC amd omolovanmoTe

KOPBA NG apxIKrg 006vNnc.

MARKTPa ARG apxIkig 08ovng

- < emotpoen otV mponyoupevn 086vn. K\eioto Tou mnktpohoyiou 1y
avaduopevwy mapabupwv.

- O: ayyi&e yia emotpépel oV apxikr 086vn. Na va Eekivioete Ty Google
Assistant, ayyi€te mapatetapéva.

- [J: ayyiéte yia mpoBor piag NoTag pie T mpéo@paTa XpNOILOMOINUEVES
EQAPHOYEC 1} EKTENEDN IO EQappOYNE amd Tn AioTa. MNa va daypdyete
ONEG TIC IPOCPATA XPNOIOTIOINUEVES EQAPHOYEC, ayyiéte EKKAOAPIZH
OAQN. Na va xpnaotpomotioeTe SUO EQAPHOYES TAUTOXPOVA HE TN
Aertoupyia MoAamwv mapaBipwy, TATAOTE KAl KOATAOTE TO KOUWTT VL)
XPNOILOTIOIEITE UIa EQAPHOYN.

- [62): EmAé€re mola kdpta SIM Ba xpnotporoteite. Matiote mapatetapéva
yla va opioeTe TiG puBpioeig Tng Simirig kaptag SIM.
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AMN\ayn Tou oTIA TwV MARKTPWY aPRG apXIKG 006vng

Mmopeite va aAGEETE To OTIA Twv MARKTPWY ARG apxIKAG 006vng.

1 Natiote O > Pubpioeig> MpoBohi > MAfiktpa a@ig apxikAg 086vne.

2 Zwnvemhoyr ITYA, em)é€te Xeipovopia kat mAfktpa f Mévo mArktpa
avahoya pE TV TPOTiNor oag.

- Xeipovopieg kat miriktpat: Eivat Siabéoipa ta miiiktpa Miow < Kat apyIKng
006vng . Na va Seite TIC MPOoPATES EQAPOYEC, CUPETE TO MARKTPO
apXIKNG 006vNG S MPo¢ Ta MAVW.

« Mévo miktpa: <] Aati®evtaita /O /[ NatAote [ yiava Seite Tig
TPOOPATEG EPAPHOYEC.

Ene€epyacia Twv MARKTpWV a@ig apxikng o00ovng

Mropeite va aMd&ete T Sidtagn Twv MKTPWY aerg oTnv apyikr 08ovn 1 va
TIPOCOECETE OUKVA XPNOIHOTOLOUEVEG AEITOUPYIES OTNV TIEPLOXT TWV KOUUTTIWY
aQr¢ TG apxikric 086vng.
Ayyi€te Siadoyika O > Pubuioeig > MpoPolr > MARKTpa ari¢ apxikrg 086vng >
TUVSUACHOG TAKTPWY KAl TTIPOOAPUOOTE TIC PUBHICELC.

- Mapéxovtal apketég Suvatotnteg, dmwg 1o QSlide, ot Eldomoinon kain

epappoyn Capture+.
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Andkpuyn Twv MARKTPWV a@hg apXIKRG 086vng
Mmopeite va amokpUYeTe Ta MKTPa apig apxIkng 08ovng yia mpoPoAr oe
peyaNUTEPN 006VN KATA TN XProN LILOG EPAPHOYAG.
1 Natote O > PuBpioeig > MpoBohi > MAfiktpa agrg apxikAg 006vne >
Anoxkpupn MARKTP. APKIKNG.
7 EM\EETE TV EQAPUOYH YIa VO ATTOKPUWETE TO KOUpTTi ApxIkr) 086vn Ke T
epappoyn katatrote QD).
« Ta koupmd agnc oto omitt e€agpavifovtal 3 SeuTeEPONETTA ETA TV
Tehevtaia agn.
« Ta va deite mAN T0 MARKTPA AQRG 0TO OTIiTL, CUPETE TO KATW UEPOG TG
006vn¢ mpog Ta mavw.

Ewovibio kAeldwparog/amokpuPng

To €1kovidio yia va KAEIOWOETE 1 va amoKPUYETE Ta KOUUTIA ARG TG APXIKAG
0006vn¢ epgavifovtal oTnV KATW apIoTEPA ywvia TG 08dvng.

Av Béhete va KAEIOWOETE Ta MARKTPA ARG apXIKRG 006vNG evw KpUBETE Ta
KOUMIA, TaToTe O 0Ta apIoTEPA TWV TIAMKTPWY ARG ApXIKNAG 006vVNG.

Mo va amokpUYETE ava Ta KOUUMA agrig, matrioTe SUo popéc @ .

E + Oplopéveg Aettoupyieg evdéxetal va unv umoatnpifovtal Kata v
AMOKPUYN TWV KOUMTILWV OIKIOKAG AP,

Baoikég Aertoupyieg
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Ewkovidia katdotaong

Otav umdpyel pia idomoinon yia éva adidaoTo privuua, éva cuppav
nuepoloyiou 1 umvntripy, N ypappn katdotaong epgaviel To avtiotolyo
elkoviblo eidomoinong. EAéy&Te TNV KaTAoTaon TNG GUOKEUAG 0OC UECW TWV
elkoviSiwv e1domoinong mou eppavifovtal 0T ypauur Katdotaong.

*1 Agv undpyel oripa

H petadoon SeSopévwy mpaypatomoleital jéow SIKTiou

7~

‘Exet pubpioTei unvntript

ng ‘Exel evepyorolnOei n Aerroupyia ddvnong

b4 ‘Exel evepyoroindei 1o Bluetooth

YUvdeon pe umohoyloTh péow USB

2140un unatapiag

AerToupyia TTACNG EvepyoToiNpEVn

AvamdvnTteg KAAOEIG

‘Exet ouvdeBei To Wi-Fi

‘Exel evepyoroindei n Aerroupyia oiyaong

' ‘Exel evepyoroinei 1o GPS

(0] ‘Exel evepyomoindei To gpopnTto onueio mpdoBaong

N Aev undpyel kdpta SIM

[N H Aerroupyia NFC givat evepyomoinpévn

E + Oplopéva amo autd ta eikovidla evogxetal va epgpavifovtal S1a@opeTIKA iy
va pnv epgavifovtat kaBolou, avahoya LE TV KATAOTACN TNG CUOKEUNG.
AlaBaoTe Ty meplypagn Twv eikoviSiwv avaloya He To mePIBANOV Kat TV
TIEQLOXT| OTTOU XPNOIHOTIOLETE TN GUOKEUN KOl TOV TIAPOXO UTTNPETLWV.

+ Ta ekovidla mou pgpaviovtal vdéxetal va Slagépouv avaloya HE Thv
TIEPLOXI) KOl TOV TIGPOXO UTINPECLWV KIVNTHG TNAEPWVIAG,
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Mivakag eldomoioewv
Mmopeite va avoiete Tov mivaka e60moIoewv CUPOVTAG T YPAUU KATAOTAONG
TIPOG Ta KATW 0TNV KUpla 08dvn.

« Mmopeite va oUpEeTE MPOE T KATW TO APdBupo E160MOICEWVY 1 VO TIATAOETE
T0 €IKovidlo BENoug yia va avoifete T AioTa pe Ta elkovibia ypriyopwv
pubuioswv.

Mmopeite va matioete /2 yia va mpocBEcete, SiaypapeTe i) TAKTOMOW|OETE Ta
lkovibla 0To Mapabupo eI6OTOICEWV.

Edv matroete mapartetapéva 1o £ikovidlo, Ba eppavioTei n 066vn pubuicewv
yla TV avtioTolyn ArToupyia.

E « Mmopeite va XpnoILOTOICETE TOV TivaKa EI60TOICEWY aKOUa Kal dTav
n 086vn eivat KAelSwpévn. ZUPETE ToV Tivaka EI50MOIRCEWVY VW N 086vN
eivat KAeldwuévn, yla va amoKTHoETE ypriyopn mpooRacn oTig SuvatotnTeg
TIou BéNETE.
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Evalayn otov mpocavatoAloué g o0dvng

Mriopeite va opioete va aAAalel auTOpaTa 0 TPOCAVATONOMOC TG 086vNng
QVANOYQ [IE TOV UOIKO TIPOCAVOTONGHO TNG CUCKEUNG.

2oV mivaka eildomotjogwy, emAéETe Mepiotpo@n amd tn Aiota Twv ekoviSiwv
ypryopnc mpoéofaong.

EvaMaktikd, matiote O > PuBpioeic > MpoBolr kat evepyorotrote Ty emhoyn
Autépatn mepLotpo@r 000vng.

Ene€epyacia tng apxikng 00ovng
TNV Apxikr) 086vn, ayyi€Te Kal KpATAOTE O€ éva KEVO ONKEIO KA, OTN GUVEXELD,
€MAEETE TNV EMBUUINTI EVEPYELD OO TIC TIOPOKATW.

- Ta va aMagete ™ didtaén Twv kapPddwv otnv apxikr 086vn, matioTe
TaPATETAPEVA TAVW OF évav KAUBA Kal CUPETE Tov O€ pia AN Béon.

la va mpooBéoete éva widget atnv Apxikry 006vn, ayyi€te €va kevo onueio TG
ApxIKAG 086vng kal kpatroTe To emiéyovtag Widgets.

Mo va aMa&eTe Tametoapieg, O€pata kat elkovidla, TATAOTE MAPATETAUEVA OE
£€va Kevo onueio otnv Apxikr 08évn kai emAé€te Dovro & Opa.

Mropeite emiong va natioete ) > PuBpioeig > MpoBoh > DévTo & Oépa
Kal va emAEEETe TameToapieg, BEpaATa Kat EKOVISIA yla vVa EQAPUOCETE 0TN
OUOKEUN.
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+ Ta va Slapop@uoEeTe TIC pUBHIoEIS TNG APXIKNG 006vNG, ayyi€Te €va kevo
onueio TG ApXIKiG 006vNG KAl KPATAOTE TO EMAEYOVTAG OTN CUVEXELD
PuBpioeig apyikrig 006vng. Mo Aemtopépeleg, avatpé€Te oTnv evotnTa
PuBioeic apyikric 086vng.

« Ta va Seite 1) va eYKATAOTACETE EQVA TIC LN EYKATECTNEVES EQAPLOYEC,

ayyi€te éva kevo onpeio TG ApxIKing 086vNng Kal KPATAOTE TO EMAEYOVTAG

Zkoumibia epappoy. Na AeMTOUEPELES, AVATPECTE OTNV EVOTNTA ZKoUTTidIa

Epappioy.

Mo va aAa&eTe TV mpoemiheypévn 006vn, ayyi€Te Kal KPATAOTE Hia KEVH

meplox TNG ApXIKNG 006vng, petakivnBeite otnv emBupnTr 086vn, ayyi€te To

koupmi 1Y, Kal 0N ouvéxela ayyi€Te TRy 086vn yia GAN Wia gopd.

MpoemAeypévn 086vn

Baoikég Aertoupyieg
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MpofBoAn Tov Béuarog pévtou
H mpoBoAi TG EIKGVAC POVTOU €ivat SuvaTr LOVO e TNV amdKpuyn Twv
€QAPUOYWV Kal Twv widget otnv apxikri 086vn.
Am\woTte ta 800 SAKTUNG oag 0TV apxIKr 086vn.
- o va emoTpéPeTe oTnV apyIkr 006V HE TIC EPappoYEC Kat Ta widget, evwoTe
Ta GAKTUNG 00C EVG) TOl AKOUUTTATE GTNV apXIKr 086vn A ayyi€te To koupmi <.

Metakivnon epappoywv aTnv apxikn 086vn
SNV apyxikr 086vn, TaTHOTE MapaTETApEVA TAVW OF HIa EQOPHOYI KAl GUPETE TV
o€ Jia AA\n Béon.

« [a va KOp@ITOWOETE TIG EQAPHOYEG TTOU XPNOIUOTIOIOUVTAL GUXVA OTO KATW
UEPOG TNG apPXIKAG 0B8OVNG, TIATHOTE MAPATETAUEVA TIAVW OF HIC EQAPLOY, Kal
OUPETE TNV 0TNV TTEPLOXT YPHYOPNE TTPOCBAONE OTO KATW HéPOG TG 08dvne.

- Nava a@aipéoete éva glkovidlo amo v mepLoyn Ypriyopng mpooRacng, oUpeTe
T0 €IKoVISI0 oTNV apyIkr 08dvn.
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Xprion @akéAwv amd Tnv apxikni 086vn
Anuovpyia akélwv

TNV apxIKf 006vn, TATHOTE MAPATETAUEVA TTIAVW OF MOl EQAPHOYI KOl CUPETE TV
TIAVW OE [t GAAN EQAPHOYN.
+ Anuioupyeital évag vEog PAKeNOG KAl Ol EQAPHOYEC TPOOTIOEVTAL OTOV PAKENO.

Ene€epyacia akéAwv
TNV apxIKf 006vn, ayyi€te £vav GAKENO Kal, EMEITA, EKTENEDTE pia amd TIG
OKONOUOEG EVEPYELEG.
+ Ta va ene€epyaoTeite T0 OVoua fj TO XPWHA TOU PAKENOU, TIATAOTE TO VO
TOU PaKENOU 1} TO XPWHATIOTO MAMKTPO 0TV emavw Se€1d ywvia.

+ [0 va mpooBEoETe EQAPHOYES, AyYIETE KAl KPATAOTE TO EIKOVIOIO HIag

£(QAPHOYNG, CUPETE TO TIAVW AT TO PAKENO Kall, OTN GUVEXELD, AQHOTE TO.

+ [0 va aQaIPECETE JIa EPAPHOYR ammd TOV QAKENO, TATAOTE APATETAPEVA
TIAVW O0TNV EQAPHOYN KAl CUPETE TNV £§w amod Tov PakeMo. Eav n katapynOeica
€pappoyn givat n Hovadikn epappoyr oTo QAkeNo, o pdakehog Ba Katapynbei
autopara.

Emiong, umopeite va mpooBETETE 1 va aQaIPECETE EQOPHOYEC TTATWVTAG OTO
Koupri (+) Tou @akélou.

E « Aev pmopeite va aANAEETE TO XPWHO TOU GAKENOU GTAV XPNOIUOTIOIETE
Kamolo Bépa mmou €xeTe KaTePATEL

PuBuioeig apxikig 006vng
Mriopeite va TPOCAPHOCETE TI PUBHITELS TG aPXIKNG 08dvNG.
1 Natote O > Pubuioeic> MpoPohr > Apxikr 006vn.
7 Mpooapp6oTe TIC TapaKaTw pudpicelc:
- EmAé€te Apxikn oghiba: emAE€Te pia Aettoupyia amo v apyikr 08dvn.
+ OOvTo: aMdETe TV TameToapia YOVTOU TNG APXIKHG 08dvNC.
« E@é 006vng: emAéETe TO €€ TIou Ba epappdleTal Katd Ty evalhayn Kappd
oTnV apxlkr 08évn.
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Txnpata eikovidiwv: emAEETE edv BéNeTe Ta Elkovidia va xouv
TETPAYWVIOHEVEG I} OTPOYYUNEHEVEG AKPEG.

Por) Google: Evepyomoiote v tpo@odoacia Google yia va epgavioTei
0TNV apIoTEPK TAEUPA TNG APKIKNG 000VNG.

+ Ta&ivopnon epappoywv avd: Seite pe molov Tpomo TaivopouvTal ot

EQAPLOYES OTNV aPXIKT 0B6VN.
MAéypa: aM3€te T Aertoupyia avadidta&ng eQapuoywv yia Tnv apyxIkn
006vn.

+ ATIOKpUYIN EQAPUOYWV: EMAECTE TIC EPAPLOYEC TIOU BENETE VA AMOKPUYETE

amoé v apxikr o6ovn.

Na empémetat KUKAIKY emavaAnyn Apxikwv o8ovwv: evepyomoloTe
QUTAV TNV EMAOYN Y10 VA EMTPEPETE TN OLVEXH KUAION 0TV apXIKr 086vn
(emoTpéyte péow Ppoxou 0TV MpwTn 086V UETA TV TeENeuTaia 0B6vn).

+ Avalit.: kavte avartnon oépvovTag mPog Ta KATw oTnv ApxIkr 086vn.
+ Kheibwpa apyikrig 086vng: EvepyomoloTe To yia va pnv yivetat

avadidraén r amopdkpuvon epapuoywy Kat widget.

KA&idwpa 006vng

Mapouaiaon kKAeldwpatog 006vng

H 0086vn T OUOKEUNG 0OC ATEVEPYOTIOLEITAL KAl KAEIGWVEL AUTOUATA OV TIATHOETE
10 MMiKTPO Aetoupyiag/kAeldwuatog. To idlo cupPaivel mmiong Kal GTav n CUOKELR
Tapapeivel og adpavela yia éva KaBoplopévo Xpovikd Sldotnua.

Edv motroeTe 10 MANKTPO EvePYOTIOINoNG/KAEIOWHATOC XWPIG val EXEL
evepyoroinOei To Kheibwpa 086vng, Ba eupavioTei autopata n apxikr 0Bdvn.

Mo va e€ao@aNoeTe TNV A0PAAEIQ TNG GUOKEUNG KAl VO AMTOTPEPETE AVEMOUUINTN
npdoBaon o€ auTr, EvepyomolroTe To KAeibwua 086vnc.

5

« To kAeidwua 006VNG AMOTPEMEL TNV TIEPITTH EI0AYWYI| EVIOADV ARG OTN
GUOKEUN Kal MELWVEL TNV KaTavaAwon 1ox00g TG Umatapiag. Zuviotdtal
VOl EVEPYOTIOINOETE TO KAEISWHa TG 006vNG GTav Sev XPnOILOTOIETE TN
OUOKEUN.
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PUBuIoN KAe1dWwaTog 006vNng

AlatiBevTal apKeTEC EMAOYEC Yia TN SIOUOPPWON TwV PUBUICEWY KAEWSWUATOC TG

0Bdvnc.

1 MNatote O > PuBpioeig> Kheibwpa 006vng & aopaleia > Alahééte
KA&idwpa 006vNng Kal 0T cuvéxela EMAEETE TN PEB0SO TTOU TIPOTIUATE.

7 Mpocapp6oTe TIG TapaKATw pudpicel:

« Kavéva: amevepyomoinon Aettoupyiag KAeildwpatog 08ovne.

+ JUPETE: 0aPWOTE TNV 006VN yia va EEKAEIOWOETE TV 080V

+ Morifo: oxediaote éva potifo yia va EekheldwveTe Tnv 086vn.

+ Kwdikog kKAeldwpatog: el0aydyete évav aplBuntikd Kwdikéd mpdoBaonc yia
va ekAeldwaoeTe TV 0B6vn.
Kwd1kog mpoopaong: eloaydyete évav aApaplOunTIKO Kwdiko mpooRaong
yia va EeKAeISWOETe TV 006vn.

AakTul. Amotunwpata: EEKAeISWOTE TNV 006V XPNOILOTIOIWVTAG TO
SaKTUNKG 0O amoTUMWLA.

E + Metd and 5 eo@alpéveg amomelpeg EEKAEIGWHATOC TG CUOKEUNE, N 086vn
umokapel yla 30 Seutepohenta.

PUBuoNn ac@alol¢ ekkivnong
Otav, we pébodo Kheldwuatog 08ovng, emiéyete Motifo, Kwdikog KAeldwpatog
1N Kwdikd¢ mpdoBaong, pmopeite va SIapop@WOETE T GUOKEUN 00 WOTE Va
KAEISWVEL OTIOTE TNV EVEPYOTIOLEITE WOTE VA IPOOTATEVOETE Ta Sedopéva oag.
+ Méxptva EekAEIOWOETE T OUOKEULN 0ag, €V UIMTOPEITE VA XPNOIOTIONOETE TIG
AEIToUPYiEC TNG EKTOC MO TIC KAAOELG EKTAKTNG AVAYKNG.
« Yemepimwon mou EexdoeTe Tov KwdIKO mpoopacng ya v
anokpumtoypdenan, Sev Ba UMopE(Te va EMAVAPEPETE Ta KPUTTTOYPAPNHEVA
Sedopéva Kal T TPOOWTIKA GTOIElD 0.
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Mpo@uldéelg yia t duvatdtnta ac@alol¢ eKKivnong

- Yemepimwon mou EexdoeTe Tov KwdIKO mpooBaong yla Ty

QIOKPUTTITOYPAPN 0N, Sev Ba PMOPEITE VOl EMAVAPEPETE TA KPUTTTOYPAPNUEVA

Sedopiéva Kal Ta TPOOWTIKA OTolXEla 0.

Oulaooete Toug kwdiKoug TPOoBaong yia 1o KAeidwpa 086vng EexwpioTa.

Av MANKTPOAOYNOETE E0PAAUEVO KWOIKO TTPOOBACNS TTEPIOOOTEPEC

(POPEC OIS AUTEC TIOU £XOUV OPIOTEL, N GUOKEUN TIPAYUATOTOLE] AUTOHOTA

EMAVAPOPA OTIC EQYOOTACIAKES PUBITELS Kal SlaypapovTal auTopaTa

TUXOV Kpuntoypagnuéva dedopéva Kal TpooSWIKES Gag TANPOPOPIES, XWPIC

SuvatétnTa AvaKTNoNG.

Na €ioTe MPOCEXTIKO{ KATA TNV €l0aywyr Tou KwdiKou TpdoBacng yia 1o

KAeibwpa Kat To EekAeidwpa TNE 000vVNC, £TOL WOTE va NV El0aydyeTe

€0QANUEVO KWOIKO TIEPIOTOTEPEG POPEC O AUTEC TIOU £XOUV OPIOTEL

+ 'OTav evVEPYOTIOLEITE TN OUOKEUN Yla TTIPWTN YOPA AUECWG META TNV EMAVAPOPd,
EeKIvael TaUTOXPOVA Kal N KPUTTToypd@non. Av SIAKOYETE TV KPUTTTOYPA®non
auBaipeta, evoéxetal va mpokAnBei opdhua os Sedopéva. BeBaiwbeite Ot €xel
olokAnpwBei n emavagopd.

Mapapetpomoinon kKAedwpatog 006vng KAEIdwaATOG

Mriopeite va TposappOCETE TV 006V KAEISWUATOG.

1 Natiote O > PuBpioeig> Kheibwpa 006vng & acpaleia >
Mapapetpomoinon kAeldwpatog 066vng.

7 Em\é€te wia Aerroupyia mou BéNete va puBpioeTe.
+ MOVTO: Zag EMTPEMEL VA OPIOETE TO PAVTO Yia TV 086V KAEWSWHATOG 00IC.
+ PolOt: Zag emtpémel va opioeTe MoU va TOMOBETHOETE TO POAOL 0TV 086vN

KAEWBWUATOG,

+ JUVTOMEVOEIC: Zag EMTPEMEL va EMAEEETE TNV eQappoyn Tou Ba exteeoTel
oTnv 006vNn KAEWOWUOTOG oac. AuTH N pUBHION gival 0paTr LOVO OTav EXel
oploTei To KAeidwua 08évne.

« ZTolKEia EMAPNG OTNV EPITTWON AMWAELAG TOU TNAEPWVOU: Zag Sivel
n SuvatdTNTa va OpisETE Keipevo oTnv 086vn KAEWSWHATOC Yia Vot
TIPOOSIOPICETE TOV KATOXO TOU TNAEQWVOU.
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PuBpioeic ao@alol¢ KAeWbwuatog

Mriopeite va opioete aopaleic pubpioelC KAeWGWPATOC,

1 Natiote O > PuBpioeig> Kheibwpa 006vng & acpaleia > Pubuioeig
ao@aAoUg KAEWSwpaATOC.

7 Em\é€te wia Aerroupyia mou BéNete va puBpioeTe.
+ Na @aivetat o portifo: Zag Sivel Tn Suvatdtnta va epgavilete To potifo.

+ XpovodiakomTng KAEWSWHATOG: EMTPEYTE QUTOHATA TOV XPOVO Yia va
PUBHIOETE TO XPOVIKO SlA0TNHA TTPWV KAEIOETE TOV QWTIOHO (XPOVIKO Oplo
Moyw adpdvelag) Letd to KAeidwua.

To koupmi tpo@odooiag KAeldwvel oTiypiaia: Evepyomolote autr v
emAoyn yla va KAeISWOETE apéowg Tnv 006vn 6Tav TMECETE TO KOUKTT
gvepyomoinong / KAeldwpatog. Autr n puBuion uneploxVel TG pUBUIoNG
XPOVOSIAKOTTN KAEIOWHATOC A0PAAEiQG.

+ Epgavion emAoyng: Zag emrtpémel va epeaviCeTe Tnv emAoyr) Tou Hevou
10XV0G Yl TNV ammevepyomoinon eldomoloewv oTnv 006vn KAEIOWHATOG,
TNV AIMEVEQYOTTOINON TOU £§UMTVOU KAEISWHATOC KAl TWV BIOPETPIKWY
KAEIOWUATWV.

+ Smart Lock: Zag divel tn Suvatdtnta va opioete afldmoTn CUOKELN,
TomoBeaia, Guwvr Kat / 1} avixveuon oTo WA TIou Ba eMTPEPEL 0TO
TNAPWVO 0ag va mapapével EEKeISwEVo.

« To kAeidwua 006vNng pevol Tiou emMAEYETE Popei va SLlaépeL avaloya UE
I peBodoug 086VNC.
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Evepyomoinan 00dvng
MropEiTe va EVEPYOTIOINTETE I VA ATIEVEPYOTIOINTETE TNV 006VN pe SIMAS matnua
TAvW TG

E + Auti n emoyn givat Slabéotun pdvo otnv apxikr 086vn TN LG. Aev
\erToupyei owoTd o€ KAmola E181KN EQapuoyn EKKIVNONG 1] 0TNV apxIKn

086vn mou éxel eykataoTabei amd Tov Xprotn.

Ma va matioete Tv 006vn agrig, xpnotpomoloTe To SAKTUAG oag. Mnv

XPNOIHOTIOIEITE TO VUXI 0OC.

« [la va xpnotpomolroete T Aeitoupyia Evepyomoinon 08ovng, PePaiwbeite
OTL 0 AleONTHPAG yyUTNTAG/ PWTIoHOU Sev epmodieTal amd kamolo
QUTOKONANTO 1 GAAN §évn ouaia.

Evepyomoinon 00dvng
MotAote pe 1o SAKTUNS oag SU0 PopEC 0TN péan TG 086vNG.
« Edv natioete 010 emdvw 1 0TO KATW PEPOG TNG 006VNG, 0 Babudg avayvwplong
NG Kivnong evEEXETaL va NV €ival EMOPKNAG.

Anevepyomnoinon 006vng

Ayyi&te pe To SAKTUNS oag SU0 Popég Tavw O €va KEVO onpiEio 0TV APKIKH
0006vn kat otnv KAelbwpévn 0Bovn.

Eva\akTIkd, matrote 500 gopég o€ évav KEVO XWPO OTN YPauHr KATdoTaong.

Anevepyomnoinon Evepyomoinon 08ovng

Edv ev BéNete va xpnotpomoleite Tn Aertoupyia Evepyomoinon 086vng, kavte Ta
€ene

Natfote O > Pubpioeig > Emektdoelg > Evepyoroinon 086vng Kat 0UpeTé To,
WOTE VO OITEVEPYOTIOINOETE TN AEITOUpYia.
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Kpumtoypd@non Kaptag HVRPNG

Mmopeite va KpUTTOYPAPHOETE Kall VA TTPOOTATEVCETE Ta SedOEVA TTOU

amoBnKevovTal 0TV KAPTA MVAKNG. Agv givat Suvatr n mpooBacn amo AMn

GUOKEUN 0T KPUTTToypa@npéva Sedopéva otV KAPTa Pvipne.

1 Natiote O > Pubuioeic> Kheibwpa 086vng & acpdaheia > Kpurrtoypagnon

& Slamoteuthpla > Kpumrtoypdgnon kdptag SD.

7 AlaBAaoTe TV mapousiacn yia Ty KpUItoypaenon TS KAPTAg UvApng mou

eu@aviCetal oTnv 086vn Kal TatroTe ZUVEXELD YIa VA OUVEXIOETE.
3 Evepyomotjote pia emoyn kat ayyifte Kpunrtoypagnon:

Baoikég Aertoupyieg

+ Kpumrtoypd@nan véou apyeiou: yia va KPUTTOYPOAPHOETE HOVO

Ta Sedopéva mou amoBnKeUTNKAV 0TV KAPTA PVAHING HETA TV
KpurToypagnon.

+ MAPNE KPUTTTOYPAPNON: VL0 VA KPUTTTOYPAproeTe OAa Ta Sedopéva Tou

lval amoBnKeupéva oTnV KAPTA VNG T SeSopévn OTIyUN.

- E€aipean apyeiwv MOAUPESWV: yia Va KPUTTTOYPAPHOETE OAa Ta apKeia,

EKTOC AMO APXEIN TTONUPESWVY, OTIWG APXEIQ LOUOIKNAE, PUTOYPAPIWY KAl
Bivteo.

« Mg Eexvrioel n KpumToypdgnon TG KAETAG VNG, OPIOUEVEG
\ertoupyieg kaBiotavral un Stabéotpeg.

« Edv n ouokeun amevepyomnoinBei evw n kpumtoypagnon Ppioketat
o€ e€ENIEN, n Sladikaoia kpurtoypd@nong Ba amotUxel kat evoéxeTal
va KataoTtpagouv oplopéva dedopéva. MNa autd, mptv EEKIVACETE TNV
Kpumtoypagnon, eAéyEte katd mdoov n oTéBpn TG pmatapiag ivat
EMAPKNAG.

« Ta KpumToypa@nUEVa apxeia gival TPOoRAaIHa LOVO amd Tn CUOKEUR OThV
omoia £YIVE N KPUTITOYPAPNOT) TOUG.

+ H kpuntoypagnuévn Kapta pvipng dev pumopei va xpnatpomoinbei oe
AMn ouokeun LG. Ma va xpnotoToloETE TNV KPUITTOypa@npévn Kapta
MVIAUNG O€ KATola AN GUCKEUN KIVNTOU TNAEPWVOU, TIPETTEL VOl EKTENEDETE
pop@omoinon TG KApTac.

+ Mmopeite va evepyoTOICETE TNV KPUTTTOYPAPNON TNG KEPTAG PVANG
AKOUA KI OTaV SEV UTIAPXEL KAPTA UVAKING OTN GUOKEUT. KABe KdpTa puviung
iou Ba TomoBeTnBei peTd TV KpuTToypAPnon Ba KpunToypageiTal
autépara.
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AQUn oTiypiotunwy

Mmopeite va SnpioupynoeTe oTtyidTuma TG 006vng mou PAEMETE.

Méow ouvtopguong
MaTAOTE MAPATETAUEVA TO TARKTPO EVEPYOTIOINONG/KAEISWATOC KL TO TIARKTPO
MEIWONG TNG €VTaong YOV (-) Tautdxpova yia TouhdyioTov 0o SeutepOAenTa.
+ Mropeite va Seite Ta oTiypidtuna 08évng mou éxete Tpapnéel otov GAkero
Screenshots 010 pevoy AApmoup.

Méow tn¢ epappoyn¢ Capture+
Evw Bpiokeote otnv 086vn To oTiypidTumo TG omoiag BéNeTe va TpaPngeTe,
OUPETE TN YPapLN KATAoTAONE TIPOG TA KATW KAl TTATHOTE (2,

E « ‘Otav n 086vn givat amevepyomoinuévn 1 KANESwévn, Hmopeite va
QMOKTHOETE MPOGRACH 0TV Epappoyr Capture+ matwvtag SU0 PopEg
T0 MARKTPO aVENONG TG EVTaong XU (+). Ma va evepyoToIOETE QUTHV
n Aerroupyia, matiote O) > PuBpioelq > Enektdoeig > SUVTOUEDGEIG Kal
evepyomolroTe 1o Avolypa Capture+.
« Ta Aemrtopépeleg, avatpé€te oTn evotnTta Anpioupyia OnUEIDOEWY O€ éva
oTlypétumo 086vng.

Eicaywyn keipévou

Xprion TnG Ypaupng epyaleiwv Smart

Mriopeite va xpnotpomotioete Slapopeg peBoSouG e10aywyn¢ MANKTPOAoYiou GE

éva Pépog. Mmopeite va emAé€eTe TV emBUPNTA HéB0SO eloaywyng amd To endvw

U€POG TOU MANKTPOAOYiOU.

1 EmAé€re n péBodo sioaywync mAnktpoloyiou ou BEAeTe amd T yoauun
epyoheiwv Smart.

7 NatAote \/ kat emAé€te T uéboSo elcaywyng mou BéNete va eupaviletal oo
epyaleio Smart rj aAN&€Te T Sidtagn Twv peBddwv elcaywync.
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. Y e —
lpappy —— e © # ¢ @ v
epyaAeiwv Smart

E « To mAnktpoAdylo LG Sev gival n mpoemoyr yia 1o TNAépwvo oag. Mmopeite
val To EMAEEETE WG TPoemAOYI amd TiG PUBIcELS MAnKTpoAoyiou.

Oplopéveg umootnpi{opeveg péBodol eloaywyng evoéxetal va Slagépouv

avdAoya e T CUOKEUN 0aG.

Mmopeite va eVEPYOTIOIOETE I} VA OTTEVEPYOTIOIOETE TN AETOUpPYia

epyaheiou Smart amo Tig pubpioelg MAnKTpoloyiou.

« Mmopeite emiong va xpnoluomoloeTE TIG LEBOSOUE EI0AYWYNAE
TANKTPONOYiOL MATGVTAG 0TO §83.

- ©:Npoobrikn emojis.

« 22 :Npocbrikn cuvopNiag pe {wypagikn.

+ U :Notote O yia eloaywyr kepévou pe T xpron euvic.

[0 VOl JEYIOTOTIOIOETE TNV QVAYVWPLON QWVNTIKWV EVTONWY, TIPETEL VAl

WiAate kabapd.

- Tla €10aywyn KEWEVOU XPNOILOTOIWVTAG TN Ywvr 0ag, Beaiwbeite 6Tin

GUOKeLN 00 eival ouvdedepévn oe Siktuo.

Mo va eMMEEETE YADOOA YIa TN GWVNTIKY avayvwpion, matiote K¢ >

M\wooeg oTnv 006V PWVNTIKAG avayvwpiong.

AuTh n Aettoupyia pmopei va punv unmootnpietay, 1 ol umooTnPI(OMEVEC

YAMDOOEG EVOEXETAL VA SIaPEPOUV avANOYa HE TNV TTEPLOXT.

- §63: NMpodoBaon ot pubpioeig Mnktpooyiou.

. : Avolypa tou diokou clip. Na Aemtopépeleg, avatpédte otnv evotnta
Mpoxelpo.

. : Evepyomoinon Tou aiwpoUpevou MANKTPoAoYiou 6Tav XpnolpomoLETe
N Aerroupyia moMam\wv mapabupwv. MIopeite EMong va UETAKIVIOETE TO
TANKTPOAOYI0 0TNV emBuNTH Béon.
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Méow Tou mAnktpoloyiou Smart

Mmopeite va XpnotUOTOIOETE TO MANKTPOAOYI0 Smart yia va El0ayAyeTe Kal va
EMECEPYOOTEITE KE(UIEVO.

Mée o minktpoAdylo Smart, umopeite va BAEMETE TO Keievo KaBwG MANKTpoloyeiTe
Xwpig va xpelaletal va evaA\AooEeoTE avApesa 0Ty 086vn Kal To SUPBATIKG
TIANKTPOAOYL0. ME QUTOV TOV TPOTIO, UTMTOPEITE EVKOAX VA EVTOTTIOETE Kall Vol
S10pBwaoeTe AABN eV TANKTPONOYEITE.

Metakivnon tov dpopéa

Mé 1o MANKTPOAGYI0 Smart, WMOPEITE VOl LETAKIVEITE TOV SPopEd aKPIBWE 0N
Béon mou Béhete. Otav MANKTPONOYEITE KeipEVO, ayyi€Te Kal KPATAOTE TO IAKTPO
S100TAHATOC KAt 0TN CUVEXELD oUPETE Se€Id 1y apIoTEPA.

< Smart keyboard >

E « Auti n emoyn SlatiBetat povo yia to minktpoAdylo QWERTY.
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Mpotdoeig Aé§ewv
To mMAnKTpoAdylo Smart avalVel auTopaTa Ta HoTiBa Xpriong 0ag yia va oag
nipoteivel KaBwg MAnKTpoloyeite AEEeIC TTou xpnotpomoleite ougvd. Oco
TIEPIOOATEPO XPNOILOTIOLEITE TN OUCKEUN 0aG, TOOO TIO AKPIBE(C gival oL
TIPOTEIVOUEVEC NECEIC.

MANKTPOAOYNOTE KEIUEVO KAl TTATAOTE TIAVW OF L0 TIPOTEIVOUEVN AéEN 1y oUpETE
amald v aplotepn 1 T Se€1d MAeuPA TOU TANKTPOAOYIOU TIPOG Ta TAVW.

- Eloayayetat autopata n Aé€n mou eméyete. Aev xpetdletat va

TIANKTPOAOYNOETE £0EiG KAOE YpAupa auThG TG AEENG.

Smartphone smart  Smartphones Smartphone  Smar Sharibhohes

I'fl.lllll LI IL]]/ !

Mpoodrkn YAwoowv 0to MANKTPoAdylo

Mriopeite va mpocbéoeTe YAWOOEC yia €i0od0 MAnKTpoAoyiou.

1 Natiote O > Pubpioeig> Zootnua > Mwoca & mAnktpoldylo > Alayeipion
mnktpoloyiwv > MAnktpoAdyto LG > Nwaooa kat Aidra&n minktpoloyiou >
Emoyn YAwooag.

7 Em\éETe TIC yAWOOEC TIOU BENETE VOl KAVETE SIOBEDIEC,
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Avtiypagn Kat emKOANon

Mmopeite va amoKOYETE 1 va avTlypaPETE KEIEVO amo pia EQAPHOYH Kal, 0Tn

OUVEXELD, Va EMKONMAOETE TO Keipevo otnv ila epappoyn. H, umopeite va avoiete

ANNEC EQAPOYEC KAl VL ETIIKOMNIOETE TO KEIMEVO OE AUTEC.

1 Natote mapatetapéva og £va onueEio KOVTA oTo Keipevo mou BéAeTe yia
avTlypa®n iy amokor.

7 Zopeteta bpla @/ B yia va oploBetroete Ty epLoxr Tou Tipoopiletat yia
QVTIYPO®N 1) ATTOKOTTH.

3 Em\éCe eite Amokor eite AvTiypagn.
+ To Keipevo mou éxel eMAeYei yla avTlypagr| 1} AmOKOTT POoTiOETal

AUTOHATA OTO TIPAXELQO.

/' Natiote napateTapéva 1o mapabupo eloaywync KEMEVOU, Kal eMNEETE
EmkoAnon.

E - Edv ev undpyel aTotyeio Tou éxel emheyei yia avTypagn 1y amokor, n
emMoyr EmkoAnon Sev Ba epgavietar.

Mpoxepo

Otav éxete eMAEEEL pia EIKOVA 1 €Va KEIPEVO YA avTlypa@r 1 AmoKoTT, To
OTOIYEI0 QUTO AMOONKEVETAL QUTOUATA OTO TIPOXELPO Kal UMTOPE( va eMKoMNBei o€
OTIOIOSTTOTE GNUEI0 AVA TTACA GTIYHI).

1 10 epyaheio Smart, em\é€re [,

EvaA\aKTIKG, TaTAOTE MapateTapéva To mapdBupo Eloaywyng KELEVOU, Kal

emAé€Te Mpoyelpo.

7 Em\é€te Kal emKoAROTE éva oTolyEo amd To TIPOKELPO.

+ XT0 IPAXELPO UIOPOUV va amoBnKeUTOUV éwg 20 OTOIKEID.

- matfjote 1o koupri L3 yia va KAelboeTe Ta anobnkeupéva oTolyeia £T0L
WOTE Va N Slaypagouy, akOua Kal OTav UTEPREITE ToV PéYIoTo aplBpud
oTolxeiwv. Mmopeite va Kheldwoete éwg 10 oTolkeia. Na va dlaypdpete ta
KAeldwpéva oTolxeia, mpémel mpWTa va Ta EEKAEIOWOETE.

- TMatrote 1o Koupri {11] yta va SlaypayeTe Ta oTolxEla TTou £xouv
amoOnKeuTel 01O MPOKELPO.

E + H \erroupyia mpoxelpou evEEKETaL VAl NV UTTOOTNPIlETAL OO OPIoHEVEG
An@Beioeg epapuoyEg.
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Kot xprion mepiexopévou

Avamapaywyn meplexopévou amod AAAn cuokeun

Mriopeite va TpayLOTOTOICETE AvVATapaywyr GWToypapLwy, BIVTEO 1) LOUGIKAG

TIOU €XOUV AMOBNKEUTEL GTN GUOKEUN Ao pia TNAEOPAON.

T Zuvbéote v tn\edpaon kal T cLokeur) oTo ib1o Siktuo Wi-Fi.

7 Evw yivetai mpoBoli evog atolyeiou otnv epappioyr) AApmoup fi Mouaikr,
TIOTAOTE TO KouTi = > Avamapaywyn o& GAAN GUOKEUH.

3 EmAé€te v Aedpacn otnv omoia BéNeTe va ouvSebeite.

E « Ta xprion pe ouokeur Chromecast, ot urnpecieg Google Play mpémet va givat
EVNUEPWHEVEG.

MpoBoAn mepleXOUEVOU AMO KOVTIVEC GUOKEVE
Mrmiopeite va Seite mepiexdpevo amd SIGPOPES GUOKEVEG, TLY. UTTOAOYIOTH, CUOKEUN
NAS 1} opnTr) GUCKEUN), XPNOILOTOIWVTAS TIG EPAPHOYEG AAUIToup i} MOUOIKH.

Z0v6eon TwWV CUCKELWY

TUvSEOTE TN CUOKEUN 0ag Kal pia AN cUoKeLH Tou umooTnpilel Ty urnpecia
DLNA oo {610 acUppato Siktuo.

E « BePaiwBeite 6T n Aertoupyia kovng xpriong apxeiwv (DLNA) ivat
EVEPYOTTOINUEVN KAl OTIG SUO CUOKEUEC,

AvalfiTnon KovTIvWwV GUCKEVWV

Mriopeite va Seite pia Niota e Tig ouokeuég DLNA mou gival ouvdedepéveg oto
i510 diktuo emAéyovtag To pevol KovTivég ouokevég oe KABE Epappoy.
XpnotpomolioTe To TEPLEXOUEVO Ao TIG KOVTIVEG CUOKEVEC OTwE Ba To
XPnotomolovoate Qv BPIOKATAV 0TN SIKN GG GUOKEUN.
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Anootoli ) AN apxeiwv
Mmopeite va KAVETE Kolvr) Xprion apxeiwv HETAE TG GUOKEUNG 0ag Kat AANG
OuOKeUr¢ LG, tablet iy umoloyioTh.

Anootoln apyeiwv
An6 to Ahuroup 1y aré GAn epappioyn, tatiote + > Kown xprion 1 «< kat
eMAEETE Hia ouoKeur| amd T NoTa KOG Xpriong apyeiou.

AAYn apyeinwv

TUPETE TN YPOAUUN KATAGTAONG TPOG T KATW Kal TATAoTE To Koupri Kowvi Xprion
Apxeiou.

Eav n ouokeun oag dev umootnpilel TV KoV Xprion apxeiwy, MaTHOTE T0
eikoviio O) > PuBpioeig > Tuvbedepéveg ouokevéc > Kol Xpron Apyeiou >
SmartShare Beam Q).

E «+ BePawBeite 611 n cuokeur| oag eivat cuvdedepévn 0To 610 aclpPpATO
S{KTUO WE TN OUOKEUT TIPOOPIGHOU YIa T HETAPOPA TWV APXEIWV.
« BePawBeite 6L n Aertoupyia Koy Xprion Apxeiou givat evepyomoinuévn
Kaltl 0TIC 5U0 GUOKEUVEC,
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Eykatdotaocn Kot ameykataotach EQapHoywv

Eykataotaon epappoywv
Mrgite o€ éva KATAOTNUA EQAPHOYWV Yia VA avalnTHOETE Kal va KaTeRACETE
EPOPLOYEG.
- Mropeite va xpnotpomotrjoete 1o SmartWorld, To Play Store j To katdotnpa
EQPOPHOYWV TOU TIAPOXOU UTINPECIWV.

E « [0 opIoPEVA KATAOTAHHOTA EQAPHOYWY EVEEXETAL VA AMAITETAL N
Snutoupyia AoyaptaopoU Kai n 6UVEEDN OE AUTOV.

Tl0l OPIOPEVES EPAPHOYES EVOEXETAL VA UTIAPXEL XPEWDN.

« Edv xpnouomoleite Sedopéva kivntrg TnAepwviag, pmopei va emPBapuvBeite
E XPEWOELG Yia TN XPrion Sedopévwy, avaloya LE To TPOYPAUMA XPEWOEWY
TIOU éXETE EMAEEEL

+ HAeroupyia SmartWorld evééxetat va pnv umootnpietal avaloya pe Thv
TIEQLOXN 1 TOV TTIAPOXO UTINPECIWV.

Katdpynon eykatdotaong eQappoywv
Katapynote amo Tn OUOKEUN 0ag TV EYKATACTACN EQAPMOYWV TIOU Sev
XPNOOTOLOUVTAL TIAEOV.

AmeyKaTAOTAON HE MAPATETAUEVO TTIATNHA
TNV apxIkr 086vn, ayyi€Te Kal KpATHOTE MATNHEVO TO EIKOVIOIO TNG EQAPHOYAS
Y10 VO KATAPYROETE TNV EYKATACTACK TNG KA, £MEITA, OUPETE TO EIKOVISIO TAVW
otnv évdelén Alaypagr 0To Endvw PEPOG TNG 006vVNG.
- Edv ol epappoyég eixav ameykataoTabei Ti¢ TeheuTaieg 24 WPES, UMopEite va
TIC eyKaTaOTAOETE {aVd. MNa AEMTOUEPELES, AVATPELTE OTNV EVOTNTA JKOUTTISIOL
Epapoy.

AmneykatdoTaon Je Xpron Tou pevol pubpicewv
MNatAote To koupni O > Pubpiceig > Epappoyéc & eidomoiioeig > Mnpogopicg
€QAPHOYNG, EMAECTE Lia epappoyn Kat matioTe Katdpynon eykatdotaong.

E «Aev gival Suvatr| n KATAPYNON OPICHEVWY EYAPHOYWV ATTO TOUG XPHOTEG.
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Katdpynon eykatdotaong epappoywy and 1o Katdotnpa
£QApPHOYWV

Mo va KaTapyHOETE TNV EYKATACTACN HIAG EQAPHOYAG, UMEITE OTO KATAOTNHA
EQAPHOYWV ATTO TO OTTO{0 KATEBACATE TNV EQAPHOYN KAl KATAPYAOTE TV
€yKATAoTAOH TNC.

Eykatdotaon Kat Katapynon eyKataotaong EQapUoywv
Katd T puOuIon

‘OTaV EVEPYOTTIOIEITE T GUOKEUN IO TIPWTN YOPJ, UMOPE(TE va KATERAOETE TIG
TIPOTEIVOUEVEC EQAPOYEC.

Mmopeite va TapaKAUYETE AUTO TO BrKA KAl VA TIPOXWPNOETE OTO EMOUEVO XWPIG
V0l EXETE OAOKANPWOEL TNV EYKATACTACH.

Ikoumidia epappoy

Mriopeite va Seite TIC epappoyég o Exouv ameykataoTadei. Emiong, pmopeite va
ETTAVEYKATOAOTAOETE TIG EQAPLOYES TTOU £XOUV ameyKataoTadei Ti¢ TeAeuTaieg 24
WPEC.
T Ayyi€e Sadoxika O > Mayeipion > Zkoumidia epappoy.
Mmopeite akopa va ayyi€eTe pia Kevr TIEPLOXT OTNV apxIKr 086vn Kal va T
Kpatoete ayyiovag To Koupni Zkoumidia pappoy.
7 Evepyoroinon emBuuntrc Aerroupyiac:
- Emava@opd: emaveyKatdoTaon eMAEYUEVNG EQAPHOYNG.
« {Il] : KATAPYAOTE MOVILIA TIC AMEYKATESTNHEVES EQAPMOYEC QMO T GUOKEUN,

E + Ol ameEYKATETTNHEVES EPAPUOYEG KATAPYOUVTAL AUTOUOTA OO TN CUOKEUN
24 MPEC UETA TNV ameykatdoTaor) Toug. Edv BéAeTe va eykataoTroeTe {ava
TIG AMEYKATEOTNUEVEC EQAPHOYEC, Ba TTpémel va TiG KateBdoeTe Eava amd To
KOTAOTNHO EQAPHOYWV.

+ Auti n Aettoupyia givat vepyortoinpévn HOVo 0TV TPOEMAEYHEVN APXIKI

0086vn. Edv ameykabioTdte epappoyEg Katd tn xprion tng 08évng EasyHome
1} GAAOU TIPOYPAUATOG EKKIVNONG, QUTEC KATAPYOUVTAL OO TN GUOKEUN
ApEOWE Kal povIpa.
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ZUVTOUEVOELG EPAPHOYWV
TNV apxIkr 086vn, ayyi€Te Kat KpATHOTE MATNHEVO £val €IKOVISIO EQaPHOYNG,
onw¢ Ta eikovidia KAron, Mivupa, Kapepa, ANUmouy, PUBICELG, yia va @avIoTEi
70 avTioTolyo Hevou ypriyopng mpdoPaong. Kavte mo 0koAn T xprion
EQAPUOYWV A€IOTIOIWVTAC TIC CUVTOEVUTELS EQAPUOYWV.

- Matfiote & yio va pUBRICETE TIC TAPAUETPOUG YIa TNV EMBUUNTH EQAPHOYH

Tou widget.
+ Matfote (D) yia va Seite Tig TANPOQOPIEG yia TNV EMBUUNTH EQAPHOYH.

E +Autij n Suvatdtnta givat S1aB€otUN MOV Yia GUYKEKPILEVES EPOPHOYEG.
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TnAépwvo

Owvnuiki KARon

MpaypatomoloeTe TNAEQWVIKY KAON XENOILOTTOIWVTAG KATTOLA OO TIG
Slabéoipeg peBddoug, Gmwg TNV MNKTPOAOYNoN Tou aplBoU TNAEPWVOU HE TO
XEPL, Kat emAéyovTag pia emagr amd tn Aiota enagwv 1 T Aiota mpdo@atwy
KA OEWV.

Mpaypatomoinon KAGng amo 1o mMANKTPoAGylo
T Natiote to kovuni O > (W > Khijon.
7 MpaypatonolfoTte pia KAon xpnotpomolovTag t uébodo e emhoyrg oag:
« TAnktpoloyaTe évav apiBud TAe@wvou kai matiote To koupri (®.
« Ayyi€te Kat kpatoTe €vav apiBpd taxeiag KAong.
+ AvalnTAOTE Hia EMOQH TTATWVTAG TO APXIKO YPALA TOU OVOUATOG TG
EMAQPNE 0TN NOTA EMAPWY, KAl TIATAOTE TO KOUTT Q

E « [la va eloaydyete 1o oUPPOMO «+» OTav mpaypatomoleite SieBveic KAOELS,
TIOTAOTE MAPATETAPEVA TOV APIOPO 0.

« BA. [lpoafikn ema@wv yio NemTOUEPELEG OXETIKA LE TOV TPATIO TPOOBRKNG
apIBuWV TNAEPWVOL GTN NioTa HE TIG Taxeieg KAOELC.

Mpayparomoinon KAong ano tn Aiota emagwv
1 Natiote O> (W > Enagéc,
2 A6 T NioTa enagav, eMAEETE Lia EMAN Kal TATAOTE TO Koupi ...
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Andavtnon o€ KA\fjon

Mo va anavtioeTe o pia KAjon, oupete o koupri @ otnv 080vn eloepyopevng
Khnonc

'Otav gival ouvSedepéva Ta OTEPEOPWVIKA AKOUOTIKE, UMOPEITE va
TIPAYHATOTOIETE KAOEIG XPNOUOTIOIWVTAG TO KOUTT KAYONG/TEPHATIOHOU
0TO OKOUOTIKG.

Mo va TeppatioeTe pia KAon xwpig va k\eioete Tv 08vn, matrote Sladoxika
(> PuBpioeig > Aiktuo & Internet > PuBpioeig kKAjoewv > ATGvtnon Kat
TEPUATIOHOG KAJOEWV Kall, 0TN CUVEXELD, EVEPYOTTOIOTE TN SuvaTtotnTa
Teppatiopdg KAjoNnG pe To mMAKTpo Tpopodoaiag.

Anoppupn kKAong

Mo va anoppipeTe pia eloepXOUEVN KAoT, 0UpeTe To koupri @ otnv 0B6vn

E10EPKOHEVNG KAONG.

Mo va oteilete éva privupa amdéppiyng, CUPETE TV EMAOYH PNVOHOTOG

anopplll)nc o€ OAn TV 006vn.

la va mpooBEoeTe 1 va eme§epyaoTeite éva uvupa amdpping, matioTe T0

koupuni O > PuBpioeig > Aiktuo & Internet > PuBpiceig khjoewv > Opayr

KAong Kat amoppPn HE prvupa > ANdppIPn He VURA.

+ Katd tnv e10epxopevn KAon, MatAoTe To MARKTPO alénong TG évtaong nxou
(+), To M\KTPO pEiwoNg TG évtaong fxou (-) 1} To TAKTPO evepyomoinong/
KAEISWUATOG Yia 6iyacn Tou HXou KARoNG 1 Tng 6vnong 1y yia 6éon g kAfong
o€ avapovh.

‘EAeyx0¢ e10€pXOMEVNG KANGNG EVW N e@apuoyn BpiokeTal
oe Aertoupyia

OTav €XETE 10 EI0EPXOUEVN KAON EVW) XPNOILOTIOLEITE Hia EQappoyr, Ba
EUQaVIOTEL i avaduopevn €16omoinon 0To emdvw PéPog TG 08ovng. Mmopeite
va SeTEITE TNV KAON, VA TV amoppieTe 1 va OTEINETE urivupa amd Ty
avaduopevn 08ovn.

E « Matfote O)> Pubpiceic> Aiktuo & internet > Pupioeic K\joswy >
Npdobeteg pubpioeig > MAaioto avaduong e0epxdpevng KAong Kat
eMAECTE TOV TPATIO TTIOU BéNETE Va epPavieTal N El0EPXOUEVN KAjon 6Tav
XPNOILOTIOLEITE HIOt EQAPHOYN.
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MpoBoAn avamdvinTwv KAoEwV
Edv undpyxel avamavtntn KAon, N YPOLr KATtdoTaong 0To eMavw uépog Tng
086vn¢ eppaviCer v €voeign X,.

Mo va Seite oTolxEl YA TIC AVATTAVTNTEG KA OELG, CUPETE TN YPAUUK KATAGTAONG

TpOG Ta katw. Evalaktikd, matrote to koupni O > (W > Apxeia katayp. kKAio.

MpoaoBdoiueg Aertoupyieg Katd T didpKela KAoNG
Kartd tn Sidpketa piag kKAjong, pmopeite va éxete mpdoRaon oe B0
AEITOUPYIWV TTATWVTAG TA KOUMTTLA TIoU gpgpavifovtal otnv 08ovn:
Emagéc: Seite Tn Niota emagwv katd T Sidpkela piag KAjong.
« Avapovn: Kpatiote pa KAfon.
MANKTP.: Y10 VO EPPAVIOETE 1 va KPUYPETE TO TANKTPOAGYIO KAONG.
+ Hyeio: yla va evepyomolioete Tn Aeltoupyia nyeiwv.
Ziyaon: yla va TpayuaTomoloeTe 0iyaon 0To MIKPO@WVE 0ag €101 WOTE N
QWVI 060G VA UNV OKOUYETAL OTOV GUVOMIANTH 0aC.
Bluetooth: mpowBroTe Tnv kArjon o€ pia culeuypévn kat ouvSeSepévn
ouokeun Bluetooth.
« @ :yiava teppatioete TV KAAoN.

+ :mpdoPaon oe MpdoBete emAoyéq KAonG.

E « Ta dlaBéotpa otolyeia pubpioewv evoéxeTal va Slagépouv avaloya Pe Ty
TIEPIOXN 1) TOV TTAPOXO UTINPECIWV.

XpriolpeG papuoyeg
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Mpayuaromoinon TpiUePoUE KARONG
Mriopeite va mpayUaTomoIoETe KAMON G€ AN EMAQR Katd T SIGEKELD oG
KAjong mou Bpioketat o€ eEENEN.
T Katén 8idpketa piag kAfong, matfote to kouprni : > Mpoodrikn kKAjong.
2 Mnktpohoynote évav apiBpd TAepwvou kat athote To koupri .

+ O16vo K\joelg eppavifovtal oTny 086vn TauToXPOVa Kal N TPWTN KAjon

Umaivel o€ avapovn.

3 Tiava EekivAoeTe pia kAo ouvSIaokePng, ayyi€te Zuyxwveuon.

« Tla KOs KAjon evdéxetal va LoxUEL xpéwan. Ma TIEPIOCOTEPES TTANPOYOPIES,
GOUMPBOUNEUTEITE TOV TAPOXO UTINPECIWV.

Mpofoln apxeiwv KARoEWY
MNa va Seite Ta mo mpdogata apyeia kKhfjoewy, atiote 1o kovpni O > (9>
Apyeia katayp. KA. Emelta, Umopeite va XpnolUoTOINOETE TIG MOPOKATW
\ertoupyieg:
+ Tava Seite AemTopepéq LI0TOPIKO KAoEwy, eMAEETE pia emagn. MNa va
TIPOYMATOTIOIOETE Ia KAON TIPOG TNV EMAEYHEVN EMAPH, TIOTHAOTE TO KOUTT

- Nava daypdyete apyeia K\joewy, matAote + > Alaypagn.

E + H&1dpkeia KAjong mou epgaviletar evoéxetal va Slagpépel amd tn didpkela
L0 TV OTT0ia XPEWVEDTE. Ma TIEPIOTATEPES TTANPOYOPIES, CUMBOUNEUTEITE
TOV TIAPOYO UTTNPEDILV.
Agv gival Suvatr n amokatdoTaon Tou SlaypapuéVou I0TOPIKOU KANOEWV.
« Ta va mpocaprOoETE To PéyEBOC YPAUUATOOELPAG TWV NUEPONOYiwV
KAOEWV ) TwV EMAQWV, TETTE pe SUo SayTula fj am\woTe Ta SAxTUNG oag.

Alapdpewaon Twv emAoywv KARoNng

Mrmiopeite va puBioeTe Ti¢ SIAPopEC emAoYEC KAONG.

1 Natiote to koupmi O > (W > KAjon 1 Apxeia katayp. kKAjo.

7 Natiote o Koupri : > PuBpioei KANOEWV Kay, EMELta, SIapopewoTe TG
€MAOYEG CUMPWVA HIE TIG TTPOTIHNCELS GG,
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Mivupa

AmMoOoTOAA UNVUHATOG

Mriopeite va SnIoupynoETe Kal va OTEINETE UNVUKATA OTIC EMAPES 0O
XPNOILOTIOIWVTAG TV £Qappoyn «Mnvopata.

5 « [l TV amooToA LNVUUATWY 0TO EEWTEPIKO EVOEXETAL VAl LIOXUOLY EMTAEOV
XPEWOELC, M0l TEPIOOOTEPES TANPOPOPIES, CUMPBOUAEUTEITE TOV TIAPOXO
UTTNPECIWV.

1 Natiote to koupmi O > 6.
2 NatAote 1o koupn! G-
3 Opiote MapahATTTN Kot SNUIOUPYHOTE éval PVULa.
- Tia va pnotpomnotoete Ti¢ emhoyég ToNpEowy, TathoTe ().

- Ta va amoktroete mpdoPaon og MPOAIPETIKA OTOIKEID IEVOU, TATAHOTE TO
Koupri : .

A Em)\é€te 1o B> (AMOOTON) yia va OTEINETE TO PAVULAL.

Avayvwon pnvopatog

Mmopeite va Seite Ta unvOpaTa TTou €xeTe avTaMAEEL avd emaegn.
1 Natiote to koupmi O > 6.

7 Em\é€te wa emagr| amo tn \iota pnvupatwy.

Alapopewaon Twv pUBUIcEWY UNVUHATWV
Mmopeite va aMAEeTe TIC pUBUITELS aVTONAYAS UINVURATWY ETOL WOTE Va
QVTATIOKPIVOVTAl OTIG TIPOTIHAOELG.

1 Natiote to koupmi O > 6.
7 Natiote 1o koupni + > PuBuioeig amd Tn NoTa unvupdTwy.
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Kapepa

Ekkivnon ¢ kapepag

Mriopeite va TpaPriete pwtoypagia ry va eyypalete Bivieo yia va anabavartioete
ONEC TIC 0EEXOOTEC OTIYUES OQC,

Nathote 1o koupni O > ().

E « Tl amd T AqPn HIag pwtoypapiag 1 Tnv eyypaer evog Bivieo, okoumioTe

TOV QOKO TNG KAUEPAG HE Eva amalo mavi.

+ TPpocéTe va pnv AeKIAOETE TOV QAKO TNG KAHEPAG HE Ta SAXTUAG oag 1) GNn
&évn ouoia.

+ O1eKoveg mou mep\apBavovtal o€ auTd To eyxelpidlo xpriong pmopei va
Sla@éPouV amoé TNV MPAYHATIK) GUOKEUN).

« Mmopeite va mpoBANETE Kal va EMEEEPYAOTEITE TIG YWTOYPAPIEG KA TAL
Bivteo péow Tou ANUmoU. ol AeTOPEPELES, VOTPEETE 0TV EVOTNTA
Emokdmnon epappoyn¢ AAUmoup.

Baoikéc Aettoupyieg otnv e@appoyn «Kapepar

Mmopeite va tpapri&ete putoypagicg iy Bivieo emAéyovtag amd éva miBog

AELTOUPYIWV KAl EMAOYWY KAUEPAC.

1 Natiote to koupmi O > (&)

7 MNotiote () yia va BydleTe pia gwtoypagia fy matrote Bivreo > @ yia
€yypaon evag Bivteo.

AMayn TG ywviag
KAPEPQG.

EmAoyry/Akipwon —=

‘— Evai\
PUBHIONG XPOVOLETPOU. & va avn petagy

PTTPOOTIVIG Katl TToW
Evzp\(onoiqon 1] — kdpepag.
amevepyoTToinan GAAG. AN GLTOYPAPIGY.

Egappoyr epé —

QiNTPOU @I ke — AVOlyja Tou
AMayn emAoywy — AApTIOUp.
G KApEPAg.
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Ayn pwtoypaepiag
T EmAé€te pia Aerroupyia kdpepag Kat maTAOTE TAVW 0To BEUA EMTPEMOVTAG
0TV KAUEPQ va E0TIAOEL EKEL.

7 Matiote () yia va BydheTe pia pwtoypagia.

« Mmopeite emiong va matroeTe To MARKTPO avénong TG évtaong nxou fj 1o

TAAKTPO pEiwong Tng évtaong rxou yla va tpaPriete pia pwtoypaegia.

+ Mmopeite va TpaBr&ete pia pwtoypagia v ypagete Bivieo matwvTtag To

@® omv obovn.

E + MmopeiTe va EKTENETETE TNV EQAPUOYH KAUEPAG TTATWVTAG Ypryopa SUo
9opéc o miikTpo Tpogodoaiac. Matrote O > Pubpiceig > Emektdoeiq >
ZuvTopeloelq Kal YeTd matroTe Avolypa Qwtoypa@ikiig Mnxavig yia va
TNV EVEPYOTTOINOETE.

« ‘Otav n 08évn €ivat amevepyomolnuévn 1 KAESwEVN, Pmopeite va
EKKIVIOETE TNV KAUEPA TTATWVTAG SUO YOPEC TO TMANKTPO HEIWONG
Tne évtaong. Matiote O > PuBpioeig > Enektdoelg > ZuVTOpEUOEIG
kat Petd matrote Avotypa Owtoypagikig Mnxaviig QD) yia va ty
EVEPYOTTOINOETE.

Eyypaon Bivieo
1 Natmore O> (&> Bivteo kat matiote endvw o1o Bpa mou BéAeTe va
€0TIAOETE.

7 Ayyi€te 1o koupmi @ yia va eyypaypete éva pivteo.
« Nava tpaPnsete pia puToypagia Katd Ty eyypaer Bivieo, matioTe To
koupmi @.

- Tiava Slakéyete mpoowpvd Ty eyypagr Bivieo, matiote to koupri @.

[a va ouveyioeTe T eyypagr Bivieo, TATHOTE TO KOUWT @ .

Katd v eyypagr evag Bivteo, UMOpE(TE va TEVIWOETE fy va AoeTe SU0
Saytula yia peyeBuvon 1 opikpuvon.

+ Katd v eyypaon Bivteo, pmopeite va ayyi€ete Ty emBupnTr meploxn yla

va puBLicETE TN PWTEVOTNTA.
3 TaTAOTE TO KOUKT (= yial va TEPUATIOETE TNV £yypa®n Bivteo.

XpriolpeG papuoyeg
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Mpocappoyn Twv emAOyWV TNE KAPEPAS
Mriopeite va mpocappoceTe MARBOG EMAOYWV KAPEPAS AVANOYA HIE TIC

TIPOTIUNTELG 0aG.

Ayyi&te To koupmi 33 otV 086VN.

E + Ot 6108éo1peg emMoyéc Slapépouv avaoya pe TV EMAEYHEVN (UTPOOTIVA 1
TMow) KAUEPA Kal TV MAeypéVN AelToupyia Kapepag.

+ [J]: Aqun ewroypaeiag oto FullVision.
+ [0]: EmAéyer i Tipéc Tou Adyou SlaoTdoewv Kat To PEyeBog yia T Ajn

PWTOYPAPIWV.

+ [X: EmAéyel g Tipég yia Ty avduon kai 1o puéyeBoc yia tnv eyypaen Bivteo.

HDR

TpaBa ewtoypapieg pe {wnpd xpwaTa Kal Snuioupyei
€@é QVTIOTABIONG OKOMA KL OTAV Ol PUTOYPAPIES
TpaplouvTal pe KOVTPA WG, AUTEC Ol AEIToupYieg
TIapéxovTal amo Ty Texvoloyia upnAol Suvauikol E0poug
(HDR) pe TV omoia ivat eEonmA\iopévn n Kapepa.

E@appoyn 'Cheese'

TpaPn&Te QWTOYPAPIES LE PUVNTIKEG EVTONEC,

TomoBsaia eTIKETAC

AnoBnkeVel T eKova el0dyovTag Ta Sedopéva
TomoBeaiag GPS.

MAéypa

Eugpaviote otnv 086vn kaBodnyntikd miéypata yia Mjyn
QWTOYPaAPIWV fj eyypaen Pivieo Bdoel Twv opi{ovTiwy Kat
KOATOKOPUPWY YPAPUWY avapopdg.

AmoOnKeUTIKAG
XWpog

Em)é€te edv BéNeTe va amoBnKeVETE TIC PWTOYPAPIEG KaL
Ta Bivteo otov Eowtep. amob. xwpog i otnv Kdpta SD.
(AatiBeTan otav éxel TomoBenBei KApTA PVARNG).

BoriBeia

Mapéxel BorBeta yia kdBe pevou Tng Kapepag.

Mpdabeteg emAoyég 0TV PMPOCTIVA KAMEPQ

Tpapnéte pia selfie emAéyovrag eite A pE XElpovopia

Selfie XePLoU gite Autopatn Ajyn.
Amnobrkeuon AMOBNKEVEL TIG EIKOVES WG AVOOTPAUMEVES apoU TpaBri&et
avaoTPoYrg selfie.

XpriolpeG papuoyeg

78



AN\ayn ¢ Aettovpyiag Kapepag
Mrmopeite va emAéEeTe ia Aermoupyia Kapepag mou va Taptdlel oto mepiBaiov
MUNG yia va TpapréeTe pwTtoypaia fy va eyypAaveTe BIVTED LIE EUXEPELD KAl AVEDT.
Ayyi€te ta eovibia O > (2) > Meproodtepa kat emAé€te T Aettoupyia mou BéeTe.
+ Mmopeite va aMAEETE TN 0€1pA TWV AEITOUPYILV OKNVWV PETAKIVOVTAG TO
€1koVib10 AeIToUpYiag oKNVAC EVW TIATATE TAPATETAPEVA TO EIKOVIOIO0.

Ald@opeg AerToupyieg KApepag

Mavépapa

Mmopeite va SnUIOUPYATETE A TAVOPAUIKH QWTOYPAPI METAKIVIOVTAC TNV

KAMEPQ TTPOG Miat KATELOUVON YIo AP PWTOYPAPIWV KAl GUPPAPH TWV CUVEXWY

MUewv piag evpuywviag mPoPBoAng.

1 Natiote O > (&) kay, 0t cuvéyela, matiote NMepiocétepa > .

7 MatioTe 10 Kouumi () Kal, £METa, METAKIVAOTE TV KAPEPX TIPOG Wiat
KatevBuvon.

+ MeTaKIVAOTE TN GUOKEUH akoAouBwVTag TV KateuBuvon tou BéNoug otnv
KaTeuBuvTAPIa PPN

3 Ayyi&re 1o koupmi @ yia va SakéyeTe T mavopapikr Aqyn.
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Oaynto
Mropeite va TpaPri&ete pia ewtoypagia rj éva Bivteo mpooapuolovtag To xpwua
Ka TV loopporria AeukoU amd 1o PUBUIOTIKO.
1 Natote O> (&) kay, 0T ouvéxela, matrote Mepioodtepa > SL.
7 Matiote () yia va ByGAeTe pia pwtoypagia.
+ YUPETE TO PUBMIOTIKO XPWHATOG 0TNV 086VN YIa Va TTPOCAPHOCETE TV
10opporia AeUKoU Kal va EMAEEETE TO KAAUTEPO XpWHA.

+ EAv T0 pUBLIOTIKG eV EUQAVIOTE, TTATAOTE S0 YIa VA TTPOCAPUOCETE TV
1oopporia Aeukou.

lprivopo @hag
Ot pwtoypagieg mou AapBavovtal g€ Kavoviko Slaotnua amodnkelovTal wg
apyxeia GIF.

1 Natiote O > (&) kay, 0T cuvéxela, matiote Meplooétepa > KA.
7 Matiote () yia va BydAeTe pia pwtoypagia.

- Otowroypapieg AapBavovtal kabe 3 SeutepOAemTa Kal amobnKevovTal wg
apxeio GIF.

« Ayyi€te [ZJ v 006vn yia va eMMEEETE TOV APIBHO TWV YUTOYPAPILV TIOU
Bé\ete va TpaPniete.

« Katd ™ Mjyn ewroypagiav, matiote @ yia va Snuioupyroete apyeia GIF
HE QuTOypaPieC ToU €xeTe TPaBrEel 0To MaPENBOV.

E + To (g eVEPYOTIOLEITAL AUTOMATA YA VA AEITOUPYOEL WG XPOVOUETPO.
+ AuTA €ival n AN kat 0 6UVOAIKOG apBOG Twv AYEwWY TTou epgaviovat
Katw amd v 0Bdvn.
« 'O)eg o1 e1KOVEG TTOU 0LV An@Bei amoBnkevovTal povo we apyeia GIF.
« Aev pmopeite va alagete T Taxutnta GIF oUTE TV OElPd EIKOVWV.

Macro

Mmopeite va BydAeTe KOVTIVEC QWTOYPAPIEC EVOC BEpaTOC.

1 Nathote O> (&) kay, 0Tn ouvéxela, matrote Meplocdtepa > @,
7 Matiote () yia va ByGAeTe pia pwtoypagia.
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YouTube Live

Mriopeite va kataypAyeTe éva Bivieo kal va To amooTeileTe ameubeiog oTo
YouTube.

1 Natote O > (E), ot ouvéxela matiote Nepioodtepa > (o).
7 MatioTe T0 KOUWTTE »  Kal eyypaYTe éva Biveo.

« Ta va xpnolgomolnoete autryv tn duvatdtnta, Ba xpelaotei va
eMPePRAIWOETE TOV TNAEQWVIKO 0ag apiOpo.

E « To YouTube Live givai S1aBéotpo povo 6tav n GUCKELN 0ag ivat
ouvdedepévn oo dladiktuo. Edv xpnaotpomoleite dedopéva KivnTrig
TNAEQWVIOC, UMOPE Vol EMBAPUVOELTE [E XPEWTELS yia TN XPrion SeSopévwy,
QVANOYQ HE TO TIPOYPAMMA XPEWTEWV TTOU EXETE EMAECEL

Moptpaito

Mriopeite va TpaPr&ete eukpiveig ikoveg pappolovTag To Qavopevo BoAwong
@aKOU TNG KAUEPAC.

Mo AemTopépeleg, avatpédTe otnv evotnta [loptpaito.

Al CAM

Mmopeite va ByaleTe 16avikéc pwToypagieg iy Bivteo kabwg n kdpepa avayvwpilel
TO QVTIKEipEva Katd Tn ewtoypagia ry To Pivteo.

Mo NemTopépeleg, avatpé€te otnv evotnta Al CAM.

AM\EC XpOIHEG AEtTOVPYiEC OTNV e@appoyn «Kapepar»

K\eidwpa autépatng ékBeang/autopatng eatiaong

Mmopeite va TPooapHOOETE To TpéKov eminedo £kOeong Kat T B€on oTiaong
TIOTWVTOC TAPATETANEVA TIAVW 0TV 086vn oTnv Autdpatn Asrtoupyia. MNa va
amevePYOTOINOETE TN AEIToUpYia, ayyi&Te pia Kevr TTEPLOXN TNG 086vVNG.
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E + Auti n Suvatdtnta eivat S1aB€01UN MOVO GE GUYKEKPIUEVES NEITOUPYIEC,

MoA\armAf AN
Mmopeite va Tpapri&ete ouveyeic APEL GWTOYPAPIWY Yia VA SNUIOUPYHOETE
KIVOULEVEG EIKOVEG.
TNV QUTOHATN AEITOUPYIa, TIOTAOTE TAPATETAMEVA TO KOUMTT
- [paypatomololvTal GUVeXEIC AMYELC e ypriyopn TaXUTNTA VW Eival TATNUEVO
TO Koupi

Evalayn peta&d kapepwv

Mriopeite va evaAdooeTe T Asttoupyia HeTagy TG EUMPAC Kall TTiow KAUEPAg yla
va taiptadel oto mepiBAAov Mjuing.

TV 086vn TG KAPEPAC, TATAOTE {0} ) HETAKIVOTE TNV 086VN EMAvw i) KATW yia
evaayr| LETAgY TE UMPOOTIVAC KAl TTIOW KAUEPAC.

<ans

+ XpnolyomoIoTe TV umpooTiviy Kapepa yia va tpaBri&ete selfie. Na
Aemtopépeleg, avatpé€te oty evotnta Selfie.
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MeyéBuvon 1 opikpuvon
Mriopeite va peyeBUVETE 1} va GIKPUVETE TV 006vN TNG KAKEPAG KATA TN AN
QwToypagiag i v eyypaen Bivteo.
+ XV 084vn TG KAPEPAS, EVWOTE 1) avoifTte Ta G0 SAKTUAG 0ag Yia GpIKPUVON
1} ueyeBuvon. H, xpnotpomolwvtag T ypappr poBuiong mou epgavietal
otav petagépete 10 (4) / (#) poc Ta Tavw, KAVTE pey£Buvon 1 GHikpuvon Kat
evahayr HETAgY TG TUMIKAG Kal TG EVPEiag ywviag.

E + HAerroupyia peyéBuvong/opikpuvong Sev eival Slabéoiun otn Aerroupyia
selfie (umpoaoTivi kdpepa).
« Auti n Aertoupyia Sev umooTtnpileTal 0€ APKETEG KATAOTATEIG AETOUpYIaC.

Selfie
Mmopeite va XPNOIUOTIOIOETE TNV UITPOCTIVI KApEPA Yia va Seite To mpdowmnd
oag otnv 086vn kai va paPriéete selfie.

AAYN pe Kivnon Tou Xeplov
Mriopeite va TpaPriéete selfie Sivovtag evTohég e amAEC KIVROELS TwV XEPLWV GG,
AvoiTe TNV TOAAWN 0OC OTPAMEVN TIPOG TNV MITPOCTIVH KAEPQ KA, EMTELTA,
KAeioTe Ta SAKTUAG 0ag o€ ypobid.
Mriopeite akopn va kAeioete Ta SAXTUAG 0ag o€ YpoBid Kal va Ta avoi§eTe TPOG TN
UMTPOOTIVH KApEPQ.

« YeTpia SeuTePONETTA TTPAYUATOTIOLETAL AN QWTOYPAPIAG.

3

i
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5 « [la va xpnolpomoloeTe autrv T Aeitoupyia, YeTapeite otn Aettoupyia
HITPOOTIVAG KAHEPAG KA, OTN OUVEXELD, ayyiTe Slasoxikd §3 > Selfie >
AAYN pe xelpovopia xeptov.
« BePawBeite 6Tt n maAdun oag kat n ypobid oag BpiokovTat Eviog TG
YPOUUAG QVapOPAS VIOl VO UTTOPEL N KAPEPA VA TIG avaYVWPIOEL.
« Auti n Aertoupyia evoéxetat va uny gival SLlaBEotun 6Tav xpnotUoToLEiTe
OPIOPEVES a0 TIC AEITOUPYIES TN KAEPQG.

Autopatn Aqgn

Mriopeite va XpnOIOTIOOETE TN AEITOUPYIQ AViXVEUONG TIPOCWTTOU YIa VAl

Tpapnéete selfie ypriyopa ki e0koha. Mmopeite va puBicETE T GUOKEUN £TOL

WOTE, OTAV KOITATE TNV 086VN, N UMPOCTIVH KALEPQA QVIXVEVEL TO TIPAOWTO GAG Kt

Tpapdel autdparta pia selfie.

+ MONG n PmpooTiv KApEPa avixveloel To IPOOWO oag, epgaviletat éva

Aeuko maiolo-o8nyoc. Eav o Bépa evtdg Tou mhaiciou-o08nyol otapatrioel
Va KIVEITAL, TO XpWHA TOU MAQLGIoU-08nyoU YIVETaL KITPIVO, KAt TOTE N KAKEPQ
Tpapdel pwToypaPia.

I_;r] « Ayyi€re S1a801kd $03 > Selfie > Autépatn Ayn yia va evepyomolioeTe T
Aertoupyia «Autopatn Ajwny.

MeooSiaotnua AqYng
Mrmopeite va tpaPriéete selfie pe xpovikr améotaon Hetady Touc.
Ev XpnOIHOTIOIETE TNV UMPOGTIVI KAPEPQ, AVOIETE TNV TAAGUN 0AG OTNV KAHEPQ
Kal, €metta, KAgioTe Ta SAKTUAG 0ag ypriyopa o€ ypoBid emavaappdvovtag thv
id1a kivnon dvo popéc.
+ ©a AneBouv TéooepIg wToyPaPie SladoyIKa META amd KaBuoTEPNON TPIWV
SeuTEPONEMTWV Yia KaBepiaL.

AnoBnKevuon avaotpoPig
Mpwv TPaBAEETE LA GWTOYPAPIX e TV UTPOCTIVH KAMEPQ, QYYIETE TO KOUWTTT §G3 >
Amnobrkeuan avaotpo@n¢. H eikdva avaotpépetal oe opllovtio dova.

E « Katd m xprion TG WmpooTiviG KAUEPAG, UMOPE(TE va AMAEETE Tov TpOTo
Mg Twv selfie oTig emMoyég kapepag. MNa AemTopépeleg, avatpédte oty

evétnta lMpooappoyr) Twv emAoywv ¢ KAUEPAG.
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ypriyopn Kotvormoinon

Mriopeite va KoVOTIOINOETE ia pwToypaia fi éva Bivieo otnv epappoyr mou

BéNeTe apéowg HETA T AYn Toug.

1 NavatpaBigete pwtoypagia ry Bivieo, matiote 1o kouuni O > (2.

7 Ayyi€te 1o elkovidio TNC epappoyrg mou epgaviletal otnv 086vn yia va 1o
KOIVOTIOIOETE PEOW TNG EQAPHOYAG.
Mmopeite emiong va oapwoeTe To €1Kovidlo mPog T avTiBetn kateubuvon
yia va Seite Toleq AANEC EQAPUOYES UMTOPEITE VA XPNOIOTIOINTETE Yia VAl
LOlPACTEITE TIC pWTOYPAPIES Kal Ta Bivied oag.

£IKOVidI0

yprivopn
KOIVOTToinaon

)

(<]

E « Hepappoyn mou epgaviel To ekoviblo ypriyopn Kovomoinon Umopei
va Slapépel avaloya Ke Tov TOTIO Kal TN GUXVATNTA IPOGRACNHS Twv
EQAPHOYWV TTOU £XOULV EYKATAOTAOE! OTN GUOKELN).

« AutA n duvatotnta gival SlaBéotun HOVO O GUYKEKPIUEVES AETOUPYIEC.
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ANUTTOUM

Emokomnnon epappoync AApmoup

M TI¢ pwToypapieg Kat Ta Bivieo mou €xouv amoBnKeUTEN 0T GUOKEUH Gag
napéxovtal Suvatdtnteg mpoPBoAng kal SLaxeipLong Toug.

1 Natiote to koupmi O > Y.

+ Orpwtoypaeieg kai Ta Biveo mou €xouv amoBnkeuTei ppavifovat
Tagvopnpéva avd GAakeAo.

7 Matiote évav pAkeAo kat MAEETE éva apyeio.

+ TpoBaNete To emAeypévo apyeio o€ Aertoupyia mrpoug 0B6vnc.

+ Evw) PAémete pia pwtoypagia, capwote Se€id iy aplotepd yia va Seite v
TiponyoUEVN A TNV EMOUEVN QWTOYpaPiaL.

+ Evw BAémete éva Bivteo, oapwoTe SeE1A ) apLOTEPA VI VA TO UETAKIVIOETE
TIPOG Ta EUMPAG A TTPOG Tal TTOW.

+ Mmopeite va mpoBaeTe pwToypagieg iy Bivieo mou opyavwvovtal and 1o
£70¢, privag 1 npépa otnv kaptéda Dwtoypapieg.

« Ta va mpoPAaAete TIC pwTtoypagieg katd Tomobeoia otnv omoia AjeOnke n
owroypagia, natote O > () > £33 > Tomobeaia eTikéTag, 0T OUVEKELD,
natote QD). Ot pwtoypagieg opadomolovvTal autopata amod T Béon
KATw amo v kaptéAa MvAun tne pappoyng MNkahepi.

E + Oplopéveg HOpPEG apyeiwv evdéxetal va unv umootnpifovtal avdhoya pe To
EYKATEOTNUEVO AOYIOUIKO.
« Evdéxetal va pnv ivat Suvatd to dvolyua opiopévwy apyeiwv e€artiog tng
KwSIKOTOINGM ¢ TOUG.

+ Apyxeia mou umepPaivouv To EMTPEMOHEVO Opl0 PeyEBOUG evdéxeTal va
TIPOKAAETOUV GQANUATA.

« [pémel va evepyorolroete tn Aertoupyia GPS yia va dnuioupyrioete éva
GATTOU PVAHNG.
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MpofBoAn pwToypagiwv
ExkivijoTe To Google
Lens.

I —— MpoaBrikn A katdpynon
amo Ta ayarnpéva.

- ﬂpécﬁgcn o€ GAeg

EmoTpogn otnv -
TIponyoUpevn 086vn.

€TMAOYEG.
‘Evapgn Tng Kapepag.
Anpioupyia I ] Aaypagr eIKOVWY.
ONUEINOEWV OE Hia
puToypagia.
Emegepyaoia eikovwy. Ko xprion eikdvuwv.

E « Tla va epgavioeTe Ta oTolygia Tou pevou, ayyi€te amala v 086vn. Mo va
QMOKPUYETE Ta GTOIE(D TOU pevoU, ayyi€te Tnv 086vn §ava.

Avamnapaywyn Bivteo

Avoipya pe QSlide.

& MMpdoPaon o€ Gheg
€TMIAOYEG.
i« ———— [priyopn mpowenon

St § — T0U BivTeo.

Mavon A
avamapaywyn Bivreo.
EmoTtpoer| Tou
Bivteo otV apxr.

Emidoyr) avaloyiwv —  i— KAeidwpa iy
086vng. Gekheidwpa 086vng.
DTS:X 3D Surround. Emegepyaoia Bivreo.
Anpioupyia apxeiou
GIF.

E « Tla va puBpioete TV évtaon tou o, TpaPnte t 6e§id meupd otnv
0006vn evog Bivteo mPog Ta KATW 1) TPOE Ta MAvVW.
« [0 va puBHICETE TN PWTEVATNTA TNG 006VNG, CUPETE TNV APLOTEPT TTAEUPA
oTtnv 066vN TPOG Ta EMAVW 1) TIPOE TA KATW.
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Eneepyaocia Bivieo

1 'Oco BAénete éva Bivieo, matrfiote To Koupri .

7 Mnopeite va xpnoionorjoste mhBog epé kai epyaleiwv enefepyaciag yia va
eme€epyaoTeite To Pivteo.

PUBpion Tng
avaAuong.
Enqva(pc):;\)d ™mg l g\unﬁumq
aAayng. nuioupyia
3 BivreokAitT 15, 30

60 beur.

; . o
b e mnanannn = — |1000CPLOYI TG
17 Sidpkelag Bivreo.

EmiAoyn evétntag
yia aAAayr Tng -
TaxuTNTOG

avaTrapaywyng.

3 Martfote AmoBAKEUON yia va anobnKeUoeTe TIC AAAQYEG.

Anpioupyia Tawviag
Mmopeite va SnpoupyRoETe pia véa tavia ouvdualovTag IKOVEG Kat Bivieo.
Mo NemTopépeleg, avatpé€Te 0TV evoTtnTa Anuioupyia taivia.

Anpiovpyia GIF

Mrmopeite eUkoAa va SnpioupynoeTe éva apyeio GIF xpnoluomolwvTag
nxoypagnuévo Biveo.

Mo AemTopépeleg, avatpé€te otny evotnta Anuioupyia GIF.
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Awaypa@n apxeiwv

Mmopeite va SiaypAaeTe apxeia XpNOILOTOIWVTAC Ui ard TIG TAPAKATW EMAOYEG:

MNatrote mapatetapéva mdvw o€ éva apxeio amd tn Niota apxeiwv kay, merta,
emAéCte Alaypan.

MatioTe 1o Koupn [11] ané tn Niota apxeiwy kat Slaypdwte To emBupntd
apyxeio.

Ta Siaypappéva apxeia petapépovtal autdpata otov Kado amoppippdrwv
Kal Hmopouv va avaktnBolv eMOTPEPovTag 0TO ANUTTOUM EVTOC 7 NUEPWV.
MatAoTe T0 KO [x] yia va SlaypAageTe povIHa Ta apyeia. S€ QuTAY TV
mepimTwon, Ta apxeia dev umopolv va avaktnBolv.

Kown xprion apxeiwv
MmopeiTe val KOIVOTIOIOETE £Val APXEIO XPNOILOTOIWVTAG Hial armd TIG TApaKATw
EMNOYEC:

- BAémovtag pia gwtoypaeia, ayyi€Te To KO o< yia va KOWVOTIOOETE TO

apyeio xpnotpomolwvtag T uéBodo mou BéAeTe.

- BAémovtag éva Bivieo, ayyi€te o koupmi ¢ > Ko Xp yia va KOWOTIOIOETE TO

apyeio xpnotpomolwvtag T uéBodo mou BéAeTe.

- NatAote 1o koupi o< amd T AioTta apyeiwv yia va en\éEete éva apyeio katva

TO KOIVOTIOIOETE XPNOIUOTIOIWVTAG TN HEB0SO ou BéNETE.
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Emagéc

Enagéc - Mapouoiaon
Mriopeite va amoBnKeVoETe Kal va SIAXEIPIOTEITE TIC EMAPES.
Ayyi€te Siadoxikd O > Ta amapaitnta > Enagéc.

MpocOnkn emagwv

MpooBnKkn véwv emagpwv
T Zv 0B6vn e Niotag Mgy, mathoTe To KOUUTT—-.
+ Oa gppaviotei éva avadudpevo mapdBupo yia va emiéEete T Béon
amoBriKeuong yla va Tnv Kovorolroete. EmAEETe Tn B€on mou BéheTe.

7 Eloaydyete ta otolyeia enmkowwviag kai matote AmoBrikevon.

Eicaywyn emagpwv

Mmopeite va eloayayeTe emagég amo i GAAn GUOKEUN amoBrikeuonc.

T Zmv 086vn ¢ Niotag emagav, ayyi€te ladoyikd = > Alaxeipion enagwv >
Ewcaywyn.

7 Em)\é€te TIc TomoBeaieC poEAELONC Kal TTPOOPICHOU Yia TV EMAQH TV
mipoopiletal yla elcaywyn kai matriote OK.

3 EmMé€te TIC emagéc kat ayyi€te Eloaywyn.

MpocBrikn ema@wv otn Aiota Tayesiag KAjong

T Zmv 086vn e Niotag enagav, TatioTe 1o koupni + > Tayeia KAjon.
7 Ayyi€te NMpoaBrkn ema@ic and évav apiBuoé Tayeiag KAGonc.

3 Em\é€te pua emagn.

« ‘Otav mpooBETeTe pia KavoUpyla emagn, TaTHoTE (57 yia va mpooBéoete
évav aplBuo tayeiag KAong.
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Avalntnon emagwv
Mmopeite va mpaypatomoloete avadtnon MA@V XpNOOToLWVTag pia amd Tig
TOPAKATW EMAOYEG:

+ MotAoTe T ypaupur avaditnong oto endvw PéPog tng 08évng Emaguv kat
EI0AYETE TNV EMAPH ) TOV APIBUO TNAEPWVOU Yia Ta omoial BENETE va KAVETE
avalrtnon.

Mpaypatomnotiote KUAIoN TG NOTAC EMAQWV TIPOE Ta TIAVW 1 TTPOG TA KATW.
« A6 10 EUPETAPIO GTNV 006VN TNG NOTAG EMAPWY, EMAECTE TO APXIKS YpAppa
yia pia eman.

E « Eav matrioete ot ypappn avalitnong oto emdvw uépog tng 08ovng
Ema@uv Kat E10AYETE pia emagn 1 évav apidpd Aepwvou, Ba eupaviotouy
Ta anoteNéopata avalfitnong amd To (0TopIkd KARCEWV Kal T AioTa
EMAQPWV TIOU Eival amoBnKeUPEVN 0T GUOKEUN.

Niota ema@wv

Ene€epyacia emagpuwv

1 Zmv 006vn e NoTag emagwy, eMAEETE pia emagn.

7 v 086vn Twv OTOIXEIWV WOG EMAQAC, TIATAGTE TO KouuTi /2 Kat
€MECEPYAOTEITE Ta OTOIYED.

3 MNatAote AMoBAKELVON Yia va anoBnKeUoeTe TIC AANAQYEC.

Awaypa@n emagwv
Mriopeite va SlaypAYEeTe EMAPEC XPNOILOTIOIWVTAC Lidl Ao TIC TAPAKATW
EMNOYEC:
+ XV 084vn Tng NioTag EmMagy, ayyiETe Kal KPOTHOTE TV EMAPN TIou BEAETE va
SlaypAYETE Kal, 0N OUVEXELD, ayyi§Te Alaypa@r ETAQAG.
- Ayyite Siadoyikd + > Alaypagr mou Bpioketat oTnv 086vn NoTag emagav.

E Ol amoUAKPUOHEVEG ETTAPES EVOEXETAL VA NV AITOKATAOTABOUV.
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Mpocbrkn ayammpévwv

Mmopeite va KATaxWPICETE TIG EMAPES TTOU XPNOLUOTIOLEITE GUXVA WG AYATTNEVEG.
71 Zmv 006vn e NoTag ema@wy, emMAEETE pia emagn.

7 v 0B6vn Twv OTOIXEIWV WOG EMAQAC, IATAGTE TO KOUTT Y.

Anpioupyia opadwv

T T Nota tg opadag enagiv, natiote —-.

2 MAnktpohoyroTe éva véo dvopa yia Ty opdda.

3 Natfote MpooBikn pehwv, em\éEte emagéc kat matriote MpoaBrkn.
/' Natriote AmoBrikeuon yia va anoBnkeVoeTe T véa opdda.

QuickMemo+

Mapouaiaon TG e@appoyng QuickMemo+

Mriopeite va @TIAEETE SNUIOUPYIKES ONUEIWOELS XPNOILOTIOIWVTAG TV YKAUA
emAoywv mou S1aBETEL AUTA N TIPoNYUEVN SuVATOTNTA TOU ONUEIWHATAPIOU, OTTWG
n Siaxeipion ekévwv Kat otiypdtunwy. Ot emioyé auté Sev umootnpilovtat amd
TO GUUPBATIKO ONUEWUATAPLO.

Anpioupyia onueiwong

1 NatAote to koupmi O > QuickMemo+.

2 TNatrote 1o koupni @ yia va Snuioupynoete pia onpeiwon.
+ V- anoBrikevon onueiwong.
+ €5 Avaipeon Tng mponyoUpevNng evépyelag megepyaciag.
> EmavéAnyn Twv Mo mpdo@atwy eVEPYEIWY Slaypaprc.
- T: eiloaywyn onueEiwong XpNOIHOTOLVTAG TO TTANKTPOAGYLO.
-/ :6nuioupyia XEPOYPAPWY ONUEIWOEWV.
- & : Blaypagn XepOYPAPWY ONUEIDTEWV.
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« {7 : ueyéBuvon 1y opikpuvon, TEPIOTPOPR 1y Slaypagr onueiwy piag
XElpOypagng onueiwong.
: :Mp6oPacn oe AAEG eMAOYEC,.
3 MatioTe 10 Koupni N~ yia va anoBnKeUoeTe T onpeiwon.

Anuiovpyia onuelCEWY o€ éva oTIYUOTUTIO 006VNG
T Katdmv mpoBoAr Tng 086vng mou BENETE va aMOTUNIWOETE, GUPETE TN YPAUUN
KATAOTaONG TTPOG T KATW KAtl, 0T GUVEXELQ, aYYIETE To Koupi (7,
+ To otiypotumo 086vng eppavifetal w O€pa AVToU 0To ONUEIWUATAPLO.
Ta epyaleia onpewoewv eppavifovtal oTo mavw PEPOS NG 086vNG.
7 Kavte mepikomt Tng ekOvac (av xpelaletat) Kat TPOoOEOTE TIC ONUEIDOELC TTOU
BéNete.
+ Snpioupyia XEIPOYPUPWY CNUEIWOEWY 0T PWTOYPAPIa.
3 MatAoTe 10 Koupri N~ Kal amoBnKeUOTe TIC GNUEIDTELG 0TV TomoBeaia mou
BéNete.
+ Mmopeite va Seite Ti¢ onewaelg mou amoBnkeloarte ite 01o QuickMemo+
&ite oT0 ANumoup.
+ [ va anoBnkeVoeTe ONUEIWOEIC TNV iSla TomoBeaia pe TV iponyouevn
(POPA, EVEPYOTIOINOTE TO TIAAiOI0 EAéyXou Xprion amé mpoemAoyn yia
AUTHVY TV EVEPYELD. KOl EMAECTE IO EQAPHOYT.

E « Mnopeite va amotunoete oAOKAnpEn TV 086vN XPNOILOTOILVTAG TH

Suvardtnta KUAIoNG.

« Evw pnotporoleite kamola epappoyr, 6mwg yla mapddetypa ta Mnvopata
1 1o Chrome, 6UpETE Tov Tivaka EI00MOICEWV TPOG Tt KATW Kalt TOTHOTE
Capture+ > Eméktaon, yla va amotumwoeTe oAokAnpen thv 086vn mou
BAémete T Sedopévn OTIYHNA WG Eva APXEID AMEIKOVIONG.

« Auti n SuvatdtnTa eivat S1a0£01Un MOV YIa OPICHEVEC EQAPHOYEG TTOU
umooTtnpiCouv T SuvatdtnTa KUNONG.

« Midote 6Uo Sdytula 1y amioTe Ta SAxTUAG oag yia va aAagete T Siataén
TWV ONpeiwv.
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Awayeipion @akéAwv

OpYavWVETE Kal BAEMETE ONUEIWTELS AVANOYA HE TOV TUTTO ONEiWONG.

1 NatAote to koupmi O > QuickMemo+.

7 Natfote = oo endvw PéPog TG 08vNG Kat £merta emAEETe TV emBupnT
Aertoupyia.
- 'O\a ta onpeiwpata: Mmopeite va Seite GUVONKA OAA T UTTIOUVIHOTA TTOU

eival amoBnkeupéva oto QuickMemo-+.

+ Inpeawaelg pou: Mmopeite va deite GAa Ta UMTOPVH AT TIOU EXOUV

Snuoupynbei oo QuickMemo-+.

Capture+: Mmopeite va Seite Tig ONUEIDTELS TTOU SnoupyROnKav Ke To
Capture+.

+ Kadog amoppippdatwv: Mmopeite va Seite TIC ONUEITELS TIOU £K0UV

Slaypagei.

+ Néa katnyopia: Mmopeite va mpoobéoete pakéAoug.
+ /P : Mnopeite va aMAEeTe Tn 0Epa TwV PakéAwv 1 va poobéoete/

Slaypayete pakéloug. Matwvtag Tov Gakelo, Umopeite va aAaeTe 1o
GVOLA TOU PaKENOU.

« Kdmotot @akehot Sev eppavifovtal dtav EeKIva apxIkd n epappoyn
paké\wv. Eppavifovtal emmiéov GAKeNOL HOVO GTav UTTAPXOUV OXETIKES
ONUEIWCEIC.

O1 S10YpAPUEVES ONHEIWOELG LETAPEPOVTAL OTOV KASO AmOpPILUATWY Kat

MMmopPoUV va avaktnBoUV eV 7 NUEPWV amd TV nuépa Slaypaprg TouG.

v epappoyn QuickMemo+, pumopeite va alagete tov T0mo mpoBoAr
Badovtag dvo daktuha aTnv 086VN Kal amopakpuvovTag i Mnotalovtag
Ta SAKTUAAL.

PoAot

Agunvion

Mriopeite va opioete va xtunmoet To unvntript pia kaBoplopévn wpa.

1 Natiote O > Polé1> Agomvion.

7 TlatAoTe To Koupni - yia va mpoaBEoeTe éva kaolpylo EumvnTApL.
3 Aapop@woTe TIC pUBIOEIC apUMVIONC Kat TIATAOTE ATTOBAKEUON.

XpriolpeG papuoyeg
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5 « Eav em\é€ete pia kataywpton apumviong mou &ixe pUBUIOTEL 0TO TAPENBOY,
UMOPE(TE va eMeCEQYAOTEITE TA OTOIKEIA TNG.

« [lava SlaypAgete pia a@onvion, moTioTe > Maypagn} oTo emdvw péPog
NG 006vNG. EVONOKTIKG, TIOTHOTE MAPATETAPEVA TV AQUTIVION.

Maykoaouo poAdt

Mmopeite va Seite TNV TpéYouoa wPa OTIG IOAELG O€ OAO TOV KOGHO.
1 Natiote O > Polé1> Maykéopio podL.

7 TlaTAoTE To KoUpTTi —- Kat TPOGBEGTE i TIOAN.

AvtioTtp. Xpovop.

Mriopeite va opioete va xTunmoet To umvnTript META amo €va kaboplopévo
XPOVIKO SidoTtnua.

1 Natote O > PoléL> Avtiotp. Xpovop.

7 PuBuiote Tnv wpa kai matiote Evapén.

- Ta avaoToAr Tou xpovodiakdmtn, matiote Maven. a cuvéyion Tou
XPOVOSIOKOTTN, TIATAOTE ZUVEXELD.

3 MartAote AlakoTH yia va SIOKOYETE TOV XPOVOSIOKOTTH.

Xpovopetpo
Mmopeite va XpnOIOTIOIOETE TO XPOVOUETPO YIa VA HETPHOETE TOV XPOVO yla
£vav yupo.
1 Natjote O > Polé1> Xpovopetpo.
7 NatAote 10 koupni Evapén yia va EEKIVAOEL TO XPOVOUETPO.
+ Tava PETPACETE TOV XPOVO yia €vav yUpo, TaTAoTe Lap.
3 MNatfote Mavon yia va avacTe\eTe TO XPOVOUETPO.
+ [0l va OUVEXiOEL TO XPOVOUETPO, TATAOTE ZUVEXELQ.

« Ta va SlaypdPete ONe TIG EYYPAPES KAl VA EEKIVIOETE TO XPOVOUETPO OO
v apxn, ayyi€te Emavagopd.
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Movuoikn

Mriopeite va aKoUoETE Kal va SIaXEIPLOTEITE TPAYOUSIA ) LOUCIKA AAUTTOUL.
1 Ayyi&e Sdoyika O > Ta amapaitnta > Mouoikn.

7 Em\é€te wa katnyopia.

3 EmAé€Te éva apyEio MOUOIKAC.

AvaTrapaywyn HOUTIKAG HE TO
(QAaG TNG KApEPAG Vo
avaBoofrver pe To pubpo TG
HOUCIKAG.

EmoTpo@r TNV TIponyoupevn —
0B06vn.

MatioTe yia avamapaywyl —
aTmé TNV apxr} TOU TPEXOVTOG
apxeiou / MatoTe dUo Qopég
yia avaTapaywyr Tou
TIponyoUpevou apxeiou /
MatioTe TTapaATETAEVA VIO
€TMOTPORPY OTNV apXT).

Avamapaywyr o€ Tuxaion —
oeipd.

Mpooappoyn g éviaong —.
fXou.

® <

o<,

o

MpoaoBnkn rj dlaypagr) amoé Ta Q

ayaTnuéva.

PUBpIoN NXNTIKWY EQE.

—— MpdoPaon o€ GAAeG €TTINOYEG.

— MerdBaon ot AioTa
avaTmapaywyng.

— [avon f avamapaywyn.

— MamoTe yia avamapaywyn
TOU ETTOEVOU apxeiou /
Mamorte maparerapéva yia
ypriyopn Tpowenon.

—— Emhoyn Aeitoupyiag
emavaAnyng.

—— AMayn Briparog ka
TaxUTNTag.

E + OpIOPEVEG LOPPEG apXEiwV EVOEXETAL va pnv umooTnpiovTal avaloya HE To

EYKATEOTNUEVO AOYIOUIKO.

Apyxeia mou unepBaivouv To emTPEMOUEVO Gplo PeyEBouG evEEKeTal va
TIPOKOAETOUV GQANUATA.

Ta apyeia HouoIKrG vOéxeTal va MpooTatelovTal amo SIEBVEIC KATOXoUG

TIVEUHOTIKWV SIKAIWUATWY 1} TOUG VOHOUG TTEPT TIVEUHATIKWV SIKAWUATWV.
Mo va avTypAWETe KAmoLo apXEio MOUGIKNG, UMOPE( va XPELaoTEl va AaBeTe
vopIpn adela. Na va mpaypatomoloete AjPn fj avtlypagr vog apyeiou
MOUGIKNG, ENEYETE TTPWTA T VOLOBEDIA TEPI TIVEUUATIKWV SIKAlWUATWY 0TN

Xwpa émou BpiokeoTe.

XpriolpeG papuoyeg
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ApiOpopnxavi
Mriopeite va xpnotpomoljoete SU0 TUTTOUG UTOAOYIOTWV: TO AITAG KOMTTIOUTEPAKI
KOl TN MNXQVIKK oplOpopnyav.
T Ayyi€e sdoyika O > Ta amapaitnta > ApiBpounyavi.
7 XpnOOTOIROTE TO TANKTPOAGYIO VI VOl KAVETE £VAV UTTONOYIOHO.
+ Ta va EeKvoeTe €vav UTOAOYIOHO amd TNV apxr, ayyi€Te Kal KpaTrHoTe T0

koupmi {xJ.

ThinQ

Mmopeite va cuvdéoeTe EUKONA TO TIPOTOV e GUOKEVEG 10T yia va TIg
TIOPAKOAOUBE(TE Kall Val TIG XPNOIUOTIOIEITE e Aveon.
Natote O > Ta amapaitnta> ThinQ.

E + Mmopeite va KataywpioeTe MUVTHPIO POUXWY, CTEYVWTHPLO, CUCTNHA
@povTidag evéupdtwv styler, MAuVTHpLo MAETWY, POUPVO Kal OKOUTIA POMTIOT
6TaV TO TIPOIOV BPIOKETAL OE KATAOTAON AVAUOVAG.

+ Avalntriote To orjpa ThinQ oo mPOIdV yia va KATAAAPETE av PMmopEi va
ouvdeDei e TV epappoyr ThinQ.

« MNatote = yia va udBeTe MEPIOTOTEPA Yia SIAPOPES NEITOUPYIES TG
gpappuoynig ThinQ.

Npoypappa Exkiv. Mayvid.

Mriopeite va emAé€ete av Ba xpnotpomoteital To Mpoypappa Ekkiv. Maywvid. dmou
umopeite va Seite T MioTa pe Ta matkvidia mou éxouv eykataoTtadei oTo mpoidv
Kall va emAEyeTe pUBIoELC yia Ta matyvidla, Omw¢ amevePYomoinon Tou fou Twv
TIOAUECWV, TIEPLOPIOUO ELSOTIOINCEWY, K.ATT.

1 Natmote O > Ta anapaitnta > MNpéypappa Exkiv. Mayxwvid.
7 Em\é€te v emoyr ou OéAete.
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Eyypaen nxov
Mriopeite va nXoypa@roeTe kal va amoBnKeVOETE T wvH 6ag 1 TN Gwvr) AWV
amo onUAvTIKd cupBavta. Emerta, Umopeite va mpayUaTomoICETE avamapaywyn
1) KOWVOTIOINGN TWV PWVNTIKWY AUTWV APXEIWV.
1 Ayyi€te 610doxika O > Ta anapaitnta > Eyypagn fxov.
- TavanpooBéoete éva oupBay, natiote + > Mpoab. etiketiv > Mpoa.
070 Zuppav. ZTn OUVEXELD, TPOOBEDTE éva GUUBAV TV NUEPOUNVIa TTOU
OéNete.
+ T va amoBnKeVoeTe Ta oToIKE(C TG B£0NG EYYPaPAC, TATAOTE & >
Mpoodrikn eTikeTwv > Npoab. oo Tomobeaia.
2 Natrote 1o koupri @.
+ Tia va SIaKOPETE TPOoWPIVA THY NXoypdenan, mathote To koupri @.
3 Natjote @yia va Teppatioete TV eyypaen.
+ To apyeio amobnkeveTal autopaTa Kal epgavifetal n 006vn pe Ta apyeia
TIOU €X0UV NYOyPaPnOEi.
A Natfote to koupri @ yia avamapaywyr TG NXOyPagNnHEVNG GWVAG.
+ Matrjote 0 :_@ yia TpoBoAr| Twv apyeiwv mou éxouv nxoypapnBei. Mmopeite
Va TIPAYUOTOTIOIOETE AVATTaPAYwYr EVOG apxEiou NXOYPAPNHUEVNG QWVHG
amo ) Niota.
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Kévtpo evnuépwong

Mmopeite va IpoBANETE Kal va yKATAOTACETE TNV TEAEUTAIA €KSOON TNG
€QApUOYNG 1} TOU AoyIoHIKOU TIou Tapéxel n LG.

Ayyi€e Siadoyika O > Mayeipion > Kévtpo evnuépwong.

Smart Doctor

Mrmiopeite va xpnotpomolroete 1o Smart Doctor yia va SlayVwoeTe Ty KatdoTtaon
TNG GUOKEUNG Kal va TN BeATIOTOTOI OETE.

Natfote O > Aaxeipion > Smart Doctor.

LG Mobile Switch

Méow Tou LG Mobile Switch petagépete elkola Sedopéva amod Uia HETOXEIPIOHEVN

OUOKEUN O€ [0 VEQ CUOKEUN.

T Ayyi&e Sdoyika O > Mayeipion > LG Mobile Switch.
Evalaktikd, ayyi€te diadoyika O > Pubpioeig > Z0otnua > Avtiypago
ao@aleiag> LG Mobile Switch.

7 AkolouBroTe TIC 08nyieg Tn¢ 006vng yia va emAéEeTe TV emBupunTy péBodo
UETAPOPAC.

E « Aev Ba dnpoupynBouv avtiypaga aopaleiag yia ta dedopéva ot Evav

Moyaptaopd Google. Otav cuyxpovilelg Tov Aoyaplacpd cou oto Google, ot
gpappoyég Google, ot emapég Google, To Huepohdyio Google, Ta Sedopéva
NG EQAPHOYING oNpEWdTWY Google Kal ot EQapLOoyEG TTou KateRaivouv
amno To Play Store amoBnkevovral otnv epappoyr Drive autépata.
DopTioTe MVPWE TNV UmaTapial TPV aré Tn HETAPopd Twv Sedopévwy yia
Va amo@eUXBEi n AoKOTN amevepyomoinon TnG CUCKEURG KaTd T SldpKela
g Sladikaoiag,
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Ikoumidia e@appoy.

Mriopeite va Seite pia NioTa pe Slaypappéves EQAPUOYEG 0TV apxIKr 086ovn.
MmopeiTe va QVOKTAOETE A EQappoyr Tou SlaypdpnKe TiC TEAEUTAIES 24 WPEC,
Ayyi&e Siadoyika O > Miayeipion > Zxoumidia epappioy.

Mo mePIoodTEPEC AETTOUEPELES, AVATPEETE OTO S KOUTTISIa EQAPLIOY.

SmartWorld

Mriopeite va KateBACETE pia PeyAAn YKApa atvISIv, NXNTIKOU TIEPIEXOUEVOU,
EQAPUOYWV KAl YPAUMATOCEIPWY TTOU TIapéxovTal amod Tnv LG Electronics.
MPOoCapUOOTE T GUOKELT QVANOYA HE TIG TTPOTIUAOELS GOC XPNOIHOTOLWVTAG T
Béuarta tng apyIkng 08dévne.

E « Edv xpnotuomoleite Sedopéva Kivntrg TnAepwviag, pmopei va emPBapuvBeite
E XPEWOELG Yia TN Xprion Sedopévwy, avaloya He To TPOYPAMMA XPEWOEWY
TIOU éXETE EMMEEEL
+ Auti n Aertoupyia pmopei va pnv umootnpiCetal, avahoya e TV TEPLoXN 1
TOV TIAPOYO UTTNPETLWV.

Ayyiéte diadoyika O > Ynnpeoieg > SmartWorld.
Matiote + > Zovbeon kat ouvdedeite.

Em\é€e kat ipaypatomolote An Twv OTOIXElwV TEPIEXOUEVOU TNG
QPEOKEIaG 0aG.

WN —
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RemoteCall Service

Mmopei va yivel amopakpuouévn Sidyvwon Tng GUOKEUNE 0aE yia TV emAuon
Twv mpoBAnpaTwv. ApxIkd, KahéoTe To Kévtpo e§umnpétnong mehatwv tne LG
aKoAoLBWVTAC T MAPAKATW Bripata:

E « Ta va XpnolMOToIOETE auTHV TN Aetoupyia, mpémel mpwTa va
OUMQWVIOETE HE TOUG OPOUE XPONG TNG AetToupyiag.
« Edv xpnotuomoleite Sedopéva Kivntrg tTnAepwviag, prmopei va emPBapuvBeite
E XPEWOELG Yia TN XPrion Sedopévwy, avaloya LE To TPOYPAUMA XPEWOEWY
TIOU éXETE EMMEEEL

T Ayyi&e Sdoyika O > Ynnpeoieg > RemoteCall Service.
7 Mpaypartonoifjote kKAjon mpog to Kévtpo e€unnpétnong mehatav g LG.
3 'Otav amavtnBei n kAo, akoAoUBHOTE TIC 08NyieC TOU CLVEPYATN EMOKEVWY
Yla va eloayayeTe évav e§aPnelo apibpo.
+ Exteleital amopakpuopévn oUVEEDN 0T GUOKEUN 0aG Kat EEKIVAeL n
QMOUOKPUOHEVN UTTOOTHPIEN.

Exmopnn KupéAng

Mmopeite va SE(Te TIC EKTOUTTEG KEIEVOU OE TIPAYHATIKO XPOVO OE KATAOTACEIG
€KTOKTNG QVAYKNG, OTIWG TUQWVES, TANUUUPEG KAl GEIGHOUG.

Ayyi€te Siadoyika O > Ynnpeoieg > Ekmopms KuéAng.
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E@appoyéc Google

Mriopeite va xpnotpomoljoste epappoyég Google opilovtag éva Aoyaplaoud
Google. Otav xpnotuomoleite pia epappoyr Google yia mpwtn @opd, eppavifetal
éva mapabupo kataxwplong Aoyaplacpou Google. Edv Sev éxete Aoyaplaopd
Google, SnpioupynoTe évav amoé Tn CUOKEUN 0ag. Ma AEMTOUEPEIEG OXETIKA ME TN
XPrion Hiag epappoyng, oupBouleuteite Tn BorBela otnv idia v epappoyn.

+ Oplopéveg pappoyEG evaExeTal va pnv Aettoupyolv, avaloya HE Thv
TIEPLOXN 1 TOV TTAPOXO UTTNPECIWV.

Chrome
‘Evag ypriyopog, am\og, KL ac@alrg mepinynTig, TIayUEVOC yia TOV GUYXPOVO (0TO.

Eyypaga

To Docs gival éva cuNoyIkd epyaleio emeepyaciag KelpEVou ToU EVIOVEL
TNV MapaywytkodTnTa. Xpnotpomolrote to Docs yia va dnuoupyrnoeTe, va
€MECEPYOOTEITE KAl VO GUVEPYAOTEITE OE TTPAYMATIKO XPOVO.

Google Drive

To Drive gival Xwpog amoBrKeuong apxeiwv Kat KOG EQAPHOYNG TTou O€
S1EUKONUVEL Va BPELG, Va MOLPACTEIG KAl OUVEPYAOTEIG O projects SOUAEIAC amo
mavtou, dpeoa.

Duo

Kdve amég, upnAr¢ molotntag BIVTEOKANTELG 0TOUG PIAOUG GOV Kal 0TV
OlKOYéVeLa e Ta TNAé@wva Android kat iPhones.

Gmail

To Gmail eivat pia eUkoAn oTn xprion epappoyr email mou diatnpei Ta pnvopaTd
060G A0Qar, KAVEL TO YPAUHATOKIBWTIO oag eEumvaTepo Kal 6ag BonBdet va giote
OPYQAVWHEVOL.
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Google

H epappoyri Google o€ KpaTAEL EVALEPO Y10 TA TIPAYHATA TIOU OE EVOIAPEPOUV.
Bpeite ypriyopeg anavtioelg, €epeuvioTe Ta evOlaQEpovTd oag, Kal Hdbete
IOTOPIEG KO TIAPTE EVNIEPWOELS Yl BEHATA TTOU GO EVOIAPEPOUV.

Trpnon onUEIWCEWV
AnIoUpyNOTE, EMEEEQYAOTEITE KAl HOLPAOTEITE TIG ONUELCELS KEILEVOU Kall
QWTOYPAPLWV 00 ME éva Aoyaplacpo Google.

Xapteg

Mdte kamov; Mnyaivete pe Toug XAPTES, N EPAPKOYN OTNV OToia PMopEiTe
va BaolOTETE yia TAOyNon O TIPAYHATIKO Xpdvo, yia Thv KukAogopia, Tn
OUYKOWVWVIQ, KAl Y10 AETTTOUEPELEC YA EKATOUUUPIA LEPN, OTIWE KPITIKES KAl
Snuo@INeic WpEC.

dwroypagia
To omiTl yla OAEG TIC QWTOYPAYIES KAl Tal BIVTES 0AC, AUTOLATA OPYAVWHEVD ETOL
WOTE VO YITOPE(TE va HoIpACEDTE Kall val amoBnKeVETE O,TL £XEL OHaciol.

Tauvieg Play
XpnotpomolioTe Tov Aoyaplacué oag Google yia evoikiaon r ayopd Taviwy.
Mmopeite va ayopAoeTe EPIEXOEVO Yia avamapaywyr mavtou.

Movuoiki YT

Mia véa urmpeoia streaming pouoikrig amo 1o YouTube.

YNoAOyIoTIKA QUANG

To Sheets eival éva 6UNOYIKO epyaleio eme€epyaoiag UTOAOYIOTIKWY QUANWV
TIOU EVIOXVEL TV TAPAYWYIKOTNTA. XPNOoIomolnote To Sheets yia va el0dyete, va
OPYOVWOETE Kal va avaAUoETe TANPoPopie Hadi 0€ TPayUaTIKO XPOvo.
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Mapouaoidoelg

To Google Slides €ivat éva cuNoyiKo pyaleio Snpioupyiag mapousiaong mou
€VIOKVEL TNV TTapaywylkotnTa. Xpnotpornotiote to Slides yia va opyavwoete
TIANPOPOPIEC, VO TTAPOUCIACETE AMOTENESHATA, KAl VA TTaipveTe amo@doelg padi og
TIPAYHATIKO XPOVO.

YouTube

MapakohouBnoe Ta ayarmuéva oou KavaAia, AKOUOE TN MOUGCIKH o ayamdc, Kat
avéBaoe BIVTEO yia va HOIPAOTEIC e avOpwmoug amd GAo Tov KOGHO.

Bon0dg

H ouokeun oag €xel Tov BonB6 Google evowpatwpévo. Bpeite amavtroeig Kat Kave
nipdypata otny mopeia. MNa va Eekvioelg, amd mdta 1o kAei BonBog Google otnv
TINEUPA TOU TNAEPWVOU 1 AYYIEE Kl KOATA TO APXIKO KOUMTTi TOU TNAEQWVOU.

E + O BonBd¢ Google dev gival SIaBECIHOG OE GUYKEKPILEVEG YAWOOES Kal
XWPEC.

Huepoloylo

H epappoyn Huepoldylo oag emtpénel va mapakoAoUBE(Te To MPOYpauua
oupPavtwy oag (mou eoeic Snuioupyroate), opyavwpévo avd Huépa, ava 3
Huépec, ERSopada i Mrva.

Files

Mriopeite va TpoBANETE Kall Vo SIOKEIPIOTEITE T APXEID TIOU EXOUV AmOBNKEUTE(
0T GUOKEUN 00C.

XPAOIUEG EPAPHOYEC 104



PuOpioesi¢



PuBpiosig

Mmopeite va TpooapUAOETE TIC PUOUITELS TNG CUOKEURC CUUPWVA HE TIC
TIPOTIUNCEIG 0QG.

Natote o koupni O > Pubpioeic.

E « Edv ei0ayete Mé€n kheidi oto mapdbupo avaditnong 0To enavw pépog
NG 006VNG, UMOPEITE va EKTENECETE TTO EUKOAA TOL OTOIXEID TIOU TIPETTEL VOl
puBuioTOLV.

Aixtuo & Internet

AR kdpta SIM
Mriopeite va Slapop@waoeTe TIC puBLicel SIMARG KapTag SIM.
T Ztnv 086vn Pubpioeic, matrote Aiktuo & Internet > Authr képta SIM.
7 Mmopeite va MpoCapHOCETE TIG IAPAKATW AEITOUPYIEC:
- Kapta SIM 1: Mmopeite va ahdEeTe To dvopa Kall To elkovibio ¢ kaptag SIM 1.
+ Kapta SIM 2: Mmopeite va ahdete To dvopa Kall To elkovibio T kapTag SIM 2.
+ Xpwpa Bépatog kaptag SIM: ANAETe Ta xpwpaTikd Bépata yia T KapTeg SIM.
+ Nerroupyia e§oikovopnong: Evepyomoliote 1y amevepyomolioTe T Asitoupyia
€olkovopunong. X Aerroupyia e€0IKOVOUNONG, av KAAETETE Jia EMAQY 0TV
omoia €€l AVTIOTOIXIOTEL Jial CUYKEKPIUEVN KapTa SIM, Ba xpnotpomolnBei
autn N SIM yia Ty kAjon akdpa K av givat evepyr n aAn SIM ekeivn T oTiyun
(eme1dr| .y, xpnotpomotei ta Sedopéva KivnTig TNAEQwViag).
- Aedopéva Kivnti¢ TNAEPwviag: Mmopeite va emAéSete Tv kapta SIM mou Ba
XPNOILOTIOLELTE Yia TNV uTnpeaia Sedopévwy KivTAG TNAepwviag, Mmopeite
€MMi0NG VO aMeVePYOTTOIOETE QUTHV T AelToupyia.

Nepraywyn dedopévwv: OpioTe auTAV TV EMAOYI Yia Va EMITPEMETE OTN
GUOKeUN oag va ypnotpomolei Ta dedopéva Kivntig TNAEQwviag dtav BpiokeoTe
O€ TTEPLAYWYI EKTOC TOU KAVOVIKOU 0a€ SIKTUOU.

- Aedopéva KIvnTAG TNAEPWViaG Katd Tn SidpKela TnG KARONG: ATOKTHOETE
npoowpvd mpdopacn oe dedopéva KIvTAG TNAEYWVIAE XpNOIHOTIOIWVTAS

ot Un poemeypévn kapta SIM Gedopévwv Katd Tn SIAPKELX LIAg QuVNTIKAG
KA\ong HD pe v idia kapta.
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Wi-Fi

Mriopeite va ouvOEDEiTe e KOVTIVEC OUOKEVEC Péow SikTuou Wi-Fi.

Yovdeon oe diktuo Wi-Fi
1 Zmv oBovn pubuicewy, matijote Aiktuo & Internet > Wi-Fi.
2 NatAote 1o koupni () yia evepyomoinon.
+ TadaBéoua diktua Wi-Fi epgaviovtal autopata.
3 Em\é€Te éva Siktuo.
+ Mmopei va XPp€elaoTel va el0ayayeTe Tov KwdIKo TpooRacng Tou SIKTuou
Wi-Fi.
+ H ouokeur mapaleinet autrv T Stadikacia yia diktua ota omoia ixe
ouvdeDei oo mapeNdOv Wi-Fi. Av Sev BéNelg va ouvdebeic autopata pe éva
oplopévo Siktuo Wi-Fi, méra o Siktuo Kat petd mdta MapdBAeyn Siktuou.

PuBpioeig Siktuou Wi-Fi
3TNV 086vn pubpioswy, matrote Aiktuo & Internet > Wi-Fi.

- Metdfaon og Siktuo KivnTAg TNAEQwViag: Qv n Aettoupyia TG oUvOEoNS
Sedopévwv KIvNTAG TNAEQuVIAE ival evepyoroinpévn, aAAd | CUOKEUN
Sev pmopei va ouvdedei oTo Internet péow g ouvdeong Wi-Fi, n ouokeun
ouvdéetal autépata oTo Internet péow tng ouvdeong Sedopévwv KIvNTAG
TAepwviag.

5 + Autij n Suvatdtnta e€aptdTal amod Tov TAPOXO UTNPECIAV.

+ : MPooappOoTE TIG PUBpIOELS Tou Sikthou Wi-Fi.
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Wi-Fi Direct
Mriopeite va GUVOEDETE T GUOKEUN GaG O& GANEG GUOKEUEC TIou UmooTnpi{ouv
Wi-Fi Direct yia ameuBeiag kovr xprion Sedopévwy pe autég. Agv gival amapaitntn
N xprion onueiov mpoofBaong. Mmopeite va cuvdebeite e meploodTepeg amod dUo
OUOKEVEG xpnotpomolwvtag Wi-Fi Direct.
1 v 0B6vn pubpioewy, natiote Aiktuo & Internet > Wi-Fi> & > Wi-Fi yia
npoxwpnuévoug > Wi-Fi Direct.
« OLKovTIVEC OUOKEVEC Tou urooTtnpiouv Wi-Fi Direct epgavifovtal autopata.
7 EmAé€te wa ovokeun.
+ YUvdeon mpaypaTomoLEiTal GTav n CUOKEL anmodexTel To aitnpa ouvdeong.

E + Hpmatapia evdéxetat va e§avtAnBei ypnyopotepa dtav xpnotpomoleitat
Wi-Fi Direct.

Agdopéva KivnTAG ThAEQWviag

MropeiTe va vePYOTIOLEITE Kall VOl ATEVEQYOTIOLELTE Ta SeSopéva KIVNTAG
TAepwviag. Mmopeite emiong va Slayelploteite T xprion Sedopévwv KivnTrg
Aepwviag.

Evepyomoinon 6edopévwv Kivntig ThAEQwviag

1 Zmv 0B6vn pubuicewy, matijote Aiktuo & Internet > AgSopéva KvnTiG
TAeQwviag.

7 Matiote 10 kouuri QD) yia evepyoroinon.

Mpocappoyn Twv pubpicewv dedopévwv KivnTAG TNAEQWVIaG
1 Zmv 0Bo6vn pubuicewy, matfjote Aiktuo & Internet > AgSopéva KvNTiG
TAepwviag.
7 NpooapudoTe TIC Tapakdtw pubpiceIC:
- Agdopéva KivnTrg TNAEPWViag: pUBLIoN yia xprion cuvdéoewv Sedopévwv
o€ KivnTd SikTua.
- Meplopiopdg xprong petddoong dedopévwv: Béote éva dplo yia ) xprion
SedopéVWY KIVNTAC TNAEQWVIAC. Z€ TIEPITTTWON TIOU PTACETE AUTO TO 6PIO,
Sev Oa emtpémetat MAéov n xprion Sedopévwy KIvNTAG TNAEQWVIAG.
. & :TIpooappoyn Twv pUBLicEWY SedopEVWY KIVNTAG TNAEQWVIAG,
0 dykog xpriong Sedopévwy umoloyiletal pe BAon To mPoidv kai 0 OyKog
10U UTTOAOYI{EL 0 TIAPOXOG 0ag EVOEKETAL VA SIAPEPEL
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KA\fon
Mriopeite va TIPOGAPHOCETE TIC PUBHITEIS KAOEWY, OTIWE Y10 TIC QWVNTIKEG
KANOELG Kal TIG EMAOYEC S1EBVWY KAOEWV.

+ Oplopéveg Aettoupyieg evdéxetal va unv umootnpifovtal, avahoya HE TV
TIEQLOXN 1 TOV TTAPOXO UTINPECIWV.

T Zmv 066vn pubuicewy, matfiote Aiktuo & Internet > PuBpioeic KAjogwv.
2 MpocappooTe TIg pUBKIoELC.

Z0vdeon HECW KIVNTIG CUGKEUNG

Z0vbeon Péow KIvNTNG OUOKEVRG e USB

Mriopeite va ouvOEDETE T GUOKEUN 0€ AMN cuokeun péow USB yia kovi xprion

Sedopévwv KIvnTiG TNAEPWVIag.

T Zuvbéote T cUOKeUR 0aG Ue ANNEG CUOKEVEG Uéow Karwdiou USB.

7 v 0B6vn pubpicswy, matrote Aiktuo & Internet > Tethering > Z0vSeon
Méow KIvnTAG 6UOKEVNRG pe USB kat ot cuvéxela matroTe To koupmi QD) yla
gvepyormoinon.

E « NMa autiv v emoyn xpnotuomolobvtal Sedopéva KivnTrg TNAEPwVIaG
Kal Umopei va emBapuvOEiTe pe XpEWOELS yia TN Xprion Sedopévwy,
avaoya HE TO TIPOYPAHHA XPEWOEWV TTOU EXETE EMAECEL M TIEPIOOOTEPE
TIANPOYOPIES, CULBOUNEUTEITE TOV TTIAPOYO UTINPETLWV.

« [l oUvdeon og umoAoyIoTH, KATERAOTE TO TTPOYpauua odrynong USB amd
TNV TomoBecia Www.lg.com Kat YKATAOTAOTE TO GTOV UTIOAOYIOTH.

« Aev givat Suvatr n amoatolr 1 N AYn apxeiwv PeTagld Tng CUOKEUNG
0ag Kal vog umooyloTr dtav gival evepyomoinuévn n ovvdeon USB.
Amevepyorotjote T ouvdeon USB yia tnv amootoAr i Aiin apxeiwv.

+ Ta AerToupyIk@ GUCTHAHATA TTOU UTTOOTNPI(OVV AUTOV ToV TUTIO CUVOEDNG
eivar ta Windows XP | petayevéatepn ékdoon, fj To Linux.
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®opnto onpeio mpooPaong Wi-Fi

Mriopeite va 0piOETE TN GUOKEUN WG AOUPHATO SPOPONOYNTH, £T01 WOTE Ol ANNEG

GUOKEVEG va pumopolv va ouvdeBoulv oo Internet xpnotpomolwvtag ta dedopéva

KIVNTAG TNAEQVIag TG CUOKEUNG 0ag.

T Zmv 0Bovn pubpicewy, matriote Aiktuo & Internet > Tethering > ®opnto
onpeio mpoéopaong Wi-Fi kat énerta matriote D) yia evepyoroinon.

7 Ayyi€te PUBon @opntol onpeiou mpdaBaong Wi-Fi kat kataxwpiote T
QAVayVWPIOTIKO Katl Tov Kwdikd mpdoBaong tou Ovopa Wi-Fi (SSID).

3 Evepyomotfjote to Wi-Fi 0TtV G\ 0UOKEUR Kat EMAEETE TO Gvopa ToU SIKTUOU
NG ouokeung otn Aiota Wi-Fi.

/A MAnktpoloyrote Tov Kwdikd mpdoBacnc SIKThou.

E « [a autv Ty emdoyn xpnotpomolobvtal Sedopéva KIvnTrig TNAEQWVIag
Kal Umopei va mBapuvoeiTe pe XPEWOELS yia TN Xprion Sedopévwy,
QVANOYQ LIE TO TIPOYPAUMA XPEWOEWV TTOU EXETE EMAEEEL M TEPIOTATEPES
TIANPOPOPIES, CULBOUAEVTEITE TOV TTIAPOYO UTTNPETIWV.

« Mmopeite va Bpeite mepIoodTEPES TANPOPOPIES OE AUTOV TOV LOTATOTIO:
http://www.android.com/tether#wifi

Xpovodiakdmtng amevepyomoinong gopntol onpeiov mpooBaong Wi-Fi

‘Otav 1o onpeio mpooRaong Wi-Fi Sev éxel xpnotpomolinei yia oplopévn mepiodo,
amevepyoroleital autdpata. Mmopeite va opioeTe Ty wpa o BEAETE va
EKTENEOTEL AUTOMATN AMOCUVOEDN.

Z0vbeon Péow KIVNTAG CUOKEVNG e Bluetooth

Mia ouvdedepiévn e Bluetooth cuokeun pmopei va cuvdebei oto Internet

XPnotpomolvtag ta Sedopéva KivnTrg TNAEPWVIAG TG CUOKEUNG 0aG.

T Zmvobovn pubpicewy, matriote Aiktuo & Internet > Tethering > Bluetooth
tethering kat otn cuvéxeia matriote To kKoupni Q) yla evepyomoinon.

2 Evepyorolrote 1o Bluetooth kai 0TI 5U0 GUOKEUEG, KAl TIPAYUATOTIOW|OTE
Cevén.
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5 « Ta autv Ty emoyn xpnotpomolobvtal Sedopéva KIvnTHiG TNAEQwVIag
Kal propei va emPBapuvBEeiTe Pe XPEWOELS yia Tn xprion dedopévay,
QVANOYQ HE TO TIPOYPAUMA XPEWOEWV TTOU £XETE EMAEEEL M TEPIOTATEPES
TIANPOPOPIEC, CUMBOUAEUTEITE TOV TAPOXO UTINPECIWV.

« Mmopeite va Bpeite mepIoodTEPES TTANPOPOPIE OE AUTOV TOV LOTATOTIO:
http://www.android.com/tether#Bluetooth_tethering

BonBsia
Mriopeite va mpoBahete T BoriBeta oxeTIKA pe TN Xprion cuvdéoewv kat hotspot.
YV 086vn pubuiogwy, matrjote Aiktuo & Internet > Tethering > Borjfeia.

Nertoupyia mtRong

Mriopeite va amevepyomnoloeTe TG Aettoupyieg KAjong kat SeSopévawv Kivntrig
Agpwviac. Otav autr n Aertoupyia gival vepyoroinpévn, ot AEIToupyieg ou
Sev amartolv T xprion Sedopévwy, OTwg matkvidia Kat avamapaywyr LOUCIKAG,
Tapapévouy SlaBEoIpEC.

1 Zmv 0Bovn pubuicewy, matiote Aiktuo & Internet > Aertoupyia mTriong.

7 Matote Evepyomoinon otnv 086vn empBeBaiwong.

Aiktua KIvNTAG TNAEPWviag
Mriopeite va TPOGAPHOCETE TIG PUBHITELG SIKTUWV KIVNTAC TNAEQWVIAG.
1 Zmv 086vn pubuicewy, matfjote Aiktuo & Internet > Aiktua Kivn TG

TAgpwviag.

2 MpocappooTe TIG TapaKATW PUBpIcEL:

+ Nertoupyia Siktvou: EmAéEte TUMO SikTUOUL.

+ Ovdpata onpeiov mpooPaong: Na epedavion rj alayr Tou onpeiov
TIPOOaONG Yia TN XPron UMnEeatwv SeSopéVwY KIVNTAG TNAEQviac. Na
va aMGEeTe To onpeio mpooBaong, emAégTe éva atolyeio amd tn Aiota
onueiwv mpooBaong.

Etaupeieg Sictoou: Ma avalritnon mapdxwv SIKTUOU Kat autopatn cuveon
o€ Kamolo SikTuo.
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VPN

Mmopeite va ouvdebeite o€ éva ao@aNég eIKOVIKO SiKTUO, TIX. O EVa ECWTEPIKO
€TAPIKO SiKTUO. MMTOpE(TE £MONG Vol SIOKEIPIOTEITE TA GUVSESEPEVA EIKOVIKA
1SlwTiKa SikTua.

MpoaoBnkn VPN
1 Zmv oBdvn pubuicewy, matfjote Aiktuo & Internet > VPN.
2 TNatrote o Koupmi .

E + Auti n Aertoupyia givat StaB€atpn povo epdoov gival evepyomoinuévn n
Aertoupyia kKAeldwpatog 006vng. Edv n Aerroupyia kKheidwuatog 086vng
gival amevepyomoinuévn, eppaviCetal pia 086vn eldomoinonc. Ltnv 086vn
eldomooewv matriote ANy YL0 VO EVEPYOTTOICOETE TN AerToupyia
KAEIOWHOTOG 006VNG. MNa AEMTOPEPELEC, AVATPEETE OTNV EVOTNTA PUBLION
KAglbwpatog 066vng.

3 Ewoaydyete ta otoixeio g ouvdeonc VPN kai matfiote AmoBrkeuon.

Alapépewon Twv pubuioswv VPN
T Ztn Aota VPNS, emAé€te éva VPN.
7 Ewoaydyete ta ototyeia hoyapiacpol xpriotn VPN kai matote Zovdeon.

+ Tlova anmoBnkeVoeTe Ta oTolxEia TOU hoyaplacuou, MAEETE To TAaiolo
e\éyyou AmoBrikeuon oTolxeiwv Aoyaplacuov.

I8iwTiko DNS

Mmopeite va Slapop@woeTe TG emAoyEg ISiwTikou DNS (Domain Name System).
T Zmv 0Bovn pubpicewy, matriote Aiktuo & Internet > 181w tik6 DNS.
7 Kavte v emhoyr mou Bé\ete Kai atriote AmoBrikeuon.
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Tuvdedepéveg CUOKEVEG

Bluetooth

Mriopeite va GUVOEDETE T GUOKEUN GOG O€ KOVTIVEG CUOKEUEG TIou umtooTnpilouv
Bluetooth yia avtaMayr SeSopévwv e QUTEC. ZUVOEDTE T GUOKELN 00 O éva
OKOUOTIKS Kat éva MANKTPOAOGYI0 He Suvatdtnta Bluetooth. Etot o éNeyxog Tng
OUOKELNC Bal gival EUKONOTEPOC,

Z0leuén pe AN cuokeun
1 Zmv 0B6vn pubuicewy, matiote Zuvdedepéveg ouokevéc > Bluetooth.
2 NartAote 10 koupni () yia evepyomoinon.

+ O18100¢01uEC OUOKEVEC EavifovTal auToHaTa.

- Tava avaveqoete T Nota ouokeuwy, atfote ().

E + Movo 01 GUOKEUEG TTOU €XOULV OPIOTE! WG 0paTEC EPaviCovTal ot AioTa.

3 EmAé€Te pia ouokeur amd tn Aiota.

/I AkohouBroTe TIC 08nyie¢ Tou pgavifovtal atny 006vN yia va
TIPOYHOTOTIOIOETE EAEYXO TAUTOTNTOC.

E + Autd T0 Bripa TAPCAAEITETAL YIa CUOKEVEG OTIG OTIOIEG EXEL UTTAPEEL
TP6oPaon oTo MaPeNBoV.

Anootoln edopévwy péow Bluetooth
T EmAé€te éva apyeio.
« Mmopeite va oteilete apyeia MOAUPESWY 1) OTOIXEIQ EMAPWV.
7 Natjote < > Bluetooth.
3 EmAEETE ot GUOKELK TIPOOPIGHOU VLA TO apXEiD.
+ To apyeio amooTENETAL LONIG YiVeEL AOSEKTO A Tr CUOKEUK TTPOOPICHOU.

E «+ O181ad1Kacieg Kovrg xpriong apxeiwv evoéxetat va Slapépouv avahoya e
TO apxeio.
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NFC

Mriopeite va XpnOIOTIOINCETE TN GUOKEUH WG HIa KAPTA Yia Ta Péoa MadiKng
HETOAQOPAG 1 WG MOTWTIKA KApTa. Emiong, umopeite va kovomoiroete Sedopéva
0& AN\EC CUOKEVEC.

1 Zmv 0Bo6vn pubuicewy, matiote Zuvdedepéve ouokeuég > NFC.
2 NartAote 10 koupmi () yia evepyomoinon.

« Ayyi&te T ouokeun oag pue AN cuokeur ou umooTtnpilet NFC yia
avtohayr dedopévav.

E « Hkepaia NFC umopei va Bpioketat o€ S1aQopeTIKS onueio avaloya Ue Tov
TUMO GUOKEUNG. Mol AETTTOEPELEG OXETIKA ME TV TIEPLOXT TG Kepaiag NFC,
avatpé€te 0TV evotnta Emokomnnon otolxeiwv.

Android Beam

Mmopeite va avtaldete apyeia ayyilovtag To mow PEPOC TG CUOKEUNC OE
AN ouokeun). Mmopeite emiong va avtaAd&eTe apyeia, Omwe Louoikn, Bivieo
1| EMAQEC, KAl VAl AVOIEETE piat IoTOOENISA ) Vot EEKIVIOETE I EQappoyn amd Ty
AN\ ouoKeun.

1 Zmv 086vn pubuicswy, matote Zuvdedepuéve ouokeuég > Android Beam.
7 Ayyi€te To miow péPOC TNC OUOKEVAC e TNV GAAN GUOKEUN.

5 + Hkepaia NFC pumopei va Bpioketat o€ S1aQopeTIkd onpeio avaloya Ue Tov

TUTO GUOKEUNG. Mo AETTTOEPELEG OXETIKA e TV TIEPLOXT TG Kepaiag NFC,
avatpé€te oty evotnta EMOoKomnon otolxeiwv.
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Mivakag KovomoIoEwv

Mmopeite va KoOToIOETE EPIEXOUEVO a6 To ANUTTOUR, TN MOUGIKR Kat T

Alayeipion apyeiwv oag og KOVTIVEG OUOKEVEG. Mmopeite emiong va KovomoloeTe

TO TIEPLEXOUEVO OE OUYKEKPIUEVA ATOHO OE EQAPUOYEG TTOU UTTOOTNPI(oLV TN

Suvardtnta dueong kotvomoinong tng Google (Google Direct Share).

T Zmv 080vn pubuicewy, matriote Zuvdedepéveg ouokevég > Nivakag
KOIVOTIOINCEWV.

7 Anevepyornojote kdOe emoyn xpnotponotwvtag 1o pubuoTikd @ .

+ Kovtivég ouokeuég: Mmopeite va IpoPAAETE TIG KOVTIVEG CUOKEUEG HE TIG
OTIOEC UMOPEITE VAl IOIPAOTEITE TIEPIEXOHEVO OTIC EQAPMOYEC ANUTTOUL Kalt
Mouoaikn.

- AmeuBeiag Kowvr Xprion: Amié pia epappoyr mou umootnpilel
Suvatdtnta dueong kovoroinon tng Google (Google Direct Share),
UTOPEITE VA EPPAVIOETE €val EIKOVISIO TTOU 0O EMTPEMEL Va PolpAleaTe
TIEPLEXOEVO |IE CUYKEKPIEVOUC AVOPWITOUG.

Ko xprion apxeiov
Mriopeite va oteileTe 1 va AAPETE apyeia avapesa 0Tn GUOKEUN 0ag Kal 08 ANAN
ouokeun 1 tablet tng LG.

1 Znv 0Boévn pubuicewy, matrote Tuvdedepéveg ouokevég > Ko Xpron
Apxeiou.

7 MpooappdoTe TIC TapaKATw puBpicEl:
+ K51S: yia va aA\AEeTe To Gvopa TG CUOKEUNG.

- AmoBrKeuon G€: 0PIOTE TOV PAKENO TIPOOPIOHOU YIa TNV ATTOBNKEVO TWV
apxeiwv mou amooTéNovTal armd AANEG GUOKEUEC.

+ Kown Xprion Apxeiou: yia va emrpépete T Ajn apyeiwv mou
anootéNovtat and AAEC GUOKEVEC.

- SmartShare Beam: yla va HOIPAGTEITE APXEID e ANAEG CUOKEUEC LEGW TOU
SmartShare Beam.

- BonBeia: umopeite va Seite T BoriBeta yia Tnv kovomoinon apxeiwv.
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Extunwon

Mriopeite va GUVOECETE T GUOKEUN 0aG O évav ekTumwTtr Bluetooth kat va
EKTUTTWOETE TIG WTOYPAPIES 1} TA EYYPOPA TIOU £XOUV AOONKEUTEL GTr GUOKELN).
2tnv 08vn pubpicswy, matrote Zuvdedepéveq ouoKeLEG > EkTUMwon.

- Martriote NpoemAeypévn UNNPEGia EKTUMWONG Yia va yivel avaltnon
EKTUTTWTQV LE TOUG OTI0{0UG popeite va ouvdeBeite. H matiote + >
MpooBRKn EKTUNWTWV yia va TPOCBECETE XEIPOKIVNTA évav EKTUNTWTH.

- Natfote (+) NMpoobrikn urnpeoiag yia va ANaPete TV eappoyr ToU EKTUNWTA
TIou BéNeTe.

E + AutA n duvatotnta givat Stabéotun povo o6tav To Siktua KIvnTAG
TAe@wviag 1 n Aetoupyia Bluetooth gival evepyormoinpévn.

« Tava NdBete Ty epappoyr extunwtr oto (+) Mpoadiikn ummpeciag, 6a
TIpEMEL MPWTA va ouVSEDE(TE aTOV Aoyaplacpo oag Google.

'Hxog

Mriopeite va TpooapHOCETE TIG PUBITELS ixou, Svnong kal eildomotioewv.

YV 086vn pubuioewy, matriote HYog Kal TPOCUPHOGTE TIG TAPAKATW PUOLICEIG:

« Hynmikd mpoil: aAd€te T Aettoupyia rixou o€ ‘Hxog, Mévo d6vnaon, ry

Tiyaon.

‘Evtaon;: puBpion tng évtaong fixou yia ta Sid@opa oTolyeia.

+ 'Hyog kAong: EmAE€Te évav fxo KAong yia eloepxopeves KAoeLS. MpooBéote
1} Slaypayte Xoug KAong.

+ 'Hxog e16omoinang: EmAéCte évav fyo eidomoinong. Opiote éva Houoiko
KOUHATL TTOU €Xel OmoONKEUTEL 0T OUOKEUN WG X0 1domoinong.

+ "HYoc kAfjong pe d6vnon: Pubpiote Tn ouokeur yia dévnon Kat avamopaywyn
X0V KAoNG TauTtoxpova.

« Ringtone ID: Snpioupyei évav rixo KAong yla pia el0epXOHEVN KON amo pia
GUYKEKPIHEVN ETTOQN).

« To @Mag avapet otav umdpyxet el0epXOpevn kKArjon: Pubpiote va avaBooprivet
TO QAAG CUUPWVA PE TOV i1X0 KAong TG LG.
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Mnv evoy\eite: Opiote TNV wpa, T SIAPKELA Kall TOV TUTTO EQAPHOYIG Yia Ta
omoia 6a AapBavete unvopata idomoinong. Mmopeite va AapBavete unvopata
€160TOINCEWV UOVO OE GUYKEKPILEVES NUEPEC TNC ERSopAdAC.

MoétnTa AXOU Kat EQE: XpnotpomorioTe Tn Aeltoupyia yia va pubuiceTe Tnv
TIOIOTNTA fXOU Kall Ta EPE KATA TV avamapaywyr evog Tpayoudiou i Biveo.
Tumog 66vnong: pmopeite va emAé€ete Tov TUMo ddvnong mou Ba
evEPYOTIOLETAL KOTA TN AYN KAROEWV.

"Hyog mAnktpoloyiou kKAfjoewv: EvepyomolroTe To NXNTIKO EPE Yia TO
TANKTPOAOYIO.

"Hxo¢ mAnktpoAoyiou LG: EvepyomotoTe To NYNTIKO €9 yia TO MANKTPOASYIO LG.

+ "Hyo¢ agrig: EvepyomolioTe éva e@é fou yla 6Tav maTaTe O€ £va OTOIXEO.

"Hyog kAeldwpatog 086vng: EvepyomoloTe éva epé rixou yia 6Tav KAEISWVeL 1y
Eekheldwvel n 0Bovn.

MpofoAn
Mrmiopeite va TpooapHOCETE AeMTOPEPEIG PUBLITELC yia KABE TUTO 066VNG.
TV 086vn pubpioswy, matrote MpoBon Kal TPOGAPHOCTE TIG TAPAKATW

P

Buioeic:

ApxiKr 000vn: TPOoaPUOOTE TIG PUBKICELS yia TV apyikr 08dvn. Na
NemTopépeleg, avaTtpéSTe oTnV evoTnTa PUBLIoEIC ap)IKknc 086vVNG.

OovTo & Oépa: EmAéCTe pia tametoapia 086vng éva Bépa kat eikovidia yia tn
OUOKEUH 00G.

Fpapparoceipd: ANGETE To péyeBog TG YPaUMATOOEIPAC, TNV £VTAoN TNG
YPAPAG 1} TN YPAHHATOCEIPA.

New Second Screen: EmiAe§e WG n ypappr KATAOTAONG Kalt 01 YWVIEG TNG
gpappoyns Ba eaivovtal.

MAARKTPa apng apxIkig 006vng: OpioTe To GTUA TOU MARKTPO ARG APXIKIG
0006vnc. MNa Aemtopépele, avatpé€te otny evdtnta AMayr Tou oTIA Twv
TARKTPWV a@ri¢ apxIkric 08ovng.

« Avetn mpofolr: puBLIOTE TN CUOKEUH £TOL WOTE VOl JEIWOETE TNV TOOOTNTA

TOU MIMAE QWTAC 0TV 080V Kall VO TIEPIOPIOETE TNV KATAMTOVNGON TWV HATIV.

- Nerroupyia vuxTag: Mmopeite va eQapUOCETE éva ayxvo Béua 08évng yia va

Pu

amo@UYETE T évtovn Aapyn tng 086vng Katd Tn SIdpKela TG vOXTag.
K\ipdkwon epappoyng: mpooapuooTe To Péyefog 080vng Twv QapUOYWVY.
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- MéyeBog 006vng: Opiote 1o péyebog Twv oTolxEIWv 0TV 006VN 6MWE 0ag

BoAevel Kamota atolyeia evdéxetal va ald&ouv Béon.

DwtevoTNTA: XPNOIUOTOIOTE TN YPAWK KUMONG Yial v OANAEETE TN

QWTEVOTNTA TNG 08OVNG TNG CUOKEUNG.

+ AuTOpaTo: pUBLICTE TN CUOKEUN T0L WOTE N PWTEIVOTNTA TNG 086VN¢ va
puBpieTal auTOUOTA CUPPWVA LUE TNV EVTAOT GWTOE TOU TTEPIBANOVTOC,

+ Aén xpovikou opiou 080vNG: ArievepyoTToLEiTal AUTOMATO ) CUCKEUT OTaV
TIapapével og adpAvela yia éva KaBoplopévo Xpoviko SIdotnpa.

+ Autopartn mepiotpo@r 000vng: Meplotpépetal autopata n 086vn avaloya pe
TOV TIPOGAVATONIGHO TNG GUCKEUNG.

« Mpo@UuAagn 086vnc: EpgpaviCetat mpo@UAagn 08évng 6Tav n OUCKEUR éxel

ouvdebei otn Bdon i Tov eopTioTh. EmAéETe Tov TUMO MPo@UAAENG 006vVNG

miou BéAete va epgavietat

Mipn epgpavion: MikpUVeTe To péyeBog TnG 080vNG, £T0L WOTE VAl UIMOPEITE va

XPNOIHOTIOLEITE TN OUOKEUN ME TO €val XEPL LUPETE TO MARKTPO ARG OPXIKAG

0006vNn¢ 0To KATW PéPOG TG 08AvVNE TPOC Ta aploTePd iy Se€ia.

KAeidwpa 006vng & ac@paleia
Mmopeite va TPooappOCETE TIC PUBHITELS TNG 086VNG KAEISWHATOC KAl TG A0PANELAC.
T Zmv 086vn pubuicswy, matfiote KAeidwpa 086vng & acpdheia.
7 MpooappooTe TIG PUOKITELC.
- Google Play Protect: Yapwvel Tn cuokeur Gou kabnpepvd yia moaveg
BhaBepéc epappioyEc.
- EOpeon ouokeunq: Mapakohoubrote Ty Tomobesia TG GUOKEUNG
anopakpuopéva. Mmopeite emiong va mpooTatéPete pe aopdhela ta dedopéva
0ag €4V X4OOTE Tr) CUOKEUN 00(C.
+ Evnpépwaon acpdAelag: EAeyxoq yia evnpépwaon Aoylopikol Kat Slapdpewon
PUBHICEWY QUTOUATNG EYKATAGTAONG.
DMahé€re KAeibwpa 000vNng: EmAéETe TN péBodo keldwpatog 08dvng mou
BéNete. Na Aemopépeleg, avatpé€te oTny evotnta PUBLION KAebwaToC 0B0vNG.

- Mapapetpomnoinon KAedwpatog 086vng: ANayn Twv TANPoeopLwY oy
eppavilovtal otnv KAeldwHévn 006vN.

+ PuBpiogic acpaloug kKAewdwpatog: ANGETE TIC pubpicei kKAeldwpatog
aopaleiac.
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+ AakTUN. ATOTUTWHATA: XPNOIMOTOINOTE TO SAKTUMKS 0OC AMOTUMIWHA Yid VOl
Eexheidwoete v 006vn 1) To EPLEXOLEVO. Ta AeTTTOPEPELEG, avaTPECTE 0TV
evotnta Avayvwplon 6akTuAKWv amotunmwpdtwy - lMapouvaiaon.

+ Kheibwpa mepiexopévou: Zag eMTPEMEL Vol OPICETE TUTIO KAEIOWHATOG (KWOIKO

mpoofaong 1 potifo) yia ta apyeia QuickMemo+ kat ZuAoyrc.

TomoBeaia: Mmopeite va MPOoapUOCETE TOV TPOTO e Tov omoio Ba

XpnotpomolovvTat ol MANPoPopieg TOMOBEGIAC GG A6 GUYKEKPIUEVES

EQUPHOYEC,

Kpunrtoypd@non & dlamoteutipia: AlapoppwoTe TIG pUBLICELS yia TV

KpUTTTOYpdenon Kai ta SlamaoTteuTrpla Tng kaptag SD.

- Kpuntoypdgnon kdptag SD: kpuntoypa@rioTe Thv KEpTa UVAKNG yia va
QAMOTPEYETE TN XN 0N TNS 08 AAN cuokeun. Mo AemTopépeleg, avatpé€te
0TnV evétnta Kpurmroypdpnon KapTag Uvipng.

Ac@alig eKKivnon: TPooTaTeEVOTE TN GUOKEUN oag opifovTag va gival

KAEWOWEVN KATA TNV evepyomoinar TnG. Na Aemtopépeleg, avatpélte otnv

evoTNTa PUBUION a0@aAoUs eKKivnong.

- Mpootacia Siamateutnpiou: mPoBoAr TUTIOU TOU XWPEOU amoBrKeUoNg

o6mou Ba amoBnKEUTEL TO TMOTOMOINTIKO ACPANEQC.

A&1omota Siamoteutrpia: MpofoAn Twv pilikwv motomoinTtikwv CA Tou

OUOTAHATOE 0ag Kal Twv moTtoroinTiKwv CA mou éxouv eykataotabei amd to

xerot.

- Awmoteutiipia Xpriotn: MpoBoAr kat ahhayr Twv acalwv MANeopoplwv

TIOTOMOINTIKOU TTOU €ival AmOBNKEVEVES 0T CUOKEUN OO,

Eykataotaon amo Tov amoBnkeuTikd xwpo: Eykatdotaon evog acpahoug

TIOTOMOINTIKOU Qo pial Movada amobrikeuonc.

EkkaBdpion Siamoteutnpiwv: Alaypagr d0QaAwY MOTOMOINTIKWY TTOU €EL
EYKOTAOTAOEL 0 XPAiOTN KAl TWV OXETIKWY SIaMOTEUTNPiwV.

PUBpIon KAeldwpatog kdptag SIM: kAeibwoTe 1y EekheldwoTe Ty kdpta USIM, 1y

aMagte Tov kwdiko mpdopaonc (PIN).

+ Na @aivovtai o1 Kwdikoi mpdopaong: Evepyomotriote autrv Ty emAoyn yia va
eppaviletat yla oUVTopHo SIAoTNHA KABE XapakTApag Tou Kwdikol mpdoBaong
KaBw¢ Tov MANKTPONOYEITE WOTE Va PAETIETE TL ELGAYETE.

MaxeIPIOTEC GUOKEVWV: EKYWPNOTE SIKAIWUATA YIa VA TIEQIOPIOETE TOV ENEYXO
1) TN XPrioN TNG CUOKEUNG O€ OUYKEKPILEVES EQOPHOYEG.

+ Trust agents: Epgaviote kat xpnolpomoljote ta trust agent mou éouv
€yKataoTaBEl 0T OUCKEUN.
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- Kapgitoa 086vng: Pubpiote Tv 006vn epapuoywv €101 woTe va eivat Suvath
UévOo n Xprion TNG EQapHOYNG TToU ival evepyn TNV EKACTOTE OTIyuN.

- MpdoPaon xpriong: Seite NeMTOUEPELEC OXETIKA HIE TN XPiON EQAPLIOYWY 0N
OUCOKEUN.

Enextaocsig

Smart Doctor

Mrmiopeite va xpnotpomnolroete 1o Smart Doctor yia va SlayVwoeTe Ty KatdoTtaon
TNG GUOKEUNE KAl val TN BEATIOTOTION OETE.

Ztnv 08vn pubuicswy, matriote Emektdoelg > Smart Doctor.

Mauyvidt

Mmopeite va Slapop@UOETE TIG PUBITELC yia epYaleia Kal Ypa@IKd matxviSiawy,
KaBw¢ Kat yia tn SuvatdtnTta 0IKOVOUINONG UMATAPIAG.

T Zmv 0bovn pubpicewy, matriote Enektdoelg > Mayvibt.

7 MpooappéoTe TIC TapaKATw puBpicel:

- Npéypappa Exkiv. Nagvid.: Matiote QD yia va xpnotponooeTe 1o
Mpdypapua kkiv. Tatyvis.

« Epyaleia magvidio0: Mmopeite va ektehéoete T Aettoupyia otav mailete
magvidia matwvTag Ta epyaleia maiyviSiol amod Ta KOUPA agn¢ NG
apxIKRG 086vNG

« Tpagika matxvidiou: Pubpiote ta ypagikd Tou maixvidiov.

5 + Eav aMd€ete Tv avdhuon og oplopéva maiyvidia, n Suvatdtnta mpoBoArg
000vNg evEEXETaL Va PNV AEITOUPYET OWOTA.
« Auti n Aertoupyia evoéxetat va unv gival SIaB€o1pn o€ EQaPHOYEG
TIAKVISIWV.

Atdheppa: MEWOTE TN QUTEVOTNTA TG 006VNG Kal Ty amodoon Kabe
POPA TTOU SIOKOTITETE TO TalYVIOL Yia TIEPIOGATEPO Ao 5 AemTd.
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AwmhA E@appoyi
Mriopeite va eyKaTaoTAOETE SU0 POPEC A EPAPHOYH AVTAAAAYAG UNVURATWY
07O TIPOIOV Kal va XpnotpoToleite SU0 AoyaplacpoUg Tautdxpova.

1

2
3

Ttnv 006vn pubpicswy, matriote Emektaoelg > A epappoyn.

Metd thv avdyvwon tng SAwong amomoinong, matriote EmpPeRaiwon.

Y Aiota StaBéoipwy epappoywy, matrote Eykatdotaon yia va
EYKATAOTAOETE éva aVTiypagpo TG EQappoyng Kat akoAoubnoTe Tic odnyieg
mou epgaviovtal otnv 0Bdvn.

+ XV 08dvn gpgavietal n Niota Twv Slabéoipwv Stmwv epappoywv. Katd

Tn SIGPKELD TNG EYKATACTAONG, OTNV apxIKr) 006vn mpooTiBevTat gikovidia
TWV EQOPHOYWV.

ZUVTOMEVOELG

Mriopeite va XpnoIOTIOLEITE KOUUTIA GTIWG TO KOUpTT evepyomoinong /
KAEISWUATOC, TO KOUTTE évTaong rXou kai To Google Assistant yla ApEC KTENETN
GUYKEKPILEVWY EQAPHOYWV 1) AEITOUPYIWV.

T Zmv 066vn pubuicswy, matriote EMeKTAOEL > ZUVTOUEUOELC,
7 NpooapudoTe TIC Tapakdtw pubpiceIC.

« TpoPoAr mivaka eidomotoewv: MepAoTe To XéPL 0OG POG TA KATW/EMAVW

oToV AleONTPA SAKTUAIKWY amOTUTIWHATWY yia VA ELQAVIOTEL O TTVAKAC
€160MOIN0EWV.

+ Avolypa Qwtoypagpikiig Mnxavig: Matiote 6U0 PopEC To TARKTPO

EVEPYOTTOINONG YIO VA AVOIEETE TNV KApEPQ.

Avoltypa Capture+: [atriote 5U0 QOPEC TO MARKTPO AlENONG TNG

£€vTaong Xou yla va avoiete t Aertoupyia Capture+ dtav 1o KAeldi givat
KAELBWHEVO 1) QTTEVEPYOTIOINKEVO.

Avotypa Owtoypagikiic Mnxavig: Matriote 1o mikTtpo Meiwong évtaong
SU0 Popég yia va avoiéete Tn Asttoupyia Kapepa otav to Kheldi ival
KAELBWHEVO 1) QTTEVEPYOTIOINHEVO.

+ Avolypa Google Bon04c¢: Matriote to mAnKtpo Tou Google Assistant oto

TINGL TOU TNAEPWVOU.

Milfjote oto Google BonB8og: Kpatriote matnuévo 1o mriktpo Tou Google
Assistant yla va AR oeTe ypriyopa e Tov BonBo oag.

+ Epgavion ontikoU otiypétumou: Matiote 1o mirktpo Google Assistant

SU0 POPEC Yia va SeiTe Eva OTIYUIATUTIO TNG NUEPAC 0AG OTNV EQAPHOYA
Google Assistant.
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5 + To Google Assistant dev umootnpiCel OAEG TIG YAWOOEG.

Evepyomoinon 006vn¢

Kdvte Stmho mdtnpa ot 006vn yia va EVEPYOTIOIOETE 1) VO ATEVEPYOTIOIOETE
v obovn.

Mo NemTopépeleg, avatpé€te oTnv evotnta Evepyormoinon oBovng.

Wneakn eunpepia & yovikoi éAeyyot
Mriopeite va deite Tov Xpdvo Xpriong Tou mPoidvTog Kat va pubpiceTe T0
XPOVOUETPO Yia KABe epappoyr. Mmopeite emiong va SIaxelpIoTE(Te ToV Xpovo
XPAoNG TOU KIvNToU TAAEPWVOU XPNOIMOTIOIWVTAG TN Aettoupyia MpogTotpaacia
Umvou kat T Aertoupyia Eotiaon.

EmAé€te Wnolakn eunpepia & yovikoi éNeyyol otnv 086vn pubpicewv kat
pubpioTe Tn Aettoupyia mou BéNeTe.

Epappoyég & eidomoinoeig

Mriopeite va Seite pia NioTa yKATAoTNHEVWY EQAPHOYWY KAl VA SIHOPQWOETE
TIC PUBHICEIC Yia £160TOINOELS, SIKAWUATWY EGAPUOYWV Kat GANQL

T Zmv 086vn pubuicswv, natriote EQappoyé & e150TOINTELG,

2 MpocappooTe TIg pUBKIoELC.

Mnatapia
Mrmiopeite va SeiTe TIC TPEXOUTEC TANPOPOPIES YA TNV prmaTapia 1 val
evepyoroloeTe T Aeltoupyia E0IKOVOUNONG EVEPYELQC.
1 Zmv oBdvn pubuicswy, matote Mmatapia.
7 MpocappooTe TIG TapaKATw puBpicel:
+ Xprion pmarapiog;: Geite AeMTOPEPELEG YIa TN XPrON TG UmaTapio.
+ Z1a6pn pmatapiog ot ypappn Katdotaong: Epgavifetal n otddun tng
UmaTapiag wg mocooTo 0T YPAUMK KATAoTAoNG.

PuBuioeig 122



+ PuBpi{opevn pmatapia: Emrtpémnel e€oikovopunon evépyelag SIoKOMTovTag
TN AETOUPYia EQApUOYWV 0TO TAPACKIAVIO.

- Meplopiopoi povTou: Evepyomolote autriv Ty MAOYH yla va TIEPIOPICETE

TNV EKTENEON EPAPHOYWV OTO TTAPACKIAVIO YIat EE0IKOVOUNTN EVEPYELQG

KOTd T Xprion TG ouokeuns. Ot epappoyEg mou meptopifovTat yia Adyoug

£€0IKOVOUNONG EVEPYELAG EVOEKETAL VA INV AEITOUPYOUV OWOTA 1 va Unv

00¢ 0TEAVOUV EIGOTIOINCELG.

E€okovopnon evépyetag: MeioTe Tnv KatavaAwan 1ox0og TG pmatapiog

emAéyovTag XapnAdTEPN TIUN O€ OPIOPEVES PUBIOELG TNG GUOKEUNG, OTTWG

TN QWTEVOTNTA TG 08OVNG, TNV TAXUTNTA TOU AEITOUPYIKOU OUGTAHHATOG

Kat v évtaon g 66vnone.

E€aipéoeig e§oikovopnong evépyetag: EmAECTe TIC epappoyég mou

B€NeTE Va XPNOIHOTIOLEITE XWPIG KAVEVAV AEITOUPYIKO TIEPLOPIOHO TIOPA TN

Aertoupyia §oikovopnong loxvog 1y BeAtioTomoinong pmatapiag.

ATTOONKEVTIKOC XWPOG

Mriopeite va TpoBANETE Kall va SIOEIPIOTEITE TOV ECWTEPIKO XWPO AMOONKEUONG
0T OUOKEUN 1 TOV amOBNKEUTIKS XWPO 0TNV KAPTA PVAMNG.

T Zmv 066vn pubpicewv, matriote AMOBNKEUTIKOG XWPOC.

7 MpocappooTe TIG TapaKaTw pubpicelc:

+ EowTePIkOG amoOnKeUTIKOG XWPOGE: A&iTe TOV GUVOAIKO XWwPO
amoBKeVONG Kal ToV ENEVBEPO XWPO OTOV ECWTEPIKO XWPO amoBriKeuong
TNG OUOKEUNG. Agite pia NoTa e TIC EQapUOYEG TIOU XpnolHomolouvTaL Kal
TOV XWPO amoBAKEUONG TTOU KATAVOAWVEL N KaBepia.

Kdapta SD: Agite Tov OUVOAIKO XWPO amoBrKeuong Kal Tov ehelBepo
XWPEO OTNV KAPTA pviuNG. AuTr n emoyn eppavietal uovo otav Exel
TomoBeTnBei KAPTA PVAKNG. Tat VA ATTEVEPYOTTOICETE TNV KAPTA UVAKNG,
TOTAOTE

Noyaplacpoi

Mriopeite va mpooBEoeTe XPROTEC LIE TOUG 0moiouG Bal XPNOIUOTIOLEITE TG KOVOU
TN GUOKEUN Kat va SntoupynoeTe éva hoyaplacud oto cloud.

T Zmnv 086vn pubuicswv, matriote Aoyaplacuoi.

7 Npooapudote Ti¢ pubpioelC.
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Google

Mriopeite va xpnotpomoloeTe TG pubpioeLl; Tou Google yia va SIaxeIPIOTEITE TIG
€pappoyéc Google Kal Tig puBLIcELS Tou AoyapLaopou.

SV 086vn puBpioswy, matote Google.

Zuothua

Kévtpo evnuépwaong

Mriopeite va TpoBANETE Kall VOl YKATAOTAHOETE TNV TEAeUTaia €KSoon TG
€(QapUoyNG 1 Tou AoyIopIKoU Tiou mapéxel n LG.

1 Zmv 086vn pubuicswy, matfote Z0oTnpa > Kévtpo evnuépwonc.

7 Mpooapp6oTe TIC TapaKATW pUBIcEIC:

+ Evnuépwon pappoyng: Eheyxog edv undpyel SlaBéotpn evnuépwon
£QApHOYNG. EQv umdipxel, UMOpEiTe va EYKATAOTHOETE TNV EVNUEPWHEVN
ékdoon.

« Evnpépwaon Noyiopikou: EAeyxog eav umdpyel StaBéotun evnuépwon
Noytopikou. Edv umdipyel, UTOPE(TE Va EyKATAOTAOETE TV EVNHEPWUEVN
£kdoon.

Mwooa & mAnktpoAdylo

Mmopeite va mpooapudoETe TIC pUBUITELS YA\WOOAC Kat TANKTPOAOYIOU yia T
OUOKEUN 00,

T Zmv 0Bovn pubpicgwy, matrote Zuotnpa > NAWooa & TANKTPOAGYIO.

7 MpooappooTE TIC TAPaKATW PUBIcEIC:

- M\wooa: EmAéETe Y\wooa yia T GUOKEUH.

« Aiayeipion minktpoloyiwv: Mmopeite va aAagete T pubuion yia to
Baotko MANKTPOASGYLO TOU TIPOIOVTOC, Va pUBIcETE Ta EPIBANOVTA
XPoNC yia To MANKTPOAGYI0 LG 1} GANa eyKATESTNUEVA TTANKTPOAOYIA KAl VOl
puBpioeTe TN Asrtoupyia avayvwpiong opthiag yia €ioodo pe Ty epappoyn
Google Voice. Mmopeite emiong va emAéEeTe av To Koupmi MAnKTpoloyiou
Ba eppavifeTal 0TV MEPIOX TWV KOUUMWY aPriG 0NV apxIkr 086vn, wote
Va UMOPE(Te va PETaBeiTe ypriyopa o€ AN TANKTPOAGYLO.
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+ Mpaypatiko MAnKTpoAoyto: EMAEETE yia va XpnOIUOTIOIOETE TO KAVOVIKO
TIANKTPOASYIO 1 yia va TTPOBAANETE TIG GUVTOUEVTELG TTANKTPOAOYIOU.

+ Ymnpeoia Autdpatn supnhiipwaon;: Evepyomotjote autiv v emAoyn
yia va yivetal eloaywyn Twv MANPOQoPLWV TV €ival amoBnKEUUEVEG
070 Aoyaplacpé oag, omwg kwdiko mpdoPaong, Sievbuvon ry
ap1BpoL MOTWTIKAG KAPTAC UE éva Povo mdtnua. Mmopeite emiong va
QITEVEQYOTIOIOETE AUTHY TNV EMAOYK, VA XPNOILOTOICETE TNV AUTOHATN
ouumAnpwon tn¢ Google fj va mpocBéoete éva véo Aoyaplaopd umnpeciog.

+ Metatpomnn Kelpévou o€ pwvn: AlapopPWOTE TIC PUBLICELS YA HETATPOTTH
KEIEVOU O OUINIQL

+ Tayvtnta Tou deiktn: PubpioTe v TayUtnTa Tou SiKTN TOL TOVTIKIOU 1)
Tou trackpad.

AvTIOTPO®H TTARKTPWY GTO TTOVTIKL: avTIOTPEYTE TO Se€i Koupi Tou
TIOVTIKIOU Y10 Va EKTEAEL PAOIKEG EVEPYELES ALIETOU XEIPIOHOU.

Hpepopnvia & wpa

Mmopeite va mpooappOCETE TIG PUBICEIC NUEPONVIOE KAt WPAC YIa TN GUCKEUN 0.
1 Zmv 006vn pubuicewy, matote ZvoTnua > Hugpopnvia & wpa.

7 Mpooapp6oTe TIG pUOKITELC.

Mvripun

Mmopeite va Seite Evav Péco Gpo yial TNV KATavaAwan PVAHNG Yia éval CUYKEKPIEVO
XPOVIKS S140TNHa, KABWG Kal TV TOGATNTA LVANG TTOU KATAVOAWVEL LAl EQOPHOYN.
1 Zmv 0Bdvn pubuicewy, matote ZooTnpa > Mviun.

7 Matiote 1o Koupri w yia va opioeTe pia xpovoBupiba yia avaktnon Sedopévwy.

Avtiypago acpaleiog
Mmopeite va Snpioupynoete avtiypaga acpaleiag yia dedopéva mou givat
amoBNKEVPEVA OTN GUOKEUN 0OG O€ pid GAAN GUOKEUN 1] A\oyoplaopo.
T Zmv 066vn pubuicewy, matriote ZuoTtnua > Avtiypago ac@aleiag.
7 NpooapudoTe TIC Tapakdtw pubpiceIC:
+ LG Mobile Switch: Zag emrtpémel va petagépete Sedopéva amo pia malid
ouokeun LG oe pia véa ouokeun LG. Na Aentopépeleg, avatpédte otnv
evotnta LG Mobile Switch.
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+ Anpioupyia avtlypd@wv ac@aleiag Kat emava@opd: Snpioupynote
avtiypaga ao@aleiog Twv GES0HEVWY TNG GUCKEVNG 1 EMAVAQEPETE
Sedopéva 0T GUOKELT 0ag amd KAToLo avTiypa@o ac@aleiag.

A + Me v emavapopd NG CUOKEUNG EVEEXETAL Va Slaypapoly apyeia
avTIypa@wv acpaleiag mou éxouv amobnKeUTEI oTOV XWPO amoBriKEUONG.
BePatwBeite oTt éxeTe avTlypdPel Kat amoBnKeVOEL 0TOV UTOAOYIOTH 0ag Ta
avtiypagpa ao@oAEiag Twv CNUAvVTIKWV apxeiwv oag.

« Avtiypago ac@. Google: ANayr Twv pubuicewv avtypd@ou acealeiog
Tou Google drive. Mmopeite emiong va mpoBaNeTe Tov Aoyaplacpd
Snuioupyiag avtypdewv ao®aleiag mou xpnolpomoleital i va mpoobéoete
évav Véo Aoyaplacpo dnuioupyiag avilypdewv ac@aleiag.

Enavekkivnon & emavagopad
Mriopeite va KAveTe EMavapopd TG GUOKEUNG TEPAapBavoUévwy Twv pUBHIcEwY
SIKTUOU Kall EQAPUOYWV.
T Zmnv 086vn pubuicewy, matriote Zuotnua > Emavekkivnon & Emavagopd.
2 MpocappooTe TIG TapaKATw pubpicel:
+ Autdépatn emavekKivnon: AUTOUATN EMAVEKKIVNON Kal Tpooapuoyn
ToU TNAEYWVOU € KaBoplopévo xpdvo. Matrote to koupni QD) yia va
£VEPYOTIOINOETE AUTH TN AelToupYia. H GUOKEUT EMAVEKKIVETAL AUTOMATA
o€ KaBoplopévo xpovo kai BeAtioTomoleitat autdpata. EmAéETe v
NUEPOUNVia Kal TNV wPa yia To Bloypagikd onueiwpa.

E « Mmopeite va puBpicete T ouokeun va Eekiva Eava pia @opd v eBGoudda. H
OUOKEUN EMAVEKKIVEITAL QUTOATO OE Uit wpa o TV TPoKaBoplopévn wpa.

+ MeTa v emavekkivnon Tng GUCKEUNG, Ot EI50TTOINCEIS Kall Tal EUBARpaTa
Katapyolvtal. AToBnKeVLOTE ONUaVTIKG GeSopéva Tptv amod Ty
npokaBoplopévn wpa.

+ H \erroupyia autdpatng emavekkivnong Sev givat evepyn 0TI akONouBeg
nepmwoelc; Otav n 08évn gival evepyomoinpévn, dtav n GUOKEUN gival o€
Xpnon, 6tav n otddun tng pratapiag eivat 30% 1 Aiydtepo, 6tav n kdpta
USIM givat kKAetbwpiévn rj To KAeidwHa GUCKEUNG Eival EvEPYOTTOINHEVO OTAV N
GUOKEUN Eival EVEPYOTTOINUEVN.

- Avdhoya e TOV TIAPOXO UTINPECIV TNAEMKOIVWVIWY, N AerToupyia
QUTOUATNG EMAVEKKIVNONG EVOEXETAL va Unv ivat SlaBéotun.
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- Emava@opd twv pubpicewv SIkTUou: emavagépel Ti¢ pubpioelg Wi-Fi,
Bluetooth kat d\\eg pubpioeig Siktuou.

+ Mnbeviopdg mpoTiunoewv epappoyng: Emavaeopd twv pubpicswy yia pia
epappoyn. Aev Ba Siaypagouv ta dedopéva mou ivat amobnkeupéva otny
£pappoyN.

- Emava@opd epyooTaoiakwy SESOUEVWV: EMAVAPEPEL ONEC TIG PUBLIOELC
yla T ouokeun Kat Staypagel ta dedopiéval.

E « H emavexkivnon Kai n emavapopa TG GUOKEURG 6ou Slaypdpel ONeG Ta
Sedopéva mvw ¢' auTriv. BANTE T0 Gvopa TG GUOKEUNC 0aE, TOV AOyaplaopo
Google kat AAeG apxIkég mMAnpogopieg Eava.
+ Meta v apyikomoinon twv dedopévwy, Sev eivai duvatr n emavagopd Toug.

ZXETIKA KE TO TNAEQWVO

Mrmiopeite va Seite MANPOQOPIES OXETIKA LIE TN OUOKEUN 0ag, OTIWG TO OVOUA TNG,
TNV KATAoTaoN, TO OTOIXEA Y10 TO AOYIOUIKO Kall VOUIKES TTANPOQOPIEG.

SV 066vn pubuioewy, matote ZVoTNUA > ZXETIKA ME TO TNAEPWVO Kal SETe TIG
TIANPOPOPIE TTOU 0AG EVSIAPEPOUV.

PuBioTiko mhaiclo & ac@dlela

Mriopeite va SeiTe TIC PUBIOTIKEC ETIKETEG TIC OXETIKEG TANPOYOPIES OTN CUOKEUN
oac.

3V 086vn pubpioswy, matrote LooTnpa > PubpioTiko mhaioto & AogpdAela.

Mpoofacipotnta
Mmopeite va SlagelploTEiTe TIG TPooBriKeg MpooBactudTnTag mou éxouv
€YKATOOTAOE! OTN OUOKEUN OAG.
1 Zmv 086vn pubuicswy, matote NpooBacipétnTa.
7 MpooappdoTE TIC TapaKATW PUBIcEIC:
- 'Opaon > TalkBack: PuBuiote Tn cuokeur| va oag eidomolel péow Gwvng yia
TNV KATaoTaon tng 006vng 1y yla eVEPYELEC.
+ 'Opaon > Qwvntikég eidomotoelg: Pubpiote T ouokeur va dlafdlel ta
OTOIXElQ ELOEPKOUEVNG KAONG HECW QWVIG.
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- 'Opaon > Mpapparooelpd: ANMAGETE To péyeBog TG YPOUUATOOEIPAG, TNV
£vTaon NG YPAPnG A TN YPAUUATOoELRd.

+ 'Opaon > MéyeBog 086vnc: Opiote To péyebog Twv oTolxEiwv 0TV 086VN
onw¢ oag Bolevel. Kdmota otoixeia evoéxetal va alagouv Béon.

‘Opaacn > MeyéBuven a@ng: yla LeyéBuvon 1y GUIKPUVON TATWVTAG 0TV

0006vn TPEIC POPEC.

+ 'Opaon > MeyéBuvon mapabupou: paypaTomoloTe peyébuvon 1y
OpikpUVON EVTOC TOU TTAPABUPOU KAl AVTIOTPEPTE TO XPWHAL.

+ 'Opaon > Meydhog Seiktng movTIKIOU: ueyeBUVeTE Tov SeiKTn TOU TTOVTIKIOU.

+ 'Opaon > 086vn uPNnAG avTiBEoNG: CKOUPUVETE TO XPWHA YAVTOU yia

006vn uPnNic avtibeong.

‘Opacn > Aviotpo@n XpwHatwv 006vng: Au§noTe Ty avtifeon XpwHdaTwv

NG 006vNC yia dTopa He iEpLopIopévn dpaon.

+ 'Opaon > PuBpion xpwpdtwv 006vng: MpocapuooTe T0 XpWwia TG 080vNg.

+ '0pacn > Movoypwpo: aAG&Te T Aertoupyia Tng 086vng o€ KALAKa TOU YKL

- 'Opaon > TeppaTiopo KAONG HE To MARKTPO TPOPodosiag: TEpUATIOTE

i KAAON HE TO TIATN A TOU ARKTPOU EVEPYOTTOINONY/KAEISWUATOC,

« Akon > \e{avTeg: EvepyomoloTe TNV UMnPesia UMOTITAWY KaTd TV
avamapaywyn Biveo yia dtopua pe mpoPAfUaTa akong.

Axkor} > Eidomoio€ig oAag: puBHIOTE Tr) CUOKEUN VO GO EVIEPWVEL LIE QUG
mou avaBooPrivel yia El0EpXOUEVES KAROELG, INVUUATA KAl AQUTTVICELG,

+ Akor} > ATop6vwon OAWV Twv RXWV: amopdvwon OAWV Twv RXwV Kal
XOHNAGTEPN 0TABUN évTaong rYou oTov GéKTn.

Axor) > Kavaht nyou: emAEETe Tov TUTIO HY0U.

Axor| > laopporia fixou: MpocapudoTe TV looppoia e§65ou rixou.

XpnoIOTIOIOTE TN YPAUUr KUAONG yia va aANAEETE Ty loopporTia.

+ Kwntikémnta kat yvwon. > Touch assistant: evepyomoioTe Tov mivaka agrg
YL EVKONGTEPN XPHON TWV KOUMTIWV KAl TWV KIVFOEWV.

+ Kivntikémnta kat yvwaon. > Eloaywyn a@ig: KataxwproTe Keilevo
TIOTWVTAG TAPATETAPEVA TNV 08VN i} TPOTIOTIOIOTE TO MATWVTAG A TV
00ovn.

+ Kivnuikotnta kat yvwon. > Mpaypatikd mAnKTpoAoyLo: mPosapUOoTE TIC

pUBpioELC TOu MANKTPOAOYiOU.

Kivnuikdtnta kat yvwon. > Autopato KNIK TovTikoU: Snuioupyrote

aUTOHATA KAIK TOU SEIKTN TOU TIOVTIKIOU € TIEQIMTTWON Amousiag Kivnong.
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+ Kwntikoémta kat yvwaon. > Ayyi€te mapatetapéva yia va KAvete KAfon:
AMAVTAOTE 1 amoppiPTe KAOEIC TATWVTAC TTOPATETAMEVA TO KOUTTE KAoNG,
Kalt Oyl e 08pwor Tou.

Kivntikétnta kat yvwon. > Afj€n xpovikou opiou 086vng: va
QTTEVEPYOTTOLEITA AUTOMATA N CUOKEUT OTAV TIOPAEVEL OE adPAVELD yia éva
KaBOoPIOPEVO XPOVIKO SIAoTNHA.

+ Kivnuikotnta kat yvwon. > Mepioxn eAéyxou a@rig: mepiopioTe Ty meploxn
APNG ETOL WOTE 0 ENEYXOG PG Va Eival SUVOTOG LOVO O€ £Va GUYKEKPIUEVO
TApa TNG 086vNC.

+ JUVTOPEUON AEITOUPYIWV TTPOORACIUOTNTAG: YIa Ypriyopn Tpoofaon o€
ertoupyieg mou xpnotpomoleite ouxvd matwviag Tpeg gopég to koupri O).

Autopatn meploTpo@r 080vNng: aAalel aUTOMATA O TTPOCAVATONOUOG TNG

086vng avdhoya pe ToV TPOCAVATONOHO TNG GUCKEUNG.

- EmAéETe yia ekpwvnon: Zag EMTPENEL VA TIOTATE OPIOPEVA OTOIXEID Yia VOl
NauBavete MPOPopIKN avatpo@oddtnon.

+ ANayn mpdéoBacng: Anioupynote cuvSLAGHOUE TARKTPWY yia va

ENEYXETE TN GUOKEUN 0AG.
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PuBuioeic y\wooag
Em\é€te Y\OOA yla TN GUOKEU.
« Ayyi&e siadoyika O > Pubioeig > Tuotnpa > FA\ooa & TANKTpoAGyio >
Mwaooa > Mpoodnkn YAwooag Kat EMAEETE pia y\wooa.
- Ayyi€Te Kal KPATAOTE TO KOUHTTI == Kal GUPETE TO OTO EMAVW PEPOG TNG
NoTaG Y\wOoOoWV Yia Vo TO 0PIOETE WG T YAWOOoa POEMAOYNG.

LG Bridge

LG Bridge - Mapouaiaon

To LG Bridge eivat pia epappoyr mou oag Bon6a va Slayelpileote eVkoAa Ti¢
(QPWTOYPAYIES, TN MOUOIKN, Ta BIVTED Kal Ta £yypaPa TV gival amoBnKeupEVa 0TO
smartphone LG amo tov umoloyloth oac. Mmopeite va SnuioupynoeTe avtiypaga
Q0QANEIOG TWV EMAPWY, TWV QWTOYPAPIWV Kal ANWV OTOIKEIWY OTOV UTTONOYIOTH
1 VO EVNUEPWOETE TO AOYIOMIKO TNG CUOKEUNC.

E « [la meploooTepeg Mnpogopieg Borbelag, avatpé€te oty evotnta LG
Bridge.

Ot umootnpI{OUEVEC AerToupyieg EvOEXETaL va Sla@EPOuV avANoya LE TN

OUOKEUN.

To mpdypappa odriynong USB LG gival amapaitnTo yia va 6uvO£CETE TO

smartphone LG pie Tov umoAoy1oTr kat ykabioTtartal Katd Thv eyKataoTtaon

Tou LG Bridge.

Aetroupyieg Tng e@appoyng LG Bridge

- MiayelploTeite Ta apyeia mou givat amoBnkeupéva oTn ouoKeun amd évav
umoAoyloTr péow olvdeonc Wi-Fi ) ouvdeong dedopévwv Kivntig TNAeQwviag.
AnuioupynoTe avtiypaga ac@aleiag Twv Sedopévwv amod Tn CUOKEUN o€ évav
UTTOAOYLOTH 1 EMaVa@EPETE Ta SeGOUEVA Ao VAV UTTOAOYLOTH| 0T GUOKEUN
péow ouvdeong kawdiou USB.
+ Evnpépwon AoyIopIKoU TNG GUOKEUNE Ao évav UTTOAOYLOTH Eow OUVEETNC

kaAwdiou USB.
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Eykatdotaon epappoync LG Bridge og umoloyloth

T MetaBeite otn SiebBuvon www.lg.com amé Tov umoAoyIoTH 0aG.

7 Em\é€te v mepioxn oac.

3 MatAote YIooTthpi€n > AOYIOUIKO Kat UNIKONOYIGHIKO.

/' TANKTPONOYAOTE TO OVOUA TNG GUOKEUNC 0ag.
H
EmAé€te TV katnyopia mpoiovToc.

5 Tava kateBdoete 1o apyeio puBiong, emAéCte Zuyxpoviopog PC> LG Bridge.
+ EmAé€Te Nemropépeleg yia va SeiTe TIG EAAXIOTES OMAITATELS Yia TV

£yKaTAoTaON TNG EPapHoy¢ LG Bridge.

Evnupépwon Aoylopikou TnAe@wvou

Evnuépwan Aoyilopikou Kivntol TnAepwvou LG améd 1o
Internet

M0l TEPIOCATEPES TANPOPOPIES OXETIKA HIE TN XPr|0N AUTAG TG AelToupyiag,
emoke@Oeite Tn dievbuvon http://www.lg.com/common/index.jsp kat emAEETe T
XWpa Kat T yAwooad 6.

Meé autrjv Tn Aertoupyia pmopeite e0koAa va evnUEPWVETE Péow Internet To
UANIKONOYIOMIKO OTO TNAEPWVO 0aG OE HIat TTO TIPOoPATN €kS0on XWwpic va
XPEdleTal va eMOKePOEITE KATTOLO KEVTPO EMOKEVWV. AUTH N Aeltoupyia

Ba eivat Slabéoiun edv kat 6tav n LG diabéoet otny ayopd veotepn ékdoon
UNIKOAOYIGHIKOU Yla TN GUCKEUN G0,

Eme16n n evnpépwaon Tou UNIKOAOYIGHIKOU TOU TNAEQWVOU TIpoUmoBETEL

TNV E0TIOOPEVN TTPOCOKN TOU XPNOTN KaBOAN TN Sidpkela Tng Stadikaciag
evnuépwong, PePatwbeite 6Tt SraBalete mpooeyTIKA ONeC TIG 08NYiES KAl TIC
ONUEIWOELS TTOU epgavi{ovTal oe KABe Bripa PV MPOKwPENOETE TNV EKTENEDH
Tou. Adfete umoYn 6T edv agatpéoete To kahwdio USB katd tn Sidpkela tng
Sladikaoiag avaBabpiong, evoéxetat va mpokAnBouv coBapd mpoBAfjuata oto
TAéQWVO 0ag.

E + HLG em@uldooetal Tou Sikaiwpatog va S1abétel, katd tn SlakpiTikn
TNG EVXEPELD, TIG EVNUEPWOELG TOU UNKOAOYIGHIKOU MOVO Yia EMAEYUéVa
povtéha kai Sev eyyudral Tn S1aBeoiudTNTA TG VEOTEPNC £KSOONG
UANIKOAOYIGHIKOU Y10l OAG TOl LOVTEAD TNAEPWVWV.
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Evnuépwan Aoylopikou Kivntol ThAe@uwvou LG péow
Over-the-Air (OTA)

AuTH N AeToupyia 0AG EMTPETEL VA EVNUEPWVETE EVKOAA TO AOYIOMIKS TOU
TNAEPWVOU 0ag o€ pia o mPooath ékdoon péow OTA, xwpic ouvdeon Kahwbdiou
USB. Auth n Aertoupyia Ba givat StaBéoiun eav kat 6tav n LG diabéoel otnv ayopd
VEOTEPN €KOOGT UNKONOYIOHIKOU YL TN GUCKEUN 0OC,

M0 Vol EKTENEOETE EVNUEPWOT TOU AOYIGHIKOU TOU TNAEQWVOU, aKOAOUBAOTE TV
€€nc Sladpoun:

PuBpioeig > Z0otnua > Kévipo evnuépwang > Evnuépwaon Aoylopikou >
EAeyxog evnpépwaong Aoyiopikou.

5 + Katd  1ad1kaoia evnpépwong Tou AOYIGHIKOU TOU TNAEQWVOU Gag
evdéxeTal va xaBolv Ta poowmika oag SeSopéva amo Tov ECWTEPIKO
XWPO amobrjKELONG TOU TNAEPWVOU, OTIWG YIal TAPASEIYUA, OL TTANPOPOPIES
OXETIKA UE TOV TIPOOWTTIKO 0ag Aoyaplacpd Google Kat GANoug
Aoyaplaopoug, Ta Sedopéva Kat ot PUBHICEIC TOU CUCTAKATOC KAl TWV
EQAPHOYWV 0aG, Ol amoBnNKEUpEVES EQappoyEC amo To Internet kai n ddeia
xprionc DRM. Emopéviwg, n LG 0dg ouviotd va dnpioupyeite avtiypapa
ao@aleiag Twv MPOCWTIKWY 6ag SeS0HEVWV TIPIV aTtd TV EVNUEPWON TOU
MoyiopikoU Tou ThAEpwvou oag. H LG ev pépel euBuvn yia evdexdpevn
QMWAELD TIPOCWTTIKWY SESOpEVWV.

« Auti n Aertoupyia eaptatal amd v mEPLOKT 1) TOV TAPOXO UTINPECIAV.
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06nyo¢ kata ¢ KAOmNG

PuBpiote Tn ouokeun oag va Pnv eMTPEMEL TN XEroN amd dANa ATopa £4v Exel
TIPAYHATOTOINOEL EMAVAPOPA EPYOCTACIOKWY PUBHICEWV XWwpig TV Adeld oag. MNa
TaPASELYHa, EQV N OUOKELR oa¢ xabei i KAamei, 1 edv Slaypagpolv ta dedopéva
NG, HOVO KATolog ke Aoyaplaopo Google fy Minpogopieg yia To KAEidwua Tng
086vn¢ Ba pmopei va xpnoIUOTOIOEL TN GUCKEUH.
To povo mou ypetdletat va Kavete yia va Befatwbeite 61 n cuokeur oag gival
TIPOCTOTEVPEVN €ival Ta E§1G:

+ Na opioete KAeibwpa 086vnc: dv n cuokeur oag xabei fy kKharmei, al\d éxete
opioel kAeidwpa 086vng, Sev gival duvatn n Slaypaer Twv dedopévwy
TIou BpIOKOVTAI OTN CUOKEUT HEOW TOU pevoU pubpioewv mapd pévo v
EekheldwOei n 0Bovn.

Na mpooBéate Tov Aoyaplacpd oag oto Google 0T cuoKeLr 0ag: £Gv Ta
Sedopiéva TG UOKEUNG oag Slaypapoly alAd ExeTe opioel Aoyaplaopo
Google, n cuokeur gv umopei va oAokANpwael Tn Sladikacia pUBUIONG UEXPL
va gloayBouv avd ta oTolxgia Tou Aoyaplacpou oag oto Google.
A@OU TIAPETE TA AMOPAITNTA HETPA VIO TV TIPOOTAGHA TNG CUOKEUNG 0ag, £4v
XPELOOTE VO TIPAYMATOTIOIOETE EMAVAPOPA TNG OTIC EPYOOTACIAKEC PUBicELS, Oa
Tipémel va EeKAEIOWOETE TV 086vN 0ag ) va EloaydyeTe Tov KwdIKO TpooBaong
yia Tov Aoyaplaopd oag 0to Google. Me autév tov Tpdmo Siacpahiletal 6T n
EMAVOPOPA UTTOPE( VO EKTENETTEI IOVO QMO KATTOIOV TTOU EUMIOTEVEDTE.

E « Tpwv ekteNéoETe EMaVaPOPd TwV EpYOoTaCIaKwY pubpicewy, Befaiwbeite
6T BupdoTe Tov Aoyaplacpo oag oto Google Kat Tov KwdIKo mpooBaong
TIoU éXETE MPOOBETEL OTr GUOKELN 0ag, EQv Sev Umopeite va mapéxete autd
Ta oTolkEia Aoyaplacpou katd T Sladikacia puBpiong, Sev Ba umopeite
VOl XPNOILOTIONOETE T CUOKEUT KaBONOU HETE amd TNV eKTENEON TNG
ENAVAPOPAG EPYOCTACIAKWY PUBHICEWV.
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MAnpo@opisg onueiwong yia to
AOYIGHIKO aQVOIKTOU KWOIKA

MNa ™ AN Tou mnyaiou kwSika mou Siémetat amd TG adeleg xpriong GPL, LGPL,
MPL kat GAeG adeteg xpriong avolytou Kwdika, o omoiog mepthapBavetat 6To
Tipoidv, emoKeTeite Tn SlelBuvon http://opensource.lge.com.

Ext0¢ amo Tov mnyaio Kwdika, Slatibevtat mpog An 6Aot ot avapepdpevol 6pot adelmv
XPONG, Ol AMOTOICEIG EYYUOEWV KAl Ol ONPEIGELG TIVEUHATIKWV SIKAWHATWV.

H LG Electronics Ba oag mapéxel emiong Tov Kwka avolx g mnyng o poperi CD-
ROM évavtt xpéwaong mou Ba kaAumTel Ta €€06a TG Slavopnic (OMwe To KHOTOC Twv
TIOAUHECWVY, TNG AIMOOTOAG Kalt TNG SLayeiplong), KATomy artuatog Yéow email
otn SievBuvaon opensource@lge.com.

H mpoopopd 1oxUEL yia TEPInS0 TPIWV ETWV amd TNV TEAEUTAIN LA ATOCTOAN
auTou To TTPOIGVTOG. H poo@opd 1oXVEL yia GAOUG TOUG TTAPAAATITES AUTHG TG
TIANPOYOpIaC.

MAnpoopieg OXETIKA [E TOUG
KAVOVIOHOUG (ApIOROC avayvwploTIKoU
KAVOVIOMOU, NAEKTPOVIKEG ETIKETEC KAL)

Mol NeTTTOPEPELEC OXETIKA LE TOUG KAVOVIOpOUG, emAEETe Sladoyikda PuBpiceig >
Y0oTnua > PubpioTiko maicio & Ac@alela.
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Epnopu(a onfpara

Mo matévteg Hyoouotnpdtwy (DTS:Dedicated To Sound=A@iepwpévo Ztov
'Hxo), 6¢¢ http://patents.dts.com. Kataokeuaopévo umo v ddeta amd DTS
Licensing Limited. To DTS, To Z0ufoAo, & DTS kat 1o ZupBolo 6Aa padi, DTS:
X kat To Aoyoturo DTS: X gival orjpata KaTateévTa 1 UMopIKA OHaTA TG
DTS, Inc. o1 Hvwpéveg MoAreieg kat / 1y og GAeg xwpeg. © DTS, Inc. Oha ta
Akaiwpata Mpootatevoval.

Mveupatikd Sikawpata ©2020 LG Electronics Inc.'OAa Ta Sikaiwpata

npootatevovTal H emwvupia LG kat to Aoyoturo LG givat orfjpata katateBévta

Tou Opidou LG Kall Twv OXETIKWY OVTOTHTWY Tou.

Ta Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android,

Chrome, Owtoypaepie; Google, Google Play Protect, Huepohdylo Google,

Google Docs, Google Drive, Google Sheets kit GA\a OxeTiKa orjpata kat

Aoydtuma givat epmopikd orjpata g Google LLC.

To Bluetooth® amotehei ofjua katateBév Tng Bluetooth SIG, Inc. maykoopiwg.

« H enwvupia Wi-Fi® kat To Aoyotumo Wi-Fi eivar orjpata katateBévta te Wi-Fi
Electronics.

+ 'ONa T UTTONOITTIAL EUTTOPIKA OHMATA KAl TIVEUATIKA SIKAIWATA ArTOTENOUV

1510KTNGi0 TWV QVTIOTOIWV KATOXWV TOUC,

HE HEVCAdvance”

‘: Covered by Patents at patentlisthevcadvance.com
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AnAwon acpaleiag Aélep
Mpoooxn!

Auto To Tpoidv xpnaoiuomolei cloTnpa Aéilep. MNa va BePaiwbeite mwg
XPNOlHoToLEiTe KATANNAa AUTO To TTPOTOY, SIaBAOTE MPOTEKTIKA TO EYXEIPISIO
XPNoTN Kat UAGETE TO yial LEAOVTIKY avagopd. Xe MePIMTwon mou n povada
XPELQOTE CUVTHPNON, EMKOWVWVAOTE E EEOUTIOS0TNHEVO KEVTPO EMOKEVWV.
H xprion otolxeiwv eAéyxou, pubpicewv r n ektéAeon Sladikaotwy mou dev
TIEPYPAPOVTAL 0TO TTAPOV EVOEXETAL VA EMPEPOLV eMmKivouvN €kBeon o
padlevépyela.

Mo va amo@UYeTe Tnv dpeon €kBeon otnv aktiva Aéilep, unv mpoomabroeTe va
avoi&ete 1o mepiBAnua fy va éxete dueon emaen e To Aéilep.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER
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AHAQZH ZYMMOPOQZHX

Me 1o mapdv, n LG Electronics SnAwvel oti to mpoiov LM-K510EMW
GUMMOPQUVETAL E TIC BACIKEC AMAITHACELS KAl LIE TIG UTONOUTEC OXETIKEC SIATALEIC
¢ Odnyiag 2014/53/EU.

‘Eva avtiypago ¢ AfAwong Zuppopewong dtatifetal otn SielBuvon
http://www.lg.com/global/declaration

AevBuvon evnuépwong yla Oépara
GUHHOPPWONE WG TTPOC TN XPHON TOU
TIPOIOVTOG

LG Electronics European Shared Service Center B.V.

Krijgsman 1, 1186 DM Amstelveen, The Netherlands
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Meproootepeg MAnpoPopicg

E€aptipara and okAnpupévo yuai

Ta e§aptripata auTrig TG CUOKEURG ammd OKANPUEVO Yuai Sev xouv SIdpKela ¢’

6pou {wrig, CUVETWC, EvOEXETAL Va BAPOUV e TNV TTdPodo Tou xpdvou.

+ Edv n ouokeun oag méoel TAvw O€ pia OKANPN EMEAVELD 1) TPOOKPOUGTEL KATTOU
e Svvapn, wmopei va mpokAnBei {nptd 6To oKANPUHEVO YUaA.
Ye QuTAv TV TePImTwan, SIaKOYTE APESWE TN XPHON TNG CUCKEUNG Kall
EMKOWVWVAOTE PE éva Kévtpo e§umnpétnong mehatwv tng LG.

TNV ayopd KUKANOQOPOUV TIPOOTATEVTIKEG BIKEC TTOU UMTOPEITE Va
TIPOUNOEUTEITE YIa VA TTPOOTATEVOETE Tr) GUOKELN 0ag amd Tn {npid.
N&Bete umOYN OTL AUTEC OL TTPOOTATEUTIKES Brikeg Sev KaAUTTOVTAL amd TV
€yyunon ¢ LG Electronics kat 6ev eyyuwvTal Tnv ao@alela.

Noyo¢ Slaotdoewv

Evdéxetal kamoleq An@Beioeg EpapHoyEC va Unv umooTni{ouv TO GUYKEKPIUEVO
Noyo SlaoTdoewv.

Y autiv TV mepimwon, emAEETe Ti¢ BEATIOTEG avahoyieg 086vng yia v
gpapuoyn i anotabeite oTov MEPOYO TNG EPAPHOYAC VIOl TIEPIOOATEPES
TIANPOPOPIEC.

MNa nepLocotepeg MAnPoYopieC
mAepwviiote oto: 801 11200 900
i and Kwnto oto: 210 4800564
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06nydc yia petagopd dedopévwv
+ Ta Sedopéva mou Pmopouy va LETaPepBouv PETay cuokevwy LG iy petay
Uiag ouokeung LG Kal piog GUOKEUNG TPITOU KATAOKEUAOTH, GUUBOUAEUTEITE

Tov mapakdTw mivaka.
ZuoKeur Tpitou
SUOKEVH LG KatooKeuaoT ZugKeun
e AerToupyIko i0S
Tumog Nemtopépeleg oTolXElOU — Android .
Zvokevn LG - Zuokeun LG
Tuokeu LG
Emagéc, unvopata, apxeia
KAOEWV, NUEPOAOYIO, @) O O
Mpocwmika PWVNTIKEG EYYPAPES
Sedoptva 2nUEWUATAPIO X O
=umvntipla X X
Agdopéva | Dwroypagieg, Pivteo, o o o
mohupéowv | Tpayoudia, éyypaga
PU’QHIOEIC apiknc 066vng o X X
(pakehot kat widget)
PU?““’E'C PUBpioEIC KAEIS(PATOC
086vng ¢ 086vNC (e€apouvTat o X X
ol puBpioelC KAeldwuatog
006vng)
An@Beioec epappoyég @) e)
Egappoyéc Mpoowmika dedopéva yia .
. . @) X
™ An@Beioa epappoyn
Anpdoto moTtomoNTIKd O @) X
PuBpioeig (Wi-Fi,
ANa Bluetooth, kAroelig,
X0 Kat E80TTONCELG, @) X X
mpooBacipotnta,
umatapia)
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E « Evdéxetal va pnv ivat QIKTr N HETAQopd oplopévwy dedopévwy avaloya
ME TV €KE0ON AOYIOUIKOU Kal EQAPOYNE, TO AEITOUPYIKO 0UOTNA, TOV
KATAOKEVAOTH 1) TNV TTONTIKY) TOU TIAPAXOU UTTNPECIAV.

Ymootnpi{opeveg {WVEG CUXVOTHTWV loxug e€680u mopmou
GSM 900 34.0dBm
GSM 1800 31.0dBm
WCDMA B1 25.0dBm
WCDMA B8 25.0dBm
LTEB1 25.0dBm
LTEB3 25.0dBm
LTEB7 240dBm
LTE B8 25.0dBm
LTE B20 25.0dBm
LTE B28 25.0dBm
LTE B38 240dBm
BT 2.4GHz 9.5dBm
WLAN 2.4GHz 19.0dBm

NFC -33 dBuA/m

Mriopeite va Bpeite minpo@opieg yia 1o poptioT tagidiou otn diebBuvon
http://www.lg.com/global/support/cedoc/cedoc
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Anoppudn tng maAidic cag GUOKEVNG

1. AuTo o Slaypappévo oUPBOAO TOU TPOXOPOPOU KASOU UTTOSEIKVUEL OTL
Ta amoBANTA NAEKTPIKWV Kat NAEKTPOVIKWY TTpoiovTwy (AHHE) mpémetva
amopP{MTOVTAl XWPIOTA OO Ta YEVIKA OIKIAKA AmoppipuaTa.

B 2 TanaNd NAeKTPIKA TPOIGVTa UMOPE( va TIEPIEXOUV EMIKIVOUVEG
0UOIEC KAl WG EK TOUTOU N 0WOTH AmoppiPn TG MaNAG 0ag GUOKEUNG
QMOTPEMEL EVEEKOUEVEC APVNTIKEG CUVETTELEG Yiat TO TIEPIBANOV
Kat v avBpwmivn uyeia. H maAid 6ag GUOKEUR PMOPE( va TIEPIEKEL
EMAVOXPNCIUOTIOOIA AVTAMAKTIKE TTou Ba pmopouoav va
XPnotpomonBouy yia Ty MoKeur GAwV TPoIOVTwWY, KaBWE Kat GMa
UAIKA a&iag mou umopouv va avakukAwBoLv yia e§oikovopunon Twv
TIEPIOPIOUEVWY PUOIKWVY TIOPWV.

3. Mmopeite va TTATE TN CUOKEUR 00, iTE 0TO KATAOTNO amd TO
0TI0i{0 AyOPACATE TO TIPOIGV, I} Va EMKOIVWVAOETE TO TOTIKS YpaPEio
AMOPPIUUATWV Yia AETTOPEPELEC OXETIKA HE TO TTANCLETTEPO EYKEKPILEVO
onueio ouloync AHHE (AnépAnTa HAektpikwv kat HAEKTpOVIKWV
JUOKEUWV). M0 TIG TTIO TPOOPATES TTANPOPOPIES YIA TN XWPA 0AG
emokepOeite T SievBuvon www.lg.com/global/recycling

AmoppiPn TWV XPNOLUOTTOINMEVWY prrataplwv/
CUGCWPEUTWY

1.To oOpBolo autd pmopei va cuvdualetal pe Ta XnUikd cupBoAa yia
Tov udpdpyupo (Hg), To kadpo (Cd) rj To pdAuBso (Pb), av n pmatapia
TIEPIEXEL TOOOTNTEG PEYaNUTEPES a6 0,0005% udpdapyupo, 0,002%
Kadpio 1} 0,004% poAupso.

2. H améppun OAwv Twv PIaTaplwv/CUCoWPEUTWY TTPEMEL vVal
YIVETOL XWPIOTA A0 TA YEVIKA OIKIAKA AMOPIpaTa, HEow EISIKWY
EYKATAOTACEWY CUNOYIG AOPPIUHATWY TTou €xouv kaBoploTei amd v
KUB£€PVNON 1 amo TIG TOTTIKEG APXEC.

3. H owotr andppipn Twv maNwy HmaTapiwv/cCUCowPEUTWY AITOTPETEL
EVOEXOUEVES OPVNTIKEG CUVETTELEC VIO TO TIEPIBANOV, KABWE Kal yia Thv
uyeia Twv {Wwv Kal Twv avBpwmwv.

4. Na Mo avaAUTIKEG TTANPOPOPIES OXETIKA LE TNV amoppIPn Twv MV
UMTOTAPIWV/CUCOWPEUTWY, EMKOIVWVAOTE WE TO TOTIKO YPaQEio, TNV
apuodia umnpeaia SIGBETNC OIKIOKWY AMOPPIMUATWY 1} TO KATAoTNHA
amné to omoio ayopdoate To TPoidv.
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ZUXVEG EPWTIOELG

370 KEQAAILO QUTS avaPEPOVTAL OPLopEVA TIPOPBAUATA TTOU EVOEXETAL Va
QVTILETWTTIOETE KATA TN XPrioN TNG OUOKEUNG 0aC. Na optopéva mpoPAruata Oa
XPELOOTE VOl EMKOWWVHOETE LIE TOV TTAPOYKO UTNPECLWV 0ag, AANG Ta TTEPIOCOTEPA
pmopeite va Ta S1opBwoETe Kal HOvol 0.

H ouokeun givat moAv {eotn

Eppaviletan moA0 (€076 OTAV XPNOILOTIOIEITE Tr) CUCKEUN.
2TIG AKOAOUBEC TTEPITTWOELG, N KATAVAAWON UMATapiag Au§AVETAL KAl | CUOKEUN
umopei va givat mmo (eotn:
- ‘OTav eVEPYOTIOLEITE YIa TIPWTN YOPA TN CUCKEUN 1} SNIOUPYEITE avTiypapa
aopaleiog Twv Sedopévwv
- Evi) exteNeite MTOMAMAEC EQaplOYES TAUTOXPOVA
- Otav ektehouvTal TOMOATAEG EQAPOYEC OTO TIAPACKNVIO
- Katd t Aqyn peyahwv apxeiwv Katd Ty mpaypatonoinon BivieokAoswy 1y
v eyypan Bivieo
+ ‘OTav PNOLUOTIOLEITE TIG EYKATACTACELS TIOU AMAITOUV UYPNAR 1oX0
- Katd v mapakohoubnon g pori¢ Bivieo oto Internet 1y katd tnv yypaen
€VOG peydou Bivteo
- ‘Otav maiCete matyvidla uPnAng motdTnTag yia peyalo Xpovikd Sidotnua
- ‘Otav XPNOILOTIOIEITE GUOKEVEG UE MEYIOTN QWTEVOTNTA 080VNG yia MEYANO
XPOVIKO SiaoTtnua
- ‘Otav pnotpomoleite MOAG Sedopéva KivnTrg TNAEPwVIaG
- Katd tn xprion Wi-Fi hotspot kai mpoodeon
- Ev Tautdypova ouyypovilete Sedopéva yia TOMOUS AoyapLaopoug
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+ Y€ ANEC TEPUTTWOELG
- Katd tn didpketa tng meplaywyrig 0To e§wTePIKO
- T& EPIOKEC e aSUVALES TIEPIOKEC ONATOC, OTAV XPNOILOTOLETE iat
ouokeun 1y ev umdpyet Mjyn

Katd tn pdption ouokeung pe Bupa kaAwdiou / Bupa USB mou
KOTAOTPEPETAL 1) LOAUVETA pE EEVO UNIKO

E + Y€ OpIOPEVES A0 TIC TAPATIAVW TIEPITTWOELG, GEV UMOPE( VOl EQAPUOOTEI
BAoEL XapOKTNPIOTIKWVY KAl EQAPUOYWY.

H ouokeun {eotaivetal katd T gopTioN.

+ H ouokeun kal 0 popTIOTAG Uropei va Beppaivovtal katd ™ edpTion. Katd
N S1APKEL TNG A0UPHATNG POPTIONG f} TNG TAXUTEPNG POPTIONG, N CUCKEUN
umopei emiong va givai (eatr) oto ML Edv n Beppokpaaia tng umatapiag
EEMePATEL £VOl GUYKEKPIUEVO ETITIESO, N CUOKEUN EVOEXETAL VA OTAUATHOEL VOl
@opTiletal

ATOOUVOEDTE TO POPTIOTH AMd TN GUCKEUN Kal KAEIOTE TUXOV EQAPHOYES
TIOU EKTEAOUVTAL. AQI\OTE TN GUOKEUN VA KPUWOEL TIPIV POPTIOETE TN
OUOKEUN 1 TPEEETE TNV EQAPHOYN.

STapatiote va eopTilete av n Bupa kahwdiou USB / USB 010 kdtw dxpo
NG OUOKEUNC Beppaivetal Kat emokepBeite To MAnoiéoTepo Kévtpo
E§unnpétnong Nehatwv e LG.

Mw¢ va Nooete v unepBéppavon TG CUOKEUNG

« ATIEVEPYOTTOINOTE TUXOV EQAPUOYEG 1 AelToupyie Tou ektehoUVTAL KAl aQrOTE
Th GUOKEUN VO KPUWOEL.

N evnUEPWVETE TIAVTA TO AOYIOHIKO 0TV TEAEUTAia ékSoon.

« Amevepyomotrjote Ti¢ Aertoupyieg Wi-Fi, Bluetooth 1) GPS evw Sev Tig
XPNOIHOTIOIE(TE.

+ ATIEVEPYOTIOIOTE TIC EPAPHOYEG TTIOU SEV XPNOIHOTIOLEITE.
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+ EQv XpNOIUOTOIEITE OUOKEUN HE LEYIOTN QWTEIVOTNTA 0BOVNG, UEIWOTE TN
PWTEVOTNTA.

+ Edv n ouokeun mapapeivel (0T yia LeyAAo XPovIKO Slaotnpa, Slakoyte
N Xpron g yia Aiyo. Edv n cuckeur Beppaivetal, emokepbeite 1o Kévtpo
E€unnpétnong Mehatwv g LG.

‘Opla xpriong otn Béppavon TG CUCKEUNG

Edv n ouokeun givat oo {eoTr) Tav TN XpnOILOTOLEITE 1) TN PopTileTe, EvéxeTal
va amevepyomolnBoUv OpIoHEVES AEITOUPYIES, EPAPHOYEG 1] OKOMN KOl CUOKEVEC,
AuTr €ival pia KavoviKi AEToupyia Yo GUOKEVEC TToU uTooTnpifouv auTh TN
Aettoupyia.

- Edv n Beppokpacia tng cuokeunc umepPei éva ouykekpipévo emimedo,
epaviCetal éva mpoerdomoinTIKG pHrjvupa.

- Edv maiCete maixvibia uPnAng molotntag, eyypAgete éva Bivieo ny
avePaoete peyala apxeia, TOTE n GUOKEUN pmmopei va gival (ot yia
Meyao XpovIkd SIE0TNHA. Z€ AUTHY TV TIEPIMTTWON, UMTOPEL VA EPPAVIOTE
£Vl TIPOEIGOTOINTIKO VLA TTOU EISOTIOLE] TOV QUTOUOTO TEQHATIOUO
Aerroupyiac.

AmevepyomnoljoTe Tn CUOKEUN 1 ameveQyoToIROTE TUXOV EQapHOYEG i
NETOUpYieC TOU EKTENOUVTAL KAl AQPHOTE T GUOKEUN VO KQUWOEL.

+ H pwtewotta g 086vng Kat n taxUtnta Asitoupyiag evaéxetal va
neplopifovtal oTn YUEn TG CUOKEUNG. TUXOV TPEXOUTEC EPAPHOYES T
Aerroupyieg evoéxeTal va gival apyég i va teppatifovral. H cuokeun pmopei va
OTOMOTACEL TN POPTION.

Z@aApa kaptag SIM

BeBaiwbeite 6Tt n kapta SIM gival owoTtd TomoBeTnévN.

Agv undpyel cOvdeon Siktuou 1 undpyel amwAgla Siktoou
XapnAé onua. MetakivnBeite kovtd og mapabupo 1y g avolytd xwpeo.

EioTe ektog TG meploxng KaAuyng Siktuou tou mdpoyou. ANAETe Béon kat eNéyEte
70 diktuo.

Aev gival S100£01EG 01 KAROELG

To véo iktuo Sev eival e§ouaiodotnpiévo.

S lyOUpPEUTEITE WG Sev EXETE OpioEl Ppayr KNOEWV YIa TOV EI0EPKOUEVO apIOUO.
T1youpeuTEiTe IWG Sev EXETE OpioEL Ppayr KAOEWV yia TOV apIBUO TTOU KOAEITE.
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Agv givan Suvatri n evepyommoinon TNG CUGKEUNG

Otav n pmatapia €xel amooptioet Mipwe, Sev Ba eivat Suvatr n evepyomoinon
TNG CUOKEUNC 0aC.

DopTtioTe MAMPWG TN UMATAPIA TPV VA EVEPYOTIOIOETE TN GUOKEUN.

Zpahpa eopTiong
Befawwbeite 4T1 n cuokeur @opTietal o€ Kavovikr Bepuokpaoia.
ENéyEte Tov opTIOTH KAl TN GUVEEDT TOU OTN GUOKEUN.

Na xpnotporoleite pdvo Ta e€aptripata mou mepAapBavovtal 0Tn GUCKEVAGia Kat
eivat e€ouctodotnuéva amd v LG.

H pmarapia teAeiwvel mo ypriyopa o€ oxéon pe 6tav aydpaca
OPXIKA TN CUCKEUN

'Otav ekTiBeTAL N GUCKEUN 1 N Umatapia og TOAD UWNAEG 1 XapnAég Beppokpaaieg,
evdéyetal va pelwbei n Sidpketa (wng Tng pratapiag.

H katavdAwon pmatapiog a au§nbei dtav xpnotuomoLeiTe OpIopEvES
XOPOKTNPLOTIKA 1 EPAPHOYEC, OTwG To GPS, maikvidia rj 1o Internet.

H pmatapia ivat avaAwotpo kat n {wn tg pmatapiog 6a petvetal e tnv mapodo
TOU XpOvou.

Epgavifovtal unvopata 6@AaNIaTog Katd TV EKKIivnon Tng
KAUEPG

Oopriote TV umatapia.

ATENEUBEPWOTE MVI N LETAPEPOVTAC ApPXEi OE Evav uTTohoyloTh iy Staypdgovtag
apxeia amd T ouokeun oag.

ETAVEKKIVE( TN OUOKEUN.

Eav e€akohouBeite va avtipetwmiCete mpdBAnUa pe TNV EQapOoyr TNG KAUEPAS
0QOTOU AKONOUONCETE AUTEC TIC CUMBOUAEG, EMKOIVWVHOTE pE €va Kévtpo Z€pPIg
NG LG Electronics.
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H moidtnta tng pwrtoypagiag givan Kakn

H motdtnTa Twv Qutoypagiwy 6ag vOEXETAI va TIOIKIAEL avahoya pe ToV
TePIBEAOVTA XWPO KAl TV TEXVIKH GWTOYPAEPNONG TTOU XPNCILOTOIE(TE.
Otav Byalete pwtoypapieg kal Bivteo, n moidtnta amd otabepr ywvia ivat
KOAUTEQN OE OX€ON HE TV QVTIOTOIXN OO EUPEI ywvid.

Edv Bydlete puToypaieg o€ OKOTEWVA €PN, TO BPASU 1 O€ ECWTEPIKO XWPO,
evdéyeTal va umdpyel 00puBog oTIC PwToyPaPies iy va givat Boléc.

Edv avtipetwmifete mpoARUaTA, KAVTE EMAVAPOPA TWV EMAOYWV.

H 086vn agri¢ avtanokpivetat apyd | A\avOacuéva

Edv TomoBetrioete mpooTtateuTikd 086vVNG 1 mpoatpeTikd e€aptripata otnv 006vn
ARG, AUTH EVOEXETAL VA PNV AEITOUPYEL OWOTA.

Eav gopare yavtia, €dv Ta xépla oag dev eival kaBapd 6tav ayyilete v 086vn
ARG iy €Qv ayyigete TNV 006VN e aIUNEA QVTIKEIUEVA 1) e Ta aKPOSAKTUAG oag,
auTr) VOEXETAL VA NV AEITOUPYNOEL GWOTA.

H 086vn agr¢ evoéxetal va unv Asitoupyrogt owoTd og cuvBrKeg uPNARG
uypaoiag rj tav ektebei o€ vepo.

EmavekkiviioTe Tn cuokeur 6ag yla va §1opBwbolv Tuxov mpoowptva mpoBAruata
AoylopiKoU.

Edv n 006vn a@ng €xel YPATOOUVIOTEL 1 UMOOTEL {nId, EMOKEPTEITE éva Kévpo
2¢pPig TG LG Electronics.

KaBuotepei | KoMl

Emavekkivjote T ouoKeun
+ Av n ouokeun oo KoMdeL 1y kaBuoTepei, pmopei va XpelaoTei va kheioeTe
KATTOLEG EPAPHOYEG ) VO ATIEVEQYOTTOIOETE T GUOKEUR KAl Vol TV
€EVEPYOTIOINOETE Eaval.

EKKIvijoTE TN GUOKeLR
« Hemavagopd umopei va xpnotpomolndei av n 08évn maywoel, ) av Ta Koupmd,
n 084vn aPnG 1 N OUCKELN eV AVTAMOKPIVOVTAL TTLL.
- [l va enavaeépeTe T GUOKELN 0ag, TIATAOTE TAUTOXPOVA T TTAKTPA PEiwong
£VTOONG X0V KAl AEITOUPYIQG LEXPL N GUOKEUT VO EMAVEKKIVNOEL
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Emavagpopd TG GuoKeurg
« Edv n xprion twv mapandvw peBodwv Sev amokataotrioel To mpoBAnua,

EKTENEOTE EMAVAPOPA EPYOTTACIOKWY SESOUEVWV.

+ XV 08dvn pubpicswy, ayyi€te Sladoxikd ‘Tootnua > Emavekkivnon &
emavagopd > Emavagopd epyosTtaciakwv Sedopévwv.

- Emavagépet ONeg TIG puBpioELC yia T ouokeun kat Slaypagel Ta Sedopéva.
Mptv MPOXWPNOETE OTNV EMavapopd pyooTactakwv edopévwy, BupnBeite
va SnuoupynoeTe avtiypapo ac@aleiog yia 0Aa ta onuavtika dedopéva
TIOU €XETE AmOBNKEVPEVA OTN GUOKEUN.

- Av kataywpnoeg évav Aoyaplaopo Google oTn GUOKEUH, TIPETEL Val KAVeL
€i0060 pe Tov (610 Moyaplaoud Google UETE Ty EMAVAPOPA TNG CUOKEUNG.

Aev Bpébnke ouokeun Bluetooth
TIyoupeuTeite wg n Aettoupyia Bluetooth €xel evepyoroinBei otn cuokeun oag.

S lyoupeuTEiTe WG N Aettoupyia Bluetooth éxel evepyomoinBei otn cuokeun pe T
omoia BéAete va ouvdeDeite.

BeBawwbeite 6L n cuokeun oag kat n GAn cuokeur Bluetooth givat evtog tng
péylotng epPéreiag Bluetooth (10 m).

Edv ot mapamdvw cupBouléc dev A0oouv To TPORANKUA G, ETIKOWVWVAOTE HE éva
Kévtpo ZépPig tne LG Electronics.

Aev mpaypatomoleital c0vVOEDn 0TV CUVOEETE TN GUCKEUN O€
évav umohoyloTh

Y lyoupeUTEiTE WG To KaAwS10 USB Tou XpnotUOTIOLEITE givat oUUBATO Ke TN
OUOKEUN 00,

S IYOUPEUTEITE TIWG EiVal EYKATAOTNEVO Kall £XEL EVUEPWOEL TO KATAANAO
TIPGYPAULA 081YNONG CUOKEUNG OTOV UTTOAOYIOTH GO,

H epappoyr mou AfjpOnke mpokalei mToAd opaipata
H epappoyr mapouatalel mpoPAfuata.
AQQIPEOTE KA EYKATAOTAOTE EAVA TNV EQOPHOYN.
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ENGLISH

About this user guide

Thank you for choosing this LG product. Please carefully read this user
quide before using the device for the first time to ensure safe and proper
use.
+ Always use genuine LG accessories. The supplied items are designed
only for this device and may not be compatible with other devices.

+ Descriptions are based on the device default settings.

- Default apps on the device are subject to updates, and support for
these apps may be withdrawn without prior notice. If you have any
questions about an app provided with the device, please contact an
LG Service Centre. For user-installed apps, please contact the relevant
service provider.

- Modifying the device's operating system or installing software from
unofficial sources may damage the device and lead to data corruption
or data loss. Such actions will violate your LG licence agreement and
void your warranty.

- Some content and illustrations may differ from your device, depending
on the area, service provider, software version, or OS version, and are
subject to change without prior notice.

- Software, audio, wallpaper, images, and other media supplied with
your device are licenced for limited use. If you extract and use these
materials for commercial or other purposes, you may be infringing
copyright laws. As a user, you are fully responsible for the illegal use of
media.

+ Additional charges may incur for data services, such as messaging,
uploading, downloading, auto-syncing and location services. To avoid
additional charges, select a data plan suitable to your needs. Contact
your service provider to obtain additional details.

- This user guide is written in major languages for each country.
Depending on the language used, content may partly differ.



Instructional notices

A WARNING: Situations that could cause injury to the user and third
parties.

A CAUTION: Situations that may cause minor injury or damage to the
device.

E NOTE: Notices or additional information.

About this user guide
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Guidelines for safe and efficient use

Please read these simple guidelines. Not following these guidelines may be
dangerous or illegal.

Should a fault occur, a software tool is built into your device that will gather a
fault log. This tool gathers only data specific to the fault, such as signal strength,
cell ID position in sudden call drop and applications loaded. The log is used only to
help determine the cause of the fault. These logs are encrypted and can only be
accessed by an authorised LG Repair centre should you need to return your device
for repair.

Exposure to radio frequency energy
Radio wave exposure and Specific Absorption Rate (SAR) information.

This device has been designed to comply with applicable safety requirements for
exposure to radio waves. These requirements are based on scientific guidelines that
include safety margins designed to assure the safety of all persons, regardless of
age and health.

+ The radio wave exposure guidelines employ a unit of measurement known
as the Specific Absorption Rate, or SAR. Tests for SAR are conducted using
standardised methods with the device transmitting at its highest certified
power level in all used frequency bands.

+ While there may be differences between the SAR levels of various LG device
models, they are all designed to meet the relevant guidelines for exposure to
radio waves.

+ The SAR limit recommended by the International Commission on Non-lonizing
Radiation Protection (ICNIRP) is 2 W/kg averaged over 10 g of tissue.

+ The highest SAR value for this model tested for use at the ear is 0.501 W/kg
(10 g) and when worn on the body is 1.335 W/kg (10 g).



+ This device meets RF exposure guidelines when used either in the normal use
position against the ear or when positioned at least 5 mm away from the body.
When a carry case, belt clip or holder is used for body-worn operation, it should
not contain metal and should position the product at least 5 mm away from
your body. In order to transmit data files or messages, this device requires a
quality connection to the network. In some cases, transmission of data files
or messages may be delayed until such a connection is available. Ensure the
above separation distance instructions are followed until the transmission is
completed.

Information about the RF exposure from FCC

In August 1996, the Federal Communications Commission (FCC) of the United
States, with its action in Report and Order FCC 96-326, adopted an updated safety
standard for human exposure to radio frequency (RF) electromagnetic energy
emitted by FCC regulated transmitters. Those guidelines are consistent with the
safety standard previously set by both international and US. standards. The design
of this device complies with FCC guidelines and these international standards.

Part 15.19 statement

This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions:

(1) This device may not cause harmful interference, and

(2) this device must accept any interference received, including interference that
may cause undesired operation.

Part 15.21 Statement

Changes or modifications not expressly approved by the manufacturer could void
the user's authority to operate the equipment.
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Body-worn Operation

This device was tested for typical bodyworn operations with the back of the device
kept 0.39 inches (1cm) between the user’s body and the back of the device. To
comply with FCC RF exposure requirements, a minimum separation distance of
0.39 inches (1cm) must be maintained between the user's body and the back of
the device.

Any beltclips, holsters, and similar accessories containing metallic components
may not be used. Body-worn accessories that cannot maintain 0.39 inches (1cm)
separation distance between the user’s body and the back of the device, and have
not been tested for typical body-worn operations may not comply with FCC RF
exposure limits and should be avoided.

Part 15.105 Statement

This equipment has been tested and found to comply with the limits for a class

B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates uses and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause
harmful interference or television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:

+ Reorient or relocate the receiving antenna.

+ Increase the separation between the equipment and receiver.

+ Connect the equipment into an outlet on a circuit different from that to which
the receiver is connected.

+ Consult the dealer or an experienced radio/TV technician for help.
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Product care and maintenance

+ Use only in-box accessories which are authorised by LG. LG does not guarantee
any damage or failure which is caused by third party accessories.

+ Some contents and illustrations may differ from your device without prior
notice.

+ Do not disassemble this unit. Take it to a qualified service technician when repair
work is required.

+ Repairs under warranty, at LG's discretion, may include replacement parts
or boards that are either new or reconditioned, provided that they have
functionality equal to that of the parts being replaced.

- Keep away from electrical appliances such as TVs, radios and personal
computers.

+ The unit should be kept away from heat sources such as radiators or cookers.
+ Do not drop.
+ Do not subject this unit to mechanical vibration or shock.

+ Switch off the device in any area where you are required to by special
regulations. For example, do not use your device in hospitals as it may affect
sensitive medical equipment.

+ Do not handle the device with wet hands while it is being charged. It may cause
an electric shock and can seriously damage your device.

+ Do not charge a handset near flammable material as the handset can become
hot and create a fire hazard.

+ Use adry cloth to clean the exterior of the unit (do not use solvents such as
benzene, thinner or alcohol).

+ Do not charge the device when it is on soft furnishings.
+ The device should be charged in a well ventilated area.

+ Do not subject this unit to excessive smoke or dust.

Do not keep the device next to credit cards or transport tickets; it can affect the
information on the magnetic strips.

+ Do not tap the screen with a sharp object as it may damage the device.
+ Do not expose the device to liquid or moisture.

+ Use accessories like earphones cautiously. Do not touch the antenna
unnecessarily.
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Do not use, touch or attempt to remove or fix broken, chipped or cracked glass.
Damage to the glass display due to abuse or misuse is not covered under the
warranty.

Your device is an electronic device that generates heat during normal operation.
Extremely prolonged, direct skin contact in the absence of adequate ventilation

may result in discomfort or minor burns. Therefore, use care when handling your
device during or immediately after operation.

If your device gets wet, immediately unplug it to dry off completely. Do not
attempt to accelerate the drying process with an external heating source, such
as an oven, microwave or hair dryer.

The liquid in your wet device, changes the colour of the product label inside your
device. Damage to your device as a result of exposure to liquid is not covered
under your warranty.

A mobile device requires proper air circulation in order to dissipate heat. Direct skin
contact and inadequate circulation of air flow to the device may cause the device
to overheat. The device must be at least 1.0cm from between the user's body.

Prevent dust of any other foreign substances from getting into the Charger/
USB cable port. It may cause heat or fire.

Avoid exposing the device to low air pressure at high altitude.

Do not expose the device to extremely low air pressure. Otherwise, it can cause
explosion of the battery or leakage of flammable liquid or gas.

Please ensure that the product does not get in contact with liquid. Do not
use or recharge the product if it is wet. Once the product becomes wet, the
liquid damage indicator changes color. Please note that this will limit you from
receiving any free-of-charge repair services provided under warranty.
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Efficient device operation

Electronics devices
All devices may receive interference, which could affect performance.

+ Do not use your device near medical equipment without requesting permission.
Please consult your doctor to determine if operation of your device may
interfere with the operation of your medical device.

+ Pacemaker manufacturers recommend that you leave at least 15 cm of space
between other devices and a pacemaker to avoid potential interference with the
pacemaker.

+ This device may produce a bright or flashing light.
+ Some hearing aids might be disturbed by devices.

+ Minor interference may affect TVs, radios, PCs etc.

Use your device in temperatures between 0 °C and 40 °C, if possible. Exposing
your device to extremely low or high temperatures may result in damage,
malfunction, or even explosion.

Road safety

Check the laws and regulations on the use of devices in the area when you drive.
+ Do not use a hand-held device while driving.
+ Give full attention to driving.

+ Pull off the road and park before making or answering a call if driving conditions
S0 require.

+ RF energy may affect some electronic systems in your vehicle such as car
stereos and safety equipment.

+ When your vehicle is equipped with an air bag, do not obstruct with installed
or portable wireless equipment. It can cause the air bag to fail or cause serious
injury due to improper performance.

- If you are listening to music whilst out and about, please ensure that the volume
is at a reasonable level so that you are aware of your surroundings. This is of
particular importance when near roads.
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Avoid damage to your hearing

To prevent possible hearing damage, do not listen at high volume
levels for long periods.

Damage to your hearing can occur if you are exposed to loud sound for long
periods of time. \We therefore recommend that you do not turn on or off the
handset close to your ear. We also recommend that music and call volumes are set
to a reasonable level

+ When using headphones, turn the volume down if you cannot hear the people
speaking near you, or if the person sitting next to you can hear what you are
listening to.

E « Excessive sound pressure from earphones and headphones can cause
hearing loss.

Glass Parts

Some parts of your device are made of glass. This glass could break if your device is
dropped on a hard surface or receives a substantial impact. If the glass breaks, do
not touch or attempt to remove it. Stop using your device until the glass is replaced
by an authorised service provider.

Blasting area

Do not use the device where blasting is in progress. Observe restrictions and follow
any regulations or rules.

Potentially explosive atmospheres
+ Do not use your device at a refueling point.
+ Do not use near fuel or chemicals.

- Do not transport or store flammable gas, liquid or explosives in the same
compartment of your vehicle as your device or accessories.
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In aircraft
Wireless devices can cause interference in aircraft.
+ Turn your device off before boarding any aircraft.

- Do not use it on the ground without permission from the crew.

Children

Keep the device in a safe place out of the reach of small children. It includes small
parts which may cause a choking hazard if detached.

Emergency calls

Emergency calls may not be available on all mobile networks. Therefore you should
never depend solely on your device for emergency calls. Check with your local
service provider.

Battery information and care

+ You do not need to completely discharge the battery before recharging. Unlike
other battery systems, there is no memory effect that could compromise the
battery's performance.

+ Use only LG batteries and chargers. LG chargers are designed to maximise the
battery life.

+ Do not disassemble or short-circuit the battery.

+ Keep the metal contacts of the battery clean.

Replace the battery when it no longer provides acceptable performance. The
battery pack may be recharged hundreds of times before it needs replacing.

+ Recharge the battery if it has not been used for a long time to maximise
usability.

+ Do not expose the battery charger to direct sunlight or use it in high humidity,
such as in the bathroom.

+ Do not leave the battery in hot or cold places, as this may deteriorate battery
performance.

+ Risk of explosion if battery is replaced by an incorrect type. Dispose of used
batteries according to the instructions.

+ Always unplug the charger from the wall socket after the device is fully charged
to save unnecessary power consumption of the charger.
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+ Actual battery life will depend on network configuration, product settings,
usage patterns, battery and environmental conditions.

+ Make sure that no sharp-edged items such as animal's teeth or claws, come
into contact with the battery. This could cause a fire.

Securing personal information

+ Make sure to protect your personal information to prevent data leakage or
misuse of sensitive information.

+ Always back up important data while using the device. LG is not responsible for
any data loss.

+ Make sure to back up all data and reset the device when disposing of the device
to prevent any misuse of sensitive information.

+ Read the permission screen carefully while downloading applications.

Be cautious using the applications that have access to multiple functions or to
your personal information.

Check your personal accounts regularly. If you find any sign of misuse of your
personal information, ask your service provider to delete or change your account
information.

« If your device is lost or stolen, change the password of your account to secure
your personal information.

+ Do not use applications from unknown sources.
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Notice for Battery replacement

.

.

Guidelines for safe and efficient use

Li-lon Battery is a hazardous component which can cause injury.

Battery replacement by a non-qualified professional can cause damage
to your device.

Do not replace the battery by yourself. The battery can be damaged,
which can cause overheat and injury. The battery must be replaced by
a qualified professional. The battery should be recycled or disposed
separately from household waste.

In case this product contains a battery incorporated within the product
which cannot be readily removed by end-users, LG recommends that
only qualified professionals remove the battery, either for replacement
or for recycling at the end of this product’s working life. To prevent
damage to the product, and for their own safety, users should not
attempt to remove the battery and should contact LG Service Helpline,
or other independent service providers for advice.

Removal of the battery will involve dismantling of the product case,
disconnection of the electrical cables/ contacts, and careful extraction of
the battery cell using specialized tools. If you need the instructions for
qualified professionals on how to remove the battery safely, please visit
http7/wwwilge.com/global/sustainability/environment/take-back-recycling.
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Custom-designed
Features



Camera features

Wide-angle camera

You can take photos or record videos with a wider range than your actual
field of vision by using the wide-angle on the rear camera.

Tap O > (@, then tap (4) / @) to switch between the standard and wide-
angle.

Change the
camera angle.

Rear Camera

5 « See Starting the camera for details.
+ You can switch between the standard and wide-angle camera lenses on
the rear camera only.

Custom-designed Features
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Portrait
You can take a sharp portrait by applying the camera lens blur effect.

1 TapO>([®, then tap Portrait.

2 Tap () to take a photo.
+ To adjust blur strength, drag the slide bar to the left or right.

- Keep the distance to your subject within 1.3 ~ 5.0 feet when using the
rear camera.

« This feature is not available if the surroundings are too dark.

« After applying this feature, tap the desired position on the preview
screen to automatically apply the exposure value and focus when using
the rear camera, or exposure value only when using the front camera.

Custom-designed Features
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Al CAM

You can effectively take photos or record videos since the camera
recognises the object when taking a photo or recording a video.

1 Tap O > then tap Al CAM.
2 When the object is recognised, the best effect for the scene is applied.
- To apply other effects, tap the scene icon.

- Pet, city, flower, food, landscape, person, sunset, auto, total 8
categories can be recognised automatically.

Sunset Flower

E « The result of the scene recognition may differ depending on the
illumination or the location of the subject while taking photos. Keywords
do not appear on the actual photos or videos.

- This feature is available only when the front and rear cameras are in the
Auto mode.

Custom-designed Features 18



Gallery features

Creating a movie
You can create a new movie by putting images and videos together.

1 Tap O > ¥ > Photos tab, then tap : > Create movie.
You can also tap O > ¥ > Play tab, then tap : > Create movie.

2 Select images or videos for your movie and tap Next.

3 Edit the selected images and videos and then tap Save.

Custom-designed Features
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Deleting files

You can select images or videos to delete from your video by tapping €
at its thumbnail.

Adding files

You can select images or videos to add after tapping -+ at the bottom
of the screen. You can also select the images or videos you have already
previously added.

E + Touch and hold a file, and then tap another file for multiple selection.

Rearranging files

To rearrange the images and videos, touch and hold the file you want to
move, then dragging it to the desired location.

Resetting the movie edits
You can reset the edits made to the movie (e.g. play time) by tapping &.

Previewing a file

Check your new video before saving it by tapping (»). After the playback
time elapses, the next file is played automatically.

E A maximum of 50 images and videos can be used to create a video.

+ The playback time for an image is 3 seconds by default and it cannot be
changed. Videos can be trimmed down to a minimum of 1 second.

« This feature may not support some image or video formats.
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Making a GIF

You can easily make a GIF file using recorded videos or photos.

Making a GIF by using recorded videos
T At the desired starting point while watching a video, tap @e.

2 Select the length of the GIF you want to create.
- GIF is generated for the time selected from the current time.

« For videos less than 5 seconds, GIF images are automatically
generated for the remaining time.

Making a GIF by using photos
1 While viewing an album, tap : > Create GIF.

2 Select the desired photos to create a GIF file and then tap Next.

+ You can add more images and adjust the GIF speed, screen ratio,
and file order.

A + You may use this feature solely for creative purposes. The use of this
feature involving infringement of any other person's rights, such as
copyright or defamatory or offensive statements, may be subject to civil,
criminal, or administrative liabilities and/or penalties under applicable
laws. You shall not copy, reproduce, distribute, or otherwise make illegal
use of any copyrighted materials without permission of the rightful
owner or copyright holder. To the fullest extent permitted by applicable
law, LG Electronics disclaims all expressed and implied warranties as well
as liabilities associated thereto.

+ A maximum of 100 images can be used to create a GIF file.
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Sound quality and effects
features

DTS:X 3D Surround

You can play a song or video in three-dimensional, immersive and vivid
sound. To use this feature, connect earphones, speaker or other external
audio devices to your device.

Tap O > Settings > Sound > Sound quality and effects > DTS:X 3D
Surround, then tap QD to activate this feature.

Adjusting the sound direction

You can adjust the sound direction as desired.

1 Tap O > Settings > Sound > Sound quality and effects > DTS:X 3D
Surround.

7 Select sound direction.

Google Assistant

Google Assistant overview
You can launch or use desired apps with your voice.

E - To use this feature, first connect to the network and sign in to your
Google Account.
« This feature may not work properly or voice recognition accuracy may
decrease in areas where Wi-Fi or mobile network signal strength is
weak.

« This function may be not supported, or the supported languages may
differ depending on the service area.
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Launching Google Assistant
1 Press and hold O from the Home screen to launch Google Assistant.
2 Tap GET STARTED.

3 Follow the on-screen instructions and say “Ok Google”.
« The device saves your voice data for recognition.

4 Tap Save.

Launching Google Assistant with your voice
1 Say “Ok Google” when the screen is turned on.

2 Say a command or question when Google assistant pop-up appears
on the screen.

Launching Google Assistant from the Home

screen

1 Touch and hold O on the Home screen.

2 Say a command or question when Google assistant pop-up appears
on the screen.

E « Voice recognition accuracy may decrease if you speak with an unclear
voice or in a noisy place. When you use the voice recognition feature,
increase its accuracy by speaking with a clear voice in a quiet place.
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Fingerprint recognition

Fingerprint recognition overview
You must register your fingerprint on your device first before using the
fingerprint recognition function.
You can use the fingerprint recognition function in the following cases:

+ To unlock the screen.

- To view the locked content in the QuickMemo+.

+ Confirm a purchase by signing in to an app or identifying yourself with

your fingerprint.
E « Your fingerprint can be used by the device for user identification. Very

similar fingerprints from different users may be recognised by the
fingerprint sensor as the same fingerprint.

+ If the device cannot detect your fingerprint, or you forgot the value
specified for registration, visit the nearest LG Customer Service Centre
with your device and ID card.

Precautions for fingerprint recognition

Fingerprint recognition accuracy may decrease due to a number of
reasons. To maximise the recognition accuracy, check the following before
using the device.

+ The device has a fingerprint sensor. Ensure that the fingerprint sensor
is not damaged by a metallic object, such as coin or key.

+ When water, dust or other foreign substance is on the fingerprint
sensor or your finger, the fingerprint registration or recognition may
not work. Clean and dry your finger before having the fingerprint
recognised.

- A fingerprint may not be recognised properly if the surface of your
finger has a scar or is not smooth due to being soaked in water.

Custom-designed Features 24



If you bend your finger or use the fingertip only, your fingerprint may
not be recognised. Make sure that your finger covers the entire surface
of the fingerprint sensor.

Scan only one finger for each registration. Scanning more than one
finger may affect fingerprint registration and recognition.

The device may generate static electricity if the surrounding air is

dry. If the surrounding air is dry, avoid scanning fingerprints, or touch

a metallic object such as coin or key before scanning fingerprints to
remove static electricity.

Registering fingerprints
You can register and save your fingerprint on the device to use fingerprint
identification.

1 Tap O > Settings > Lock screen & security > Fingerprints.

+ Alock screen must be set to use this feature.

+ If the screen lock is not active, configure the lock screen by following the
on-screen instructions. See Setting a screen lock for details.

2 Locate the fingerprint sensor on the back of the device and gently put
your finger on it to register the fingerprint.

E « Gently press the fingerprint sensor so that the sensor can recognise
your fingerprint.
- Ensure that your fingertip covers the entire surface of the fingerprint
sensor.
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3 Follow the on-screen instructions.
+ Repeat scanning the fingerprint by moving your finger little by little
until the fingerprint registers.
/4 When the fingerprint registration is done, tap OK.

- Tap Add more to register another fingerprint. If you register only
one fingerprint and the corresponding finger is not in a good
condition, the fingerprint recognition may not work well. As the
preventive measure against this kind of situation, register multiple
fingerprints.

Managing fingerprints

You can edit or delete registered fingerprints.

1 Tap O > Settings > Lock screen & security > Fingerprints.
2 Unlock according to the specified lock method.

3 From the fingerprint list, tap a fingerprint to rename it. To delete it, tap
.

Unlocking the screen with a fingerprint

You can unlock the screen or view the locked content by using your
fingerprint. Activate the desired function:

1 Tap O> Settings > Lock screen & security > Fingerprints.
2 Unlock according to the specified lock method.

3 On the fingerprint settings screen, activate the desired function:
+ Screen lock: Unlock the screen with a fingerprint.

« Content lock: Unlock content with a fingerprint. To do this, make
sure that the content lock is set.
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Multi-tasking feature

Multi window
You can use two apps at the same time by separating the screen into the
multiple windows.
1 Tap [Jfrom the Home touch buttons.
+ Recently-used apps appear.
2 Tap 5 at the top of the desired app to use the Multi window feature.
+ The selected app appears at the top half of the screen.
Alternatively,
1 Touch and hold [Jwhile using an app.
+ Recently-used apps appear on the split screen.
7 Tap 5 at the top of the desired app to use the Multi window feature.
+ The selected app appears at the bottom half of the screen.

E - To deactivate the Multi window feature, touch and hold &5 on the
Home touch button.

« To adjust the size of the split screen, drag — at the center of the
screen.

+ The Multi window feature is not supported by some LG apps and the
apps downloaded from the Play Store.

Overview screen
The Overview screen provides a preview of your recently used apps.

To view the list of recently used apps, tap [_] on the Home, then tap the
displayed app.
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Product components and
accessories

The following items are included with your device.

+ Device + Charger
- Stereo headset - Quick Start Guide
+ USB cable + Ejection pin

+ Jelly Phone Case

+ The items described above may be optional.

+ The items supplied with the device and any available accessories may
vary depending on the area and service provider.

« Always use genuine LG Electronics accessories. Using accessories made
by other manufacturers may affect your device's call performance or
cause malfunctions. This may not be covered by LG's repair service.

« Some of the device parts are made of tempered glass. If you drop your
device on a hard surface or subject it to severe impact, the tempered
glass may be damaged. If this happens, stop using your device
immediately and contact an LG Customer Service Centre.

E « If any of these basic items are missing, contact the dealer from which
you purchased your device.

« To purchase additional items, contact an LG Customer Service Centre.
« Some items in the product box are subject to change without notice.

« The appearance and specifications of your device are subject to change
without notice.

« Device specifications may vary depending on the area or service provider.

+ Remove the protective film from the Fingerprint sensor before use of
the fingerprint recognition feature.
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Parts overview

Front camera lens —

Volume keys (+/-) —[

Google Assistant key —|

Earpiece
[_1— Proximity/Ambient light

/ﬁ\ sensor

-]-— Nano-SIM/Memory card
_] tray
— Power/Lock key

Touch screen

Stereo headset jack

: t Charger/USB cable port

Microphone ———

Rear camera lenses —
(Macro/Super Wide/
Depth/Standard sensor)

A

)OO @@—_ Flash

@ i Fingerprint sensor

--------- [—""""' — NFC area

Speaker ———— *———— Microphone
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A Do NOT attempt to remove the back cover by yourself.

Doing so may severely damage the battery and device, which could cause
overheating, fire, and injury. This device's back cover and battery are not to
be removed or replaced by a non-qualified professional

+ Proximity/Ambient light sensor

- Proximity sensor: During a call, the proximity sensor turns off the
screen and disables touch functionality when the device is in close
proximity to the human body. It turns the screen back on and enables
touch functionality when the device is outside a specific range.

- Ambient light sensor. The ambient light sensor analyses the ambient
light intensity when the auto-brightness control mode is turned on.

- Volume keys
- Adjust the volume for ringtones, calls or notifications.

- While using the Camera, gently press a Volume key to take a photo.
To take continuous photos, press and hold the Volume key.

- Press the Volume Down (-) key twice to launch the Camera app
when the screen is locked or turned off. Press the Volume Up (+) key
twice to launch Capture+.

+ Power/Lock key
- Briefly press the key when you want to turn the screen on or off.
- Press and hold the key when you want to select a power control
option.
+ Google Assistant key

- Your device has the Google Assistant built-in. Find answers and get
things done while on-the-go. To get started, just tap the Google
Assistant key on the side of the phone.

- Activate Google Assistant. See the Google Assistant for details.

Basic Functions 31



+ Fingerprint sensor

- Turn on the fingerprint recognition feature to simplify the process
of unlocking the screen. See Fingerprint recognition overview for
details.

E + Some functions may be restricted for access, depending on the device

specifications.

+ The rear of the device includes a built-in NFC antenna. Be cautious when
handling the device to avoid damaging or covering the NFC antenna.

+ Do not put heavy objects on the device or sit on it. Failure to do so may
damage the touch screen.

+ Screen-protective film or accessories may interfere with the proximity
sensor.

« If your device is wet or is being used in a humid place, the touch screen
or buttons may not function properly.

Hold the device correctly as shown below. If you cover the microphone
hole with a hand, finger, or protective case while using the device, you may
sound unclear during a call

Good example Bad example
Microphone Do not cover the microphone.
|
A 5 =
Q

S~

Microphone Do not cover the microphone.
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Turning the power on or off

Turning the power on
When the power is turned off, press and hold the Power/Lock key.

E + When the device is turned on for the first time, initial configuration
takes place. The first booting time for the smart phone may be longer
than usual

Turning the power off
Press and hold the Power/Lock key, then select Power off.

Restarting the device

When the device is not working properly or does not respond, restart it by
following the instructions below.

1 Pressand hold the Power/Lock key and the Volume Down (-) key at
the same time until the power is turned off.

2 When the device is restarted, release the key.

Power control options

Press and hold the Power/Lock key, then select an option.
« Power off: Turn the device off.

- Power off and restart: Restart the device.
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Installing the SIM card

Insert the SIM (Subscriber Identity Module) card provided by your service
provider to start using your device.

A + Be careful with the ejection pin since it has a sharp edge.

1 Insert the ejection pin into the hole on the card tray.

2 Pullout the card tray.

Basic Functions 34



3 Put the SIM card on the card tray with the gold-coloured contacts
facing downwards.
Put the primary SIM card on the SIM card tray 1 and the secondary
SIM card on the SIM card tray 2.
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E « This device supports only Nano SIM cards.

Micro Standard
e @

« For problem-free performance, it is recommended to use the device
with the correct type of SIM card. Always use a factory-made SIM card
supplied by the operator.

« If you insert the card tray into your device while the card tray is wet,
your device may be damaged. Always make sure the card tray is dry.

Precautions when using the SIM card

+ Do not lose your SIM card. LG is not responsible for damage and other
issues caused by loss or transfer of a SIM card.

+ Be careful not to damage the SIM card when you insert or remove it.
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Inserting the memory card

Insert the memory card into your device.

Depending on the memory card manufacturer and type, some memory
card may not be compatible with your device.

7 Insert the ejection pin into the hole on the card tray.
2 Pullout the card tray.

3 Put the memory card on the card tray with the gold-coloured contacts
facing downwards.

I— Memory card
(optional-sold separately)

SIM card
4 Insert the card tray back into the slot.
A - Some memory cards may not be fully compatible with the device. If you

use an incompatible card, it may damage the device or the memory card,
or corrupt the data stored in it.

+ Frequent writing and erasing of data may shorten the memory card
lifespan.
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Removing the memory card
Unmount the memory card before removing it for safety.
1 Tap O > Settings > Storage > /\.

2 Insert the ejection pin into the hole in the card tray and then pull out
the card tray from the device.

3 Remove the memory card from the card tray.
4 Insert the card tray back into the slot.
A + Do not remove the memory card while the device is transferring or
accessing information. This may cause data to be lost or corrupted, or
may damage the memory card or the device. LG is not responsible for

losses that result from the abuse or improper use of memory cards,
including the loss of data.

Battery
Charging the battery

Before using the device, fully charge the battery.
Charge the device with the USB Type-C cable.

Charging cable terminal
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A « Do not use the external terminal, charging cable or gender for the
device in presence of moisture. This may cause fire, electric shock,
injury, or device malfunction. If there is moisture, stop using the device
immediately and remove the moisture completely.

« Make sure to use the USB cable provided with your device.

« Make sure to use an LG-approved charger and charging cable. Charging
the battery with a third-party charger may cause the battery to explode
or may damage the device.

+ Your device has an internal rechargeable battery. For your safety, do not
remove the embedded battery.

« Using the device when it is charging may cause electric shock. To use the
device, stop charging it.

E « Remove the charger from the power socket after the device is fully
charged. This prevents unnecessary power consumption.

« Another way to charge the battery is by connecting a USB cable
between the device and a desktop or laptop computer. This may take a
longer time than plugging the adapter to a wall outlet.

+ Do not charge the battery by using a USB hub that is unable to maintain
the rated voltage. Charging may fail or unintentionally stop.

Precautions when using the device

- Make sure to use the USB cable provided; do not use third party USB
cables or chargers with your device. The LG limited warranty does not
cover the use of third party accessories.

+ Failure to follow the instructions in this quide and improper use may
damage the device.
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Using the battery efficiently

Battery lifespan may decrease if you keep many apps and functions
running simultaneously and continuously.

Cancel background operations to increase battery life.
To minimise battery consumption, follow these tips:

« Turn off the Bluetooth® or Wi-Fi network function when not using
them.

- Set the screen timeout to as short a time as possible.

+ Minimise the screen brightness.

- Set a screen lock when the device is not used.

+ Check the battery level while using any downloaded apps.

Touch screen

You can familiarise yourself with how to control your device by using
touch screen gestures.

Tapping
Lightly tap with your fingertip to select or run an app or option.
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Touching and holding
Touch and hold for several seconds to display a menu with available
options.

Double-tapping

Tap twice quickly to zoom in or out on a web page or map.

Dragging

Touch and hold an item, such as an app or widget, then move your finger
to another location in a controlled motion. You can use this gesture to
move an item.
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Swiping

Touch the screen with your finger and move it quickly without pausing.
You can use this gesture to scroll through a list, a web page, photos,
screens, and more.

Pinching and spreading
Pinch two fingers to zoom out such as on a photo or map. To zoom in,
spread your fingers apart.

O

/,'

- Do not expose the touch screen to excessive physical shock. You might
damage the touch sensor.
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Basic Functions

A touch screen failure may occur if you use the device near a magnetic,
metallic or conductive material.

If you use the device under bright lights, such as direct sunlight, the
screen may not be visible, depending on your position. Use the device
in a shady location or a location with an ambient light that is not too
bright and bright enough to read books.

Do not press the screen with excessive force.

Gently tap with your fingertip on the option you want.

Touch control may not work properly if you tap while wearing a glove or
by using the tip of your fingernail.

Touch control may not work properly if the screen is moist or wet.

The touch screen may not function properly if a screen-protective film
or accessory purchased from a third party store is attached to the
device.

Displaying a static image for extended periods of time may result in
after-images or screen burn-in. Turn off the screen or avoid displaying
the same image for a long time when you do not use the device.
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Home screen

Home screen overview

The Home screen is the starting point for accessing various functions
and apps on your device. Tap O on any screen to directly go to the Home
screen.

You can manage all apps and widgets on the Home screen. Swipe the
screen left or right to view all installed apps at a glance.

Home screen layout

You can view all apps and organise widgets and folders on the Home
screen.

Status bar — ST I
"

feaher WidQEt _.-

-— Google Search widget

B0790n

[ s — Page icon

C 8 0 a -—Quickaccessarea

Home touch buttons —; IR

+ The Home screen may differ depending on the manufacturer policy, user
settings, software version or service provider.
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- Status bar: View status icons, the time and the battery level.

- Weather widget: View the information of weather and time for a
specific area.

- Google Search widget: Type or speak to open Google Search.

- Page icon: Display the total number of Home screen canvases. You
can tap the desired page icon to go to the page you selected. The icon
reflecting the current canvas will be highlighted.

- Quick access area: Fix main apps at the bottom of the screen so that
they can be accessed from any Home screen canvas.

+ Home touch buttons
- <:Return to the previous screen. Close the keypad or pop-up

windows.

- (O :Tap to go to the Home screen. To launch Google Assistant, touch
and hold.

- [J:Tap to view alist of recently used apps or run an app from the
list. To delete all the recently used apps, tap CLEAR ALL. To use two
apps at the same time with the Multi window feature, touch and
hold the button while using an app.

- [@2): Choose which SIM card you are going to use. Tap and hold to
configure the Dual SIM card settings.

Basic Functions 45



Changing the style of the Home touch buttons
You can change the style of the Home touch buttons.
1 Tap O > Settings > Display > Home touch buttons.
2 Under STYLE, select Gesture and buttons or Buttons only to suit
your preferences.
+ Gesture and buttons: Back button < and Home button &= are
available. To see recent apps, swipe the Home button & up.
« Buttons only:<]/ /[ are available. Tap (] to see recent apps.

Editing the Home touch buttons

You can rearrange the Home touch buttons or add frequently used

functions to the Home touch buttons area.

Tap O > Settings > Display > Home touch buttons > Button

combination and customise the settings.

- Several functions, including QSlide, Notification and Capture+, are
provided.

— = = @ G
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Hiding the Home touch buttons

You can hide the Home touch buttons to view in a larger screen while

using an app.

1 Tap O > Settings > Display > Home touch buttons > Hide Home
touch buttons.

2 Select apps to hide the Home touch buttons while using the app, and
tap Q.
+ The Home touch buttons disappear 3 seconds after the last touch.

+ To view the Home touch buttons again, drag the bottom of the
screen upwards.

Lock/hide icon

The icon to lock or hide the Home touch buttons appears at the bottom
left of the screen.

If you want to lock the Home touch buttons while hiding the buttons, tap
O on the left of the Home touch buttons.

To hide the Home touch buttons again, double-tap ®.

E - Some features may not be supported while hiding the Home touch
buttons.
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Status icons

When there is a notification for an unread message, calendar event or
alarm, the status bar displays the corresponding notification icon. Check
your device's status by viewing notification icons displayed on the status

bar.
A No signal
Data is being transmitted over the network
® Alarm is set
i Vibrate mode is on

Bluetooth is on

o Connected to a computer via USB
[ Battery level
4+ Airplane mode is on
A Missed calls
2= | Wi-Fiis connected
N Mute mode is on
Q@ | GPSison
(0} Hotspot is on
N NoSMcard
N The NFC mode is on

« Some of these icons may appear differently or may not appear at all,

depending on the device's status. Refer to the icons according to the
actual environment and area in which you are using the device and your
service provider.

Displayed icons may vary, depending on the area or service provider.
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Notifications panel

You can open the notifications panel by dragging the status bar
downward on the main screen.

+ You can drag down the notice window or tap the arrow icon to open
the list of quick setting icons.

- You can tap £ to add, delete or arrange icons in the notice window.

- If you touch and hold the icon, the settings screen for the
corresponding function appears.

+ You can use the notifications panel even on the lock screen. Drag the
notifications panel while the screen is locked to quickly access the
desired features.
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Switching the screen orientation

You can set the screen orientation to automatically switch according to
the device’s physical orientation.

On the notification panel, tap Rotation from the quick access icon list.

You can also tap O > Settings > Display and activate Auto-rotate
screen.

Editing the Home screen

On the Home screen, touch and hold on an empty space, then select the

desired action from below.

- Torearrange the Home screen canvases, touch and hold on a canvas,
then drag it to another location.

- To add a widget to the Home screen, touch and hold on a blank area of
the Home screen, then select Widgets.

- To change wallpapers, themes, and icons, touch and hold on a blank
area of the Home screen, then select Wallpaper & theme.

You can also tap O > Settings > Display > Wallpaper & theme, then
select wallpapers, themes, and icons, to apply to the device.
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- To configure the Home screen settings, touch and hold on a blank area
of the Home screen, then select Home screen settings. See Home
screen settings for details.

- Toview or reinstall the uninstalled apps, touch and hold on a blank area
of the Home screen, then select App trash. See App trash for details.
+ To change the default screen, touch and hold on a blank area of the

Home screen, move to desired screen, tap Y, then tap the screen once
more.

L — Default screen
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Viewing the background theme

You can view only the background image by hiding the apps and widgets
on the Home screen.

Spread two fingers apart on the Home screen.

- Toreturn to the original screen, which displays apps and widgets, pinch
your fingers on the Home screen or tap <

Moving apps on the Home screen

On the Home screen, touch and hold an app, then drag it to another
location.

+ To keep frequently used apps at the bottom of the Home screen, touch
and hold an app, then drag it to the quick access area at the bottom.

+ Toremove an icon from the quick access area, drag the icon to the
Home screen.

Basic Functions 52



Using folders from the Home screen

Creating folders
On the Home screen, touch and hold an app, then drag it over another
app.

A new folder is created and the apps are added to the folder.

Editing folders
On the Home screen, tap a folder and do one of the following actions.

- To edit the folder name or colour, tap the folder name or colour button
on upper right corner.

- To add apps, touch and hold an app, then drag it over the folder and
release it.

- To remove an app from the folder; touch and hold the app and drag it to
outside the folder If the removed app is the only one app that existed
in the folder, the folder is removed automatically.

+ You can also add or remove apps after tapping () in the folder:

E + You cannot change the folder colour while using downloaded theme.

Home screen settings
You can customise the Home screen settings.
1 Tap O > Settings > Display > Home screen.
2 Customise the following settings:
- Select Home: Select a Home screen mode.
- Wallpaper: Change the Home screen background wallpaper.

- Screen swipe effect: Select an effect to apply when the Home
screen canvas switches.

Basic Functions 53



Icon shape: Choose if you want icons to have square or rounded
corners.

Google feed: Enable Google feed to show to the left of Home
screen.

Sort apps by: Set how apps are sorted on the Home screen.
Grid: Change the app arrangement mode for the Home screen.

Hide apps: Select which apps you want to hide from the Home
screen.

Loop Home screen: Enable to allow continuous Home screen
scrolling (loop back to first screen after the last screen).

Search: Search by swiping down on the Home screen.

Home screen lock: Turn on to prevent apps and widgets from being
rearranged or removed.

Screen lock

5

Screen lock overview

Your device's screen turns off and locks itself if you press the Power/Lock
key. This also happens after the device is left idle for a specified period of
time.

If you press the Power/Lock key when a screen lock is not set, the Home
screen appears immediately.

To ensure security and prevent unwanted access to your device, set a
screen lock.

+ Ascreen lock prevents unnecessary touch input on the device screen
and reduces battery consumption. \We recommend that you activate the
screen lock while not using the device.
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Setting a screen lock
There are several options available for configuring the screen lock settings.
1 Tap O > Settings > Lock screen & security > Select screen lock and
then select the method you prefer.
2 Customise the following settings:
+ None: Deactivate the screen lock function.
- Swipe: Swipe on the screen to unlock the screen.
+ Pattern: Draw a pattern to unlock the screen.
+ PIN: Enter a numeric password to unlock the screen.
« Password: Enter an alphanumeric password to unlock the screen.
« Fingerprints: Unlock the screen by using your fingerprint.

5 « If you incorrectly attempt to unlock the device 5 times, the screen is
blocked for 30 seconds.

Secure start-up settings

When you select Pattern, PIN or Password as a screen lock method, you
can configure your device to be locked whenever turning on the device in
order to secure your data.
+ You cannot use all functions, except for emergency calls until you
unlock the device.
- If you forget your decryption password, you cannot restore encrypted
data and personal information.
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Precautions for the secure start-up feature

- If you forget your decryption password, you cannot restore encrypted
data and personal information.

- Be sure to keep your screen lock passwords separately.

- If you enter the screen lock passwords incorrectly more than the
specified times, the device automatically resets itself and the encrypted
data and your personal information are deleted automatically and they
cannot be restored.

- Be cautious not to enter incorrect screen lock passwords more than
the specified times.

+ When you turn on the device right after the device resets, encryption
also starts. If you stop the encryption arbitrarily, the data may be
damaged. Be sure to wait until the reset is completed.

Customize Lock screen

You can customise lock screen.

1 Tap O > Settings > Lock screen & security > Customize Lock
screen.

2 Select a function you want to set.
- Wallpaper: Allows you to set the background for your Lock screen.

+ Clock: Allows you to set where to position the clock on the Lock
screen.

+ Shortcuts: Allows you to choose apps to run on your Lock screen.
This setting appears only when a screen lock is set.

- Contact info for lost phone: Allows you to set text to be displayed
on the Lock screen to identify the phone's owner.
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Secure lock settings
You can set secure lock settings.
1 Tap O > Settings > Lock screen & security > Secure lock settings.
2 Select a function you want to set.
- Make pattern visible: Allow you to make pattern visible.

+ Lock timer: Allows you to set the amount of time before the screen
automatically locks after the backlight turns off (time-out due to
inactivity).

- Power key instantly locks: Enable this option to instantly lock the
screen when the Power/Lock key is pressed. This setting overrides
the Security Lock timer setting.

- Show lockdown option: Allow you to show power menu option to
turn off Lock screen notifications, Smart Lock and biometric locks.

-+ Smart Lock: Allows you to set trusted devices, places, voice, and/or
on-body detection that will allow your phone to remain unlocked.

+ Menus you can set may be different depending on lock screen methods
you choose.
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KnockON

You can turn the screen on or off by double-tapping the screen.

I_;'] « This option is available only on the Home screen provided by LG. It may
not function properly on a custom launcher or on the Home screen
installed by the user.

+ \When tapping the screen, use your fingertip. Do not use a fingernail.

+ To use the KnockON feature, make sure that the proximity/light sensor
is not blocked by a sticker or any other foreign substance.

Turning the screen on
Double-tap the middle of the screen.

- Tapping the top or bottom of the screen may decrease the recognition
rate.

Turning the screen off
Double-tap on an empty space on the Home screen and Lock screen.
You can also double-tap an empty space on the status bar.

Disable KnockON

If you don't want to use the KnockON function, set as follows:

Tap O > Settings > Extensions > KnockON and drag it to disable the
function.
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Memory card encryption

You can encrypt and protect data saved on the memory card. The
encrypted data in the memory card cannot be accessed from another
device.

1 Tap O > Settings > Lock screen & security > Encryption &
credentials > Encrypt SD card.

72 Read the on-screen overview of memory card encryption and then tap
Continue to continue.
3 Select an option and tap Encrypt now.
- New data encryption: Encrypt only data that is saved on the
memory card after encryption.
+ Full encryption: Encrypt all the data currently saved on the memory
card.

+ Exclude media files: Encrypt all files, except for media files such as
music, photos and videos.

E + Once memory card encryption starts, some functions are not available.
- If the device is turned off while encryption is underway, the encryption
process will fail, and some data may be damaged. Therefore, be sure to

check if the battery level is sufficient before starting encryption.

Encrypted files are accessible only from the device where the files were

encrypted.

+ The encrypted memory card cannot be used on another LG device. To
use the encrypted memory card on another mobile device, format the
card.

+ You can activate memory card encryption even when no memory card

is installed into the device. Any memory card that is installed after

encryption will automatically be encrypted.
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Taking screenshots

You can take screenshots of the current screen you are viewing.

Via a shortcut

Press and hold the Power/Lock key and the Volume Down (-) key at the
same time for at least two seconds.

+ Screenshots can be viewed from the Screenshots folder in the
Gallery.

Via Capture+

On the screen where you want to take a screenshot, drag the status bar
downwards, then tap (7.

5 + When the screen is turned off or locked, you can access Capture+ by
pressing the Volume Up (+) key twice. To use this feature, tap O >
Settings > Extensions > Shortcuts and turn on Open Capture+.

- See Writing notes on a screenshot for details.

Entering text

Using the Smart toolbar

You can use various keyboard input methods in one place. You can select
the desired input method from the top of the keyboard.

1 Select the desired keyboard input method from the Smart toolbar.

2 Tap v and select the input method you want to show on the Smart
tool, or reorganise them.
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E + LG keyboard is not default on your phone. You can change it from the
keyboard settings.

- Some supporting input methods may differ depending on the device
you have.

+ You can turn on or off the Smart tool feature from the keyboard
settings.

- You can also use the keyboard input methods by tapping G3.

- ©:Add emajis.
+ 22 :Add adraw chat.
+ § :Tap & to enter text with your voice.
- To maximise the voice command recognition, speak clearly.

- To enter text with your voice, make sure that your device is
connected to a network.

- To select the language for voice recognition, tap £% > Languages
on the voice recognition screen.

- This function may not be supported, or the supported languages
may differ depending on the service area.

« §63 : Access keyboard settings.
- [EE): Open the clip tray. See Clip Tray for details.

. : Activate floating keyboard when you use the Multi-window
feature. You can also move the keyboard to the desired location.
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Using the Smart keyboard
You can use the Smart keyboard to enter and edit text.

With the Smart keyboard, you can view text as you type without
bothering to alternate between the screen and a conventional keyboard.
This allows you to easily find and correct errors when typing.

Moving the cursor

With the Smart keyboard, you can move the cursor to the exact position
you want. When typing text, touch and hold on the space bar and then
drag left or right.

Smart keyboard

E « This option is available only on the QWERTY keyboard.
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Suggesting words

Smart keyboard automatically analyses your usage patterns to suggest
frequently used words as you type. The longer you use your device, the
more precise the suggestions are.
Enter text, then tap a suggested word or gently drag the left or right side
of the keyboard upwards.
+ The selected word is automatically entered. You do not need to
manually type every letter of the word.

Smartphone smart  Smartphones Smartphone  Smarf Sharibhohes

I'fllll-l- l--llll !

Adding languages to the keyboard
You can make additional languages available for keyboard input.

1 Tap O > Settings > System > Language & keyboard > Manage
keyboards > LG Keyboard > Language & keyboard layout > Select
languages.

2 Select the languages you want to make available.
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Copy and Paste

You can cut or copy text from an app, and then paste the text into the
same app. Or, you can run other apps and paste the text into them.

7 Touch and hold around the text you want to copy or cut.
2 Drag @/ W to specify the area to copy or cut.
3 Select either Cut or Copy.
+ Cut or copied text is automatically added to the clip tray.
4 Touch and hold the text input window, then select Paste.

- If there is no item that has been copied or cut, the Paste option will not
appear.

Clip Tray
If you copy or cut an image or text, it is automatically saved to the clip tray
and can be pasted to any space at any time.

7 Onthe Smart tool, select @]
You can also touch and hold the text input window, then select Clip
Tray.

2 Select and paste an item from the clip tray.
+ Amaximum of 20 items can be saved to the clip tray.

+ Tap &3 to lock saved items in order not to delete them, even when
the maximum quantity is exceeded. A maximum of ten items can be
locked. To delete locked items, unlock them first.

+ Tap [if] to delete the items saved to the clip tray.

5 + The clip tray may not be supported by some downloaded apps.
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Content sharing

Playing content from another device
You can play photos, videos or songs saved on your device froma TV.

71 Connect the TV and your device to the same Wi-Fi network.

2 While viewing an item in the Gallery or Music app, tap : > Play on
other device.

3 Select the TV you want to connect to.

E « For use with Chromecast, Google Play services should be up to date.

Viewing content from nearby devices

You can view content from various devices, such as a computer, NAS or
mobile device, by using the Gallery or Music app.

Connecting the devices

Connect both your device and another device that support DLNA function
to the same wireless network.

E « Make sure that File sharing (DLNA) is activated on both devices.

Searching for nearby devices

You can view a list of DLNA devices on the same network by selecting the
Nearby devices menu in each app.

Use content from nearby devices as if you were using it on your device.
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Sending or receiving files

You can share files between your device and another LG device, or a tablet
or computer.

Sending files

From the Gallery or other apps, tap : > Share or <<, then select a device
on the file sharing list.

Receiving files
Drag the status bar downward and then tap File sharing.

If your device does not support the file sharing feature, tap O > Settings
> Connected devices > File sharing > SmartShare Beam ().

E + Make sure that your device is connected to the same wireless network
as the file transfer target device.

- Make sure that File sharing is activated on both devices.
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Installing and uninstalling apps

Installing apps
Access an app store to search and download apps.

+ You can use SmartWorld, Play Store or the app store provided by your
service provider.

E + Some app stores may require you to create an account and sign in.
+ Some apps may charge fees.

« If you use mobile data, you may be charged for data usage, depending
on your pricing plan.

+ Smart\World may not be supported depending on the area or service
provider.

Uninstalling apps

Uninstall apps that you no longer use from your device.

Uninstalling with the touch and hold gesture

On the Home screen, touch and hold the app to uninstall, then drag it over
Delete at the top of the screen.

- If apps were uninstalled within 24 hours from now, you can reinstall
them. See App trash for details.

Uninstalling by using the settings menu
Tap O > Settings > Apps & notifications > App info, select an app, then
tap Uninstall

I_;,] + Some apps cannot be uninstalled by users.
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Uninstalling apps from the app store

To uninstall an app, access the app store from which you download the
app and uninstall it.

Installing and uninstalling apps during the

setup

\When you turn on the device for the first time, you can download
recommended apps.

You can skip to the next step without installation.

App trash

You can view the uninstalled apps. You can also reinstall apps which were
uninstalled within 24 hours from now.
1 Tap O > Management > App trash.
You can also touch and hold an empty area of the Home screen, then
tap App trash.
2 Activate the desired function:
- Restore: Reinstall the selected app.
« {ij : Remove the uninstalled apps permanently from the device.

E + Uninstalled apps are automatically removed from the device 24 hours
after they were uninstalled. If you want to reinstall the uninstalled apps,
you must download them again from the app store.

- This feature is activated on the default Home screen only. If you
uninstall apps while using the EasyHome screen or other launcher, they
are immediately and permanently removed from the device.
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App Shortcuts

On the Home screen, touch and hold an app icon such as Call, Message,
Camera, Gallery and Settings to display a quick access menu. Use apps
more easily through App Shortcuts.

- Tap & to configure the settings for the desired app's widget.
+ Tap @ to view the information for the desired app.

E « This feature is available only on some apps.
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Phone

Voice call

Make a phone call by using one of the available methods, such as manually
entering a phone number and making a call from the contact list or the
list of recent calls.

Making a call from the keypad

1 TapO>@® > Dial

2 Make a call by using a method of your choice:
- Enter a phone number and tap @@.
+ Touch and hold a speed dial number.

« Search for a contact by tapping the initial letter of a contact name
in the contact list, and then tap @@.

E + Toenter "+" when making an international call, touch and hold number
0.

+ See Adding contacts for details on how to add phone numbers to the
speed dial list.

Making a call from the contact list

T TapO>®> Contacts.

2 From the contact list, select a contact and tap &...
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Answering a call
To answer a call, drag @ on the incoming call screen.
+ When the stereo headset is connected, you can make calls by using the
call/end button on the headset.
+ To end a call without turning off the screen, tap O > Settings >
Network & internet > Call > Answer and end calls and then activate
End call with the Power key.

Rejecting a call
To reject an incoming call, drag @ across the incoming call screen.

- To send a rejection message, drag the rejection message option
across the screen.

- To add or edit a rejection message, tap O > Settings > Network &
internet > Call > Call blocking & Decline with message > Decline
with message.

+ When a callis coming in, press the Volume Up (+), Volume Down (-) or
Power/Lock key to mute ringtone or vibration, or to hold the call

Checking an incoming call while using an app

When a call comes in while using an app, a pop-up notification can be
displayed at the top of the screen. You can receive the call, reject the call,
or send message from the pop-up screen.

E - Tap (O > Settings > Network & internet > Call > Additional settings

> Incoming voice call pop-up and then select the desired way you
would like to display the incoming call while using an app.
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Viewing missed calls
If there is a missed call, the status bar at the top of the screen displays X.

To view missed call details, drag the status bar downwards. You can also
tap O > (@ > Call logs.

Functions accessible during a call

During a call, you can access a variety of functions by tapping the
on-screen buttons:

- Contacts: View the contact list during a call.

+ Hold: Hold a call.

- Dialpad: Display or hide the dial pad.

- Speaker: Turn on the speakerphone function.

- Mute: Mute your voice so that your voice cannot be heard by the other
party.

+ Bluetooth: Switch the call to a Bluetooth device that is paired and
connected.

- @ :Endacal

« ¢+ :Access additional call options.

+ Available settings items may vary depending on the area or service
provider.
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Making a three-way calling
You can make a call to another contact during a call.
1 Duringacal, tap : >Add call.

2 Enter a phone number and tap @.
+ The two calls are displayed on the screen at the same time, and the
first callis put on hold.

3 To start a conference call, tap Merge calls.

E « You may be charged a fee for each call. Consult with your service
provider for more information.

Viewing call records

To view recent call records, tap O > (> Call logs. Then, you can use the
following functions:

- To view detailed call records, select a contact. To make a call to the
selected contact, tap ...

- To delete call records, tap : > Delete.

E « The displayed call duration may differ from the call charge. Consult with
your service provider for more information.

« The deleted call history can not be restored.

« Pinch two fingers or spread your fingers apart to adjust the font size of
call logs or contacts.

Configuring call options
You can configure various call options.
1 TapO>(®> Dial or Call logs.

2 Tap : > Call settings and then configure the options to suit your
preferences.
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Messaging

Sending a message

You can create and send messages to your contacts using the Messaging

app.

« Sending messages abroad may incur additional charges. Consult with

your service provider for more information.

T TpO>0

2 Tap Gl

3 Specify a recipient and create a message.
+ To use multimedia options, tap ().
+ To access optional menu items, tap .

4 Tap B> to send the message.

Reading a message
You can view exchanged messages organised by contact.

1T TpO>B

2 Select a contact from the message list.

Configuring messaging settings

You can change messaging settings to suit your preferences.

T TpO>B

2 Tap : > Settings from the message list.
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Camera

Starting the camera

You can take a photo or record a video to cherish all of your memorable
moments.

TapO> @
E « Before taking a photo or recording a video, wipe the camera lens with a
soft cloth.

+ Be careful not to stain the camera lens with your fingers or other
foreign substance.

+ Images included in this user guide may be different from the actual
device.

+ Photos and videos can be viewed or edited from the Gallery. See Gallery
overview for details.

Basic features in the Camera app

You can take photos or record videos by selecting a variety of camera
modes and options.

1T Tap O>@®
2 Tap () to take a photo, or tap Video > @ to record a video.

Change the
camera angle.

Set/Cancel timer — Switch between

front and rear
cameras.

°a— Take photos.

g — Start the Gallery.

camera options.
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Taking a photo
1 Select a camera mode and tap the subject to focus the camera on.

2 Tap () to take a photo.

+ You can also press the Volume Down or Volume Up key to take a
photo.

+ You can take a photo while recording a video by pressing @ on the
screen.

E « You can run the camera app by short-pressing the power key twice. Tap
(O > Settings > Extensions > Shortcuts and then tap Open Camera
to activate it.

+ When the screen is turned off or locked, start the camera by pressing
the Volume Down key twice. Tap (> Settings > Extensions >
Shortcuts and then tap Open Camera () to activate it.

Recording a video

1 Tap O > @ > Video and tap the subject to focus on.
2 Tap @ to record a video.

To take a photo while recording a video, tap @.

To pause the video recording, tap @. To resume the video recording,
tap e

While recording a video, you may spread or pinch two fingers to
zoom in or out.

+ While recording a video, you may tap the desired area to adjust the
brightness.

3 Tap(= toend the video recording.
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Customising the camera options
You can customise a variety of camera options to suit your preferences.

Tap 63 on the screen.

E - Available options vary depending on the selected camera (front or rear
camera) and the selected camera mode.

+ []:Take aphoto in

FullVision.

- [0]: Select values for aspect ratio and size for taking photos.

+ [4:Select values for resolution and size for recording videos.

HDR

Obtain photos in vivid colours and get compensated
effects even when they are taken against the light.
These functions are provided by the high dynamic range
(HDR) technology equipped in the camera.

Cheese shutter

Take photos with voice commands.

Tag locations

Save the image with GPS location data.

Display guide grids so that you can take photos or

Grid record videos based on the horizontal and vertical
reference lines.
Select if you want to store the pictures and videos

Storage in the Internal storage or SD card. (Available when a
memory card is inserted.)

Help Provide Help for each camera menu.

Additional options on the front camera
) Take a selfie by selecting its option between Gesture
Selfie shot shot and Auto shot.
Save as flipped Save as flipped images after taking selfies.
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Changing the camera mode

You can select a camera mode that suits your environment to take a
photo or record a video easily and conveniently.

Tap O > (&) > More, then select the desired mode.

- You can change the order of the scene modes by moving the scene
mode icon while pressing and holding the icon.

Various camera modes

Panorama

You can create a panoramic photo by moving the camera in one direction
to photograph and stitch continuous shots of a wide view.

1 Tap O > (&), then tap More > .
2 Tap () and then slowly move the camera in one direction.

+ Move the device by following the direction of the arrow in the
guideline.

3 Tap @ to stop capturing the panoramic.

T
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Food

You can take a photo or record a video with adjusting the colour slide bar
and white balance.

T TapO> @, then tap More > SR.

2 Tap () to take a photo.

+ Drag the colour slide bar on the screen to adjust the white balance
and select the best colour.

- If the slide bar is not displayed, tap %% to adjust the white balance.

Flash Jump-Cut
Photos taken at a regular interval are saved as GIF files.
1 TapO> [ then tap More >~
2 Tap () to take a photo.
+ Photos are taken every 3 seconds and saved as a GIF file.

- Tap f@on the screen to select the number of photos you want to
take.

+ While taking photos, tap @ to create GIF files with previously taken
photos.

5 + The flash automatically turns on to act as a timer.

+ The shots taken this time and the total number of shots are displayed
at the bottom of the screen.

- All taken photos are saved as GIF files only.
+ You may not change the GIF speed nor image order.

Macro

You can take a close-up of a subject.
1 Tap Q> () then tap More >'®,
2 Tap () to take a photo.
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YouTube Live
You can record a video and directly upload to YouTube.
1 Tap O> (@ then tap More > ((e)).
2 Tap - and record a video.
+ To use this feature, you need to verify your phone number.

E + YouTube Live is available only when your device is connected to the
Internet. If you use mobile data, you may be charged for data usage,
depending on your pricing plan.

Portrait
You can take sharp portrait by applying camera lens blur effect.
See Portrait for details.

Al CAM

You can effectively take photos or record videos since the camera
recognises the object when taking a photo or recording a video.

See Al CAM for details.

Other useful features in the Camera app

Auto-Exposure/Auto-Focus lock

You can fix the current exposure level and focus position by touching and
holding the screen in the Auto mode. To turn off the feature, tap a blank
area on the screen.
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E « This feature is available only in specific modes.

Burst shot
You can take continuous shots of photos to create moving pictures.
In the Auto mode, touch and hold ( .

- Continuous shots are taken at a fast speed while () is held down.

Switching between cameras

You can switch between the front and rear cameras to suit your
environment.

On the camera screen, tap {o} or drag the screen up or down to switch
between the front and rear cameras.

ans

E « Use the front camera to take selfies. See Selfie shot for details.
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Zoom in or out

You can use zoom in or out on the camera screen while taking a photo or
recording a video.
+ On the camera screen, pinch or spread two fingers to zoom in or
out. Or using the adjustment bar which appears when drag (&) / @)
upwards, zoom in or out and switch between the standard and wide
angle.

- Zoom in/out function is not available in the selfie mode (front camera).
« This function is not supported in a number of modes.

Selfie shot

You can use the front camera to view your face on the screen and take
selfies.

Gesture shot

You can take selfies by using gestures.

Show your palm to the front camera and then clench your fist.

You can also clench your fist and then open it towards the front camera.
+ In three seconds, a photo is taken.

J

n

g
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E « To use this feature, switch to the front camera mode, then tap @ >
Selfie shot > Gesture shot.

+ Make sure that your palm and fist are within the reference line so that
the camera can detect them.

« This feature may not be available while using some of the camera
features.

Auto shot

You can use the face detection feature to take selfies easily and
conveniently. You can set the device so that, when you look at the screen,
the front camera detects your face and takes a selfie automatically.

+ The white coloured guide frame appears when the front camera
detects your face. If the subject within the guide frame stops moving,
the guide frame colour turns yellow, then the camera takes a photo.

I_;'] - Tap £83> Selfie shot > Auto shot to enable the Auto shot feature.

Interval shot
You can take selfies at an interval.

While using the front camera, you can show your palm to the camera,
then clench your fist twice quickly.

« Four photos are taken at reqular intervals after a timer delay of three
seconds.

Save as flipped

Before taking a photo with the front camera, tap €63 > Save as flipped.
The image is flipped horizontally.

E + When using the front camera, you can change how selfies are taken in
the camera options. See Customising the camera options for details.
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quick share

You can share a photo or video to the app you want immediately after
taking it.

1 TapO>[®, then take a photo or record a video.

2 Tap the app icon that appears on the screen to share it using that app.
You can also swipe the icon towards the opposite direction to see
what other apps you can use to share your photos and videos.

quick share icon

5 + The app displayed by the quick share icon may vary, depending on the
type and frequency of access to the apps installed on the device.

« This feature is available only in specific modes.
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Gallery

Gallery overview
You can view and manage photos and videos saved on your device.
1T OB
- Saved photos and videos are displayed by folder.
2 Tap afolder and select a file.
+ View the selected file in full-screen mode.
+ While viewing a photo, swipe left or right to view the previous or
next photo.
+ While viewing a video, swipe left or right to rewind or fast-forward
the video.
+ You can view the photos or videos organised by year, month or day
in the Photos tab.
- To view photos by location at which the photo was taken, tap O >
(2) > 53> Tag locations, then tap (). The photos are automatically
grouped by location under the Memory tab of the Gallery app.

E - Some file formats may not be supported, depending on the installed
software.

+ Some files may not be opened due to encoding.
« Files that exceed the size limit may cause an error.
+ You need to activate the GPS feature to create Memory albums.
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Viewing photos

Start Google Lens.
— Add to or remove
from your favorites.

- Access additional
options.

Back to the —¢
previous screen.

Start the camera.

Write a memo on a T T Delete images.
photo.
Editimages. Share images.

E + Todisplay the menu items, gently tap the screen. To hide the menu
items, tap the screen again.

Playing a video
Open with QSlide.

Pause or play the O Acg_ess additional
video. options.

Rewind the video —— g et T o — Fast-forward the

¥ g e video.
Choose screen —— T Lock or unlock the
ratio. screen.
DTSX 3D Surround. Edit the video.
Making a GIF file.

E + To adjust the sound volume, drag the right side of the video screen up
or down.

+ To adjust the screen brightness, drag the left side of the screen up or
down.
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Editing videos
1 While viewing a video, tap /2.
2 Use avariety of effects and edit tools to edit the video.

Adjust the
resolution.

Revert the edit. Automatically
createa 15 sec,
30 sec or 60 sec
video clip.

Select a section to
change the play
speed.

duration.

3 Tap Save to save changes.

Creating a movie
You can create a new movie by putting images and videos together.
See Creating a movie for details.

Making a GIF

You can easily make a GIF file using recorded video.
See Making a GIF for details.
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Deleting files

You can delete files by using one of the following options:
+ Touch and hold a file from the file list, then tap Delete.
« Tap {ifj from the file list and delete the desired files.

+ Deleted files are automatically moved to Trash and they can be
restored to the Gallery within 7 days.

- Tap [] to completely delete the files. In this case, the files cannot be
restored.

Sharing files
You can share files by using one of the following options:

+ While viewing a photo, tap «< to share the file by using the method
you want.

+ While viewing a video, : > Share to share the file by using the method
you want.

« Tap < from the file list to select files and share them using the method
you want.
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Contacts

Contacts overview
You can save and manage contacts.
Tap O > Essentials > Contacts.

Adding contacts

Adding new contacts

1 Onthe contact list screen, tap -
- A pop-up appears for selecting the saving location for contact.
Select the location you want.

2 Enter contact details and tap Save.

Importing contacts
You can import contacts from another storage device.

T Onthe contact list screen, tap : > Manage contacts > Import.

2 Select the source and target locations of the contact you want to
import, and then tap OK.

3 Select the contacts and tap Import.

Adding contacts to the speed dial list
T Onthe contact list screen, tap : > Speed dial
7 Tap Add contact from a speed dial number.

3 Select a contact.

E + While adding a new contact, tap {313} to add a speed dial number.

Useful Apps

90



Searching for contacts
You can search for contacts by using one of the following options:

- Tap the search bar at the top of the Contacts screen and enter the
desired contact or phone number you want to search for.

+ Scroll the contact list up or down.

+ From the index of the contact list screen, tap the initial letter of a
contact.

E + Pressing the search bar at the top of the Contacts screen and entering
a contact or phone number brings up the integrated search results from
the call history and contacts list saved onto the product.

Contacts list

Editing contacts
7 Onthe contact list screen, select a contact.
2 On the contact detail screen, tap ¢ and edit details.

3 Tap Save to save changes.

Deleting contacts
You can delete contacts by using one of the following options:

+ On the contact list screen, touch and hold a contact you want to
delete, then tap Delete contact.

- Tap : > Delete on the contact list screen.

E + Deleted contacts may not be restored.
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Adding favourites

You can register frequently used contacts as favourites.

1 On the contact list screen, select a contact.
2 On the contact detail screen, tap ¥y

Creating groups

T On the contacts group list, tap -+

2 Enter anew group name.

3 Tap Add members, select contacts, then tap Add.

/| Tap Save to save the new group.

QuickMemo+

QuickMemo+ overview

You can make creative notes by using a variety of options on this

advanced notepad feature, such as image management and screenshots,

which are not supported by the conventional notepad.

Creating a note
1 Tap O > QuickMemo+.
2 Tap @ to create a note.
+ \ :Save anote.
+ €5 :Undo the previous edit.
+ > :Redo the recently deleted edits.
+ T :Enter a note by using the keypad.
-/ \Write notes by hand.
+ & :Erase handwritten notes.
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+ {y:Zoomin or out, rotate or erase the parts of a handwritten note.
« ¢ :Access additional options.

3 Tap~ tosave the note.

Writing notes on a screenshot
1 While viewing the screen you want to capture, drag the status bar
downwards and then tap (7.
+ The screenshot appears as the notepad background theme. Memo
tools appear at the top of the screen.
2 Crop the image (if necessary) and take notes as desired.
+ Write notes by hand on the photo.

3 Tap < and save the notes to the location you want.
- Saved notes can be viewed in either QuickMemo+ or Gallery.

- To save notes in the same location all the time, select the Use as
default app checkbox and select an app.

+ You can capture the entire screen by using the scroll capture feature.

+ While using an app such as Message and Chrome, drag the notifications
panel downwards and then tap Capture+ > Extended to capture the
entire screen you are currently viewing as a single file.

- This feature is available only on some apps that support the scroll
capture feature.

+ Pinch two fingers or spread your fingers apart to change the memo
layout.
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Managing folders
You organise and view memos according to the memo type.
1 Tap O> QuickMemo+.

2 Tap = on the top part of the screen and then select the desired
function.

+ All memos: You can collectively view all memos save in
QuickMemo+.

+ My memos: You can view the memos created in QuickMemo+.
- Capture+: You can view the memos created using Capture+.

« Trash: You can view the deleted memos.

- New category: You can add folders.

- /2 You can change the order of folders or add/delete folders. By
pressing the folder, you can change the folder name.

5 « Some folders do not appear when the folder app initially started. Folders
are additionally displayed only when relevant memos exist.

+ Deleted memos are moved to the trash bin and can be recovered within
7 days from the day they were deleted. In the QuickMemo-+ app, you can
change the display type by placing two fingers on the screen and either
widening or narrowing the fingers.

Clock

Alarm
You can set an alarm to trigger it at a specified time.

1 Tap O> Clock > Alarm.
2 Tap—}to add a new alarm.

3 Configure the alarm settings and tap Save.
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« If you select a previously set alarm, you can edit the alarm.

- Todelete an alarm, tap ¢ > Delete at the top of the screen. You can also
touch and hold the alarm.

World clock

You can view the current time in cities around the world.
1 Tap O> Clock > World clock.

2 Tap-}and add acity.

Timer
You can set the timer to trigger an alarm after a specified period of time.
1 Tap O> Clock > Timer.

2 Set the time and tap Start.
- To suspend the timer, tap Pause. To resume the timer; tap Resume.

3 Tap Stop to stop the timer alarm.

Stopwatch
You can use the stopwatch to record a lap time.
1 Tap O > Clock > Stopwatch.
7 Tap Start to initiate the stopwatch.
- Torecord a lap time, tap Lap.
3 Tap Pause to suspend the stopwatch.
+ To resume the stopwatch, tap Resume.
+ To clear all the records and restart the stopwatch, tap Reset.
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Music

You can play and manage songs or music albums.
1 Tap O > Essentials > Music.

7 Select a category.

3 Select a music file.

Play music with the

camera flash blinking to —— Set sound effects.
the beat.
Back to the previous —s ¢ % It = :e— Access additional options.

screen.
— Switch to the playlist.

— Pause or play.

Tap to play from the

Tap to play the next file /

beginning of the current Touch and hold to fast
file / Double-tap to play forward.
the previous file / Touch
and hold to rewind. x M Ppoowm
Play in random order. ——I L— Select a repeat mode.
Adjust the sound volume. — g % #s—— Change pitch and speed.

Add to or delete from your Q

favourites.

5 « Some file formats may not be supported, depending on the installed
software.

« Files that exceed the size limit may cause an error.

« Music files may be protected by international copyright owners or
copyright laws. You may have to obtain legal permission before copying
amusic file. To download or copy a music file, first check the copyright
law for the relevant country.
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Calculator

You can use two types of calculators: the simple calculator and the
scientific calculator.

1 Tap O > Essentials > Calculator.

2 Use the keypad to make a calculation.
- Torestart a calculation, touch and hold the {x] button.

ThinQ
You can easily connect the product with ol appliances to monitor and

conveniently use the appliances.
Tap O > Essentials > ThinQ.

I_;r] + Washing machine, dryer, styler, dishwasher, oven, and robot cleaner can
only be registered when the product is in the standby mode.

+ Look for the ThinQ mark on the product to see if it can be connected to
ThinQ app.
« Tap = to check various function of the ThinQ app.

Game Launcher

You can set whether to use the game launcher where you can view the
list of games installed on the product and select game settings such as
muting media volume, limiting alerts, etc.

1 Tap O > Essentials > Game Launcher.
2 Select the desired option.
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Audio Recorder

You can record and save your voice or others’ voices from important
events. Recorded voice files can be played back or shared.

1 Tap O > Essentials > Audio Recorder.

- Toadd anevent, tap : >Add tags > Add under Event. Then, add an
event to the desired date.

+ To save the recording’s location details, tap : > Add tags > Add
under Location.

2 Tap@.
- To pause recording, tap @.

3 Tap @ to end the recording.
« The file is saved automatically and the recorded files screen appears.

4 Tap @ to play the recorded voice.

E - Tap =0 to view the recorded files. You can play a recorded voice file from
the list.
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Update centre

You can check and install the latest version of the app or software
provided by LG.

Tap O > Management > Update centre.

Smart Doctor

You can use Smart Doctor to diagnose the device's condition and optimise

it.
Tap O > Management > Smart Doctor.

LG Mobile Switch

Easily transfer data from a used device to a new device via LG Mobile
Switch.

1 Tap O > Management > LG Mobile Switch.
You can also tap (O > Settings > System > Backup > LG Mobile
Switch.

7 Follow the on-screen instructions to select a desired method for
transfer.

E « Data in a Google Account will not be backed up. VWhen you synchronise
your Google Account, Google apps, Google contacts, Google Calendar,
Google memo app data and apps downloaded from the Play Store are
stored on the Drive app automatically.

Fully charge the battery before transferring data to avoid unintentional
powering off during the process.
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App trash

You can see the list of apps deleted on the home screen. The app that was
deleted within the last 24 hours can be recovered.

Tap O > Management > App trash.
For more details, refer to App trash.

SmartWorld

You can download a variety of games, audio content, apps and fonts
provided by LG Electronics. Customise your device to suit your preferences
by using Home themes and fonts.

E - If you use mobile data, you may be charged for data usage depending
on your pricing plan.
« This feature may not be supported depending on the area or service
provider.

1 Tap O > Services > SmartWorld.
2 Tap : >Signin, then signin.

3 Select and download the desired content items.
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RemoteCall Service

Your device can be remotely diagnosed for resolving issues. First, make a
phone call to an LG Customer Service Centre as follows:

« To use this function, first you must agree to usage of the function.

+ If you use mobile data, you may be charged for data usage depending
on your pricing plan.

1 Tap O> Services > RemoteCall Service.
2 Connect a call to an LG Customer Service Centre.

3 After the call connects, follow the service associates instructions to
enter a six-digit access number.
+ Your device is remotely connected and the remote support service
starts.

Cell Broadcast

You can view real-time text broadcasts on emergency situations, such as
typhoons, floods and earthquakes.

Tap O > Services > Cell Broadcast.
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Google apps

You can use Google apps by setting a Google Account. The Google
Account registration window appears automatically when you use a
Google app for the first time. If you do not have a Google Account, create
one from your device. For details on how to use an app, see the Help in
the app.

E + Some apps may not work depending on the area or service provider.

Chrome
A fast, simple, and secure web browser, built for the modern web.

Docs

Docs is a collaborative, word-processing tool that powers productivity. Use
Docs to create, edit and work together in real-time.

Drive

Drive is a file storage and sharing app that makes it easy to find, share and
collaborate on work projects from anywhere, instantly.

Duo

Make simple, high quality video calls to your friends and family on Android
phones and iPhones.

Gmail

Gmail is an easy to use mail app that keeps your messages safe, makes
your inbox smarter; and helps you stay organised.
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Google

The Google app keeps you in the know about the things you care about.
Find quick answers, explore your interests, and get a feed of stories and
updates on topics that matter to you.

Keep notes
Create, edit, and share you text and photo notes with Google Account.

Maps

Going somewhere? Go with Maps, the app you can rely on for real-time
GPS navigation, traffic, transit, and details about millions of places, such as
reviews and popular times.

Photos

Home for all your photos and videos, automatically organised so you can
share and save what matters.

Play Movies & TV

Use your Google Account to rent or purchase movies. Purchase content
and play it anywhere.

YT Music

A new music streaming service from YouTube.

Sheets

Sheets is a collaborative spreadsheet processing tool that powers
productivity. Use Sheets to import, organise and analyse information
together in real-time.
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Slides

Google Slides is a collaborative presentation creation tool that powers
productivity. Use Slides to organise information, present results, and make
decisions together in real-time.

YouTube

Watch your favorite channels, listen to music you love, and upload videos
to share with people around the world.

Assistant

Your device has the Google Assistant built-in. Find answers and get things
done while on-the-go. To get started, just tap the Google Assistant key
on the side of the phone or touch and hold the home button of the phone.

E + The Google Assistant is not available in certain languages and countries.

Calendar

The Calendar app allows you to track your schedule of events (that you
created), organised by Day, 3-day, Week or Month.

Files
You can view and manage files saved on your device.
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Settings

You can customise the device settings in accordance with your
preferences.

Tap O > Settings.

E « If you enter a keyword on the search window at the top of the screen,
you can conveniently run the items that need to be set.

Network & internet
Dual SIM Card

You can configure Dual SIM settings.
T On the settings screen, tap Network & internet > Dual SIM Card.
2 Customise the following functions:

+ SIM card 1:Change the name and icon of the SIM card 1.

+ SIM card 2: Change the name and icon of the SIM card 2.

+ SIM card colour theme: Change the colour themes for the SIM
cards.

+ Cost save mode: Activate or deactivate the cost save mode. In the
cost save mode, if you make a call to a contact to which a specific
SIM'is assigned, this SIM is used for the call even if the other SIM is
active, for example, it is using mobile data.

- Mobile data: Select a SIM card you want to use for mobile data
service. You can also turn off this function.

- Data roaming: Select this option to enable the device to use mobile
data when you are roaming outside your home network area.

- Mobile data during calls: Access mobile data using the nondefault
data SIM card temporarily during an HD voice call with the same
card.
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Wi-Fi

You can connect to nearby devices over a Wi-Fi network.

Connecting to a Wi-Fi network
1 On the settings screen, tap Network & internet > Wi-Fi.

72 Tap Q) toactivateit.
+ Available Wi-Fi networks appear automatically.

3 Select a network.
+ You may need to enter the network’s Wi-Fi password.

+ The device skips this process for previously accessed Wi-Fi
networks. If you do not want to automatically connect to a certain
Wi-Fi network, tap the network and then tap Forget.

Wi-Fi network settings

On the settings screen, tap Network & internet > Wi-Fi.

Switch to mobile data:If the mobile data connection function is
activated but the device cannot connect to the Internet via Wi-Fi
connection, the device automatically connects to the Internet via the
mobile data connection.

I_;'] « This feature depends on the service provider.

« + :Customise Wi-Fi network settings.
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Wi-Fi Direct

You can connect your device to other devices that support Wi-Fi Direct to
share data directly with them. You do not need an access point. You can
connect with more than two devices by using Wi-Fi Direct.

T On the settings screen, tap Network & internet > Wi-Fi> : >
Advanced Wi-Fi > Wi-Fi Direct.

+ Nearby devices that support Wi-Fi Direct automatically appear.

2 Select a device.
« Connection occurs when the device accepts the connection request.

E + The battery may drain faster when using Wi-Fi Direct.

Mobile data

You can turn mobile data on and off. You can also manage mobile data
usage.

Turning on mobile data
1 On the settings screen, tap Network & internet > Mobile data.
2 Tap QD toactivate it.

Customising mobile data settings
71 Onthe settings screen, tap Network & internet > Mobile data.
2 Customise the following settings:

+ Mobile data: Set to use data connections on mobile networks.

- Limit mobile data usage: Set a limit for mobile data usage to block
mobile data if the limit is reached.

« + :Customise mobile data settings.

- Data usage volume is measured based on the product, and the
volume calculated by your mobile provider may be different.
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Call

You can customise call settings, such as voice call and international call
options.

+ Some features may not be supported depending on the area or service
provider.

71 Onthe settings screen, tap Network & internet > Call.

2 Customise the settings.

Tethering
USB tethering

You can connect the device to another device via USB and share mobile
data.
7 Connect your device and other devices via USB cable.

2 On the settings screen, tap Network & internet > Tethering > USB
tethering and then tap Q) to activate it.

E + This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ When connecting to a computer, download the USB driver from
wwwilg.com and install it on the computer:

+ You cannot send or receive files between your device and a computer
while USB tethering is turned on. Turn off USB tethering to send or
receive files.

+ Operating systems that support tethering are Window XP or higher, or
Linux.
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Wi-Fi hotspot
You can set the device as a wireless router so that other devices can
connect to the Internet by using your device's mobile data.

1 On the settings screen, tap Network & internet > Tethering > Wi-Fi
hotspot and then tap (D) to activate it.

7 Tap Set up Wi-Fi hotspot, and enter the Wi-Fi name (SSID) and
password.

3 Turn on Wi-Fi on the other device, and select the name of the device
network on the Wi-Fi list.

4 Enter the network password.

+ This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

« More information is available at this web site:
http7/www.android.com/tether#wifi

Wi-Fi hotspot turn off timer

When the Wi-Fi hotspot has not been used for a specific period of time,
it is automatically disconnected. You can set the time for automatic
disconnection.

Bluetooth tethering

A Bluetooth-connected device can connect to the Internet by using your
device’s mobile data.

1 On the settings screen, tap Network & internet > Tethering >
Bluetooth tethering and then tap (O to activate it.

2 Turn on Bluetooth on both devices and pair them.
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5 - This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ More information is available at this web site:
http//www.android.com/tether#Bluetooth_tethering

Help
You can view help on using tethering and hotspots.
On the settings screen, tap Network & internet > Tethering > Help.

Airplane mode

You can turn off the call and mobile data functions. When this mode is
on, functions that do not involve data, such as games and music playback,
remain available.

71 Onthe settings screen, tap Network & internet > Airplane mode.

2 Tap Turn on in the confirmation screen.

Mobile networks
You can customise the mobile networks settings.
7 Onthe settings screen, tap Network & internet > Mobile networks.
2 Customise the following settings:
+ Network mode: Select a network type.

+ Access Point Names: View or change the access point for using
mobile data services. To change the access point, select a choice
from the access point list.

+ Network operators: Search for network operators and connect
automatically to a network.
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VPN

You can connect to a safe virtual network, such as an intranet. You can
also manage connected virtual private networks.

Adding VPN
1 On the settings screen, tap Network & internet > VPN.
2 Tap+

5 - This feature is available only when the screen lock is activated. If the
screen lock is deactivated, a notification screen appears. Tap Change
from the notification screen to activate the screen lock. See Setting a
screen lock for details.

3 Enter VPN details and tap Save.

Configuring VPN settings
71 Tapa VPN from the VPN list.

2 Enter the VPN user account details and tap Connect.

- To save the account details, select the Save account information
checkbox.

Private DNIS

You can configure the Private DNS (Domain Name System) options.
71 On the settings screen, tap Network & internet > Private DNS.
2 Select the desired option and tap Save.
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Connected devices

Bluetooth

You can connect your device to nearby devices that support Bluetooth to
exchange data with them. Connect your device to a Bluetooth headset
and a keyboard. This makes it easier to control the device.

Pairing with another device

7 On the settings screen, tap Connected devices > Bluetooth.

2 TapQDtoactivateit.
+ Available devices appear automatically.
+ To refresh the device list, tap (.

5 + Only devices set as visible are displayed on the list.

3 Select a device from the list.

4 Follow the on-screen instructions to perform authentication.

E « This step is skipped for previously accessed devices.

Sending data via Bluetooth

1 Select afile.
- You can send multimedia files or contacts.

2 Tap << > Bluetooth.

3 Select a target device for the file.
« The file is sent as soon as the target device accepts it.

E + File sharing processes may differ, depending on the file.
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NFC

You can use the device as a transportation card or credit card. You can also
share data with the other device.

71 On the settings screen, tap Connected devices > NFC.

2 TapQDtoactivateit.
« Touch your device with other device that supports NFC to allow
sharing data.

E + NFC antenna may be located differently depending on the device type.
See Parts overview for details about the NFC antenna area.

Android Beam

You can share files by touching the back of the device to other device. You
can also share files including music, videos or contacts and open a web
page or launch an app from the other device.

1 On the settings screen, tap Connected devices > Android Beam.

7 Touch the back of the device with another device.

E + NFC antenna may be located differently depending on the device type.
See Parts overview for details about the NFC antenna area.
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Sharing panel

You can share contents from Gallery, Music and File Manager with nearby
devices. Also you can share the content with specific people in apps that
work with Google Direct Share.

7 Onthe settings screen, tap Connected devices > Sharing panel.

7 Tap @ to deactivate each option.

- Nearby devices: You can display the nearby devices to which you
can share contents on the Gallery and Music apps.

- Direct share: From an app which supports Google Direct Share, you
can display an icon which allows you to share contents to specific
people.

File sharing
You can send and receive files between your device and other LG devices
or tablets.
7 On the settings screen, tap Connected devices > File sharing.
2 Customise the following settings:
- K51S:Change the device name.

- Save to: Set the destination folder to save files sent from other
devices in.

+ File sharing: Permit receipt of files sent from other devices.

- SmartShare Beam: Share files with other devices via SmartShare
Beam.

+ Help: You can view help on sharing files.
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Printing

You can connect your device to a Bluetooth printer and print photos or
documents saved on the device.

On the settings screen, tap Connected devices > Printing.

- Tap Default print service to search for printers you can connect to. Or,
tap : > Add printer to manually add a printer.

+ Tap (+) Add service to download the printer app you want.
E - This is available only when the mobile network or the Bluetooth
function is turned on.

« To down the printer app in (+) Add service, first log on to your Google
account.

Sound

You can customise sound, vibrate and notification settings.
On the settings screen, tap Sound and customise the following settings:

Sound profile: Change the sound mode to Sound, Vibrate only, or
Silent.

Volume: Adjust the sound volume for various items.

SIM1 ringtone/SIM2 ringtone: Select a ringtone for incoming calls.
Add or delete ringtones.

SIM1 notification sound/SIM2 notification sound: Select a
notification ringtone. Set music saved on the device as a notification
ringtone.

Ring with vibration: Set the device to vibrate and play a ringtone
simultaneously.

Ringtone ID: Create a ringtone for an incoming call from a particular
contact.

Flash alert for incoming call: Set the flash to blink according to LG
ringtone.
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- Do not disturb: Set the time, range and app type to receive
notification messages. Receive notification messages only on particular
days of the week.

- Sound quality and effects: Use the function to set the sound quality
and effects while playing a song or video.

- SIM1 vibration type/SIM2 vibration type: You can select the type of
vibration when receiving calls.

- Dialing keypad sound: Enable the keypad sound effect.
- LG Keyboard sound: Enable LG keyboard sound effect.
+ Touch sound: Enable a sound effect for tapping an item.

+ Screen lock sound: Enable a sound effect when the screen is locked
or unlocked.

Display
You can customise detailed settings for each screen type.

On the settings screen, tap Display and customise the following settings:

- Home screen: Customise settings for the Home screen. See Home
screen settings for details.

- Wallpaper & theme: Select a screen wallpaper, theme and icon for
your device.

- Font: Change the font size, bold text or type.

- New Second Screen: Select how the status bar and app corners will
look.

+ Home touch buttons: Set the Home touch button style. See Changing
the style of the Home touch buttons for details.

- Comfort view: Set the device to reduce amount of blue light on screen
to reduce eye strain.

- Night mode: You can apply a dimmed screen theme to avoid glare on
the screen at night time.

- App scaling: Adjust the screen size of apps.
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- Display size: Set the items on the screen to a size easy for you to see.
Some items may change position.

- Brightness: Use the slide bar to change the device's screen brightness.

+ Auto: Set the device so that the screen brightness is automatically
adjusted in accordance with the ambient light intensity.

- Screen timeout: Automatically turn off the screen when the device is
left idle for a specified period of time.

- Auto-rotate screen: Automatically rotate the screen according to the
device’s orientation.

- Screen saver: Display a screen saver when the device is connected to
the holder or charger. Select a screen saver type to display.

- Mini view: Make the screen size smaller to conveniently use the device
with one hand. Drag the Home touch button at the bottom of the
screen to the left or right.

Lock screen & security

You can customise lock screen and security settings.
1 On the settings screen, tap Lock screen & security.

2 Customise the settings.
+ Google Play Protect: Scans your device daily for potentially harmful
apps.
+ Find My Device: Remotely track the device location. You can also
protect your data securely if you lost your device.

- Security update: Check for software update and configure
automatic installation settings.

- Select screen lock: Select the desired screen lock method. See
Setting a screen lock for detalils.

- Customise Lock screen: Change the information displayed on the
locked screen.

- Secure lock settings: Change the secure lock settings.
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Fingerprints: Use your fingerprint to unlock the screen or content.
See Fingerprint recognition overview for details.

- Content lock: Allow you to set a lock type (password or pattern)
for your QuickMemo+ and Gallery files.

Location: You can customise how your location information is used
by particular apps.

Encryption & credentials: Configure the settings for SD card
encryption and credentials.

Encrypt SD card: Encrypt the memory card to prevent use on

another device. See Memory card encryption for details.

- Secure start-up: Protect your device with a lock when it powers
on. See Secure start-up settings for details.

- Credential protection: View the type of the storage where the

security certificate will be saved.

Trusted credentials: View your system's root CA certificates and

user-installed CA certificates.

- User credentials: View and change secure certificate information
stored on your device.

- Install from storage: Install a secure certificate from a storage.

- Clear credentials: Delete user-installed secure certificates and
related credentials.

Set up SIM card lock: Lock or unlock the USIM card, or change the

password (PIN).

Make passwords visible: Enable this option to briefly show each
character of the password as you type it so you can see what you've
entered.

Phone administrators: Allow privileges to restrict the control or
use of the device to particular apps.

Trust agents: View and use trust agents installed on the device.

Screen pin: Fix the app screen so that only the currently active app
can be used.

Usage access: View details on usage of apps on the device.
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Extensions

Smart Doctor

You can use Smart Doctor to diagnose the device's condition and optimise

it.
On the settings screen, tap Extensions > Smart Doctor.

Gaming
You can configure settings for game tools, graphics and battery saving
feature.
7 On the settings screen, tap Extensions > Gaming.
2 Customise the following settings:
- Game Launcher: Tap QD to use the game launcher.

- Game tools: You can run the function while playing games by
touching the game tools icon among the home touch buttons.

- Game graphics: Adjust the game graphics.
I_;'] + When you change the resolutions on some games, the screen display
feature may not work properly.

« This function may not be available in certain game apps.

- Break time: Reduce the screen brightness and performance
whenever you leave the game running for more than 5 minutes.
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Dual App

You can install duplicate messenger apps on the product and use two
accounts at the same time.

7 On the settings screen, tap Extensions > Dual App.

7 After reading the disclaimer, tap Confirm.

3 Inthe list of available apps, tap Install to install a copy of a desired app
and follow the on-screen instructions.

+ On the screen, the list of available dual apps is shown. During
installation, app icons are generated on the home screen.

Shortcuts

You can use buttons such as the Lock/Power, Volume, and Google
Assistant to run certain apps or functions right away.

1 On the settings screen, tap Extensions > Shortcuts.

2 Customise the following settings.

- View notification panel: Swipe down/up on the fingerprint sensor
for the notification panel.

- Open Camera: Press Power key twice to open Camera.

- Open Capture+: Press Volume Up key twice to open Capture+
when the screen is locked or off.

+ Open Camera: Press Volume Down key twice to open Camera
when the screen is locked or off.

- Open Google Assistant: Press the Google Assistant key on the
side of the phone.

- Talk to Google Assistant: Press and hold the Google Assistant key
to quickly talk to your Assistant.

- Show visual snapshot: Press the Google Assistant key twice to see
a snapshot of your day in the Google Assistant app.

E + Google Assistant does not support certain languages.
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KnockON

Double-tap the screen to turn the screen on or off.
See KnockON for details.

Digital Wellbeing & parental
controls

You can view the product use time and set the timer for each app.
Also, you can manage the mobile phone use time by using the Sleep
Preparation Mode and Focus Mode.

Select Digital Wellbeing & parental controls on the settings screen and
set the desired function.

Apps & notifications

You can check a list of installed apps, and configure the settings for
notifications, app permissions, and more.

71 On the settings screen, tap Apps & notifications.

2 Customise the settings.

Battery

You can view the current battery information or turn on power-saving
mode.

1 On the settings screen, tap Battery.

2 Customise the following settings:
- Battery usage: View the battery usage details.

- Battery percentage on status bar: Display the remaining battery
level as a percentage on the status bar.
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- Adaptive battery: Allow you to save the battery by stopping apps
running in the background.

- Background restrictions: Enable this option to restrict background
apps to save the battery while using the device. Restricted apps
for power saving may not work properly or may not send you
notifications.

- Battery saver: Reduce battery consumption by cutting down some
device settings, such as the display brightness, speed and vibration
intensity.

- Power saving exclusions: Select apps to use without any
functional limitation while in power saving or battery optimisation
mode.

Storage

You can view and manage internal storage on the device or storage space
of the memory card.

7 On the settings screen, tap Storage.

2 Customise the following settings:
- Internal storage: View the total storage space and free space in the
devices internal storage. View a list of apps in use and the storage
capacity for each app.

+ SD card: View the total storage space and free space in the
memory card. This option appears only when a memory card is
inserted. To unmount the memory card, tap

Accounts

You can add users to share your device and register a cloud account.
1 On the settings screen, tap Accounts.

2 Customise the settings.
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Google

You can use Google settings to manage your Google apps and account
settings.

On the settings screen, tap Google.

System

Update centre

You can check and install the latest version of the app or software
provided by LG.

1 On the settings screen, tap System > Update centre.

2 Customise the following settings:

+ App Updates: Check if an app update is available. If available, you
can install the update.

- Software Update: Check if a software update is available. If
available, you can install the update.

Language & keyboard

You can customise language and keyboard settings for your device.
1 On the settings screen, tap System > Language & keyboard.

2 Customise the following settings:
- Language: Select a language to apply for the device.

- Manage keyboards: You can change the product’s basic keyboard
setting, set the use environments for LG Keyboard or other installed
keyboards, and set the speech recognition function for Google Voice
input. Also, you can set whether to display the keyboard button in
the touch button area on the home screen so that you can quickly
switch to another keyboard.
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- Physical keyboard: Select to use the physical keyboard, or check
keyboard shortcut keys.

- Autofill service: Enable this option to enter your information saved
in your account such as password, address, or credit card number
with a single tap. You can also disable this option, use Google
Autocomplete, or add a new service account.

- Text-to-speech output: Configure the settings for text-to-speech
output.

+ Pointer speed: Adjust the pointer speed of a mouse or trackpad.

- Reverse mouse buttons: Reverse the right mouse button to
perform primary direct-manipulation actions.

Date & time

You can customise date and time settings for your device.
1 On the settings screen, tap System > Date & time.

2 Customise the settings.

Memory

You can view the average amount of memory usage over a certain period
of time and the memory occupied by an app.

7 On the settings screen, tap System > Memory.

7 Tap w to set a time slot to retrieve data.

Backup

You can back up data saved on your device to another device or account.
7 On the settings screen, tap System > Backup.

2 Customise the following settings:

+ LG Mobile Switch: Allow you to transfer data from an old LG device
to your new LG device. See LG Mobile Switch for detalls.
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- Backup & restore: Back up your device data or restore data to your
device from a backup.

+ Resetting your device may delete backup files saved in storage. Make
sure to copy and store the important backup files to your PC.

+ Google backup: Change Google drive backup settings. You can
also check the backup account currently used, or add a new backup
account.

Restart & reset
You can reset the device including network and app settings.
T On the settings screen, tap System > Restart & reset.

2 Customise the following settings:

+ Auto-restart: Automatically restart and optimise the phone at a
set time. Tap QD to activate this feature. The device automatically
restarts at a set time and optimise itself. Select a date and time for
restart.

E + You can set the device to restart itself once a week. The device
automatically restarts in an hour from the preset time.

+ Once the device restarts, notifications and badges are erased. Save
important data before the preset time.

+ The Auto-restart feature is not activated in the following situations:
When the screen is turned on, when the device is in use, when the
battery level is 30% or less, when the USIM card is locked, or when the
device lock is activated while turning on the device.

- Depending on the telecommunication provider, the auto-restart
function may or may not be available.

- Network settings reset: Reset \Wi-Fi, Bluetooth and other network
settings.

- Reset app preferences: Reset the settings for an app. The data
saved in the app will not be deleted.
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Factory data reset: Reset all settings for the device and delete
data.

+ Restarting and resetting your device deletes all data on it. Enter your
device name, Google Account and other initial information again.

« After data initialisation, the data cannot be restored.

About phone

You can view information about your device, such as the name, status,
software details and legal information.

On the settings screen, tap System > About phone and view information.

Regulatory & safety

You can view regulatory marks and related information on your device.

On the settings screen, tap System > Regulatory & safety.

Accessibility

You can manage accessibility plug-ins installed on your device.

T On the settings screen, tap Accessibility.

2 Customise the following settings:

Vision > TalkBack: Set the device to notify screen status or actions
via voice.

Vision > Voice notifications: Set the device to read the caller
information via voice.

Vision > Font: Change the font size, bold text or type.
Vision > Display size: Set the items on the screen to a size easy for
you to see. Some items may change position.

Vision > Touch zoom: Zoom in or out by tapping the screen three
times.
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- Vision > Window zoom: Zoom in or out within a window and invert
the colour.

+ Vision > Large mouse pointer: Magnify the mouse pointer.

- Vision > High contrast screen: Turn the background colour into
black for a high contrast screen.

- Vision > Screen colour inversion: Increase the display colour
contrast for people with low vision.

- Vision > Screen colour adjustment: Adjust the display colour.
- Vision > Monochrome: Switch the screen to grayscale mode.

- Vision > End call with the Power key: End a call by pressing the
Power/Lock key.

+ Hearing > Captions: Turn on the subtitle service when playing
videos for the hearing impaired.

- Hearing > Flash alerts: Set the device to notify you with a blinking
light for incoming calls, messages and alarms.

+ Hearing > Mute all sounds: Mute all sounds and lower volume on
the receiver.

+ Hearing > Audio channel: Select the audio type.

- Hearing > Sound balance: Adjust the audio output balance. Use the
slide bar to change the balance.

- Motor & cognition > Touch assistant: Turn on the touch board to
make buttons and gestures easier to use.

- Motor & cognition > Touch input: Enter text by touching and
holding the screen or modify it by simply touching the screen.

+ Motor & cognition > Physical keyboard: Customise the keyboard
settings.

+ Motor & cognition > Auto mouse click: Automatically click the
mouse pointer in case of no movement.
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+ Motor & cognition > Touch and hold for calls: Answer or decline
calls by touching and holding the call button instead of dragging it.

+ Motor & cognition > Screen timeout: Turn off the screen
automatically when the device is left idle for a specified period of
time.

+ Motor & cognition > Touch control areas: Limit the touch area
so that only a particular portion of the screen can be controlled by
touch input.

+ Accessibility features shortcut: Quickly access a frequently used
function by tapping O three times.

- Auto-rotate screen: Automatically change the screen orientation
according to the physical position of the device.

- Select to Speak: Allow you to tap items to hear spoken feedback.
+ Switch Access: Create key combinations to control your device.
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Language Settings
Select a language to use on your device.
- Tap O > Settings > System > Language & keyboard > Language >
Add language, and select a language.
- Touch and hold = and drag it to the top of the language list to set it
as a default language.

LG Bridge

LG Bridge overview

LG Bridge is an app that helps you manage the photos, music, videos

and documents saved on your LG smartphone from your computer
conveniently. You can back up contacts, photos and more to the computer
or update the device software.

E + See LG Bridge help for details.
+ The supported features may vary depending on the device.

+ LG USB driver is a necessary program to connect your LG smartphone
with the computer and is installed when you install LG Bridge.

LG Bridge functions
+ Manage the files on the device from a computer via Wi-Fi connection
or mobile data connection.

+ Back up data from the device to a computer or restore data from a
computer to the device via USB cable connection.

+ Update the device software from a computer via USB cable connection.
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Installing LG Bridge on a computer
1 Go to wwwilg.com from your computer.
2 Select your region.
3 Click Support > Software & Firmware.
4 Enter the name of your device.
OR
Select by the Product Category.
5 Go to PC Sync > LG Bridge to download the setup file.

+ Go to Details to view the minimum requirements for installing
LG Bridge.

Phone software update

LG Mobile phone software update from the

Internet

For more information about using this function, please visit
http//wwwi.lg.com/common/index,sp, select your country and language.
This feature allows you to conveniently update the firmware on your
phone to a newer version from the Internet without needing to visit a
service centre. This feature will only be available if and when LG makes a
newer firmware version available for your device.

Because the mobile phone firmware update requires the user's full
attention for the duration of the update process, please make sure

you check all instructions and notes that appear at each step before
proceeding. Please note that removing the USB cable during the upgrade
may seriously damage your mobile phone.

+ LG reserves the right to make firmware updates available only for

selected models at its own discretion and does not guarantee the
availability of the newer version of the firmware for all handset models.
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LG Mobile Phone software update via Over-
the-Air (OTA)

This feature allows you to conveniently update your phone's software to
a newer version via OTA, without connecting a USB cable. This feature will

only be available if and when LG makes a newer firmware version available
for your device.

To perform the phone software update,

Settings > System > Update centre > Software Update > Check now
for update.

E « Your personal data from internal phone storage—including information
about your Google Account and any other accounts, your system/
application data and settings, any downloaded applications and your
DRM licence—might be lost in the process of updating your phone's
software. Therefore, LG recommends that you backup your personal
data before updating your phone’s software. LG does not take
responsibility for any loss of personal data.

« This feature depends on the area or service provider.
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Anti-Theft Guide

Set up your device to prevent other people from using it if it's been reset

to factory settings without your permission. For example, if your device is

lost, stolen, or wiped, only someone with your Google Account or screen

lock information can use the device.

All you need to make sure your device is protected is:

- Set a screen lock: If your device is lost or stolen but you have a screen

lock set, the device can't be erased using the Settings menu unless
your screen is unlocked.

- Add your Google Account on your device: If your device is wiped but
you have your Google Account on it, the device can't finish the setup
process until your Google Account information is entered again.

After your device is protected, you'll need to either unlock your screen or
enter your Google Account password if you need to do a factory reset.
This ensures that you or someone you trust is doing the reset.

E « Do not forget your Google Account and password you had added to
your device prior to performing a factory reset. If you can't provide the
account information during the setup process, you won't be able to use
the device at all after performing the factory reset.
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Open Source Software Notice
Information

To obtain the source code under GPL, LGPL, MPL, and other open
source licenses, that is contained in this product, please visit
http://opensource.lge.com.

In addition to the source code, all referred license terms, warranty
disclaimers and copyright notices are available for download.

LG Electronics will also provide open source code to you on CD-ROM
for a charge covering the cost of performing such distribution (such
as the cost of media, shipping, and handling) upon email request to
opensource(@lge.com.

This offer is valid for a period of three years after our last shipment of this
product. This offer is valid to anyone in receipt of this information.

Regulatory information
(Regulation ID number, E-labeling, etc.)

For regulatory details, go to Settings > System > Regulatory & safety.
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Trademarks

« For DTS patents, see http//patents.dts.com. Manufactured under
license from DTS Licensing Limited. DTS, the Symbol, & DTS and the
Symbol together, DTS, and the DTSX logo are registered trademarks
or trademarks of DTS, Inc. in the United States and/or other countries.
© DTS, Inc. All Rights Reserved.

.A,@)
dts

===

=

N

+ Copyright ©2020 LG Electronics Inc. All rights reserved. LG and the
LG logo are registered trademarks of LG Group and its related entities.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play,
Android, Chrome, Google Photos, Google Play Protect, Google Calendar,
Google Docs, Google Drive, Google Sheets and other related marks and
logos are trademarks of Google LLC.

- Bluetooth®is a registered trademark of Bluetooth SIG, Inc. worldwide.

+ Wi-Fi® and the Wi-Fi logo are registered trademarks of the Wi-Fi
Alliance.

- All other trademarks and copyrights are the property of their
respective owners.

HE HEVCAdvance”

‘: Covered by Patents at patentlisthevcadvance.com
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Laser safety statement

Caution!

This product employs a Laser system. To ensure proper use of this
product, please read this owner's manual carefully and retain for future
reference. Should the unit require maintenance, contact an authorised
service centre.

Use of controls, adjustments, or the performance of procedures other
than those specified herein may result in hazardous radiation exposure.
To prevent direct exposure to laser beam, do not try to open the enclosure
or make direct contact with the laser.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER

DECLARATION OF CONFORMITY

Hereby, LG Electronics declares that this LM-K5TOEMW product is in
compliance with the essential requirements and other relevant provisions
of Directive 2014/53/EU.

A copy of the Declaration of Conformity can be found at
http//wwwi.lg.com/global/declaration
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Contact office for compliance of
this product

LG Electronics European Shared Service Center BV.
Krijgsman 1, 1186 DM Amstelveen, The Netherlands

More information

Tempered glass parts

Tempered glass parts of this device are not permanent and they may wear
out over time.

- If you drop your device on a hard surface or subject it to severe impact,
the tempered glass may be damaged.

If this happens, stop using your device immediately and contact an LG
Customer Service Centre.

+ You can purchase protective cases to protect your device from damage
on the market.

Note that these protective cases are not covered under the warranty
service provided by LG Electronics and safety is not guaranteed.

Aspect ratio
Some downloaded apps may not support specific aspect ratio.

In this case, select the most optimal screen ratio for the app or consult
the app provider for more information.
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Guide to data transfers

- For the data that can be exchange between LG devices or between the

LG device and a third party device, see the following table.

Third party
LG device Android iOS device
Type Item details - device —
LG device - LG device
LG device

Contacts, messages,

dial logs, calendar, voice @) O O
Personal | recordings
data Memos X O

Alarms X X
Media Photos, videos, songs,
data documents o o O

Home screen settings

(folders and widgets) % X X
Screen
settings Lock screen settings

(screen lock settings @) X X

excluded)

Downloaded apps O O
Apps Personal data of the o X B

downloaded app

Public certificate @) @) X
Others | Settings (Wi-Fi, Bluetooth,

Calls, sound & notification, @) X X

accessibility, battery)

E + Some data may not be transmitted depending on the software version,
app version, operating system, manufacturer or service provider's policy.
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Supported Frequency Bands Transmitter Output power

GSM 900 34.0 dBm
GSM 1800 31.0dBm
WCDMA B1 250dBm
WCDMA B8 250dBm
LTEB1 25.0dBm
LTEB3 250dBm
LTEB7 24.0dBm
LTEBS8 25.0dBm
LTEB20 250dBm
LTEB28 250dBm
LTEB38 24.0 dBm
BT 2.4GHz 9.5dBm
WLAN 2.4GHz 19.0 dBm
NFC -33dBuA/m

Travel Adapter Information can be found at
http//wwwi.lg.com/global/support/cedoc/cedoc
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Disposal of your old appliance

1. This crossed-out wheeled bin symbol indicates that waste electrical
and electronic products (WEEE) should be disposed of separately
from the municipal waste stream.

N 2 Old electrical products can contain hazardous substances so correct
disposal of your old appliance will help prevent potential negative
consequences for the environment and human health. Your old
appliance may contain reusable parts that could be used to repair
other products, and other valuable materials that can be recycled to
conserve limited resources.

3. You can take your appliance either to the shop where you purchased
the product, or contact your local government waste office for
details of your nearest authorised WEEE collection point. For
the most up to date information for your country please see
wwwi.lg.com/global/recycling

Disposal of waste batteries/accumulators

1. This symbol may be combined with chemical symbols for mercury
(Hg), cadmium (Cd) or lead (Pb) if the battery contains more than
0.0005% of mercury, 0.002% of cadmium or 0.004% of lead.

2. All batteries/accumulators should be disposed separately from the

municipal waste stream via designated collection facilities appointed
by the government or the local authorities.

3. The correct disposal of your old batteries/accumulators will help
to prevent potential negative consequences for the environment,
animal and human health.

4. For more detailed information about disposal of your old batteries/
accumulators, please contact your city office, waste disposal service
or the shop where you purchased the product.
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FAQ

This chapter lists some problems you might encounter when using your
device. Some problems require you to call your service provider, but most
are easy to fix yourself.

Device overheats

Device overheats while it is used.

In the following cases, the battery consumption increases and the device
may overheat:

+ When you turn on the device for the first time or back up the data
- When running multiple apps simultaneously
- When multiple apps are running in the background

- When downloading large files while making a video call or recording
avideo

+ When using features that require high power

- When watching video streaming on the internet, or recording a long
video

- When playing high-end games for long time
- When using the device with maximum screen brightness for a long
time
+ When using lots of mobile data
- When using Wi-Fi hotspot or tethering
- When synchronising the data for multiple accounts simultaneously
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+ Other cases
- When roaming overseas
- When using the device in areas with weak signals or no reception

- When charging the device with the charger/USB cable port that is
damaged or contaminated with foreign substance

+ Some of the above cases may not apply depending on the features and
apps.

Device overheats while charging.

+ The device and the charger may become hot while charging. If the
battery temperature rises above a certain level, the device may stop
charging.

- Disconnect the charger from the device and close any running apps.
Let the device cool down before charging the device or running an
app again.

- Stop charging if the charger/USB cable port at the lower part of the
device overheats, and visit the nearest LG Customer Service Centre.

How to solve overheating of the device

+ Close any running apps or features, and let the device cool down.
- Always update the software to the latest version.

+ Turn off Wi-Fi, Bluetooth, or GPS features while not using them.
- Close apps you don't use.

« If you are using the device with maximum screen brightness, decrease
the brightness.

« If the device overheats for a prolonged period, stop using it for a while.
If the device continues to overheat, visit the LG Customer Service
Centre.
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Usage limitations when the device overheats

If the device overheats while using it or charging, some features, apps, or
even the device may be turned off.

This is a normal operation for the devices that support this feature.

+ If the device temperature rises above a certain level, a warning
message appears.

- If you play high-end games, record videos, or upload large files, the
device may overheat for a prolonged period. In this case, a warning
message may appear to notify automatic shutdown.

Turn off the device or close any running apps or features, and let the
device cool down.

+ The screen brightness and the operating speed may be limited to cool
down the device. Any running apps or features may slow down or stop.
The device may stop charging.

SIM card error
Make sure the SIM card is correctly inserted.

No network connection or dropped network
Signal is weak. Move to a window or an open area.
You are outside the carrier network area. Move and check the network.

Calls are not available

New network not authorised.

Make sure you have not set call barring for the incoming number:
Make sure you have not set call barring for the number you are dialing.

Device cannot be turned on
When the battery is completely discharged, your device will not turn on.
Fully charge the battery before turning on the device.
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Charging error

Make sure device is charging at a normal temperature.
Check the charger and its connection to the device.

Use only in-box accessories which are authorised by LG.

The battery depletes faster than when first purchased

\When you expose the device or the battery to very cold or hot
temperatures, the battery life may be reduced.

Battery consumption will increase when you use certain features or apps,
such as GPS, games or the Internet.

The battery is consumable and the battery life will get shorter over time.

Error messages appear when launching the camera
Charge the battery.

Free some memory by transferring files to a computer or deleting files
from your device.

Restart the device.

If you are still having trouble with the camera app after trying these tips,
contact a LG Electronics Service Center.

The photo quality is poor
The quality of your photos may vary, depending on the surroundings and
the photography techniques you use.

If you take photos and videos, standard angle quality is better than wide-
angle.

If you take photos in dark areas, at night or indoors, image noise may
occur or images may be out of focus.

If you have any problems, reset the options.
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The touch screen responds slowly or incorrectly

If you attach a screen protector or optional accessories to the touch
screen, the touch screen may not function properly.

If you are wearing gloves, if your hands are not clean while touching the
touch screen or if you tap the screen with sharp objects or your fingertips,
the touch screen may malfunction.

The touch screen may malfunction in humid conditions or when exposed
to water.

Restart your device to clear any temporary software bugs.

If the touch screen is scratched or damaged, visit a LG Electronics Service
Center.

Hangs or freezes

Restart the device

- If your device freezes or hangs, you may need to close apps or turn the
device off and then on again.

Perform a boot-up

- Asoft reset may be used to reset the device if the screen freezes, or
the buttons, touch screen or device are no longer responding.

- To perform a soft reset of your device, simply press and hold the
Volume Down and Power keys until the device restarts.
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Reset the device

+ If the methods above do not solve your problem, perform a factory
datareset.

+ On the settings screen, tap System > Restart & reset > Factory data
reset.

- This method resets all settings for the device and deletes data.
Before performing the factory data reset, remember to make back-
up copies of all important data stored in the device.

- If you registered a Google Account to the device, you must sign in to
the same Google Account after resetting the device.

Bluetooth device is not located
Make sure the Bluetooth wireless feature is activated on your device.

Make sure the Bluetooth wireless feature is activated on the device you
wish to connect to.

Make sure your device and the other Bluetooth device are within the
maximum Bluetooth range (10 m).

If the tips above do not solve your problem, contact a LG Electronics
Service Center.

A connection is not established when you connect the
device to a computer
Make sure the USB cable you are using is compatible with your device.

Make sure you have the proper driver installed and updated on your
computer.

Downloaded application causes a lot of errors
Application has problems.
Remove and reinstall the application.
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